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Introduction



E



xcel 2007 makes life much easier than it has been in the past. You’ll find that features and functions are easier to locate via the Ribbon, but you’ll also wonder how to do things you might have done in the past. In this book, we want you to learn how to do things quickly and easily — even if you just skim the book for tips and tricks. We write the sort of books that we like to use (quick references); in fact, we refer to our own books when we haven’t used a specific feature in a year or two and when we want the answer fast. Our intention with this book was to write an easy-to-use insider’s guide to the best, quickest ways to do the things that most people need to do (and brief introductions to some features that fewer people need to use, but enough to show you what those features are capable of). We don’t intend this book to be a compendium of every single feature in Excel — there are much fatter books that do that job admirably. For example, there are a great many more functions in Excel than we cover in this book. Many of them have been around since the dinosaurs and have since been replaced by features that are altogether easier to use than the original functions. Many other functions are useful only to individuals in high-end mathematics, science, and engineering fields; other books do cover them (see Appendix B for some titles), but not this book. We intend this book to be an easy-to-use, quick reference for when you’re at work and you need to quickly know or be reminded of how to do something; to show you the best, easiest, most efficient ways of doing everything; and possibly show you how you can make your work easier and faster using techniques that you didn’t know you could use.
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Special Features Every book in the Unofficial Guide series offers the following four special sidebars that are devised to help you get things done cheaply, efficiently, and smartly. 1. Hack: Tips and shortcuts that increase productivity. 2. Watch Out!: Cautions and warnings to help you avoid common pitfalls. 3. Bright Idea: Smart or innovative ways to do something; in many cases, this will be a way that you can save time or hassle. 4. Inside Scoop: Useful knowledge gleaned by the author that can help you become more efficient. We also recognize your need to have quick information at your fingertips, and have provided the following comprehensive sections at the back of the book: 1. Glossary: Definitions of complicated terminology and jargon. 2. Creative Worksheets: Real-world worksheets that go well beyond the average worksheet by combining Excel features, objects, controls, formulas, and macros. Use them for creative inspiration. 3. Recommended Resources: Suggested titles and Web sites that can help you get more in-depth information on related topics. 4. Index
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Getting In and Out



T



his chapter covers all the most basic procedures in Excel 2007. Starting, quitting, opening and closing files, using hyperlinks, creating templates, and saving files are all the same as in other Office programs, and in fact you can use the information learned in this chapter in other Office programs. This consistency helps reduce your learning curve. Even if these procedures are familiar to you, keep in mind that the Excel 2007 interface is organized differently than previous versions, so it’s a good idea to get in on the ground floor and make sure you have a mastery of the basics.



Starting Excel The first time you start Excel, you click the Windows Start button to start the program. Thereafter, you have the option to open Excel from the Windows Start menu. The Excel icon appears in the listing of recently opened programs. If you want to make Excel a permanent part of the Start menu, simply right-click the Excel icon on the Start menu and click Pin to Start Menu. This method gives you a quick and easy way to start Excel from this point forward.



3



Chapter 1



GET THE SCOOP ON... Starting Excel ■ The Excel environment ■ Getting help ■ Opening workbook files ■ Using Quick Access Toolbars ■ Using hyperlinks to open files ■ Saving workbook files ■ Creating and using templates ■ Closing workbook files
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STARTING OUT WITH EXCEL 2007



Bright Idea If you would rather not start Excel with the Start menu, click and drag the Excel icon from the Programs menu and drop it on your desktop instead to create a desktop startup icon. To avoid cluttering your desktop with icons, you can create a new folder on the desktop and drop new icons in that folder. You can also add Excel to your Quick Launch menu in Windows XP and Windows Vista.



The Excel environment If you’re new to Excel, you’ll find a lot of unfamiliar terms and objects in the Excel landscape. Even if you have used Excel in the past, you’ll find that the 2007 version looks different. Figure 1.1 shows the default Excel window and many of the terms and objects we refer to in procedures throughout the book. When you first start Excel, you see the window that appears in Figure 1.1.



Figure 1.1. The standard Excel interface
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Inside Scoop



When you position the mouse pointer over a toolbar button, a Mini Toolbar — a small label — appears that tells you the name of the button and what you can do with the feature. If you don’t see the Mini Toolbar, click the File button in the upper-left-corner of the interface (it has the Office logo on it) and click the Excel Options button. In the Personalize section, clear the Show Mini Toolbar on selection check box. You can also change the ScreenTip scheme here if you want the Mini Toolbar to show you something different.



The Ribbon The Ribbon is a new management feature in all Office programs. The Ribbon is the toolbar area you see along the top of Excel containing icons and tabs, such as Home, Insert, Page Layout, and so forth. The Ribbon is Microsoft’s answer to the ever-growing complexity of Microsoft Office; it’s an attempt to reduce the number of drop-down menus and dialog boxes so that the program’s features are easier to find. Notice that each tab on the Ribbon contains different categories called “groups.” For example, on the Home tab, you see the Clipboard group, Font group, Alignment group, and so forth. Each group contains buttons and options for items within that group. Additionally, many groups contain a Dialog box launcher in the right corner of the group (looks like a box and an arrow). Click the launcher to open older-style dialog boxes and properties pages.



Task panes The task pane (shown in Figure 1.2) is a vertical pane of information that appears on the right side of your Excel program window when you perform certain operations. This feature was first introduced in Office 2003, but frankly, was overkill and it cluttered the interface of the Office programs. Its use has been greatly reduced in Excel 2007, but you’ll still see it appear for some of the features, such as the Research feature. Because the task pane is a bit unwieldy, it has been replaced by expandable menus that appear from selection items on the Ribbon. Task panes have list boxes and text links that help you perform a specific task, and they’re fairly straightforward.
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STARTING OUT WITH EXCEL 2007



Figure 1.2. A task pane



Menus Of course, you no doubt already know what the menu bar is and how to use menu commands: you click the menu button and then click the command on the drop-down menu. However, menus in Office 2007 are different. Across the top of your screen, you see two layers of menus, shown in Figure 1.3. The top layer of menus is icon based and the second layer of menus actually provides access to what are now called Quick Access Toolbars.
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Figure 1.3. Icon menus and standard menus with the Quick Access Toolbar



You have the following basic menus: ■



Microsoft Office Button: This icon shows you the Office logo. When you click this icon, you can save, print, send, and publish documents. Figure 1.4 shows you the Office Menu.



■



Save. Clicking the disk icon opens a standard Windows Save As dialog box.



■



Undo and Repeat. These options enable you to quickly undo and repeat actions within Excel.



■



Customize Quick Access Toolbar. This option allows you to customize your Excel experience, which is discussed later in this book.



Figure 1.4. Microsoft Office menu



Note that toward the right of the interface you can access the Help button as well as Minimize and Restore Window commands.
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Tabs Tabs, which are found on the Ribbon, are designed to give you most everything you need in Office programs without wading through layers of menus, dialog boxes, and task pane options. For the most part, they work well and provide a more streamlined approach to using Office. The tabs you find in each Office product vary a bit according to the product, but from within Excel, you have the following default tabs: ■



Home. The Home Quick Access Toolbar contains basic text- and cell-formatting functions and features.



■



Insert. This option enables you to insert items into your Excel documents, such as shapes, tables, pictures, graphs, and so forth.



■



Page Layout. This toolbar provides page layout options such as colors, fonts, margins, breaks, gridlines, and so on.



■



Formulas. This toolbar provides formulas and functions to use within Excel.



■



Data. This option allows you to manage data from different sources, data sorting, data filtering, text-to-table functions, and grouping.



■



Review. This toolbar option allows you to check your spelling, use a thesaurus, create and manage comments, protect and share workbooks, and so on.



■



View. This option enables you to create custom views, show and hide options, use zoom, control and manage general window appearance.



■



Add-Ins. This option enables you to add custom toolbars and other add-in software.



On each tab, you have additional drop-down menu items depending on the options that are available. For example, in Figure 1.5, notice that we access the drop-down menu for Conditional Formatting under the Home tab.



The Formula bar The Formula bar is the long, open box that appears above the column letters in the worksheet. The box at the left end, the Name box, shows either the address of the selected cell or the name of the selected cell or range (if the selection is named). We tell you more about naming cells and ranges in Chapter 4. The fx button is the Function Wizard button; it opens the Insert Function dialog box (see Chapter 5 for more in-depth information).
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Figure 1.5. Additional menus appear when you access options on different tabs.



The Formula bar displays the underlying data in the active cell, whether the actual cell data is a formula or a value. The data displayed in the cell, the displayed value, is the result of formatting the value in the cell and can be entirely different from the actual value in the cell. Regardless of what is displayed in the cell, the data you see in the Formula bar is the data Excel calculates. We discuss formatting in Chapters 6 and 7. You can type data directly in a cell, or you can select the cell and then click in the Formula bar to type your entry. Usually, typing data directly in the cell is most efficient, but sometimes it’s easier to edit an entry in the Formula bar. When you open a cell for entry or editing — when you begin to type an entry or double-click a cell to edit its data — an X and a check mark appear between the Name box and the Formula bar. The X button cancels your editing operation (the same as pressing Esc) and the check mark button enters the data (same as pressing Enter). Inside Scoop



Inside Scoop We’ve never used either the X or the check mark button because pressing Enter and Esc is so much quicker when your hands are already on the keyboard.
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Watch Out! If you attempt to type numbers on your keypad and all you get is the active cell bouncing around, the problem is that your Number Lock is turned off (you won’t see NUM in the status bar, either). Press the Num Lock key to fix it.



The status bar The status bar is the bar along the bottom of the Excel program window (shown in Figure 1.6). It usually reads Ready at the left and provides different view and zoom controls toward the right.



Figure 1.6. The status bar displays different indicators.



The word Ready at the left end means Excel is waiting — ready — for you to do something; when you are doing something, such as typing or copying an entry, Ready changes to a directive that tells you what to do next because Excel assumes that you don’t know what to do next. You rarely notice any of these words at the left end of the status bar, nor do you need to, but someone always wonders about those words. You can learn more about what is turned on and off on the status bar by rightclicking the status bar and viewing the current Status Bar Configuration.



Getting help The fastest way to get help is to look it up in the index of a good book (like this one), but if someone else is using the book, or you want the answer to an obscure question that’s not covered in your book, you can look up a topic in Excel’s Help files. Just click the Help button (looks like a question mark). If you’re connected to the Internet when you ask for help, Excel goes online to Microsoft for help (and you generally get far too many options on superficial, vaguely connected topics). If you’re not connected to the Internet, Excel searches its local Help files for the answers (which is much faster and more direct). But even if you’re connected — and most highspeed connections keep you constantly connected — you can choose which help source (local or online) you want. Just type the subject you’re looking for in the provided dialog box and click Search. You can also click the drop-down arrow on the search button to specify the location in which you want Help to look, shown in Figure 1.7.
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Figure 1.7. Help dialog box



Your search subject will return different articles and step-by-step examples, as shown in Figure 1.8. Remember to keep searches specific; if your search returns no results, you’ll need to broaden your search specification.



Figure 1.8. Search results
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Inside Scoop Are you wondering about the silly and obtrusive Office Assistant character that appeared way too much in Office 2003? You can breathe a sigh of relief because the Office Assistant is gone in Office 2007.



Excel, heal thyself If Excel begins to behave strangely, you may have a corrupt program file (yes, it still happens, although rarely). Fortunately, Excel has a new Office Diagnostics program that provides comprehensive testing and automated repair capabilities. If you’re having problems, follow these steps: 1. Click the File button. 2. On the File menu, click the Excel Options button. 3. Click the Resources option and then click the Diagnose button under Office Diagnostics, as shown in Figure 1.9. 4. A diagnostic test will be run, as shown in Figure 1.10. Follow any instructions the wizard provides.



Figure 1.9. Choose the Diagnose button.
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Hack If you find a helpful article in the Knowledge Base, bookmark the Web page in your browser or print it for future reference.



Figure 1.10. Office Diagnostics



Searching the Microsoft Knowledge Base When you have serious problems in Excel, or in any Microsoft program, the Microsoft Knowledge Base is sometimes a good source of solutions. For us, it’s a last resort because, although the Knowledge Base is an extensive database of articles about bug fixes, known problems, workarounds, and so on, it’s not fast. You’ll find lots of articles that don’t apply to your problem at all, and it takes some time to plow through all the article titles to find applicable information (if it exists). Occasionally, however, it’s got the information you need. For, if for example you install a new antivirus program and suddenly a Microsoft program goes out of kilter. And it’s free. To use the Microsoft Knowledge Base, go to http://support. microsoft.com. Click the Search Knowledge Base link and follow the instructions for your software program and question.



Bright Idea As long as you’re in the Microsoft site, take a look around for updates and extra features to download.
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Opening workbook files When you start Excel, a new unsaved workbook file opens. To open another new workbook, click the File menu and then click Open (or just press Ctrl+O). The workbooks, by default, are named Book1, Book2, and so on, which indicates their unsaved status. Quite often, however, you want to open existing workbooks. If Excel is not already open, you can open both the file and Excel at the same time. If Excel is already open, you can use the File menu; if you’ve used the file recently, the file is listed on the File menu in the Recent Documents section.



When Excel is closed We use a few different methods to open existing workbook files, depending on where the file is saved, whether Excel is already open, and when we last used the file. ■



If we’ve used the file recently, we open it from the Start menu Documents list (My Recent Documents in the new Windows XP Start menu).



■



If it’s a file we haven’t used in a while, we navigate through folders to find the file icon. We have shortcut icons on our desktop to the folders we use most often, which saves us considerable navigation time (for example, we don’t have to start at My Computer and work our way down).



■



If it’s a file we use a lot, such as my Checkbook Balance workbook (see the Appendix to learn about that workbook), we keep a shortcut icon to that file right on our desktop, where it couldn’t be any more convenient.



To put an icon to a specific file on your desktop, open the folder where the file is stored, right-click and drag the file icon onto the desktop, and click Create Shortcut(s) Here on the shortcut menu that Bright Idea A shortcut icon label is not connected to the file — you can change it to anything you want. To change the icon label to something shorter or more intuitive, click the label twice (not a double-click), type a new name, and press Enter.
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appears when you drop the icon. To put a shortcut to a folder on your desktop, do the same thing — open the folder where the folder you want is stored, and right-click and drag the folder icon onto the desktop. When you want to delete a shortcut icon from a cluttered desktop or because you no longer regularly use the file, right-click the icon and click Delete. Confirm you want to delete the shortcut (the file or program remains unaffected; all you delete is the shortcut icon on the desktop), and it disappears from your desktop.



When Excel is already running If you’ve used a file recently, you find it listed on the Office menu (as shown in Figure 1.11). You can show up to 50 recently used files there; Excel lists each file you open or save and pushes the least recent file off the list. We like to show four files, which is long enough to be useful but short enough to keep the menu from becoming unwieldy.



Figure 1.11. Recent files are listed on the Office menu.



Hack If your Open or Save dialog box suddenly maximizes to fill the screen, you probably inadvertently double-clicked the title bar. To return the dialog box to a normal size, double-click the title bar.
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The most common way to open workbooks from within Excel, especially if you haven’t used the file in a while, is to click Open on the Office menu and navigate to the file in the Open dialog box. You can then double-click the Excel file you want to open.



Opening several files at once You can open several files at the same time from the Open dialog box: Ctrl+click or Shift+click to select the files and then click Open. Ctrl+click (click an initial item, then press Ctrl while you click more items) selects each individual item you click, and is best when you want to select multiple nonadjacent items; Shift+click (click an initial item, and then press Shift while you click another item) selects all the items in between the initial item and the item you Shift+click. Both work in all Office programs and for all kinds of items — cells, sheet tabs, paragraphs in Word documents, files in folder windows, and so on.



Multiple windows If you used Excel 2003, you know that it was difficult to open files in separate Excel windows. When you opened multiple files, Excel opened then all in the same program window. However, in Excel 2007, that issue has been resolved. When you open multiple files in Excel, each file opens in its own window so that it is easier to work with several files at the same time, allowing you to easily move between them.



Multiple taskbar buttons One more thing that happens when you have more than one file open, whether or not they’re in multiple program windows, is that in Windows XP or Windows Vista you may have a single Excel button on the taskbar and you need to do extra clicks to switch between open files. We like each of our open files to have its own taskbar button so we can see at a glance which files are open and switch to a different file with a single click. To make separate taskbar buttons in Windows XP, right-click the taskbar and click Properties. On the Taskbar tab, shown in Figure 1.12, deselect the Group similar taskbar buttons check box. Inside Scoop



Inside Scoop You can also “lasso” several adjacent file icons with the mouse to select and open all the files at once.
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Figure 1.12 Taskbar properties



Using hyperlinks Hyperlinks are a really fast way to open another file or a Web page, and they’re easy to create. A hyperlink is text you can click to open a different Web page in your browser — you’ve probably used them quite a lot while surfing the Internet — and you can create them in worksheets to open both Web pages in your browser and other files on your computer. To create a hyperlink to a Web page, type the URL in a cell and press Enter. For example, if you type www.google.com in a cell and press Enter, your entry turns blue and underlined, and when you click the new hyperlink your browser opens to the Google search Web site. To create a hyperlink to another file on your computer or on your network, use the Insert Hyperlink dialog box. Follow these steps: 1. Choose Insert  Hyperlink. 2. Click Existing File or Web Page in the Link to pane and Current Folder in the Look in pane (see Figure 1.13). The usual navigation tools appear above the list of files. Bright Idea The URL may be useful, but if you want a more user-friendly name for the hyperlink, right-click the link and click Edit Hyperlink. In the Edit Hyperlink dialog box, type the display name you want in the Text to display box.
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3. Navigate to the file you want and click it (the URL appears in the address box). 4. Type a user-friendly display name in the Text to Display text box, and if you want an explanatory ScreenTip to appear when the mouse is over the hyperlink, click ScreenTip and type the text.



Figure 1.13. Create hyperlinks to other files in your computer or network.



If you need to select the cell after the hyperlink is created (so that you can add color to it, for example) click the hyperlink and hold down the mouse button for a moment; the mouse pointer changes from white cross to a hand, and the cell behind the hyperlink is selected. To remove a hyperlink, right-click the hyperlink and click Remove Hyperlink. The hyperlink text remains but is no longer active; press Delete to remove the text.



Saving workbook files Saving an Excel workbook is like saving any other file: Click the Save button on the toolbar (or press Ctrl+S). If the file has never been saved, the Save As dialog box opens. Type a filename in the File name dialog box, choose a folder in the Location dialog box, and click Save. If you’re saving a file that’s already been saved, click the Save button to save the changes. By default, Excel tries to save every workbook in the My Documents folder in Windows XP or Documents folder in Windows Vista. Saving workbooks to your own more-accessible folder makes more sense. If you don’t want to use the default Documents folder, and you don’t want the extra trouble of navigating to your own folder each time
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you save a new workbook, change the default folder by doing the following: 1. Choose Office  Excel Options. 2. Click the Save option, and then adjust the default file location path (shown in Figure 1.14) by typing the path to your folder. If you’re not used to typing paths, the easiest way to find the path to your folder is to open the folder window. The path to the folder is in the Address box at the top of the folder window. 3. Copy that path and paste it in the Default file location box.



Figure 1.14. Change the default folder.



The Save As dialog box opens with your file in the Save in box, and the Open dialog box opens with your file in the Look in box.



Setting workbook properties At one time, Workbook properties, in particular the Keywords property, were important for speedy file searches. They’re not as important now that file searching searches for words anywhere in the file, including keywords. But you can still use keywords to your advantage by setting a Keywords property that is unique to a particular file or set of files, regardless of whether the keyword appears in the file text. To set file properties, choose Office  Finish  Properties. A properties dialog with several available dialog boxes appears, as shown in Figure 1.15. You can set workbook properties any time you have the workbook open; just be sure you save the workbook again after you set the properties. Watch Out! If you completely mess up a workbook, don’t save it because you’ll overwrite all the good data that was in it when you started. Instead, close the workbook without saving it, and then reopen it and start again.
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Bright Idea Set several keywords for a file, using every word you might happen to think of two years from now when you’re trying to find the file again.



Figure 1.15. Setting file properties



AutoRecover Excel is set up to automatically save your data every ten minutes, so if your system crashes for any reason there’s a backup file with all but the last few minutes of data saved. If you do crash, when you start Excel again you are offered saved backup copies of all the files that were open at the time of the crash. You can open a backup file (you must save it again), or you can open the original and see what, if anything, was lost. If you don’t want Excel to save backups of your files automatically, choose Office  Excel Options. Under the Save category, deselect the Save AutoRecover info every check box (Figure 1.16). You can also change the time period for saves if, for example, you want AutoRecover backups saved more often.



Figure 1.16. Set or turn off AutoRecover.



Inside Scoop



Inside Scoop File Properties provide detailed information in folder windows. In a folder, choose View  Details. Right-click the header row and click the properties to display. Click More to show properties not on the first list. (Don’t bother displaying the keywords property — it doesn’t work. It’s a bug.)
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Watch Out The saved backup files are not really saved copies of your files; they’re only temporary in case of a crash. You still need to save your workbooks in the normal way.



Bright Idea If you create (and save) a workbook containing formulas and macros that you want to use repeatedly without saving new data in it (such as the Checkbook Balance workbook in the Appendix), don’t save the workbook at all. Ever. Every time you open it you find it ready to use again.



Creating and using templates A template is a foundation workbook you use to create other workbooks. If you create the same sort of workbook repeatedly (for example, an invoice), using a template is huge timesaver because all the setup work is done; all you add is data. You set up a template with all the formatting, formulas, macros, and workbook/worksheet settings you need in the finished file, and then save it as a workbook template instead of a workbook. When you open the template, what you get is a complete copy of the workbook rather than the template itself.



Creating your own templates To save a workbook as a template, choose Office  Save As and, in the Save As dialog box, click Template in the Save as type drop-down box. A workbook template file has the extension .xlt instead of .xls. When you choose Template, the Save in folder switches to the Templates folder and tries to save your template in the deeply buried Microsoft/ Templates folder. Our preferred way to handle saving templates is to navigate to the folder of choice in the Save in box. That way we know exactly where the template is, and we can easily open the template file if it needs modification. Our opening procedures depend on what we want to do. If we want to modify the template, we open it using Excel’s Open dialog box. It reads “.xlt” in the filename, and we can modify it and save it again. If we want to open a copy of the template — an unsaved workbook ready for
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Reuse existing workbooks We have to admit, we often don’t bother creating templates; instead, we just reuse an existing workbook by changing the data. But if we forget to save it as a new file, we lose all the data in the original file. A lot of you probably do that, so now there’s a link on the New Workbook task pane (which opens when you choose Office  New) called From existing workbook. It allows you to open an unsaved copy of an existing workbook so you don’t lose the original. You just have to remember to choose Office  New and click the link to open the workbook copy (this is the safest way to make a copy of an existing workbook as if the existing workbook was a template).



data — we can either double-click the template file in the folder window where it’s saved, or choose Office  New, click the From Existing Workbook link in the New Workbook task pane, and navigate to the folder where we saved the template.



Using Excel’s prebuilt templates Excel also has several prebuilt template files, both installed with Excel and available on the Web. To get to them, choose Office  New. You can then navigate through the links and choose a template from a category that matches what you want to do. We’ve never used a prebuilt template because we prefer to build our own, but they’re worth a look because they are good examples of items and features you may want to include in your own templates. And readyto-use is certainly faster than building your own (see Figure 1.17). Watch Out! If you have file extensions (.xls and .xlt) hidden, you won’t know a template is open unless you include the word template in the filename. To show the extensions, open any folder and choose Tools  Folder Options. On the View tab, deselect the Hide extensions for known file types check box.
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Figure 1.17. An Excel template from the Microsoft Office Online link



Changing Excel’s default templates Whenever you open a new workbook, you get a copy of Excel’s default workbook template filled with copies of Excel’s worksheet template. If there’s something in a new workbook or worksheet that you change every time, such as gridline color, column width, or font size, you can create the settings you want in the default workbook so that every new workbook opens with your changes already in place. Some settings, such as number of worksheets in a new workbook and font and font size, are easiest to set in the Options dialog box. Choose File  Excel Options and select Personalize to make changes to the basic font and sheets within a new workbook. You can create other more personalized settings, such as changing gridline color or placing a company logo on every worksheet, in the default workbook template (book.xlt) or the default worksheet template (sheet.xlt).
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Watch Out! If other people use your computer, they may be dismayed to find that new Excel workbooks are based on your modified default workbook template. You should be prepared to either tell them about the change or delete the new default workbook.



Change the default workbook template To make changes in the default workbook template, open a new workbook (the default workbook template is applied). Make your changes, and then save the workbook as a template named book.xltx or book.xltm in the XLSTART folder, which is located in the Excel folder on your computer.



Change the default worksheet template Customization in the workbook template, book.xltx, appears in every new workbook, but if you add a new worksheet to the workbook, you get a copy of the default sheet template, regardless of the customization in book.xltx. For customized new worksheets, you must also create a new worksheet template. To customize the worksheet template, open a new workbook and delete all but one worksheet. Customize the remaining worksheet and save the workbook as a template named sheet.xltx in the XLSTART folder. Your new templates won’t affect existing files, but all new workbooks and worksheets will have your new templates applied. To return to either of Excel’s default templates, open the XLSTART folder and delete the book.xlt or sheet.xlt that you created. When your template is gone, Excel generates new default workbooks based on its own internal settings.



Closing workbook files Closing workbook files is just like closing files in other Office programs: The fastest way to close a workbook file is to click the Close Window button in the upper right corner of the workbook window. The Close Window button is below the Close button for the program.
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Hack If you’re a keyboarder rather than a mouser, you can quit Excel by pressing Alt+F4.



Quitting Excel When you finish using Excel, or when you need to shut down or restart your computer, click the Close button in the upper-right corner of the Excel window. Be sure you click the Close button in the program window — the button in the Excel title bar, whose ScreenTip reads “Close” — rather than the Close Window button in the workbook window.



Just the facts ■



Start Excel from the Start menu.



■



Get help from the Office icon in the upper-right corner of the Excel interface.



■



Go to the Microsoft Knowledge Base when all else fails.



■



The File menu has been replaced by the Office icon. However, it’s still a standard File menu as with previous versions of Excel.



■



Open existing files from the Start menu Documents list or from a folder window, and start Excel at the same time.



■



Excel’s Ribbon tabs are designed to give you an easier-to-use, more integrated interface that is free of excessive menus and dialog boxes.



■



Use hyperlinks to open Web pages or other files in your computer or network.



■



Use templates to create ready-to-use workbook files with all formulas, formatting, and macros in place.



■



Close files with the Close Window button in the upper-right corner of the workbook window.



■



Quit Excel with the Close button.
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n the early days of spreadsheet programs, there wasn’t much to learn about worksheets because there was only one in each file. An entire Excel file consisted of a single worksheet, and there was no need to name it or move it or rearrange it or delete it, nor could you add another. Then someone thought, “Wouldn’t it be a great idea to have more than one worksheet?” and the next version of Excel had a default 16 worksheets in each new file. That was a lot of worksheets (allegedly the idea was one for each month and one for each quarter), and when Microsoft discovered that users were deleting them en masse, it calmed the corporate worksheet frenzy so that by Excel 2000 there were only the three default worksheets in each file that we have today. With the ability to add new worksheets, files became workbooks for holding the surfeit of worksheets, and there were more and more features added for rearranging, adding, deleting, and naming them, navigating through them, and coloring their sheet tabs. Now there are enough things you can do with worksheets to fill a whole chapter about them. (More things you can do with worksheets, such as protecting them, appear in other chapters.)
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Chapter 2



GET THE SCOOP ON... Worksheet basics ■ Selecting worksheets ■ Naming worksheets ■ Rearranging worksheets ■ Adding and deleting worksheets ■ Changing the default number of worksheets ■ Hiding worksheets ■ Moving around in a worksheet ■ Selecting cells ■ Freezing panes ■ Splitting panes ■ Multiple windows ■ Zooming a view
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Worksheet basics The worksheet (shown in Figure 2.1) is the basic document in which you do work in Excel, including entering, calculating, and organizing data. One or more worksheets are contained in each workbook, which is an Excel file. Three worksheets are in each workbook by default, but the number you end up with is your choice — you can add and delete worksheets as needed. Here are the basics you need to know about worksheets: ■



Each worksheet is divided into a grid of rows and columns. The rows are identified by numbers down the left side of the worksheet, and the columns are identified by letters across the top of the worksheet.



■



The grid units are called cells. Each cell has an address — a location on the worksheet — given by its row number and column letter. When a cell is selected, its row number and column letter are highlighted, and its address appears in the Name box.



■



You can enter data into any cell you want, in any order that’s efficient for you. You can enter data in one cell at a time or into several cells at once (see Chapter 3 for specific data-entry techniques).



■



A worksheet has a total of 16,384 columns and 1,048,578 rows, and cannot be expanded beyond those limits.



Figure 2.1. Elements of a worksheet
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Aside from the standard worksheet view, Excel 2007 also provides a new Page Layout View, shown in Figure 2.2. Page Layout View is like a combination of Normal view, Print Preview, and Page Setup. It allows you to quickly see how your data will look when it is printed, and you can easily apply formatting options and see a “true to print” look. You can easily switch back and forth between the standard worksheet view and Page Layout View by clicking the Page Layout View button on the View tab of the Ribbon.



Figure 2.2. Page Layout View



Selecting worksheets A workbook can contain a single worksheet or hundreds of worksheets, limited only by your system memory and your patience. By the way, worksheets are also called sheets; the name worksheet distinguishes them from chart sheets (covered in Chapter 14).
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Bright Idea Create a single workbook to hold many worksheets that contain similar data, such as all your invoices for a month or a year, all the complex formulas you’ve used in other files, or custom styles or formatting you’ve created for other workbooks and want to reuse to standardize your presentations.



Selecting a single worksheet Select a single worksheet by clicking its sheet tab, found on the worksheet toolbar beneath the worksheet, shown in Figure 2.3. In Page Layout View, you can also scroll to the next sheet using the left and right scroll bar. Clicking a sheet tab brings that worksheet to the top of the virtual stack of worksheets in the workbook. The selected sheet tab turns white with bold font, while unselected tabs remain gray with normal font (unless you color the sheet tabs, which is covered later in this chapter). The selected worksheet is called the active worksheet.



Figure 2.3. Scroll through a large number of worksheets with the sheet tab scroll buttons.



When you have a great many worksheets in a workbook, some of the sheet tabs may be hidden on the left or right end of the sheet tab bar. Use the buttons on the sheet tab scrollbar to bring the hidden tabs into view one at a time or to jump to the leftmost or rightmost tab.



Selecting several worksheets If you need to move, add, or delete several worksheets, it’s quickest to select them all and perform the operation on all of them at the same time. To select several worksheets in a row, click the first tab, and then Shiftclick the last tab. To select several worksheets that are not next to one another, click the first tab, and then Ctrl-click the remaining tabs. When more than one worksheet is selected, the word [Group] appears in the program title bar — a useful reminder if a selected sheet tab is hidden at the end of the sheet tab bar. When several worksheets are selected, the active worksheet — the one on top — is the worksheet with the boldfaced name (as shown in Figure 2.4).



Figure 2.4. A group of worksheets is selected.
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Create multiple worksheets Here’s an efficiency trick we use a lot: To create several identical worksheets — for example, to change the font or font size or add specific borders, data, or formulas — select several worksheets and enter the formatting, data, and formulas that you want them to share. Everything you do to any one of the selected worksheets is done in all of the selected worksheets.



Deselect a group of worksheets When you finish working with a group of worksheets, you need to deselect them (unless you’ve deleted the group, which leaves you with just one of the remaining sheets selected anyway). To deselect the group, click any tab in the workbook other than the active tab (the active tab is the one with the name in bold font).



Naming worksheets No two worksheets can have the same name, and the default worksheets are named with sequential numbers, as in Sheet1, Sheet2, and so on. In a workbook in which we’re just experimenting or messing around and using only the first worksheet, we don’t bother naming the worksheets, but in a workbook with many worksheets or one that we need to send to someone else, the worksheet name is all-important as a means of finding the data we want quickly. Hack If you create a set of identical worksheets and forget to select the group of worksheets before formatting them, all is not lost. Make copies of the worksheet you formatted (see how later in this chapter).



Watch Out! If you have only two or three sheets selected, clicking one of them doesn’t deselect the others; it merely activates the sheet you clicked. If you have only three sheets in the workbook and they’re all selected, to deselect them you must right-click one of them and click Ungroup Sheets.
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Watch Out! Although you can use other characters such as periods, semicolons, apostrophes, and quote marks in a sheet name, those characters can add an element of unpleasant unpredictability in formulas and VBA code.



To rename a worksheet, double-click the sheet tab, type the new name (as shown in Figure 2.5), and then press Enter or click in the worksheet.



Figure 2.5. Renaming a worksheet



Worksheet names can have up to 31 characters but cannot use the characters :, \, /, ?, or *. Don’t worry about remembering them, however; if you try to type a forbidden character in a sheet name, the character simply won’t type.



Color-coding workbook contents Coloring sheet tabs is more than just giddy fun; it allows you to colorcode the contents of a workbook. To color a sheet tab: Right-click the tab, click Tab Color, and then select a color from the Theme Colors or Standard Colors (see Figure 2.6). You can also choose the More Colors option if you like.



Figure 2.6. Coloring sheet tabs



06_045947 ch02.qxd



1/4/07



9:57 PM



CHAPTER 2



Page 33



■



ALL ABOUT WORKSHEETS



33



When sheet tabs are colored, all the unselected tabs show full color; selected tabs are white with bold font and a stripe of color at the bottom of the tab. The white color and bolded font enable you to easily look at the tabs and know which tab is selected at the moment.



Rearranging worksheets Eventually you may want to rearrange the worksheets in a workbook. You can move a worksheet to a new location in the same workbook, make a copy of a worksheet in the same workbook, and move or copy worksheets into another workbook.



Moving worksheets The quickest way to move a worksheet is to click and drag the sheet tab to a new location among the other sheet tabs. When you drag a sheet tab, a small triangle appears above and between sheet tabs; drag the mouse with the little sheet icon along the row of tabs and drop it when the triangle is between the sheets where you want to move your sheet (see Figure 2.7).



Figure 2.7. Drop the sheet tab when the small triangle is in position.



Copying worksheets When you copy a worksheet, you create an identical copy of the worksheet except for the sheet name, which gets a sequential number in parentheses appended to it. The quickest way to copy a worksheet is to drag the tab — as if you are moving it — and press Ctrl when you drop it. When you press Ctrl, the mouse pointer changes to a little sheet icon with a small plus symbol to indicate a copy.



Inside Scoop



Inside Scoop In every Office program, you don’t have to hold down Ctrl while you drag to copy an item; you only need to press Ctrl while you release the mouse to drop the item you’re copying.
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Moving or copying worksheets to another workbook Moving or copying sheets to another workbook is almost as easy as moving or copying within a workbook: Open both workbooks and drag the sheet tab from one workbook to the other (press Ctrl to drop a copy of the sheet). To see both workbooks so that you can drag from one to the other, you need to arrange the workbook windows (see how later in this chapter). Dragging between two workbooks is easier, but if you don’t want to arrange the windows to see both workbooks, you can still move or copy sheets the long way: 1. Right-click the tab for the sheet you want to move or copy, and click Move or Copy. The Move or Copy dialog box is shown in Figure 2.8.



Figure 2.8. Moving or copying a sheet to another workbook



2. In the To book box, select the name of the workbook into which you want to move or copy the sheet. 3. In the Before sheet box, click the name of the sheet where you want to position the moved/copied sheet (it doesn’t matter where you position the sheet — you can move it by dragging it within the new workbook later). 4. To copy the sheet, select the Create a copy check box. Inside Scoop



Inside Scoop When you move or copy a worksheet to a new workbook, all the cell/range names, styles, and custom formats in the sheet move with it into the new workbook, and are available to all the sheets in the new workbook.
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Create a new workbook from a worksheet You can create a new workbook from a single worksheet by dragging the sheet tab into the program window. Click the Restore Window button to the right of the Ask A Question box to make the workbook resizable within the Excel program window. Drag the workbook window borders so you can see a bit of blank program window, and then drag the sheet tab out of the workbook and drop it in the Excel window outside of the workbook. A new, unsaved workbook is created with the sheet you dragged. (Press Ctrl when you drop the sheet tab if you want to create a new workbook with a copy of the worksheet.)



Adding and deleting worksheets To add a new worksheet, right-click a sheet tab and click Insert. In the Insert dialog box, double-click the Worksheet icon (shown in Figure 2.9). You can also click the Insert Worksheet button that appears on the worksheet toolbar (at the end of your existing worksheet tabs).



Figure 2.9. Adding a new worksheet



To add several worksheets at a time, select as many worksheets as you want to add before you right-click a sheet tab and click Insert.
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Create your own worksheets When you open the Insert dialog box, there are several icons for sheets you can insert. All but the worksheet icon are not generally useful, but you can create your own special worksheet templates that you can add as needed from the Insert dialog box. First, delete all but one worksheet from a workbook, and set up the remaining worksheet as your template. Then choose File  Save As and save the file as a template in the Templates folder. Close the workbook. Open a new workbook, right-click a sheet tab, and click Insert; your new worksheet template is there!



To delete a worksheet, right-click the sheet tab and click Delete. To delete several worksheets at one time, select all the worksheets you want to delete before you right-click a sheet tab and click Delete.



Changing the default number of worksheets If you find yourself consistently adding or deleting worksheets in new workbooks, save yourself the effort and change the number of worksheets in new workbooks. Choose Office (Tools icon)  Excel Options, and on the Personalize tab (shown in Figure 2.10), change the number in the Include this many sheets dialog box.



Figure 2.10. Change the number of worksheets in new workbooks.



Watch Out! You can’t undo a deleted sheet. If you inadvertently delete a worksheet, quickly close the workbook without saving it. When you reopen the workbook, the deleted sheets are back in place.
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Inside Scoop



You can also limit users’ mobility in a workbook by hiding the sheet tabs, so they have access to only one visible sheet. To hide sheet tabs, choose Office  Excel Options  Advanced; Under Display options for this workbook, deselect the Sheet tabs check box. To show sheet tabs again, select the check box. This, however, does not prevent users from accessing the other sheets by using Ctrl+Pg Up or Ctrl+Pg Dn.



Hiding worksheets Sometimes we create a workbook for a client who isn’t terribly adept in Excel. As part of the “bulletproofing” process, we place data that we don’t want clients altering on a separate worksheet and then hide that worksheet; because the clients aren’t terribly proficient, they never know there’s a hidden worksheet (or how to unhide worksheets). They just think the workbook is amazing. To hide a worksheet, click the sheet tab to make it the active worksheet, and then choose the Home tab on the Ribbon. In the Cells category, click Format  Hide & Unhide  Hide Sheet. To unhide a worksheet, choose Format  Hide & Unhide  Unhide Sheet.



Moving around in a worksheet There are many ways to move around in a worksheet and get from cell to cell. Table 2.1 lists all the ways we use (but is by no means comprehensive).



Table 2.1. Moving around a worksheet To Move



Do This



Down one cell



Press Enter



Right one cell



Press Tab.



One cell up, down, left or right



Press the arrow keys.



To the beginning of a row



Press Home.



To the upper left corner of the worksheet



Press Ctrl+Home.



To the lower right corner of the used area of the worksheet



Press Ctrl+End. continued
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Table 2.1. continued To Move



Do This



To the beginning or end of a data row



Double-click the left or right border of the active cell in that row.



To the top or bottom of a data column



Double-click the top or bottom border of the active cell in that column.



Up or down



Use the mouse wheel or drag the vertical scrollbar; drag the scrollbar to the end of its channel to go to the bottom of the worksheet used area.



Side to side



Drag the horizontal scrollbar; drag the scrollbar to the end of its channel to go to the right end of the worksheet used area.



To a specific named range



Select the name in the Name box list.



To the active cell after scrolling



Press Ctrl+Backspace.



The worksheet used area You can go to the end of a worksheet’s used area by pressing Ctrl+End; this takes you to the farthest reaches in which you’ve ever worked in that worksheet, whether or not there is still data in those areas. Your scrollbars stretch to those empty reaches, so if you ever wonder why your current table is small but the scrollbars are really short, it’s because the scrollbars still correspond to the worksheet’s used area. We like to view the end of a long table quickly by dragging a scrollbar right to the end of its scroll channel, but if the worksheet used area is much bigger than we’re working in, it’s no longer an efficient means of scrolling quickly. We always reduce the used area of a worksheet when it grows larger than we currently need: Delete all the rows and columns between the end of the used area and your current working area, and then save and close the workbook. When you reopen the workbook, the used area is reduced to what’s really in use and the scrollbars are longer and more efficient.
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Selecting cells Selecting cells and ranges of cells is elementary to entering data. Table 2.2 lists all the methods we use for selecting cells.



Table 2.2. Selecting cells and ranges To



Do This



Select a cell



Click the cell.



Select a rectangular range



Click and drag over the cells, or click the cell at the start of the range, and then Shift+click the cell at the end of the range.



Select a contiguous table of data around the active cell (the current region)



Press Ctrl+A.



Select a specific named range



Select the name in the Name box list.



Expand a selected range by one cell, row, or column



Press and hold Shift and press an arrow key.



Select a column



Click the column letter.



Select a row



Click the row number.



Select all the cells in the worksheet



Click the gray box above the row numbers and left of the column letters.



Select multiple separate cells



Click the first cell, and then Ctrl+click the remaining cells.



Select a column of cells in a long table of data



Click the top cell, and then press Shift and double-click the bottom border of the top cell.



Freezing panes Freezing panes is a procedure we use quite often. When you work on a very long or wide list, the column and/or row headings disappear when you enter data at the end of the list. But you can keep your column headers in view no matter where you are in the list if you freeze the rows that hold the column headers, and keep row headers in view if you freeze the columns that hold the row headers.
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To freeze rows, select the row below the row you want to freeze by clicking its row number (see Figure 2.11) to select the entire row, and then choose View  Freeze Panes. You can also choose to Freeze the Top Row and Freeze the First Column in this same location.



Figure 2.11. Select the row below the row you want to freeze.



When you scroll up and down the list, the header row stays in view. To freeze columns, select the column to the right of the column you want to freeze by clicking its column number to select the entire column and choose View  Freeze Panes. To unfreeze panes, choose View  Unfreeze Panes. Hack When you have frozen panes, you can get back to the upper left corner of the unfrozen pane quickly by pressing Ctrl+Home.
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Splitting panes Splitting panes is the fastest way to look at two separate areas of the same worksheet at once, although we find multiple windows to be more effective. To split panes so that you can scroll through rows in two parts of the worksheet (see Figure 2.12), select a desired cell where you want the split to occur, and then click the Split button in the Window category of the View tab on the Ribbon. Click the Split button again to turn off the feature. Using the Split button, you can segment any worksheet into a more manageable document depending on your work needs.



Figure 2.12. Use the split button to create multiple panes within your worksheet.



Split panes versus multiple windows The biggest differences between split windows and multiple windows are that in split windows, you have only one set of row numbers and column letters, and in multiple windows you have row numbers and column letters in every window (which can crowd a small monitor). Split panes can be used only within the same worksheet, and several multiple windows can be opened into the same worksheet, different worksheets in the same workbook, and different workbooks.
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Multiple windows A better way to work in two parts of the worksheet simultaneously is to use multiple windows. But more than that, you can work in different worksheets and different workbooks with multiple windows.



Opening windows in the same workbook To open multiple windows in the same workbook, as shown in Figure 2.13, choose View  New Window on the Ribbon.



Figure 2.13. Two windows open in the same workbook



You won’t see much of a change, other than in the title bar, which will read workbook name:2, indicating a second window into the active workbook. These are not copies of the workbook; they are merely windows into the same workbook that allow you to view different parts of the same workbook at the same time. To see both (or all) windows, as shown in Figure 2.13, choose View  Arrange on the Ribbon, and choose an arrangement. Vertical is the most useful, I think, but try all four arrangements to see what works best for your task. Watch Out! Limit your number of open workbooks when you open multiple windows, or you may be overwhelmed with the number of windows that open.
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Inside Scoop No matter which arrangement you choose, you can reshape any window by dragging its borders and reposition any window by dragging its title bar.



Opening windows in different workbooks If you want to open windows into two different workbooks — for example, to move or copy sheets from one into the other by dragging sheet tabs — all you need to do is open both workbooks and then choose Window  Arrange and choose an initial arrangement.



Closing windows To return any window to full size within the program window, doubleclick the window title bar. All open windows remain open but hidden behind one another (and you can switch between them by clicking the taskbar buttons). Click the Window menu to see a list of all the windows that are open after they are maximized. To close a window, click its Close button. If the window is a workbook, the workbook closes; if the window is a duplicate of a single workbook (the title bar reads workbook name:2), the workbook remains open but the duplicate window into it closes.



Comparing side by side You can view and compare multiple workbook sheets using the Compare Side by Side command. It allows you to scroll through two or more worksheets or workbooks at the same time for visual comparison, which is useful when you need to compare similar worksheets, and saves you having to scroll through each window separately. With Compare Side by Side turned on, scrolling either the vertical or horizontal scroll bar in one window scrolls both windows identically, as shown in Figure 2.14. To turn on side-by-side scrolling in two windows, open both workbooks — or a new window into the one workbook if you’re comparing worksheets within the same workbook — and display them in separate windows. Then choose View  Compare Side by Side on the Ribbon, located in the Window category.
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Figure 2.14. Two different worksheets opened in Compare Side by Side view



When Compare Side by Side is turned on, a toolbar appears with two buttons: ■



Synchronous Scrolling turns side-by-side scrolling on and off.



■



Reset Window Position repositions open windows to a horizontal arrangement.



■



To turn off the Side by Side feature, simply click the button again.



If you want to rearrange the windows while side-by-side scrolling is turned on, choose View  Arrange and choose a different arrangement (Figure 2-15); changing the arrangement doesn’t affect side-by-side scrolling.



Figure 2.15. Choose a window arrangement.



06_045947 ch02.qxd



1/4/07



9:57 PM



CHAPTER 2



Page 45



■



ALL ABOUT WORKSHEETS



45



Watch Out! Comparing side by side is new and still just a little buggy. If you start switching between views and turning side by side on and off, you may get unexpected and useless results of all kinds. Close all open workbooks, reopen them, and start again.



Zooming your view Zooming your view lets you zoom out for an aerial view or zoom in for a magnified view (see Figure 2.16). When you open a workbook, the zoom setting is 100%, but depending on the size of the font in your worksheet or the resolution of your monitor, 100% may be either too small to read comfortably or too big to see enough of your worksheet. Zooming your view in or out does not affect the printed worksheet at all.



Figure 2.16. Zoom to see your items closely.



The quickest way to zoom to a different standard zoom setting is to click the magnifying glass icon on the Zoom button on the View tab of the Ribbon, and then click one of the preset zoom settings (Figure 2-17). The Fit to Selection entry on the Zoom button list zooms to fill the workbook window with the selected range.



Figure 2.17. Zoom option
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Bright Idea If you have named ranges of cells, you can see the ranges easily by zooming out to 39% or less. The range name is displayed across the range, rather like city names on a map. See Chapter 4 for more about naming ranges.



Often the most convenient zoom is a customized zoom setting that works best for you. In one of our templates, the text is very small, so we keep it zoomed to 120% to read it easily (workbooks saved with a zoom setting keep that zoom setting when reopened). To set a custom zoom setting, click the Zoom box, type the percentage you want, and then press Enter.



Just the facts ■



Select a worksheet by clicking its sheet tab.



■



Name a worksheet by double-clicking its sheet tab and typing a new name.



■



Move a worksheet within a workbook or to another workbook by dragging its sheet tab.



■



Add a worksheet by right-clicking a tab and clicking Insert.



■



Delete a worksheet by right-clicking a tab and clicking Delete.



■



Open multiple windows in the same workbook by choosing the View tab on the Ribbon.



■



Open multiple windows into more than one open workbook by choosing View  Arrange.



■



Change the zoom setting by selecting one in the Zoom button list or by typing a number in the Zoom button.
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ntering data can be as simple as clicking a cell, typing, and pressing Enter, but when you have a lot of data to enter, you can make the process faster and easier by taking advantage of some exquisite data-entry features and tricks, including AutoComplete, AutoFill, custom lists, and keystrokes that even inveterate mousers like myself can’t do without. In this chapter we talk about raw data, by which we mean text and number values rather than formulas. Writing formulas is covered in Chapters 4 and 5, and importing data from other programs is covered in Chapter 18. In addition to entering raw data, we show you how to move data around after it’s entered, get it entered correctly to begin with using data validation, edit data, and correct mistakes. We also show you how to separate, or parse, a single column of data into multiple columns, insert and delete rows, columns, and cells into a worksheet, add comments to a worksheet, and use AutoCorrect to speed up data entry.



Entering data directly Entering data directly into cells in a worksheet (that is, without using a data-entry form) is a subject rife with possibilities and tweaks and techniques for doing things faster. Entering numbers is just like entering text, and when an entry consists of nothing but numbers, Excel assumes 49



Chapter 3



GET THE SCOOP ON... Data entry techniques ■ Editing cell entries ■ Inserting, deleting, and rearranging data ■ Checking your spelling
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the entry is a calculable number. Leading zeroes are removed, the number is included in calculations, and number formatting is available. If, however, the entry contains any letters, Excel assumes the entry is text and ignores it in calculations.



Punctuation for automatic formatting Some punctuation marks control how Excel interprets your entry and whether or how the data is calculated, and you can use these punctuation marks to tell Excel how you want the data interpreted without specifying formatting for the cell (you can always specify different formatting after the data is entered — see Chapter 7 about formatting data).



Punctuation for numeric formatting If you type the following punctuation marks when you enter numeric data, the data is simultaneously formatted: ■



A minus sign before the number, as in -100, makes the number negative.



■



Enclosing a number in parentheses, as in (100), makes the number negative.



■



A percent symbol at the beginning or end of the number, as in 25% or %25, makes the number a percentage.



■



A currency symbol at the beginning of the number, as in $100, makes the number currency.



■



A single decimal point, as in 100.10, makes the number a decimal (but two decimal points, as in 100.10.10, makes the number text).



■



One or more commas separating groups of three numbers (hundreds), as in 1,100,100, specifies a number (but 1,100,10 is text because it’s not a real number).



■



An equal sign (=) starts a formula. See Chapter 4 for more on formulas.



■



An apostrophe (‘) typed at the beginning of a number tells Excel the number is text; it’s not calculable and retains leading zeroes. Hack If you’ve got many numbers mistakenly entered with apostrophes, you can convert them back to numbers all at once: Enter 1 in a cell, and then select and copy the cell. Select the range of cells to convert, choose Home  Paste  Paste Special, choose Multiply, and click OK. (You can then delete the 1 in that first cell.)
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Watch Out! If you don’t see what you expected when you enter data, it’s often because the cell was previously formatted as something different and the new entry gets the previous format no matter what punctuation marks you type. Choose Home  Editing  Clear  Clear Format to return the format to General.



Punctuation for date or time formatting Excel calculates dates and times as serial numbers, but if you see a serial number in a cell you’ll be hard-pressed to identify the date it represents, and in Excel, there are many formats for dates and times. There are several date formats, and when you enter any number that Excel can possibly interpret as a date, you get a date. Dates and times are calculable numbers that are covered more fully in Chapter 7. If you type the following punctuation marks when you enter data, the data is simultaneously formatted: ■



Forward slashes in numbers that might be dates, as in 7/4 or 1/1/07, create dates.



■



Dashes in numbers that might be dates, as in 7-4 or 1-1-07, create dates. You can type the month name or abbreviation, as in jun 4, to enter a date. If you don’t type a year, Excel assumes (and calculates) the current year on your computer clock.



When you type time entries, all you do is type the hour and minute numbers separated by a colon (:), as in 10:30. You can enter times in a 24-hour format, in which 11:00 PM is entered and displayed as 23:00, or you can enter times in a 12-hour format, in which 11:00 PM is entered as 11:00 pm or 11:00 p or 11 p, and displayed as 11:00 PM. Whatever your displayed time might be, you can see what time Excel is using to calculate by selecting the cell and looking at the Formula bar (see Figure 3.1). Inside Scoop



Inside Scoop When you enter a date in a cell, it’s usually automatically formatted as a date and you see the date format in both the cell and the Formula bar. If you want to see the serial number that Excel is really calculating, format the cell as General (more on formatting data in Chapter 7).
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Watch Out! If you enter a date with just numbers and punctuation, Excel may misunderstand which number is the month and which is the day. To be sure of your entry, either type the month name, as in 4/jul, 4/jul/05, 4 jul, or jul 4, or format the cells with a date format before you enter dates.



Figure 3.1. No matter what the displayed value shows, the calculable value is found in the Formula bar.



You can enter time components in hours, minutes, seconds, milliseconds, and even smaller, by separating each component with a colon. A time entry must have an hour component; to enter a time of less than an hour (for example, 22 minutes), enter 0:22.



Using data entry techniques Different situations call for different data-entry techniques, but all the techniques we show you are those that we use all the time. Being a mouser myself, we won’t waste your time and mine on esoteric keystrokes that you can always look up in the Help files, but we’ll give you the keystrokes that we use often. In addition to scattering this handful of useful keystrokes into separate sections, we list them for you in Table 3.1.



Enter data in a single cell To enter data in a single cell, click the cell to select it, type the data, and press Enter. That’s it. You can also “lock in” your entry by clicking any other cell in the worksheet, or by pressing Tab to move to the right, which is the best way to enter data in a table row. Inside Scoop



Inside Scoop If you want to display a number with text, as in 6.5 hours or 10 years, don’t type the text (because then it’s noncalculable). Instead, type the number and then format the cell to display the text automatically (see Chapter 7 to learn how).
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Inside Scoop If you are a hard-core keyboarder, type keyboard shortcuts in the Ask A Question box and you find more keystrokes than you thought existed.



Table 3.1. Keystrokes we can’t live without Keystroke



What It Does



Ctrl+C



Copies the current selection



Ctrl+X



Cuts the current selection



Ctrl+V



Pastes the most recent cut or copy



Ctrl+Z



Undoes the last action; if pressed repeatedly, it undoes each preceding action



Ctrl+’



Copies the entry in the cell above



Ctrl+;



Enters the current date



Ctrl+Shift+;



Enters the current time



Ctrl+D



Copies the cell at the top of a selection into all the selected cells below



Ctrl+Enter



Enters the same entry in all selected cells



Esc



Clears the currently open cell before you press Enter



F4



Repeats the last action; if pressed repeatedly, it continues to repeat the same action



Enter data in a table Here is why using the Tab key to enter data across a table is the best way: If you enter data in a multicolumn table and move along each row before starting the next row, using the Tab key to move to the next cell on the right automatically starts the table-entry feature. This feature doesn’t have a clever name, but it works like this: Type data in the leftmost cell in the row, press Tab to move to the right, type data, and so on until you reach the end of the row. Then press Enter. Instead of moving down one cell, pressing Enter moves the active cell back to the beginning of the row, but in the next row down (as shown in Figure 3.2).



08_045947 ch03.qxd



1/4/07



9:58 PM



54



Page 54



PART II



■



CRUNCHING NUMBERS



Press Tab to move across the row



Press Enter to start a new row



Figure 3.2. Press Tab to move across the row in a table, and then press Enter to move to the beginning of the next row.



Enter numbers with a fixed decimal If you enter a long list with at least one column of decimal entries (for example, prices) you’ll be typing the decimal point in every one of those numbers. To avoid the extra typing and the potential for misplaced decimals, we turn on fixed-decimal entry. With fixed-decimal entry, all we type are the numbers; the decimal inserts itself at the correct place (see Figure 3.3).



Figure 3.3. Use the Advanced options to turn on fixed decimals.
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Watch Out! If you click to select a different cell, you temporarily break the table-entry feature; to get it working again, just click at the beginning of the row and start using the Tab key again to move from cell to cell.



To turn on fixed-decimal entry, choose Office  Excel Options. On the Advanced tab, select Automatically insert a decimal point (you can change the decimal place number if you need to, but the default 2 is correct for currency), shown in Figure 3-3. Fixed-decimal is an application-level setting; it turns on for all workbooks and stays turned on until you turn it off (by deselecting the Automatically insert a decimal point check box). We think even the clicking involved in toggling the fixed-decimal on and off is too much work, so we created a macro and custom toolbar button that toggles fixed-decimal on and off with a single click (see Chapter 21).



The Table A table — a concept that is integral to many Excel features — is a rectangular region of data that contains no fully blank rows or columns. A table can have many empty cells, but a completely empty row or column delineates the perimeter of the table. Many of Excel’s most useful features, including AutoFilter, AutoComplete and Pick From List, PivotTables, Charts, sorting, and subtotaling, to name but a few, expect to find your data in a contiguous table. The terms list and table have always been used interchangeably, in both this book and Excel’s Help files. Excel 2007 also contains a list item, but it’s more intricate than a simple list of data. We call the list a dynamic list to differentiate it from the simple list, which is a range of data with column headings (more about dynamic lists later in this chapter).



Hack When you turn on fixed-decimal entry, the word Fix Decimal appears at the right end of the Excel Status bar. It’s unobtrusive and you may never notice it; we usually test the fixed-decimal state by entering 123 in a cell, and then toggle the fixed-decimal state if we need to.
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Enter fractions To enter a fraction in a cell, leave a space between the whole number and the fraction, as in 5 3/16. When you press Enter (or “lock” the entry in the cell by any means), the fraction you typed appears in the cell and the decimal equivalent appears in the Formula bar (see Figure 3.4); the decimal equivalent is what Excel uses in calculations. If you want to display the decimal equivalent for a fraction, enter the fraction and then format the cell as General (more about formatting data in Chapter 7). If you want to enter just a fraction, as in 1⁄4, type a zero first, as in 0 1/4, or Excel enters a date instead of a fraction. What’s calculated



What’s typed



Figure 3.4. Type the fraction for a fractional display.



Start a new line in a cell Quite often an entry is longer than the cell width, and you want to see the entire entry without stretching the column width from here to London. To break the line where you want it broken, and format the cell with Wrap Text at the same time, press Alt+Enter at the breakpoint in the entry. You can break a line as many times as you want; each line break starts a new line and makes the row taller (see Figure 3.5).



Figure 3.5. Text is automatically wrapped when you add a line break.
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Hack To separate a long entry into two cells (instead of increasing row height for wrapped text), open the cell, drag to select the second segment of text with your mouse, press Ctrl+X to cut, and press Enter; then press Ctrl+V to paste the cut segment in the new cell.



To remove a manual line break and let the line break where the column width dictates, open the cell for editing, place the insertion point at the end of the broken line (it’s easiest to do this in the Formula bar), and press Delete. You may still need to change the column width and the row height to make the cell look the way you want it, or remove the Wrap Text formatting to return the row height to normal; see Chapter 6 about formatting columns and rows, and using Wrap Text.



Make the same entry in several cells Sometimes the data requires entering the same data in several cells in a table. For example, when we do my business expenses at the end of the year, we have many receipts from the same vendors. We sort the receipts and then enter all the receipts from one vendor at a time so we can enter the receipt data faster. Then we enter all the Vendor column entries (such as Office Depot) at once, and most of the Purpose entries (such as Office Supplies) at once, which reduces my time and tedium (see Figure 3.6). We use all of the techniques listed here at random just to break up the monotony of data entry.



Figure 3.6. One way to speed up data entry
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■



Instantly enter the same data in several cells: Select several cells (drag to select a range, or Ctrl+click or Shift+click several cells), type the entry, and press Ctrl+Enter (see Figure 3.7).



■



Repeat the entry in the cell above: Press Ctrl+’.



■



Repeat an entry into several cells below the entry: Drag to select the cell with the entry and several cells below, and then press Ctrl+D.



■



Repeat an entry into several cells to the right of the entry: Drag to select the cell with the entry and several cells to the right, and then press Ctrl+R.



Figure 3.7. Ctrl+click several cells and then Ctrl+Enter the same data all at one time.



Other ways to repeat the same entry include AutoFill, AutoComplete, and Pick From List, which are explained in the next few sections.



AutoFill a text entry To fill a list with identical entries, make the entry in the first cell, and then drag the fill handle (the small black box in the lower right corner of the cell shown in Figure 3.8) in any direction to fill the entry into all the cells you drag over.



Figure 3.8. Drag the fill handle to fill the other cells with the entry.
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If the initial entry is text, the dragged cells are filled with identical entries. If the initial entry is part of a standard list such as weekday names or month names, a list of the names is filled instead of the initial entry. You can take advantage of the AutoFill list behavior by creating your own custom list (for anything from employee names to product part numbers), which is covered later in this chapter. If you want to fill a range with a single entry, for example, “Monday” instead of a list of weekday names, use the other multicell entry techniques listed in the previous section.



AutoFill numbers When you use the fill handle to fill cells with numbers, even number-type entries that are formatted as text, AutoFill usually fills a number series instead of identical copies. We say usually because if you enter a single number, such as 45, and drag the fill handle on that cell, AutoFill repeats the number 45. But if you AutoFill a number that’s formatted as text, such as a part number or a telephone number, AutoFill fills a simple number series. Why? We don’t know — perhaps there’s a reason, or perhaps not. At any rate, be forewarned that AutoFill does not always do what you expect with regard to numbers. If the AutoFill Options button appears when you release the mouse button to drop the fill handle, you can click the button and use the button’s list to control whether a number is copied or a series is filled. Personally we don’t like the interference of the AutoFill Options button because we know how to fill what we want, so we keep it turned off. If you want to fill a simple series, such as consecutive numbers to number a list, type the first two numbers (for example, 1 and 2, or 23 and 24), then select both cells and drag the AutoFill handle to continue the series as far as you need it (see Figure 3.9). While you drag the fill handle, take a look at the mouse character — it shows you the numbers as you drag over the cells, which makes it easy to know when to stop dragging the fill handle. Hack To turn off the AutoFill Options and Paste Options buttons, choose Office  Excel Options. On the Advanced tab, deselect the Show Paste Options buttons check box. You may need to close and restart Excel for the change to take effect.
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Figure 3.9. AutoFilling numbers



AutoFill continues any number series you start it with; for example, if you start with the numbers 1 and 4, AutoFill continues the series in increments of 3. If you want to get fancy with series filling, right-click and drag the fill handle and select one of the commands on the shortcut menu that appears when you drop the handle. Interesting things can happen when you select the Growth Trend command (for example, the series 1 and 4 fills by multiplying each preceding number by 4). The Series command on the shortcut menu gives you more intricate options for series filling. If you start your series with a date, AutoFill fills the series with dates incremented by day; if you need a series incremented by months or years instead, enter the date, then right-click and drag the fill handle and select Fill Months or Fill Years on the shortcut menu (shown in Figure 3.10).



Figure 3.10. Change the AutoFill date-filling behavior with the shortcut menu.
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Repeat an entry in the column Two more useful techniques for repeating an entry that already appears anywhere within the column are AutoComplete and Pick From List. Both repeat an entry from anywhere within the column.



AutoComplete When you begin typing an entry, AutoComplete fills in the remaining characters for you if it recognizes the first few characters you type (see Figure 3.11). If the entry is what you want, press Tab or Enter and move on. If the entry is not quite what you want, keep typing.



Figure 3.11. AutoComplete fills in an entry that’s already somewhere else in the list; if you don’t want that entry, keep typing.



If you find AutoComplete annoying, which some people do, you can turn it off like this: Click Office  Excel Options. On the Advanced section deselect the Enable AutoComplete for cell values check box.



Pick From drop-down list If you have two entries in which the first several characters are the same, save yourself time by right-clicking the cell and clicking Pick From Dropdown List; a list opens to display all the entries in the column, and you click the one you want to enter (see Figure 3.12). Inside Scoop



Inside Scoop We can’t overstate the importance of having identical entries in a list spelled identically — for successful sorting, filtering, consolidation, PivotTables, and pretty much every data-organization technique. Using any of Excel’s repetitiveentry features ensures that like entries are spelled identically.
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Bright Idea When you have two or more entries that have the same first several characters, you can repeat those entries even more quickly by setting up AutoCorrect entries for them. For more, see the AutoCorrect section.



Figure 3.12. Pick an entry from a list of entries in the column.



AutoCorrect We purchase lots of items at Office Depot and Office Max. When we do my tax numbers each year, instead of typing the entire “office d” or “office m” to let AutoComplete finish the entries, we use a much faster AutoCorrect entry: we type “od” or “om” and let AutoCorrect do the work for me. The results are the same as using AutoComplete, but with less effort on my part. Not only does AutoCorrect correct your spelling as you type (built-in corrections include “the” for “teh” and “back” for “bcak”), but you can add personalized corrections to the list (see Figure 3.13). The most useful aspect of AutoCorrect is that you can use it to enter long names or phrases when you type a short acronym. For example, if you need to repeatedly type Lake City High School Alumni, you can create an AutoCorrect entry that enters the long phrase when you type lch. To create an AutoCorrect entry: 1. Choose Office  Excel Options. 2. Click Proofing and click the AutoCorrect Options button. On the AutoCorrect tab, in the Replace box, type your short acronym.
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3. In the With box, type the replacement entry. 4. Click OK.



Figure 3.13. Creating an AutoCorrect entry



Remember that AutoCorrect entries are available and active in all your Microsoft Office programs, and may make unexpected corrections when, for example, you type in a Word document. In any Microsoft Office program, you can either delete the entry and re-create it when you need it again, or press Ctrl+Z to undo the correction and continue typing. To delete an AutoCorrect entry, return to the AutoCorrect dialog box. On the AutoCorrect tab, type the acronym in the Replace box (if you can’t remember the correct acronym, type the first letter or two and scroll for the entry). When you see the entry in the With box, click Delete. The entry is deleted in all your Microsoft Office programs.



Create a custom list Earlier in this chapter we told you about AutoFilling data such as day names or month names; these are built-in lists, and AutoFill fills the list of names for you. You can create a custom list of words or names of your own, perhaps for employee names, product names, or part numbers. Hack One feature of AutoCorrect in Office 2007 that we don’t like is the AutoCorrect buttons that appear after AutoCorrect corrects an entry. To turn them off, open the AutoCorrect Options dialog box. On the AutoCorrect tab, deselect the Show AutoCorrect Options buttons check box.
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Inside Scoop In the AutoCorrect Options dialog box there’s a tab for Smart Tags. Smart Tags don’t always work; when they do work, they give you more options than you usually need. We turn them off: on the Smart Tags tab, deselect the Label data with Smart Tags check box.



To create a custom list: 1. Type the list entries in a column, and then select the entire list. 2. Choose Office  Excel Options  Personalize. 3. Click the Edit Custom Lists button, and click Import. The imported list appears in the Custom Lists window. When you type any item in the custom list and drag the fill handle from that cell, the list is AutoFilled beginning with your entry (and uses the capitalization style you typed in your initial entry, even if that is not the capitalization style you used when you created the custom list). The list is repeated as you continue to drag the fill handle.



Delete data To delete data, click the cell and press Delete. To delete data from several cells, select all the cells and press Delete. To delete data from an entire worksheet, click the gray box at the intersection of the row numbers and column letters and press Delete.



Mix your techniques and technologies When we have a project that requires a high volume of data entry, we mix techniques and technologies to get the fastest, most accurate data entry we can. In addition to the data-entry techniques elucidated in this chapter, we often use a voice-recognition program to read data rapidly into a Word document, do any editing and formatting we need in Word (because it’s usually much faster for text editing), and then copy the data from Word into Excel. We also use an optical character-recognition program to convert data from a scanned fax if it’s clear enough, and we always ask clients to send us data in electronic format if possible, because any data that’s already electronic can be imported into Excel without introducing new typographical errors. See Chapter 18 for more about importing data.
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Bright Idea Make a Clear All macro and toolbar button to clear everything — data, formats, and comments — with just one click. See Chapter 19 to learn about toolbar buttons, and Chapter 21 to learn about macros and how to record my simple Clear All button.



When you delete data, the formatting and comments in the cells are untouched. To clear selected cells of everything, choose Home  Clear  Clear All.



Undo an action If you’ve done a number of things in a worksheet — entering data, formatting, deleting data or objects, whatever — and you decide that you’ve done it all wrong and want to change what you did, you can just undo those things without the bother of deleting data, unformatting, and remembering what exactly you did nine actions back. You can undo the last 16 actions you performed in Excel — in the reverse order in which you performed them — by pressing Ctrl+Z repeatedly or by clicking the Undo button on the Quick Access toolbar (shown in Figure 3.14). On the Undo button there’s a down arrow you can click to see a drop-down list of the last several things you did; click any item on that list to undo every action back to and including that item. If you change your mind about undoing something, you can redo what you undid by clicking the Redo button on the Standard toolbar (Ctrl+Y is the keystroke for Redo).



Figure 3.14. The Undo and Redo buttons on the Standard toolbar



Creating a dynamic list/table A dynamic list was one of the more noticeable new features in Excel 2003. In Excel 2007, however, lists are now called “tables,” so we’ll call it a dynamic table to differentiate it from a normal list or table, which is just columns of data with column headings at the top. Excel just calls it a table, which is a little confusing because Microsoft and everyone else have always used the term table for a regular table.
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Inside Scoop A dynamic list is a good source for chart data, too, because as you add rows of data to the bottom of a dynamic list, the chart data source expands and the data is automatically included in the chart.



At any rate, the new dynamic list has some features automatically added for you, including AutoFilter buttons, a SUBTOTAL formula at the bottom, and a data row at the bottom so the list automatically expands to include all your data. You can turn AutoFilter on and off yourself on any table or list, write your own SUBTOTAL formula, and insert new rows in a table any time you like, but when you create a dynamic list all these things are done for you. To create a dynamic table the easy way, create a normal list (at least a couple of rows of data and some column headings at the top), click any cell in the list, choose Insert  Table, and click OK in the Create Table dialog box. The new dynamic table has a border (so you can tell it’s a dynamic list), bold column headers, and AutoFilter buttons on the column headers (see Figure 3.15).



Figure 3.15. The new dynamic list adds features to your list automatically.



On the toolbar, click the Total Rows button to display or hide the total row with the SUBTOTAL formula. We have more to say about the SUBTOTAL function in Chapter 5 and AutoFilter in Chapter 8. If you want to change a dynamic table back to a normal list, first click in the table and then click the Convert to Range option on the Design tab on the Ribbon, shown in Figure 3.16.
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Inside Scoop When the Total row is displayed, click the Total cell. An arrow appears to the right of the cell. Click the arrow and select a different function if you want to change the formula to a different calculation.



Convert to range



Figure 3.16. The Convert to Range option returns the table to a normal list.



The only thing that a dynamic table can do for you that you cannot do yourself is publish your list to a SharePoint site. A SharePoint site is a shared-data Web site on a server that runs Windows SharePoint Services, and is beyond the scope of this book. If you type SharePoint in the Ask A Question box, you can find lots of information about it in the Microsoft Office Online Help files.



Validating data during entry It’s all too easy to inadvertently enter inaccurate data, which renders the data worthless. You can spare yourself the time spent fixing some kinds of data entry errors if the data is entered into the worksheet correctly to begin with. Data validation can help you avoid several kinds of incorrect data entry — especially helpful if someone else is entering data in your workbook — by demanding that each entry meets validity criteria that you set. For example, if a cell needs a valid date entry, or a calculable numeric entry rather than text, Excel can scream (or politely whisper) “No, that entry is incorrect. Try it again” and refuse to accept the invalid data. To set up data validation: 1. Select the cell or range in which you want to validate data. 2. Choose Data  Validation (the icon is found in the Data Tools category on the Ribbon). The Data Validation dialog box appears, as shown in Figure 3.17.
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Figure 3.17. The Data Validation dialog box



3. On the Settings tab, select the data type for acceptable entries in the Allow box. 4. Select limiting criteria in the Data box. The settings in the Data box (if any) change according to your selection in the Allow box. 5. Set limiting values in the boxes below the Data box. You can type a limiting number, a formula, or a cell address. Table 3.2 lists some useful validation settings.



Table 3.2. Useful validation examples For



Allow



Data



Value



Credit card numbers



Text



Equal to



16



Credit card expiration date



Date



Greater than or equal to



=TODAY()



Specific entries



List



n/a



Drag to select a range of entries on the worksheet and enter the valid entries in those cells (you can delete the worksheet entries after you create the validation list)



Bright Idea Instead of permanently specifying your criteria value in the Data Validation dialog box, click in the Minimum and/or Maximum boxes and then click in a worksheet cell. Type your criteria value in that cell; if you want to change the criteria value, edit the value in the cell.
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Inside Scoop To locate validated cells on a worksheet, choose Home  Editing  Find and Select  Go To and click Special. In the Go To Special dialog box, click Data Validation, click All, and then click OK. All cells with validation settings are selected.



6. Click the Input Message tab and type a title and message that will appear when the cell is selected (this is optional). 7. Click the Error Alert tab, select a style, and type a title and a message that will appear when invalid data is entered (see Figure 3.18). In the Style box, a Stop error prohibits invalid data entry, and Warning and Information errors allow invalid entries after the user clicks Yes or OK in the error message.



Figure 3.18. Data validation message



To remove data validation, select the cells in which you want to remove validation, choose Data  Validation, and click Clear All. To clear validation from all the cells where this particular validation setting is applied, select the Apply these changes to all other cells with the same settings check box before you click OK.



Editing cell entries If you are in the middle of typing an entry and haven’t locked the entry in yet, press Esc to erase everything in the cell.
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There are three ways to edit an existing entry: ■



Double-click the cell to open it and edit the characters in the cell.



■



Select the cell, press F2 to open the cell for editing, and then edit the characters in the cell (this technique keeps your fingers on the keyboard).



■



Click in the cell and edit the entry in the Formula bar (very useful if the font in the cell is small and difficult to work with).



Whether you are editing in the cell or in the Formula bar, you can use the arrow keys to move through the characters one character at a time; the Backspace and Delete keys to delete one character at a time; or the mouse to select several characters to cut, copy, or delete all at once.



Finding and replacing data If you need to find a specific cell in a large worksheet, let Excel find it for you; if you need to replace something throughout the worksheet, let Excel make all the replacements for you. This is especially useful if you are reusing a worksheet for a new month, a new year, or a different employee name: You can replace 2005 with 2006, January with February, or Dave Smith with Mary Jones. But you can also find a cell (or all cells) with a specific formula by searching formulas for all or part of the function name, find cells with a text string but only if specific letters are capitalized, or remove your user name from all the comments in a worksheet. In short, you can find and/or replace pretty much anything in a worksheet except for worksheet headers and footers (if you hardcode the year in your annual tax worksheet headers like we do, you have to remember to open and change the headers manually every year).



Find a string Most often you only want to find text strings in a cell (text strings are any characters typed in a cell, numbers as well as letters). To find a simple text string, press Ctrl+F and type the characters in the Find what box on the Find tab. In a simple Find procedure, Excel finds all cells that have strings containing the characters you typed (so, for example, we finds Wellington and Hollowell as well as we). You can refine your search:



08_045947 ch03.qxd



1/4/07



9:58 PM



CHAPTER 3



Inside Scoop



■



Page 71



ENTERING AND EDITING DATA



71



Inside Scoop The Name column in the pane lists named ranges where found cells are located. Naming cells and ranges is useful in many ways; see Chapter 4 to learn more.



■



To find each single instance of the characters, click Find & Select on the Home tab, and click Find to see the Find and Replace dialog box.



■



To find all instances of the characters, click Find All. A found-cells pane opens in the Find and Replace dialog box, listing the location of each instance of the string. When you click a line in the foundcells pane, the active cell jumps to that cell.



To refine and narrow your search further, click Options on the Find and Replace dialog box and set more stringent search criteria (see Figure 3.19). You can restrict the search to strings in which the characters have specific capitalization (select the Match case check box) or comprise the entire cell entry (select the Match entire cell contents check box), or search the whole workbook (select Workbook in the Within box). You can also search formulas or comments instead of displayed values by selecting Formulas or Comments in the Look in box.



Figure 3.19. The Find and Replace dialog box displaying Options for search criteria and the found-cells pane



Inside Scoop



Inside Scoop You can also limit your search to cells with specific formatting. Click the arrow on the Format button, click Choose format from cell, and click a cell that has the formatting you want to find. Then click Find All or Find Next.
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Replace a string Replacing a string is just like finding a string, but you run the procedure from the Replace tab in the Find and Replace dialog box. You can either press Ctrl+F and then click the Replace tab, or press Ctrl+H to open the same dialog box with the Replace tab displayed. Type the characters you want to replace in the Find what box, and the replacement characters in the Replace with box. You can replace cell formatting without changing the cell contents by replacing characters with the same characters and setting up a replacement format in the Replace with line (see Figure 3.20). Changing formatting alters the formatting in the whole cell, not just the characters (you can format individual characters manually; see Chapter 6 to learn more).



Figure 3.20. You can change cell formatting by replacing the same characters with a different format.



To replace characters one by one, click Replace repeatedly. The active cell jumps to each new cell before it makes a replacement; if you don’t want to replace the characters in the current cell, click Find Next to ignore the currently selected cell and move to the next cell. If you click Replace to replace strings one by one and you see a message that says Microsoft Excel cannot find a match, it just means that you Bright Idea If you want to find and replace a whole word rather than characters, type a space character in the appropriate position in both the Find what and Replace with boxes. The space character ensures that you don’t end up with unintentional run-together words.
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Hack If you click Replace All and find that the procedure made changes you didn’t intend, press Ctrl+Z to quickly undo the Replace All, and then set up a better Replace All procedure and run it again, or replace strings one by one.



have to help Excel find an initial match before it begins replacing (this is a bug, but it’s one Microsoft created a Help file for instead of fixing). Click Find Next, and then click Replace repeatedly. Interestingly, this doesn’t happen when you click Replace All (like we said, it’s buggy). To replace all occurrences of your text string in cell values and in formulas (called a global search and replace), click Replace All.



Moving and copying data The fastest way to move or copy data on the same worksheet is to drag it. Select the cell or range you want to move or copy, and then position your mouse pointer over one border of the selected range (it doesn’t matter which border). When the mouse is a four-headed arrow, you’ve got the border; drag the border to a new location. To move the range to the new location, just release the mouse button to drop the range. To copy the range to the new location, press Ctrl while you release the mouse button (the small plus symbol on the mouse pointer tells you that you are dropping a copy).



Between workbooks and worksheets You can drag ranges between worksheets and workbooks, too. ■



To drag a range to a new workbook, show both workbooks side by side and drag the range from one to the other.



■



To drag a range to another worksheet in the same workbook, press Alt, drag the range down to the sheet tab for the worksheet you want, and when the worksheet opens, drag the range into position on the new worksheet. Inside Scoop



Inside Scoop The small box that appears next to the dragged range border while you drag is a range tip that shows you the cell or range address where the dragged range is located before you drop it. You can ignore it.
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The next-fastest way to move or copy data is to use keystrokes. These keystrokes are a part of every Excel aficionado’s repertoire because they are so common, and they allow you to work quickly with one hand on the mouse and one hand on the keyboard. ■



Ctrl+X. To cut cells, select a cell or range and press Ctrl+X.



■



Ctrl+C. To copy cells, select a cell or range and press Ctrl+C.



■



Ctrl+V. To paste cut or copied cells, select the upper left corner cell of the paste range and press Ctrl+V.



■



Ctrl+Z. To undo mistakes, no matter what you’ve done (almost), press Ctrl+Z.



My third choice for quick cutting, copying, and pasting is the right-click method. Select the cell or range, right-click the selection, click Cut or Copy, right-click the cell where you want to paste the item, and click Paste.



Paste items The fastest way to paste a cut or copied item is to press Enter. Cut or copy your item using any method you like, click the cell where you want to paste it, and press Enter. Everything — contents, formulas, and formatting — is pasted. The next-fastest ways, in no particular order, are pressing Ctrl+V, and right-clicking and then clicking Paste. The difference between these two methods and pressing Enter is that when you press Enter, you get only one paste. When you use the right-click or keystroke method, you can paste the same item repeatedly. When you cut or copy anything — in any Microsoft Office program — the cut and copied selections are stored in the Office Clipboard, a hidden storage cache. To see, and choose from, all your cut-and-copied data, choose Home  Clipboard (click the little expansion icon to see the Clipboard). From the Clipboard pane (shown in Figure 3.21) you can click to paste anything repeatedly and in any order you want (just click the cell where you want to paste and then click the item in the task pane). Watch Out! If you copy and paste cells with formulas, you may get unexpected results because relative formula references change when you copy cells, although not when you move cells. For more about relative references and moving/copying cells, see Chapter 4.
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Figure 3.21. Paste copied items from the Clipboard pane.



You can also access the expanded Paste menu from the Home tab, as shown in Figure 3.22, to give you more paste options.



Figure 3.22. The Paste button options for copied data



Inside Scoop



Inside Scoop Any item you cut appears in the Clipboard task pane, but when you paste it from the task pane, the item is copied to the paste location, not moved. To move an item rather than copy it, use the border-drag or keystrokes methods rather than the Clipboard task pane.
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Inside Scoop Transposing a copied selection turns the item 90 degrees; columns become rows and vice versa. Learn more about transposing in Chapter 6.



The most useful item in the list is the Paste Values option. Pasting values is something we do quite often. It used to be hidden several mouse clicks away, and most users were never aware of it. Why use Paste Values? Here’s a good reason: When we create a list of formulas to join the contents of two cells (such as creating a column of full names from two separate columns of first names and last names), we want the new column of names to be values, not formulas, so we can delete the columns of first and last names without losing the formula results. By copying the column of formulas and then pasting the resulting values in their place, the formulas are replaced with their results, and the columns of first and last names can be safely deleted. To do this, select the cells with formulas and copy them. Then click the arrow in the Paste button and click Values without choosing a new paste location. Last, press Esc to remove the blinking border. If you cut a selection and then use the Paste button options, there’s only one option available besides Paste: Paste Link. Pasting a link creates formulas in the paste area that reference the cut cells (for example, if you cut cell A1 and Paste Link it in another cell, the formula =A1 is pasted), and the cut cells are not moved. Linked cells display the values in the original (source) cells, and if you change a source cell’s value, its linked cell changes, too.



Inserting, deleting, and rearranging Worksheets are never written in permanent ink. One thing you will need to do eventually (perhaps often) is insert and delete rows, columns, and cells. Hack When you paste items, you may see a Paste Options button next to the pasted item. If you click the button, you get a list of paste options. It’s unnecessary worksheet clutter. To turn it off, choose File  Excel Options  Advanced. Under the Cut, copy and paste section, deselect the Show Paste Options buttons check box.
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Inside Scoop Deleting rows and columns doesn’t make your worksheet any smaller; the worksheet still has 16,384 columns and 1,048,576 rows. When you delete a row or column, a new row or column is added at the bottom or right side of the worksheet.



You may have entire rows or columns of data in a table that you want to delete, but if you only delete the data you end up with a blank column or row that breaks your table in half. What you really need to do is delete the row or column itself from the worksheet, not just the data. On the other hand, you may need to insert a column or row because you want to add data that belongs in the middle of the table.



Delete a row or column To delete a row, right-click the row number and click Delete. To delete several rows, click and drag to select all the row numbers, and then rightclick in the selected rows and click Delete. To delete a column, right-click the column letter and click Delete (as shown in Figure 3.23). To delete several columns, click and drag to select all the column letters, and then right-click in the selected columns and click Delete.



Figure 3.23. Select column letters (or row numbers) to delete entire columns (or rows).
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Insert a row or column To insert a row, right-click a row number and click Insert (the row number you right-click is pushed down to make room for the new row). To insert several rows, click and drag to select the number of row numbers you want to insert, and then right-click in the selected rows and click Insert (the row numbers you selected are pushed down to make room for the inserted rows, as shown in Figure 3.24).



Figure 3.24. Inserting rows and columns



To insert a column, right-click the column letter and click Insert (the column you right-clicked is pushed to the right to make room). To insert several columns, click and drag to select all the column letters, and then right-click in the selected columns and click Insert (the selected columns are pushed to the right to make room). Inserted rows and columns always pick up the formatting of the surrounding rows and columns. Inside Scoop



Inside Scoop You can repeatedly insert or delete rows, columns, or cells quickly by pressing F4: Insert or delete a row, column, or cell the normal way, and then select the next row, column, or cell and press F4. Continue pressing F4 to repeat the procedure as many times as you need.
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Insert and delete cells When you need to insert or delete individual cells in a table, you can do it without affecting tables on the rest of the worksheet. When you insert cells in a table, the surrounding cells move down or to the right to make room, depending on what you select in the dialog box. When you delete cells in a table, the surrounding cells move up or left to fill in the blanks, again depending on what you select in the dialog box. To insert cells, select the cells to be moved to make room, and then right-click the selection and click Insert. In the Insert dialog box, select the option you want for moving the existing cells (see Figure 3.25).



Figure 3.25. By selecting Shift cells down, the selected cells are moved down to make room for the inserted cells.



To delete cells, select the cells you want to delete, and then right-click the selection and click Delete. In the Delete dialog box, select the option you want for moving the remaining cells to fill in the blanks.



Rearrange rows, columns, and cells Suppose you just need to rearrange the columns in a table. Perhaps you have all your tax data for the year entered and decide to switch the Vendor and Purpose columns. You can select a row or column of table data or individual cells or entire worksheet rows and columns, and insert them in a new position within existing data. To rearrange rows, columns, or cells, select the data you want to insert elsewhere. Drag the selection border as if you were moving it (look for the mouse pointer to change into the four-headed arrow), and press Shift while you drag the border. A hatched-line insert bar appears (see Figure 3.26) and bounces around between cells as you drag the border. When the insert line is where you want to insert your selection, release the mouse button to drop the cells.
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Figure 3.26. The hatched insert line shows where cells will be inserted.



When you drop the inserted cells, the cells around the insertion move down or right to make room.



Breaking a column into multiple columns Sometimes we enter a list of names in a worksheet and type both first and last names in the same cell (or at least we used to; now we know better). The names are more useful when they’re separated into two columns, one for first names and one for last names. Instead of deleting and retyping the names cell by cell, Excel can separate, or parse, the data into two columns for me. All we need to do is tell Excel where to break the entries (see Figure 3.27). To parse cells: 1. Select the cells. Leave an empty column on the right so the new column you’re about to create has somewhere to go. 2. Choose Data  Convert Text to Data. 3. In the Convert Text to Columns Wizard – Step 1 of 3, select the Delimited option and then click Next. (Delimiters are characters that separate data, such as spaces, commas, and tabs.) 4. In Step 2 of 3, choose a delimiter. With names the delimiter is most likely a space, but try selecting different check boxes. Click Next. 5. In Step 3 of 3, you can set formatting for each column of data. It’s faster to let Excel handle this step — you can reformat data later if you need to. Click Finish.
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Hatched insertion line



Figure 3.27. The vertical line shows where the data will be separated into columns.



The column is separated into two columns, with the new column started at the delimiter. If the column is parsed into extra columns because of multiple delimiter characters in some cells (such as a middle name in a list of names), you can manually move data and cells around in those few rows until you have what you need.



Adding worksheet comments Comments are a terrific way to add explanatory information to a worksheet without having the information appear in the worksheet (unless you want to display it). We have accountant friends who use these all the time as reminders of source data for cell contents; we often use them to remind me of what a complex formula does, especially if we don’t look at the worksheet for a year or so. A comment floats on top of the worksheet instead of appearing in the worksheet. It appears when you position the mouse pointer over the cell, whether the cell is selected or not (see Figure 3.28). A small, red triangle appears in the upper right corner of a cell that has a comment. You can do the following: ■



To add a comment, right-click the cell and click New Comment. Type your comment text and click a different cell.



■



To edit an existing comment, right-click the cell and click Edit Comment. When the comment opens, edit the text and click a different cell.



■



To delete a comment, right-click the cell and click Delete comment.
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Figure 3.28. A comment adds and hides extra information.



When you create a comment, it opens with your user name in bold font (see Figure 3.28). That’s great if you are sharing this workbook with other users and you and the other users want to explain your entries, but if you don’t need to identify the commenter, you can delete the user name. Comments open with a default size and shape, which may not fit your text. You can change the size or shape during inserting or editing (when the border around the comment is hatched or dotted) by dragging one of the handles on the sides or corners of the comment. You can easily manage comments using the Review tab on the Ribbon, as shown in Figure 3-29.



Figure 3.29. Use the Review tab to create comments, view them, show them, or hide them.



Checking your spelling Adding spelling corrections to the AutoCorrect list works well for words you consistently misspell, but when you aren’t aware that a word is misspelled, or flying fingers on the keyboard inadvertently misspell a word
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Hack If you inadvertently add a misspelled word to the dictionary, you can open the dictionary and delete the word. The dictionary is named CUSTOM.DIC; use Windows Search to find the file name on your hard drive. Open the file, delete the word, choose File  Save, and close the file.



that’s not in the AutoCorrect list, Excel can find many of those errors by checking your spelling for you. To spell-check the entire worksheet, click a single cell. To highlight a section of the worksheet, drag to select the cells you want to check, and then click the Spelling button on the Review tab on the Ribbon. When the spell-checker finds a word it doesn’t recognize (see Figure 3.30), it displays the Spelling dialog box.



Figure 3.30. The Spelling dialog box found a misspelled word.



Your options are ■



Ignore Once. Ignore this instance because in other instances this spelling may be incorrect.



■



Ignore All. Ignore this misspelling every time because it’s always correct in this worksheet.



■



Add to Dictionary. Add this spelling to the dictionary because this spelling is always correct everywhere and you don’t want the spellchecker to catch it anymore.
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■



Change. Change to the spelling highlighted in the Suggestions list, just this once. If the spelling you want is not in the Suggestions list, change the spelling in the Not in Dictionary box and then click Change or Change All.



■



Change All. Change to the spelling highlighted in the Suggestions list everywhere in the worksheet. If the spelling you want is not in the Suggestions list, change the spelling in the Not in Dictionary box and then click Change or Change All.



■



AutoCorrect. Change the spelling to the highlighted word in the Suggestions list, and add the misspelling and changed spelling to the AutoCorrect list.



The Options button opens another dialog box with dictionary and language options that you will probably never need to use.



Just the facts ■



Enter data by clicking a cell, typing data, and pressing Enter or Tab or clicking another cell. Use punctuation to format data as you enter it.



■



Use AutoFill, AutoComplete, Pick From List, custom lists, and AutoCorrect to enter complete entries quickly.



■



Validate data as it’s entered to prevent many errors.



■



Use Find and Replace to change data throughout the worksheet.



■



Drag data to move or copy it across a worksheet, to another worksheet, or to another workbook.



■



Insert and delete cells, rows, and columns to remove or add data in the middle of a table.



■



Insert worksheet comments to add extra information that hides in the worksheet.



■



Check your spelling to keep it looking professional.
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fter data is entered in a workbook, you’re ready to perform calculations on it (after all, calculations are why Excel exists). To perform calculations in a worksheet, you write formulas; to perform complex calculations, you use functions in your formulas (functions are built-in mathematical equations that save you time and effort, and are covered in Chapter 5). This chapter is full of basic calculation information: getting fast answers without formulas, writing your own formulas, using cell references and cell names for better calculation control, and fixing errors. It could just as well have been titled “Calculations 101.”



Simple calculations, quick answers To get really quick answers without writing a formula yourself, you have two options: AutoCalculate, which calculates cells in the worksheet temporarily but doesn’t write formulas; and AutoSum, which writes very simple formulas in the worksheet very quickly.



AutoCalculate AutoCalculate is a handy tool that we use often to calculate cells on the fly while we work. The AutoCalculate box is near the right end of the Excel Status bar, shown in Figure 4.1. You have the following options: 85



Chapter 4



GET THE SCOOP ON... Simple calculations and quick answers ■ Cell references ■ Writing formulas ■ Moving and copying formulas ■ Linking workbooks with formulas ■ Cell names ■ Editing formulas ■ Auditing formulas ■ Locating worksheet errors
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Figure 4.1. AutoCalculate is always at work. All you need to do is select two or more cells. ■



To use AutoCalculate, select the cells you want to calculate (two or more) and look at the AutoCalculate box. AutoCalculate sums cells by default, but it can also average cells, count entries, count numeric entries, and tell you the maximum or minimum number in a range.



■



To change the calculation function, right-click anywhere in the Status bar and select a different function (see Figure 4.2). You can turn AutoCalculate off by selecting None, but it’s so unobtrusive that many people never even notice it, so why bother turning it off?



Figure 4.2. Changing the AutoCalculate function
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If there’s no display in the AutoCalculate box (and it’s not turned off), that’s because you have only one cell selected, or you don’t have appropriate data selected for the current AutoCalculate function. For example, if you have only text cells selected, only the Count function works.



AutoSum You can use the AutoSum button on the Standard toolbar to enter a formula in the worksheet that calculates a group of numbers, instead of writing the formula yourself. AutoSum can write sums and average numbers, count all entries, and display the maximum and minimum numbers in a range. To use AutoSum, click a cell directly below a column of numbers you want to sum, and then click the AutoSum button (shown in Figure 4.3), found in the Editing section on the Home tab’s Ribbon. Auto Sum



Figure 4.3. The AutoSum button on the Home tab’s Ribbon



Make sure that the moving border surrounds the cells you want to sum (see Figure 4.4), and press Enter.



Figure 4.4. The moving border surrounds the cells that will be summed.
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Hack AutoSum can write a formula anywhere and calculate any cells you select. Click the cell where you want the formula, click AutoSum, and then drag or Ctrl+click all the cells you want to calculate.



Sum is the function most people want to use with AutoSum (and it’s the function most people use in a workbook), so the default calculation is sum. To use AutoSum with a different calculation, when you click the AutoSum button, click the arrow on the button and select a different function (see Figure 4.5).



Figure 4.5. Change the AutoSum function.



Use the calculator For calculations on the fly that don’t require any worksheet data, use the Windows calculator (see Figure 4.6). You’ve probably seen and used the calculator — it’s available in Start  All Programs  Accessories in Windows XP and Vista. The calculator is a plain-Jane sort and fairly limited, but its simplicity is what makes it convenient, and it’s what we use when we want to calculate something simple without typing data into a worksheet. Inside Scoop



Inside Scoop You can make the calculator much more high-tech by choosing View  Scientific (we leave it to you to understand the higher-level mathematics available there). By the way, if you want to do a quick square root, it’s on the small standard calculator, but not on the scientific calculator.
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Figure 4.6. The Windows calculator.



About cell references A cell reference is the cell’s address on the worksheet in terms of its column letter and row number. You can tell what any cell’s reference is by either looking at the row and column that intersect at the cell or by selecting the cell and looking at the Name box (see Figure 4.7). Name Box



Figure 4.7. The Name box shows the selected cell address or name.



If you click in the upper left corner of the worksheet, the Name box reads A1, which is that cell’s address: the combination of the column letter, which is A, and the row number, which is 1.



09_045947 ch04.qxd



1/4/07



9:59 PM



90



Page 90



PART II



Inside Scoop



■



CRUNCHING NUMBERS



Inside Scoop To reference an entire column, use the column letter, as in B:B for column B. To reference several columns, use the first and last column letters, as in B:D. Do the same to reference entire rows. The reference types described below also apply to whole-column and whole-row references.



When you write formulas that include cells, the cells in the formula are identified by their references. For example, in Figure 4.8, the formula =SUM(A1:B1) sums the values in cells A1 and B1.



Figure 4.8. Formulas use cell references.



A range reference is a rectangular range of cells identified by the references of the range’s upper left corner cell and lower right corner cell. A colon (:) separates the references, as in the range reference A1:B6 (see Figure 4.9). This range reference...



...refers to this range.



Figure 4.9. This SUM formula uses a range reference.



Cell reference types Cells can have different types of references, depending on how you want to use them in the formula. First, we explain the terminology and how to
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create the different types; then we show you how they work with actual examples (at which point they’ll make more sense). For any cell, there is only one reference but four reference types: relative, absolute, and two mixed types. Dollar signs ($) in the reference determine the type: ■



A1 is called relative.



■



$A$1 is called absolute.



■



$A1 and A$1 are called mixed.



An absolute cell reference is a fixed geographical point, like a street address, such as 123 Cherry Street. A relative cell reference is a relative location, as in “one block west and two blocks south.” The mixed cell reference is a mixture of absolute and relative locations, as in “three blocks east on Hampden Avenue.” A mixed cell reference can have an absolute column and relative row, as in $A1, or a relative column and an absolute row, as in A$1. The dollar signs designate the row and/or column as absolute, or unchanging, within a reference. When you write formulas, the meanings of absolute, relative, and mixed become more clear (see Figure 4.10).



Figure 4.10. The four reference types.



Change reference types If you need to change a cell reference type in a formula, there’s a much faster way than typing dollar signs ($). The fastest way to change cell reference types is to cycle through the four types until you find the one you want: Double-click the cell containing the formula, and within the formula, click in the cell reference you want to change (see Figure 4.11). Press F4 until the reference changes to the type you want (pressing F4 repeatedly cycles through all the possible reference types). When the reference type changes to the type you want, you can either click another cell reference to change it or press Enter to finish.
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Figure 4.11. Open the cell, click the reference (in the cell or in the Formula bar), press F4 to cycle, and press Enter.



Writing formulas You’ll probably need to do more calculations in your workbooks than AutoSum can do for you, which means learning how to write formulas.



Arithmetic operators A simple formula might consist of adding, subtracting, multiplying, and dividing cells. Excel’s arithmetic operators are detailed in Table 4.1.



Table 4.1. Arithmetic operators Operator



Description



+ (plus sign)



Addition



- (minus sign)



Subtraction



* (asterisk)



Multiplication



/ (forward slash)



Division



^ (caret)



Exponentiation



() (parentheses)



To group operations, such as =(2+3)*4, which gives a different result than =2+3*4



Bright Idea Here’s a formula that uses arithmetic operators and a simple function to calculate the circumference of a circle, πr2: = PI()*ref^2. Specify a cell in the ref argument and type the radius of the circle in that cell; then you can use this formula repeatedly by changing the radius entered in the ref cell.
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Cell references versus static entries Occasionally you’ll want to write formulas that include a static (constant, not calculated) entry such as a sales tax rate or a product name, but it’s more efficient to write formulas that use only cell references. For example, if you want to write a formula that totals prices and calculates sales tax, you can write a formula like =SUM(F6:F17)* .07, but when the tax rate changes you must open all the formulas that use the sales tax rate and change it in every formula. However, if you put the tax rate in a cell and reference that cell in your formulas, you need to change only the tax rate in the cell and all the formulas that reference the tax rate cell are instantly updated.



All formulas can calculate cells in the same worksheet, on different worksheets, and even in different workbooks (which links the workbooks and worksheets together). Some simple formulas have to be written by you; there’s no easy automatic feature to write them for you. But writing your own simple formulas is, well, simple. For example, a subtraction formula has to be written by you.



Simple formulas To write a simple formula that calculates two cells (for example, subtracting one cell from another), click the cell where you want to display the results, type an equal sign (=), click one of the cells you want to use, type your arithmetic operator, click the second cell you want to use, and press Enter. The simple formula is entered, as shown in Figure 4.12. When you build a formula by clicking cells and dragging ranges, the cells have relative references. What the formula in Figure 4.12 really does is subtract the cell two cells above from the cell three cells above the current Watch Out! Always click a cell to enter it in a formula; typing cell references is laborious and error prone.
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Hack You can quickly show all the formulas in a worksheet if you press Ctrl+` (the grave accent on the same key as the tilde [~]). Press Ctrl+` again to hide the formulas.



cell because of the relative references. The advantages and disadvantages of using relative references become clear when you copy formula cells to a new location.



Figure 4.12. This formula subtracts one date (in cell D2) from another date (in cell D3) to show the number of days between; there’s no quick automated tool for subtraction.



Moving and copying formulas You use all the same techniques for moving and copying formula cells as for nonformula cells, but sometimes with different results. When you move a formula cell, the formula moves intact and the cell references stay the same regardless of the reference types of the input cells (see Figure 4.13). But when you copy a formula cell, bad things can happen if you’re not prepared for them.



Copy a formula cell When you copy formulas, the reference type comes into play. Absolute references do not adjust when you copy a formula; they always calculate the same input cells.
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Relative references changed the results Results still correct



Figure 4.13. Moving and copying cells with relative references



Relative references, on the other hand, give the input cells’ locations relative to the formula cell; and when you copy a formula cell to a new location, relative references continue to refer to locations relative to the formula cell. This behavior is quite handy when you expect it, and frustrating if you aren’t aware of it. To copy a formula cell with relative references and keep the formula intact, change the references to absolute before you copy it. You can also open the cell, drag to select the formula, copy the formula, press Enter to close the cell, and then paste the copied formula in a different cell; but changing the references is less work and more permanent. If you want to use the same formula with relative references elsewhere in the workbook or worksheet (for example, to use the same formula in another similar table), copy the cell and paste it in the new location.



Copy with AutoFill Most often you’ll want the relative references to do their job and change the copied formula to suit its new location. For example, when you set up a Quantity column and a Price column and then want to multiply the quantities by the prices for a total price in each row, just write your formula one time at the top of the total column, and click and drag the AutoFill handle down the column to fill the formula cells (see Figure 4.14). If you Bright Idea The best way to keep cell references intact and also easily identifiable is to use cell names.
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Bright Idea If you want a formula to calculate one changing cell with one unchanging cell, such as the cells in a Price column and an unchanging TaxRate cell, write the formula quickly with relative references and then change the TaxRate cell reference to absolute before copying it. Better yet, name the TaxRate cell.



double-click the Fill handle, the formula or cell entry is filled all the way down the column until there’s no entry in the cell to the left. Formulas copied with AutoFill adjust themselves so that every relative reference refers to the correct cell relative to the formula cell (the relative references do the adjusting).



Fill handle



Figure 4.14. Click and drag or double-click the Fill handle to copy the formula down the column.



Linking worksheets and workbooks You can write formulas that reference cells in other worksheets or workbooks; those formulas link the worksheets or workbooks.



Formulas that link worksheets It’s a great convenience to be able to write a formula on one worksheet that calculates cells on a different worksheet. For example, we often transcribe client lists of household goods and their replacement values for insurance claims, and the very long list is on one worksheet while the very short summary list is on a second worksheet (which eliminates scrolling to see the totals).
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Hack If you only need to display a value from a different worksheet, start the formula with =, and then click the cell on the other worksheet that you want to display and press Enter.



To write a formula that includes a cell on another worksheet, click the sheet tab and click the cell (the sheet name and cell reference are entered in the formula, as shown in Figure 4.15). Click the original sheet tab to return to the original worksheet and continue the formula, or press Enter to finish the formula and return to the original worksheet.



Figure 4.15. This formula references a cell on another worksheet — Sheet3, cell C5.



Formulas that link workbooks You can also write formulas that calculate cells in other workbooks. For example, if you have workbooks that represent sales from different districts, you can write a formula in another workbook that sums values from the district workbooks. To write a formula that links workbooks, open all the workbooks in multiple windows, arranged so you have quick access to each of them. Begin the formula with =, write your formula and click the cell in each workbook to include the cell in the formula, and finish by pressing Enter. Each referenced cell is identified by workbook name, sheet name, and cell address, as shown in Figure 4.16.



Figure 4.16. This formula references a cell in another workbook — Qsales.xls, sheet Qtr 1, cell C71.
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Inside Scoop If you open a source workbook while the dependent workbook is open, the linking formula automatically recalculates with the current data in the source workbook. This is faster than waiting for recalculation from a closed workbook.



The workbook with the formula is called a dependent workbook because it depends on input from other workbooks. The input workbooks are called source workbooks because they are the data source for the linking formulas. Each time you open a dependent workbook, you are asked if you want to update it with linked information from the other workbooks. Click Yes to update the linked formulas with current data in the other workbooks; click No to keep the current values or if you don’t want to wait for the data to be updated. If you want to break the link so you can keep the current value and not be prompted with the update question, replace the formula with a static value by copying and pasting values. See Chapter 3 to learn more about pasting values.



Using cell names Cell names make formulas easier to read because the cells to which they refer are quickly and easily identified (for example, the formula =Subtotal+Tax is easier to understand than =G19+G20). Also, cell names keep cell formulas intact when the formulas reference cell names because cell names are always created with absolute references.



Naming cells There are a few ways to name cells, the easiest being the Name box and the Create Names dialog box. Each method is most convenient in particular situations. No matter what method you use to name cells, names must follow certain rules: ■



Names must start with a letter or an underscore character (_) or a backslash(\).



■



No spaces are allowed. For multiword names, use an underscore or, better yet, use initial capital letters to separate words, as in LastName.
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Bright Idea Always use some capital letters in a name, because when you type a name in lowercase letters and Excel recognizes the name, the name is switched to its official capitalization. However, if you misspell the name, it won’t be capitalized, and that’s often a clue to the error you get.



Names are not case-sensitive, so if you type the name in a formula, you don’t have to type the capital letters; however, the initial capitals make the name easier to read. ■



Don’t use periods. They’re allowed, but they may interfere with VBA programming code.



■



Keep names shorter than 255 characters (which is too long to be practical, anyway).



■



Do not use hyphens or other punctuation marks (if Excel doesn’t let you create a name, a punctuation mark may be the problem).



The Name box The Name box, located on the left end of the Formula bar, is the fastest way to name a range or a single cell. To name a cell or range with the Name box, select the cell or range you want to name, click in the Name box (see Figure 4.17), type the name, and press Enter. Using the Name box, you can name cells and ranges that have no identifying headings on the worksheet. No matter what method you use to name cells and ranges, the names appear in the Name box list when you click the arrow next to the Name box. Click the arrow and click a name to select the named range. Name box



Selected cell being named



Figure 4.17. Click in the Name box, type a name, and press Enter.
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The Create Names dialog box If the names you want to use are already headings in a table or labels for specific cells (such as Total or TaxRate), the fastest way to name the cells to which the labels refer is the Create Names dialog box. The Create Names dialog box not only uses existing names (no typing), but it can also create several names at once (for example, it can name all the columns in a table using the table headings). To name cells with the Create Names dialog box (shown in Figure 4.18), select the range you want to name (including the headings or labels), and then click the Formulas option in the Ribbon and in the Named Cells category, click Create from Selection. Select or deselect the check boxes as needed so that the correct headings or labels are used, and click OK. The names are created, and you can select any of the named ranges by clicking its name in the Name box list.



Figure 4.18. The Create Names dialog box.



Name Manager dialog box The Name Manager dialog box shown in Figure 4.19 is not a good choice for naming cells (it’s too laborious), but it’s the only way you can name constant values and formulas, edit the definition of an existing name, or delete a name. To define a name for a constant value (for example, a tax rate), choose the Formulas tab on the Ribbon and click Name Manager. Type the name (for example, TaxRate) in the Names in workbook box (shown in Figure 4.19); then select and delete everything in the Refers to box (including =), and type =your value (for example, =0.75). Click OK (not Close). Why would you want to define a tax rate in a named constant value instead of a named cell? Because it doesn’t appear in the worksheet, yet it is available to formulas throughout the workbook, and all formulas can be updated by editing the named constant value. To define a name for a formula, as shown in Figure 4.20, (for example, a long, complex formula with multiple nested segments), type the name (for example, InvoiceNumber) in the Names in workbook box;
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Inside Scoop You won’t see formula or constant names in the Name box or the Apply Names dialog box, but you can type them in formulas (so use easily remembered names).



then select and delete everything in the Refers to box (including =). Type =your formula (for example, =LEFT(A3,3)&”-”&RIGHT(H5,4) ). Click OK (not Close).



Figure 4.19. The Name Manager dialog box



Figure 4.20. Defining a formula name
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To use a named formula in a cell, type = and the formula name (as shown in Figure 4.21). If the formula is complex and you use it more than once a year, naming it saves a lot of time.



Figure 4.21. Using a named formula in a cell.



Edit names Regardless of the method by which you create a name, you can find it in the Name Manager dialog box, found in the Named Cells section of the Formulas tab on the Ribbon. Sometimes we want to edit a range name just to add an extra row or column; instead of deleting the existing name and naming the new range, we take the fast route and edit the existing name. In the Name Manager dialog box, shown in Figure 4.22, click the name you want to edit. and edit the reference, formula, or constant value in the Refers to box. Press Enter (not Close).



Figure 4.22. Edit a name in the Name Manager dialog box.
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Be careful not to disturb the exclamation point (!), dollar sign ($), or colon (:) marks or you’ll break the name and probably have to delete and re-create the name.



Delete names You must use the Name Manager dialog box to delete names, and lest you think this is unnecessary, we dare you to try to figure out what’s going on in a workbook with lots of formulas and 85 named ranges, many of them duplicates! (We had to do that for a client once, and it was not fun.) Names live on long after the data is deleted. To delete a name, in the Name Manager dialog box, click the name you want to delete, click Delete, and then click OK or Close (either button works).



Using names in formulas To use a name in a formula, type the name wherever the formula calls for the cell or range reference (see Figure 4.23). If you used at least one capital letter in the name (a very good idea), you can type the name in lowercase letters. When Excel recognizes the name, the letters are switched to their original capitalization. If you misspell the name, Excel won’t recognize it. You get an error, and the lack of capitalization tells you that the name is misspelled.



Figure 4.23. Type the name in place of a reference in a formula.



You can type defined names in formulas as you write them, or in the Function Arguments dialog box (covered in Chapter 5).



Paste names If you can’t remember the name, or it’s a long name, you can use the Paste Name dialog box to paste the name into the formula.
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To paste names into a formula, start the formula, and place the insertion point where you want to insert the name. Choose Defined Names  Use in Formula  Paste Names, click the name, and then click OK (see Figure 4.24). If you don’t mind memorizing another keystroke, it’s faster to click in the reference you want to replace with a name and then press F3 to open the Paste Names dialog box.



Figure 4.24. Paste names instead of typing them.



Apply names If you’ve already written formulas using normal cell references instead of named cells, you can quickly change all the named cell references in a worksheet into their names. Select the range of cells that contain formulas (as many cells as you like, including cells that don’t contain formulas), and in the Named Cells section of the Formulas tab in the Ribbon, click the drop-down menu next to Name a Range and choose Apply Names. Click every name you want to apply and then click OK (see Figure 4.25).



Figure 4.25. Apply names to replace references in formulas.
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Named ranges and apply names When you create names in a table using the table headings as range names, and then AutoFill or otherwise copy a formula that references the cells in those named ranges, and then apply names to the formulas, what you get is a column of formulas that all look the same. For example, a Total column has formulas that multiply a Price column by a Quantity column, and the Price and Quantity columns are named ranges. The formulas in the Total column all read =Price*Quantity. Each formula is using the cells in the named range that are in its own row, so the formulas are correct, even if it’s unnerving that they all look the same.



You can even name cells after you write the formulas and apply those names to the formulas that have cell references.



Editing formulas You can easily change a formula in any way (function, arithmetic operators, referenced cells, or constant values, which pretty much covers everything). To edit a formula, double-click the cell and select and replace whatever needs changing, as shown in Figure 4.26. Press Enter to finish your edits.



Figure 4.26. You can edit a formula in the cell or in the Formula bar.



Bright Idea If you want to replace a cell reference with a different cell reference, don’t type the new reference; instead, double-click the old reference and then click the new reference cell on the worksheet.
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Watch Out! Be careful not to click other cells unintentionally while a cell is open for editing, because those unintentional cells are added to your formula. If you inadvertently add other cells to your formula, press Esc to back out of the cell with no changes and start again.



Editing a formula is often easier if you click the cell and do your editing in the Formula bar. Depending on your worksheet font, the formula in the Formula bar is nearly always easier to read and use your mouse in. Easy ways to change parts of a formula are ■



To replace a referenced cell, double-click the reference to select it, and then click the replacement cell in the worksheet.



■



To replace a range, double-click and drag over both references (to select the whole range), and then drag to select the replacement range in the worksheet.



■



To replace a constant value or arithmetic operator, select the character(s) and type a replacement.



Tracing a formula In some worksheets, formulas reference other formulas that reference still other formulas. When you need to dig into a complicated worksheet to understand its architecture, Excel has tools to help you. The process of tracing formulas is called auditing, and there’s a toolbar with buttons that do the work. But first, you should understand the terminology of auditing formulas: ■



A precedent cell is an input cell referenced in the formula you’re auditing.



■



A dependent cell is a cell that uses the results of the formula you’re auditing. Bright Idea To see the immediate precedent cells for a formula, double-click the formula cell. The cell references in the open cell are colored; the colors correspond to the colored outlines around the referenced cells and ranges. Press Enter or Esc to close the cell without changing the formula.
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To trace a formula, click the Formulas tab on the Ribbon to access the Formulas Auditing section, and then click the cell with the formula you want to trace (see Figure 4.27). Then ■



To trace precedents, click the Trace Precedents button. The first level back is shown by blue lines that connect the formula cell to all its input cells. Click the Trace Precedents button again to trace the next level back, and continue clicking the Trace Precedents button until no new blue lines appear.



■



To trace dependents, click the Trace Dependents button. The first level forward is shown by blue lines that connect the formula cell to all its dependent cells. Click the Trace Dependents button again to trace the next level forward, and continue clicking the Trace Dependents button until no new blue lines appear.



To erase the precedent or dependent lines one generation at a time, click the Remove Arrows button and choose either Remove Precedent Arrows or Remove Dependent Arrows. To remove all the lines so you can trace another cell, click the Remove Arrows option.



Figure 4.27. Tracing a formula
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Locating worksheet errors Errors and invalid data seem to sneak into even the most scrupulously designed and maintained worksheets. You can find them with the help of a few tools on the Formula Auditing section of the Formulas tab on the Ribbon. If you see an error, Table 4.2 provides a list of what the errors mean and how to fix them.



Table 4.2. Error Values This error



Usually means this



To fix it, do this



#####



The column isn’t wide enough to display the value.



Widen the column.



#VALUE!



Wrong type of argument, value, or cell reference (for example, calculating a cell with the error value #N/A).



Check values, references, and arguments; make sure references are valid.



#DIV/0!



Formula is attempting to divide by zero or by an empty cell.



Change the value or cell reference so the formula doesn’t divide by zero.



#NAME?



Formula is referencing an invalid or nonexistent name.



Make sure the name still exists or correct the misspelling.



#N/A



Usually means no value is available or inappropriate arguments were used.



In a lookup formula, make sure the lookup table is sorted correctly.



#REF!



Excel can’t locate the referenced cells (for example, if referenced cells are deleted).



Click Undo immediately to restore references, and then change formula references or convert formulas to values.



#NUM!



Incorrect use of a number (such as SQRT(-1), which is not possible), or formula result is a number too large or too small to be displayed.



Make sure that the arguments are correct, and that the result is between -1*10307 and 1*10307.



#NULL!



Reference to intersection of two areas that do not intersect.



Check for typing and reference errors.



Circular reference message



The formula refers to itself, either directly or indirectly.



Click OK in the message; look at the status bar to see which cell contains the circular reference and remove references to the formula cell.
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To show the Formula Auditing toolbar, right-click in the toolbar area and click Formula Auditing.



Locate errors in formulas On the Formula Auditing section on the Formulas Ribbon (shown in Figure 4.28), click the Error Checking button. The tool checks all cells in the worksheet for any sign of an error (and picks up things that aren’t errors, such as numbers deliberately preceded by an apostrophe to make them text).



Figure 4.28. The Formula Auditing group.



If a perceived error is located, the Error Checking dialog box appears and tells you what it thinks the error is. You can use any of the helpful buttons to understand and fix the error; if you know the error is not an error, click Ignore Error to continue the check. If you have an error value displayed on the worksheet (see Table 4.2 to see what error values look like), you can access the Formula Auditing group, click in the error cell, and click the Error Checking  Trace Error. Sometimes the error is not in the cell itself, but is in a precedent cell. The Trace Error button finds what it thinks is the culprit input cell. It might or might not help you, but you still have to fix the error yourself after it’s found, using Table 4.2 as a reference. Then again, you may never need to trace errors because Excel tries to catch your errors as you enter them. If you enter an alleged error, such as a number with an apostrophe first to make the number text, Excel pops a green triangle into the corner of the cell, and when you click the cell you get an error button in the worksheet as well. You can click the error button for a shortcut menu that might or might not help.



Find invalid data in a worksheet If someone has entered invalid data into a worksheet in which data validation is in effect (see Chapter 3), you can locate the inaccuracies with the Error Checking option (Figure 4.29). (Remember that if you don’t
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use the Stop style on the Error Alert tab when you set data validation, users can ignore your warnings and enter invalid data; see Chapter 3.) To locate invalid data, on the Formula Auditing section, click the Circular References option on the Error Checking drop-down menu. If data validation was not set up before the invalid data was entered, you can set up validation after the fact and then run the Circle Invalid Data button to find the bad data.



Figure 4.29. Error-checking option.



Just the facts ■



Use AutoCalculate for instant, on-the-fly calculations and AutoSum to write fast, simple formulas.



■



Relative cell references change when you copy formula cells.



■



Absolute cell references never change, even when you move or copy formula cells.



■



Change reference types by clicking in the reference and pressing F4 to cycle through the four types.



■



Move and copy formula cells with the same methods you use to move and copy nonformula cells, but watch out for reference types.



■



Use cell names for easy-to-understand formulas and stable cell references.



■



Edit formulas by double-clicking to edit in the cell, or clicking to edit in the Formula bar.
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ot all calculations are simple. Fortunately, Excel can handle tremendously complex calculations for you by using functions. Functions are built-in formulas that perform complex math; in fact, many functions perform math that’s not possible by using arithmetic operators alone. Most of the formulas you need on a routine basis depend on functions, and some, such as AVERAGE, can prevent serious miscalculations. Functions can do a lot more than just math, however. They can look up data in another location, calculate cells only if they meet a specific criteria, combine the contents of two or more cells, tell you what a payment will be for a specific loan, and tell you what the largest and smallest values in a range are (and even format a range to make the largest value stand out in a different color; more about that in Chapter 6). And as useful as functions are when they work alone, they get really powerful when you combine them with other functions.



Using functions Excel comes with a slew of functions — some you’ll use all the time, and some you’ll be interested in only if you’re an electrical engineer or nuclear physicist.



111



Chapter 5



GET THE SCOOP ON... Using functions ■ Common and useful functions ■ Combining functions for more power
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Note If you create cell names, Excel automatically uses the cell name instead of the reference when you use the cell in a formula.



Functions have specific names, like SUM or AVERAGE or BETADIST, that must be spelled correctly or Excel won’t recognize them; however, Excel provides dialog boxes that do the spelling for you and help you fill in the arguments each function requires. Each function has a name and a set of parentheses. The parentheses enclose arguments, the information the function needs to perform its special calculation. Every opening parenthesis must have a closing parenthesis (which is easy in simple functions, but gets interesting when the formula combines and nests functions, each of which have their own parenthetical sets). Some functions are so simple that they have an empty set of parentheses, such as the =NOW() function, which returns the current time with no further input from you. Other functions have arguments so arcane that, unless you use the function daily, you probably won’t remember them; in those cases, you should use the Function Wizard. To use the Function Wizard, click the cell for the formula and then click the Function Wizard button on the Formulas tab on the Ribbon (the icon reads fx) to open the Insert Function dialog box (see Figure 5.1). If you know which function you want, select a category in the Or select a category list box; then scroll through the function names in the Select a function list. When you click a function name, a description of the function appears below the list; if you want to know more, click the Help on this function link. When you decide on a function, select it in the Select a function list and click OK. Bright Idea Always type function names in all lowercase letters. If the name is spelled correctly, Excel uppercases it; if it’s misspelled, you get an error and the stilllowercase name tells you why.
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Figure 5.1. Use the Insert Function dialog box for help with functions.



A dialog box specific to your function appears (see Figure 5.2), and you get copious help with each argument, as well as displays of argument and function results as you build the function.



Figure 5.2. The Function Arguments dialog box tells you what to enter in each argument.



Inside Scoop



Inside Scoop Instead of scrolling through a long list of function names, click in the Select a function list and type the first letter of the function name. The list jumps to the alphabetical point where the letter you typed begins.
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Bright Idea If you know the name of the formula but want help with the arguments, here’s a faster way to get it: Type =, the function name, and the opening parenthesis, and then click the Insert Function button. The Insert Function dialog box opens directly to your function.



In many arguments, you’ll want to select a range of cells. Don’t type them; either drag the dialog box out of the way or click the Collapse/ Expand icon at the right end of the argument box, and then drag to select your range on the worksheet. To redisplay the dialog box after dragging the range, click the Collapse/Expand icon (at the right end of the argument box) again. As you add arguments, the cumulative formula result appears near the lower left corner of the dialog box. If you enter an inappropriate argument, the dialog box tells you so next to the argument box. When you’re finished, as always, click OK. The current Function Wizard experience is really very efficient and helpful, even to Excel old-timers. Of course, you don’t have to use the Function Wizard. To write a formula using a function you know how to use (such as SUM, which requires only a range of cells entered into its single argument), click the cell where you want the formula, type =, and type the sum name with arguments between parentheses. Again, don’t type cell and range references if you don’t need to; make sure the insertion point is in place between the parentheses, and drag to select the range on the worksheet. (We talk about SUM functions a little later in this chapter.)



Common and useful functions In this section, we cover the most common and useful functions, and situations in which they are useful (the situations we present should give you a jumping-off point for adapting them to your own needs). This is by no means an exhaustive list of functions; you can find exhaustive lists in many encyclopedic tomes about Excel (see Appendix B for some recommendations). Bright Idea When you use a function for the first time, test it to be sure it calculates accurately before using it in real data. Test it with mock data (phony numbers) that consist of short text entries and round numbers so you can do the math in your head and know quickly whether you’re getting what you want.
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AVERAGE The AVERAGE function is a common and easy-to-write function for which you don’t need the Function Wizard. To write an AVERAGE formula, type =average(range), and either drag to select a range reference or type a range name in the function argument. (Remember to type the function name in lowercase.) The difference between the AVERAGE function and the paper-andpencil method of summing cells and dividing by the number of cells is displayed in Figure 5.3. If the range of cells you sum and divide by contains any blank cells, the average value is wrong (a blank cell is added as zero), but the AVERAGE function ignores blank cells so you get a true average.



Figure 5.3. The AVERAGE function is the safest way to get an accurate average.



You don’t need to write an AVERAGE function at all unless you want to use it in combination with another function or another Excel feature, because you can use the AVERAGE calculation in the AutoSum button list of functions.



SUM functions There are three common and useful functions that sum data: SUM, which does simple arithmetic addition; SUMIF, which sums cells according to criteria you set; and SUBTOTAL, which sums only the visible cells in a filtered list. For each function there are circumstances in which that function is most appropriate.



SUM The SUM function is universally useful, so much so that Microsoft created several ways to invoke it. But you’ll probably have occasion to include it in combined formulas, so you should be familiar with writing your own function and arguments.
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To write a SUM formula yourself, type =sum(range), as shown in Figure 5.4.



Figure 5.4. To write your own formula, type it and press Enter.



If the range you select is named, you’ll be pleasantly surprised to see the range name appear in the argument instead of the range reference. Remember that you can change a reference type by clicking in the reference and pressing F4 to cycle through the types. As with the AVERAGE function, you don’t need to write a SUM function at all unless you want to use it in combination with another function or another Excel feature, because you can use the AutoSum button.



SUMIF The SUMIF function sums values in a column if they correspond to a criterion in another column. For example, a list of monthly coffee sales of different types appears in Figure 5.5. We want to know how much Kona coffee was sold that month, so we use the SUMIF formula to sum only the Kona sales. If you start with the Function Wizard, you’ll find the SUMIF function in the Math & Trig and All categories, but save yourself time and start by typing =sumif( and then clicking the Insert Function button.



Figure 5.5. The SUMIF function sums the sales of a specific item.
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Inside Scoop Although you can put the formula anywhere on the worksheet, it’s usually handier near the top of the table.



Bright Idea A better alternative to typing the criterion name is to enter a cell reference in the Criteria box; then you can enter a criterion name in the referenced cell to change the formula criteria without editing the formula. (You’ll have a formula error until you enter a product name in the criteria reference cell.)



In the Range argument, drag to select the column that contains the criteria (in this case, the coffee names). If you name the table columns with the Create Names dialog box, you can type or paste the column name here instead. In the Criteria argument, type the name of the criterion (in this case, the name “Kona”) with quotation marks around it to tell Excel it’s a string. In the Sum_range box, drag to select the column with the numbers to be summed, in this case the Total column. Again, if you name the column, you can type or paste the column name here instead. The Function Arguments dialog box shows you the results of the formula; if it looks right, click OK. If you entered a cell reference in the Criteria argument, enter the name of an item to be summed in that cell; then enter a different name, and watch the SUMIF function do its magic.



SUBTOTAL Yet another useful member of the sum family is the SUBTOTAL function. The biggest advantage to using the SUBTOTAL function is that it calculates only the visible cells in a list. Here’s the problem: If you filter a Bright Idea If you used a cell reference instead of a string entry in the Criteria argument, label or format that cell somehow (with a border or color) so you don’t lose track of your criteria entry cell.
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list and use the SUM function to sum numbers, the SUM function sums all the numbers in the list, including the hidden numbers. That’s rarely what you want (as shown in Figure 5.6). However, the SUBTOTAL function calculates only the numbers displayed by the filter (and it’s for this very reason why Microsoft incorporated the function in the Total row in its new dynamic lists).



Figure 5.6. The SUBTOTAL function ignores cells hidden by a filter.



To write a SUBTOTAL function yourself, type =subtotal(function number,range). The function number is the number that specifies the calculation function (see Table 5.1); the range is the range of values you want to calculate. Use the Function Wizard until the function is familiar. The SUBTOTAL function can calculate 11 different functions, depending on the arguments you enter. The function arguments are not intuitively numbered — the SUM function is number 9, and we know that offhand only because we’ve used it for so many years — and while it would be nice if Microsoft would list the function arguments numbers for us right in the SUBTOTAL dialog box, it only does this if you enter the argument directly into the cell. You can either click the Help on this function link in the SUBTOTAL dialog box, or look up the function number in Table 5.1.
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Inside Scoop If you use the AutoSum button to write a SUM formula while a list is filtered, you get a SUBTOTAL function instead. More about filtering in Chapter 8.



Table 5.1. SUBTOTAL function arguments This argument



Performs this calculation



1



AVERAGE



2



COUNT



3



COUNTA



4



MAX



5



MIN



6



PRODUCT



7



STDEV



8



STDEVP



9



SUM



10



VAR



11



VARP



MAX and MIN The MAX and MIN functions find the maximum and minimum values in a range, respectively. The functions are written =MAX(range) and =MIN(range). We’re big fans of combining Excel’s features to get an extraordinary result. A really useful way to use these formulas is in a conditional format, so that within a range of data (perhaps a table of monthly sales commissions for several employees for the year), the single largest and smallest values have colorful formatting that makes them stand out in the sea of numbers, as shown in Figure 5.7. That’s much better than a maximum or minimum value sitting in a cell on its own.
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We teach you about conditional formatting in Chapter 7.



Figure 5.7. The MAX and MIN formulas, used with conditional formatting



COUNT Functions There are several COUNT functions, but only three are commonly used, and, of course, they are most valuable when used in conjunction with other functions. COUNT counts the number of cells in a range that contains numbers; to write it, type =count(range). COUNTA counts all the cells in a range that are not empty, regardless of what they contain; to write it, type =counta(range). COUNT and COUNTA are functions we use as arguments in other functions, such as the dynamic OFFSET function described later in this chapter. They can also be used alone, as shown in Figure 5.8. Watch Out! Even though they have the same names, the count functions are not equivalent in different Excel features. In AutoSum, the COUNT calculation counts number cells; in AutoCalculate, the COUNT calculation counts all cells, and the COUNT NUMS calculation counts only number cells.
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COUNT counts numbers COUNTA counts entries



Figure 5.8. The COUNT and COUNTA functions in use



COUNTIF is similar to the SUMIF function. It counts the number of cells in a range that meet specific criteria. To write it, type =countif(range,criteria). The range argument can be a range reference or a range name; the criteria argument can be a text string enclosed in quotes, or a cell reference (you type the criteria in the referenced cell). As an example of COUNTIF in action, Figure 5.9 shows a list of monthly coffee sales of different types. We want to know how many orders of Kona coffee were filled that month, so we use the COUNTIF formula to count only the Kona sales. The criteria cell for both formulas The SUMIF formula



The COUNTIF formula



Figure 5.9. COUNTIF counts the cells that meet your criteria.
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Bright Idea Combine the SUMIF and COUNTIF functions to average the sales in a list like in Figure 5.9: SUMIF(range,criteria,sum_range)/COUNTIF(range,criteria). Use the same range reference and criteria cell reference in both functions, and then type any product name in the criteria reference cell.



VLOOKUP VLOOKUP (and its less-used cousin, HLOOKUP) looks up values elsewhere in a worksheet or workbook. For example, in an invoice, you might want Excel to look up the state tax rate for the shipping address; or if you’re a teacher keeping grade sheets, you can have Excel look up the letter grades corresponding to your students’ test scores. The only difference between VLOOKUP and HLOOKUP is that VLOOKUP works vertically and HLOOKUP works horizontally in a lookup table (hence the V and H before each name). Here we show you how to use VLOOKUP. In the unlikely event that you ever need to use HLOOKUP, it works just like VLOOKUP, but horizontally instead of vertically (and the Help file is very helpful). To write a VLOOKUP formula, first create a lookup table, such as the scores-and-grades Lookup table in Figure 5.10. The table needs to be set up so that the values you are looking up (in this example, the score/grade cutoff values) are in the leftmost column and sorted in ascending order. The lookup table can have several columns in it, as long as the values the formula looks up are on the left.



Figure 5.10. Use the Function Arguments dialog box.
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Bright Idea If you need to copy the formula down a column in a data table like the actual test scores in the pictured example, use AutoFill.



Then create the VLOOKUP formula: =vlookup(lookup_value,table_array,col_index_num,range_lookup). The arguments are ■



lookup_value: the cell that contains the value you want to look up.



■



table_array: the lookup table range (drag to select it).



■



col_index_num: the number of the column in the lookup table where the looked-up values are found (think of the table columns as numbered left to right; in this example, the looked-up grade letter is in column 2).



■



range_lookup: an optional argument. If you leave it blank, the formula looks down the leftmost column for the closest match (which is why the column is sorted). If you enter FALSE, the formula looks for an exact match. (If, for example, you want to create a lookup table for state tax rates, enter FALSE so the VLOOKUP formula finds an exact match in the leftmost state abbreviations column.)



IF The IF function is a way to determine a cell value based on criteria you set, and gives you a result depending on whether or not the criteria is met. The IF function works like this: IF a statement is true, THEN return this first value, OTHERWISE return this second value. Figure 5.11 shows some examples of the IF function in action. The IF function is useful for accomplishing specific data-management tasks, such as the one explained in the sidebar below, and for controlling data displays in a worksheet.
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Figure 5.11. The IF function makes decisions about what to display for you.



Find duplicates The IF function is one of several ways to find specific entries in a list. Other ways include sorting, filtering, and Find, but we like the IF function because it’s fast and saves us the time it takes to eyeball the entire list. For example, when we need to find duplicate entries in a very long list, we often use the IF function. (This example assumes that the column with the entries begins in A1, and column B is empty — that’s where we write our IF function.) First, we sort the entries in column A so duplicates will be sorted together; in cell B2, we write the formula =IF(A2=A1,”xxx”,””) (there’s no space between the quotes). The formula reads, “If the cell next to me is the same as the cell above it, display an xxx, otherwise display nothing.” Then we AutoFill the formula down column B by doubleclicking the Fill handle. If we scroll through the list, duplicates are clearly marked; better yet, we can sort the list by column B, and all the duplicates (the xxx entries) sort to the bottom or top, where the duplicate rows are quick to delete.
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PMT If you’re shopping for a house, car, boat, or anything else that’s expensive enough for a loan, a key piece of information in your decision to buy is probably the size of the monthly payment. The PMT function figures it out quickly for you based on the annual interest rate, number of monthly payments, and initial size of the loan. You can write just the formula, but it’s more helpful to set up a table with all the pertinent information and reference the table cells in the formula (see Figure 5.12).



Figure 5.12. Use the PMT function to calculate a loan.



To write a PMT formula, type =pmt(rate,nper,pv). The arguments are ■



rate: the rate for the interest period. If you use an annual rate but make monthly payments, enter this argument as annual rate/12, so the formula calculates with a monthly rate.



■



nper: the total number of payments (for example, if it’s a four-year loan with monthly payments, the nper argument is 48). Bright Idea Name the cells in your table so the formula makes more sense. See Chapter 4 to find out more about naming.
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Bright Idea Set up two or three side-by-side tables with different terms in each. It’s a simple way to compare different loan scenarios. If you name the cells in each table, name them rate1, rate2, and so on.



Watch Out! The most common and often unnoticed source of error in this formula is neglecting to divide the annual interest rate by 12. If you don’t divide the rate argument by 12, your payment will be whopping big!



■



pv: the amount, or present value, of the loan. Enter this number as negative because it represents money you owe (if you enter it as positive you get a negative payment amount).



To make the loan-payment table even more useful, add an extra eyeopening bit of information: total interest paid. Somewhere on the worksheet (as shown in Figure 5.12), write the formulas: ■



Total loan payback: =monthly payment * number of payments (click the appropriate cells to add them to the formulas)



■



Total interest paid: =total loan payback – loan amount



NOW and TODAY The NOW function returns the current date and time; the TODAY function returns the current date. They’re handy to have in the corner of a worksheet when you want the time or date to be updated every time the worksheet calculates (which happens every time you make an entry in the workbook or open or print the workbook). NOW and TODAY have no arguments, and you don’t need the Function Wizard. You write them as =NOW() and =TODAY() (don’t type anything between the parentheses, and as always, don’t add any spaces). Figure 5.13 shows the two functions in use. Bright Idea If you keep a TODAY formula in the corner of a worksheet, that current date is a permanent part of the printed worksheet. You can always tell how old a printout is by looking at the date.
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Watch Out! Don’t use the NOW or TODAY function in a worksheet that contains historical data, such as an invoice (data that should have an unchanging creation date), because the date or time updates every time you open the worksheet. Instead, use Ctrl+; (semicolon) to enter a current date that won’t change.



Figure 5.13. The NOW and TODAY functions in use



Text Functions First, the text case functions: UPPER, LOWER, and PROPER. All three of these functions have the same syntax and take only one argument, ref, which is the cell address of the text to change. UPPER(ref) changes all the text in the reference cell to uppercase, LOWER(ref) changes all the text in the reference cell to lowercase, and PROPER(ref) changes every word in the cell to proper case (first letter capitalized). Figure 5.14 shows all three functions in use.



Figure 5.14. The UPPER, LOWER, and PROPER functions in use



You can quickly render a list more professional in appearance by making the letter case match throughout the list. Insert a new column next to the column with the entries you want to change, enter the text formula in the top cell in the new column, and then AutoFill the formula down the new column.
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Hack After you use these formulas to create a new column with the correct letter-case entries, copy and paste values in the new column so you won’t lose the new entries when you delete the original column of entries.



Other text functions such as LEFT and RIGHT seem rather pointless unless you have a real-life use for them; then they’re remarkable. Each of these functions extracts a specific number of characters from the left and right end of a text string, respectively (as shown in Figure 5.15).



Figure 5.15. The LEFT and RIGHT functions in use



To write a LEFT formula, use the Function Wizard until you are comfortable with the function syntax. Type =left( and then click the Insert Function button on the Formula bar. In the LEFT dialog box, click in the Text argument, and then click the cell that contains the text string. Click in the Num_chars argument, and type the number of characters you want to extract. The RIGHT function works the same way. We use these functions and the CONCATENATE function to create unique invoice numbers and change the letter case of entries in a list. We show you how in the “Combining functions for more power” section later in this chapter.



CONCATENATE The CONCATENATE function joins together the displayed values in two or more cells. It can also join a text string to the value displayed in a cell. Fortunately for all of us, we don’t ever have to type “concatenate” because the shorthand for CONCATENATE is & (ampersand). To write a CONCATENATE formula, type =cellref&cellref, as shown in Figure 5.16.
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Figure 5.16. The CONCATENATE function without incorporated spaces



This formula displays the entries from the two referenced cells joined together. As written, the two joined entries are displayed as a single entry with no spaces. You can join spaces, other characters, and other formulas into the formula result. For example, to join two cell entries into a single cell (see Figure 5.17) type =cellref&” “&cellref, which joins the first cell value to a space character, and then to the second cell value. If you join any text strings (including space characters) into a CONCATENATE formula, you must enclose the text string in quote marks.



Figure 5.17. Julia’s client didn’t know how to format wrapped text, so she entered long entries in separate cells; Julia joined each set of separated entries with the CONCATENATE function.



Watch Out! If you delete any of the input cells for a CONCATENATION formula, the formula breaks because its input data is gone. To prevent that, after you write the CONCATENATE formula, copy the CONCATENATE formula and then click the Paste button to paste values.
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OFFSET OFFSET is a somewhat elaborate function that we saw no earthly use for until someone showed me how to use it to define dynamic ranges, which grow and shrink as data is added to or deleted from a table. What the basic OFFSET function does is define a static range, just as if you dragged to select a range on the worksheet with a specific upper left cell and a specific number of columns and rows. We explain dynamic ranges in the “Combining functions for more power” section later in this chapter, but before we get to that level, you need to understand how the basic OFFSET function works. You cannot usefully set up an OFFSET formula in the Function Arguments dialog box because the OFFSET function defines a range rather than calculating a value. You use an OFFSET function by naming it, as shown in Figure 5.18, and then using the named function in other functions that calculate values.



Figure 5.18. Naming an OFFSET function



The OFFSET function is: =OFFSET(reference,rows,cols,height,width). The arguments are ■



reference: the anchor cell, from which the other arguments measure the defined range.



■



rows: the number of rows above or below the anchor cell where the range begins. The upper left cell of the range is this many rows away from the anchor cell (a positive number is rows down; a negative number is rows up).



■



cols: the number of columns right or left of the anchor cell where the range begins. The upper left cell of the range is this many
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columns away from the anchor cell (a positive number is columns right; a negative number is columns left). ■



height: the number of rows in the range (optional: if you leave it blank, the range is the same height as the reference argument range, which is usually 1).



■



width: the number of columns in the range (optional: if you leave it blank, the range is the same width as the reference argument range, which is usually 1).



An OFFSET range, selected by naming the OFFSET formula (see Chapter 4) and then using the Go To dialog box (In the Editing group, click Find & Select  Go To dialog box, is shown in Figure 5.19.)



Figure 5.19. A basic OFFSET formula defines this range. The range is named SampleRange, and it can be selected with the Go To dialog box.



More Functions The Function Wizard also contains a number of engineering and statistical formulas, as well as other specialized options. Just click the More Functions icon in the Function Library on the Formulas tab. You’ll see formula categories for statistical, engineering, cube, and information. One additional function we would like to note here, however, is the Convert function. To convert things like inches to millimeters, grams to ounces, statute miles to nautical miles to meters, liters to cups, degrees Celsius to degrees Fahrenheit, and so on, use the CONVERT function (see Figure 5.20).
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Inside Scoop In the From_unit and To_unit arguments you must type common abbreviations, not full words. To see what the acceptable abbreviations are, click the Help on this function link in the CONVERT section of the Function Arguments dialog box.



Figure 5.20. The CONVERT function can convert many units to many other units.



Type =convert( and then click the Insert Function button to open the CONVERT section of the Function Arguments dialog box. As with any other function, you can type the actual values into the argument boxes, or click cells to enter references in the argument boxes and enter your values in those cells on the worksheet (which makes the worksheet itself a conversion tool).



Combining functions for more power Many, if not most, of Excel’s functions seem pointless on the face of them because they were never meant to be stand-alone functions. Most functions are designed to be used in concert with other functions, and all functions can be used with other functions to get more elaborate, difficult-to-calculate, and useful results. In this section we show you a few examples of combining functions for more computing power. Hack When we need to write a particularly complex formula, we build it without typing = so we can copy and paste bits and pieces in position and see the whole formula take shape while we build it. When the formula looks ready, we type = at the beginning of the formula and press Enter. If it’s incorrect, we delete the = and fix it.
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Dynamic range with OFFSET and COUNTA In most of our lists, we place a SUM or SUBTOTAL formula at the bottom of the list, and both functions have a range argument. Instead of using a static range reference (which both named ranges and dragged ranges are), we use an OFFSET function to define a range that always includes all the cells in the column above, even when the list grows or shrinks. OFFSET defines a dynamic range when it’s used in conjunction with the COUNTA function (which counts all the entries in a range). To create a dynamic range formula, change the height and width arguments to COUNTA functions. This formula creates a dynamic range that begins in cell A1 and extends the length of column A and the width of row 1: =offset($A$1,0,0,counta($A:$A),counta($1:$1)). If your table is in a different location on the worksheet, adjust the first three arguments as necessary.



Test the dynamic range To see the formula work, name the formula in the Define Name dialog box (see Chapter 4), and then choose Find & Select  Go To in the Editing group and type the formula name in the Reference box. Add and delete entries to the bottom of column A and the right end of row 1, as shown in Figure 5.21, and watch the named formula select the correct range every time!



Figure 5.21. Change the number of entries in the table and then Go To the named OFFSET formula again.
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Watch Out! If you have any empty cells in column A, or any entries in column A outside of the table, your dynamic range will be wrong because the dynamic OFFSET function is counting all entries in that column to create the size of the reference (same goes for row 1).



Use a dynamic range How can you use a dynamic range? Well, we use it in expense lists, to sum all the entries in the column above our SUM formula, even as the list grows or shrinks. We never need to adjust the range reference being summed because the dynamic OFFSET formula does that for us. To do this, we choose a cell at least one row below our column of entries (it can be three or four rows below the column, just not in the row immediately below the column), and put a border around that cell to identify it. For this example, we chose cell D11 (the initial cell matters — you may not understand why, but you’ll see it work). Then we enter the formula =OFFSET($D$11,-1,0,) in the Refers to box of the Define Name dialog box (see Figure 5.22), and name it “CellAbove.” This formula always selects the cell above cell D11 (1 row up and 0 columns over from the anchor cell). It uses the height and width of the anchor cell (1 high, 1 wide) to determine the size of the range (the optional height and width arguments are left out, but that last comma is important).



Figure 5.22. Type the OFFSET formula in the Define Name dialog box and name it.



Okay, the named formula is finished. Now, to use it, we enter this formula in cell D11: =SUM($D$2:CellAbove). This formula sums all the entries between D2 (the topmost cell in our column of entries because we have a column header in D1) and the cell above the sum formula cell, as shown in Figure 5.23.
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Inside Scoop If you move the sum cell down to a new location and then open the Define Name dialog box, you see the changed anchor cell reference in the CellAbove formula. (Excel appends the sheet name to the anchor cell address; just ignore that.)



Figure 5.23. As the formula cell is moved down and data is added to the column, the formula cell continues to sum all the cells above it.



Here’s the dynamic part: When you move the sum formula cell down, the named formula CellAbove changes its anchor cell reference to the cell above the cell where you move it. As we add data to the column, we just move the sum cell down, always at least one row below the column of entries, and the formula always sums every entry between the top cell in the column and the cell above the formula. You can use a dynamic formula in any formula or procedure in which you want a range argument that adjusts to changing range size.



Nested IF functions The IF function, which makes a decision for you and displays a result based on criteria you set, can incorporate other functions and be nested up to seven levels deep. (Nesting is writing more IF functions inside each other, as shown in Figure 5.24).



Figure 5.24. These IF functions are nested.
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Inside Scoop Some people use nested IF functions in lieu of a VLOOKUP function (for example, to look up letter grades for test scores). We think the VLOOKUP function is more elegant and easier to write, but the nested IF function takes up less worksheet space.



A three-levels-deep nested IF function reads: IF this first statement is true, THEN return this first value; IF this second statement is true, THEN return this second value; IF this third statement is true, THEN return this third value; OTHERWISE (if all previous statements are false) return this last value.



Text functions and CONCATENATION Here are a couple of ways in which Julia combines text functions and concatenation: she creates unique invoice numbers and changes the letter case in long lists without retyping.



Unique invoice numbers In her invoices, Julia uses a numbering system that automatically creates unique invoices by combining the first three letters of her client name and the last four digits of the current date serial number. She uses the LEFT and RIGHT functions to extract the characters, and she joins them using the CONCATENATION function (see Figure 5.25).



Figure 5.25. Text functions and concatenation create a unique invoice number.



First, this system depends on her client name and the invoice date always being entered in the same cell. Because her invoices are created from a template, the name and date cells and the numbering formula are always in place.
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Bright Idea Automatically pull the highest and lowest figures out of a range of numbers and combine them with an introductory statement: =”The best and worst figures for 2004 were “&MAX(ref)&” and “&MIN(ref). Make sure you include appropriate space characters in the text strings.



The formula for the invoice number is =left(nameref,3)&”-”&right(dateref,4). The formula concatenates a hyphen (-) into the result between the name and date characters.



Change letter case We don’t care for lists typed in all uppercase letters or all lowercase letters (it’s a personal quirk), so to make imported or received lists look more professional, we change the letter case. We could do it rapidly with the text function PROPER, but that’s not quite what we want. We want to change the cell entries such that the first word is proper-cased (that is, initial capped) and the remaining words are lowercased (for example, we want to change TOASTER OVEN to Toaster oven). To do this, we need to combine a few different functions. The formula shown in Figure 5.26 proper-cases the first word in the referenced cell and lowercases the rest of the letters in the cell: =upper(left(ref))&right(lower(ref),len(ref)-1)



Figure 5.26. Combining text functions to make cell entries look professional



The formula is two formulas concatenated together: The first extracts the first letter with the LEFT function and uppercases it with the UPPER function; the second uses the RIGHT function to extract all but the leftmost letter and lowercases them.
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Calculating dates and times Regardless of formatting, Excel sees all dates as serial numbers, beginning with the number 1 on January 1, 1900, and running through December 31, 9999, (at which point Excel 2007 will be obsolete). Because Excel calculates dates as serial numbers, it’s easy to ask how many days there are between dates: Type dates in two cells, and in a third cell type =earliercellref-latercellref. No functions involved; just subtract one cell from the other. The same goes for times: To get elapsed time, subtract one time cell from another time cell. You may need to format the result to be something understandable, but we show you how in Chapter 6. The Date and Time functions DAY, WEEK, and MONTH extract the numeric day, week, or month from a date, and are good for combining in other formulas. For example, the formula =”You have “&MONTH(ref1)MONTH(ref2)&” months left.” (shown in Figure 5.27) calculates the number of months between the cells in ref1 and ref2 and concatenates it into a sentence.



Figure 5.27. DAY, WEEK, and MONTH functions in use



Because Excel doesn’t see dates any earlier than January 1, 1900, you can’t calculate dates earlier than that. You can only enter earlier dates in a cell as text strings. Hack If the elapsed time or date result is a negative number, the display is #######. Make sure you subtracted the correct cell; it’s easy to get the two cells switched.
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Just the facts ■



Functions perform complex mathematics that you cannot do with arithmetic operators alone.



■



Each function has a name and arguments that provide the function with the input data to calculate.



■



Use the Function Wizard to write functions you’re unfamiliar with; open the Insert Function dialog box by clicking the Insert Function button on the Formula bar.



■



Combine functions for more computing power.
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Formatting Cells



F



ormatting dresses up a worksheet and makes it presentable. But more than that, formatting makes data more meaningful by visually segregating data into groups and highlighting summary information so your audience can grasp your point quickly. We’ll tell you how to create your own cell formatting, including borders, colors, fonts and font sizes, rotating, merging, aligning entries, fitting entries into cells, rows, and columns, and more. After you do all the creative work to format a single cell or set of cells, we’ll show you the fast way to copy that formatting to other cells and to cells in other workbooks. Later in this chapter, we’ll show you how to apply Excel’s built-in formats to a table (which are quick but uninspired). This chapter is about formatting cells, the containers that hold your data. Nothing in this chapter changes the display of the values in cells. Chapter 7 covers formatting the values in those cells. Keep in mind as you read that although it’s fun to format a worksheet, you shouldn’t get too carried away. A worksheet that’s too whimsical loses its professional impact.



The Font and Alignment Ribbon groups The Font and Alignment groups of the Home tab on the Ribbon hold buttons for the most commonly used formatting choices (Figure 6.1). Some of the buttons you may use 143



Chapter 6



■



1/4/07



12_045947 ch06.qxd



144



1/4/07



10:03 PM



Page 144



PART III



■



DRESSING UP YOUR DATA



often; others not at all. In Chapters 19 and 21, we show you how to create a macro and custom toolbar button for your own custom formatting operations, too.



Figure 6.1. Font and Alignment options on the Ribbon



Keep in mind that you can click the expansion arrow at the bottom right corner of the Font and Alignment sections to see the Format Cells dialog box if you would rather apply styles in that manner, shown in Figure 6.2.



Figure 6.2. You can also apply formatting options from the Format Cells dialog box.



Formatting the font Formatting the font means changing the look of the characters in a cell. Not only can you change the appearance of all the characters in a cell, you can change individual characters within a cell (which is essential when you need superscript or subscript characters to write H2O or 103, for example).
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Inside Scoop When you use the Font button on the Formatting toolbar, you can jump to the font name you want quickly by opening the list, typing the first letter or several letters of the font name, and then clicking the Font name you want.



The toolbar buttons don’t need detailed explanation; they’re fairly intuitive (and if you don’t understand one, click a cell and then click the button to see what happens). Buttons apply formatting quickly, and some of them are a great deal more convenient than using the Format Cells dialog box, but you can do a lot more formatting than what the toolbar offers by using the Format Cells dialog box. Right-click a cell you want to format and click Format Cells (see Figure 6.3). We talk about the Number tab in Chapter 7; in this chapter we look at the Alignment, Font, Border, and Fill tabs, beginning with the Font tab.



Figure 6.3. The Font tab provides many possibilities for detailed font formatting.



The Font tab settings (refer back to Figure 6.2) are mostly selfexplanatory, but here are some tips. Every change you make appears in the Preview box. (To format specific characters in a cell, open the cell and drag to select those characters before you open the Format Cells dialog box.) ■



Font: Click a font name and look at the Preview box to see the typeface you clicked. The Font button in the Formatting toolbar button is faster.



■



Font style: This is just what it says; bold and italic are more quickly applied with the Formatting toolbar buttons or with keystrokes (Ctrl+B for bold, Ctrl+I for italic).



■



Size: Again, just what it says. Font is measured in points; there are 72 points to the inch.



■



Underline: Open the drop-down list and click an underline style. Single underline has a button on the Formatting toolbar (and a keystroke, Ctrl+U), and there is a ready-made button for double
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underlines in the Customize dialog box. Accounting underlines leave a space between characters and the underline, which makes characters more legible because their descending tails aren’t hidden by the underline. ■



Color: Colors the characters (either the whole cell or just selected characters). The Font Color toolbar button is faster.



■



Normal font: Select this check box to return the font formatting to the workbook’s Normal style (see Chapter 7 about styles). Effects: Superscript (like this), subscript (like this), and strikethrough (like this). Select the specific characters to be formatted (especially for superscript and subscript), and then open the Format Cells dialog box and apply the formatting. Oddly, there are ready-made buttons for this in Word, but not in Excel. However, if you use subscript and superscript often, it’s worth your while to record a macro and make your own toolbar button (see Chapters 19 and 21).



■



■



Preview: Displays your font formatting changes as you make them.



Working with borders We like cell borders that are simple and utilitarian. In most cases for numeric data, simple and nondistracting borders are better for data presentation, but for table headers and highly visual worksheets with charts and worksheet controls, elaborate and colorful borders are terrific. The only borders on a printed worksheet are the ones you create, and they make a big difference in the presentation of any data.



Simple borders For simple borders in black, the fastest way to apply them is with the Borders drop-down menu on the Font section of the Home tab. Select the cells you want to border, and then click the drop-down menu and choose a style to apply individual borders. The More Borders option, as you can see in Figure 6.4, simply opens the Font dialog box, which we discuss in the next section.



Elaborate borders If you want to get more colorful, use diagonal lines to make a cell look crossed out, or use double-lined borders, you need the Format Cells dialog box (see Figure 6.5).
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Figure 6.4. Border options on the Font section of the Home tab



Figure 6.5. Elaborate borders are possible with the Border tab.
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Inside Scoop If you didn’t select all the cells to border before you created the borders, you can “paint” (copy) the new borders to other cells quickly with the Format Painter (covered later in this chapter).



The trick to using the Border tab is to follow a strict and orderly procedure: 1. Click a line style in the Style box. 2. Select a color from the Color drop-down list. 3. Apply the borders by clicking any button on the left in the Border section or by clicking inside the Border box. When you click OK, the borders you built are applied to the selected cells. To erase all borders, click the None button in either the dialog box Border tab or the Border palette.



Adding colors There are two sources of color in cells: the characters (font color) and the cell background (fill color). You can apply both font color and fill color from the Format Cells dialog box, but they’re much faster from the Font section on the Home tab. What you cannot apply from the palettes is cell patterns; for patterns, you need the Format Cells dialog box.



Use the Font section on the Home tab To access color options, click either the Fill Color or Font Color button in the Font group. Figure 6.6 shows you the menu you see when you click the Fill Color button. To use the menus, select cells and click a color on the menu palette. To color specific characters, double-click the cell, drag to select the characters, and click a color in the Font Color palette. You can also click the More Colors option to open the Colors dialog box. Here, you’ll find a standard color grid where you can choose a fine level of color, as shown in Figure 6.7, or even input values for Red, Green, and Blue to create your own color on the Custom tab.
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Figure 6.6. Using the Font color and Fill color menus



Figure 6.7. The Colors dialog box gives you a fine level of color control.



Use the Format Cells dialog box There is one thing you must do from within the Format Cells dialog box: Apply patterns to cell backgrounds. You can choose fill colors or pattern style and color on the Fill tab of the Format Cells dialog box. Patterns
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can obscure cell values, but they can also highlight cells gently if you choose a light pattern and a light color, as shown in Figure 6.8. To apply patterns to selected cells, right-click in the selected cells and click Format Cells. Patterns are on the Fill tab, shown in Figure 6.9.



Figure 6.8. Highlight cells with pale patterns and colors.



Figure 6.9. Choose pattern options on the Fill tab.
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Bright Idea Use colors and/or patterns to create a more pronounced table border. Surround a table with very narrow columns and rows, and apply a color or pattern to the cells in those table-defining rows and columns.



To apply a pattern, click the Pattern Style drop-down menu. The color palette on the patterns list colors the pattern you click. Click a pattern, and then click a color (or click a color and then click a pattern, it doesn’t matter).



Create custom colors You can create custom colors to replace the standard color palette in a workbook. For example, we like our pale yellow, green, blue, and gray shades to be as pale as possible (paler than the default pale shades in the color palette) — you can see the difference in Figure 6.10. Excel’s default pale colors



My custom pale colors



Figure 6.10. One workbook has our custom colors, the other workbook has default colors.



To create custom colors, you access the previously mentioned Colors dialog box. Click a Color drop-down menu on the Font section of the Home tab and click the More Colors option. In the Colors dialog box, click the Custom tab. Click in the rainbow (use arrow keys to move around, too) until you get the color family you want, and then click and drag the slider up and down until you get the color density you want. The new color and the color you are replacing are displayed in the lower right corner, shown in Figure 6-11. Hack If you have data in colored cells and you’re going to print the worksheet on a black-and-white printer, use the palest colors you can because they’ll be gray (often too dark) on the printed page.
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Figure 6.11. One workbook has our custom colors, the other workbook has default colors.



As long as you’re here, take a look at the Red, Green, and Blue settings. The higher the number, the less dense that particular hue is, and the closer you get to white (and the lower the number, the denser the color and closer to black).



Fitting the text in the cell Fitting text in the cell is an important way to make your data more readable. You have lots of options, including alignment, merging cells, rotating to a slant or vertical entries, indenting, wrapping text, changing row height and column width, shrinking entries to fit, and transposing a table layout.



Alignment Excel’s default alignment is left-aligned for text and right-aligned for numeric entries. You can, however, realign any entry to suit your visual layout (and realignment is usually necessary to make a worksheet look professional). Figure 6.12 shows you the possibilities on the Alignment tab for the Format Cells dialog box. The right-aligned, left-aligned, centered, and merged-and-centered alignments are all buttons on the Alignment section of the Home tab. For all the other alignment possibilities, right-click the cell and click Format Cells; you’ll find all possible alignment settings on the Alignment tab.
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Bright Idea In lists in which you have labels to the left of values, right-align the labels so the reader’s eye moves smoothly from each label to its value. Right-aligned labels bleed over to empty adjacent cells on the left, so long labels don’t push the labels far from their values.



Figure 6.12. Myriad alignment possibilities



Indent Indenting entries is a great way to clarify data by making a list look outlined, with major heading labels and indented subheading labels (see Figure 6.13). The quickest way to indent is with the Increase Indent and Decrease Indent buttons on the Alignment section. The buttons increase and decrease indentation as you watch (no guessing how much to indent and then closing the dialog box to see the results). As with all formatting, you can select several cells and indent all of them equally at the same time.



Rotate Rotated labels can keep a table narrow and easy to read (as shown in Figure 6.13). To rotate text, select the cell(s), right-click the selection, and then click Format Cells. On the Alignment tab, click in the Orientation dial to set a rotation angle.
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Bright Idea Give several cells the same rotation angle by setting the angle in one cell and then painting the angle to other cells with the Format Painter, or by selecting all the cells before applying rotation.



Figure 6.13. Clarify groupings of data with indents.



Change column width and row height When text entries are longer than the column width, the entry bleeds over into the adjacent cell. When you make an entry in the adjacent cell, the long entry in the first cell is partially hidden. There are a couple of ways to make the entire entry visible, depending on the length of the entry. Usually all you need to do is make the column wider; but if the entry is so long that this isn’t practical, you can wrap the text to multiple lines (which makes the row taller but keeps the column width reasonable).



Drag to fit The fastest way to change column width or row height in a controlled fashion is to click and drag the border of a column letter or row number.
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Bright Idea Separate a table from any worksheet entries above the table with a very narrow row — visually the worksheet looks coherent, but Excel treats the table like the separate table that it is because of the row that separates the table from the entries above it.



To change column width, position the mouse pointer at the right-hand border of the column letter, and click and drag the two-headed arrow to a new width (shown in Figure 6.14). To change row height, position the mouse pointer at the bottom border of the row number, and click and drag the two-headed arrow to a new height. Drag right border



Drag bottom border



Figure 6.14. Drag a border with the two-headed arrow mouse pointer.



If you need to create matching column widths for specific columns (for example, to keep all your number columns the same width), select all the columns first (drag or Ctrl+click column letters to select the columns), and then drag the right-hand border of any selected column. All the selected columns are resized to exactly the same width. The same method also works with row heights.



Double-click to fit An even faster, albeit less controlled, way to change column width or row height is to double-click the border of the column letter or row number. Double-clicking the border “best-fits” the column or row to the biggest entry in the column or row. The hazard in best-fitting a column width is Hack If you inadvertently best-fit a column that’s suddenly too wide, press Ctrl+Z to undo the best fit, and then click and drag to widen the cell in a more controlled manner. If the culprit is a wide table title, merge and center the title over the table so it doesn’t interfere with best-fitting column widths in the table.
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that you may have a very long entry in the column, and unless the long entry is word-wrapped to multiple lines, your best-fitted column might be wider than your visible worksheet. You can double-click to best-fit multiple columns or rows, and each is sized for its own largest entry (so you won’t have identically sized columns or rows).



Wrap text A useful way to fit a long entry into a narrow column is to wrap text in the cell. As shown in Figure 6.15 (Alignment tab), wrapped text breaks the entry into multiple short lines that all display within the column; the row height increases to make room. Some procedures, such as justified alignment or inserting a line break, automatically turn on wrapped text. To turn on wrapped text yourself, right-click the cell and click Format Cells. On the Alignment tab, select the Wrap text check box. If you need to turn off wrapped text in a cell, deselect the Wrap text check box. You can also more easily turn Wrapped text on and off using the Wrap text button on the Alignment section of the Home tab.



Figure 6.15. Wrapped text keeps columns narrower.



12_045947 ch06.qxd



1/4/07



10:03 PM



Page 157



CHAPTER 6



■



FORMATTING CELLS



157



Hack Double-clicking to AutoFit a wrapped-text row or column entry often doesn’t work. When it doesn’t work, click and drag to enlarge the column by quite a bit, and then double-click the column and then the row to best-fit both.



You’ll usually want to resize the column and/or row after applying wrapped text to make the entry look right. Some wrapped-text entries break at an inconvenient place in the text. To force the entry to break where you want it, click the cell to select it. In the Formula bar, click to place the insertion point where you want the break and then press Alt+Enter. If you need to remove the forced break, select the cell, and in the Formula bar, click at the end of a broken line and press Delete.



Hide and unhide columns and rows Often when we work on a long list, we enter data one entire column at a time (depending on the data, it’s more efficient), and we want the column we’re entering data in to be right next to a column of labels so we can be sure we’re applying each entry in the correct row. The easiest way to put two spread-out columns together is to hide the columns in between them. (This really is faster and easier to control than splitting or freezing panes.) To hide columns, select the columns (click and drag or Ctrl+click the column letters), right-click in the selection, and click Hide (Figure 6.16). You’ll know the columns are hidden because the hidden column letters are not visible. You can hide rows the same way. Select the rows (click and drag or Ctrl+click the row numbers), right-click in the selection, and click Hide. You’ll know the rows are hidden because the hidden row numbers are not visible. To unhide columns or rows, click and drag to select the surrounding column letters or row numbers, and then click in the selection and click Unhide.



Bright Idea Use hidden rows and columns in workbooks you send to others to hide data the other users don’t need to see. For example, you can hide the columns that contain a lookup table for a VLOOKUP formula.
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Figure 6.16. Hidden columns have hidden letters.



Shrink entries If you have a cell entry that doesn’t quite fit and you don’t want to enlarge the column or row to make room for it, you can shrink the entry to fit within the cell. The text shrinks and grows back to normal as necessary when you change the column width (see Figure 6.17). To shrink an entry, right-click the cell and click Format Cells. On the Alignment tab, select the Shrink to fit check box. To remove the Shrink to fit setting, deselect the check box.



Figure 6.17. Entries shrink or grow to fit the column width.



Merge cells Most tables have a title across the top, and the title is usually too wide for a single cell. In addition, it’s difficult to truly center a title over a table if you place it in a single cell. Instead, center the title across the entire
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table. Select all the cells in a row above the table and click the Merge and Center button on the Alignment tab (Figure 6.18). The selected cell gridlines disappear because you merged them into a single cell. Type your title and it’s centered perfectly above the table (and remains centered even when you manipulate column widths in the table). To unmerge a merged cell, select it and click the Merge and Center button again. Merge and Center



Figure 6.18. Center titles exactly by merging and centering.



Transpose a table Sometimes we create a table like the one shown in Figure 6.19 and realize after a fair amount of data entry that our layout is impractical. We want to switch the columns to rows and the rows to columns. To transpose a table, select the table and copy it. Then click a cell away from the table in which to paste the transposed table, click the arrow on the Paste button (on the Standard toolbar), and click Transpose.
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Original wide table



Transposed table



Figure 6.19. A transposed copy of the original is pasted, and the original can be deleted.



Copying formatting with Format Painter When you format a cell or group of cells and you want to use the same formatting on other cells (even in another workbook), the fastest way to copy the formatting is to use the Format Painter. The Format Painter is a button on the Clipboard section of the Home tab that looks like a paintbrush. Click the formatted cell, click the Format Painter button (shown in Figure 6.20), and then click the cell to which you want to copy the formatting. Format Painter



Figure 6.20. Painting formatting with the Format Painter
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Bright Idea Make a table easy to read by coloring the rows with alternating stripes of white and pale green. Color the top row, and then select the top colored row and the next white row; then click Format Painter and paint the alternating colors down the table in one continuous mouse drag.



But wait, there’s more. If you double-click the Format Painter, it becomes “hot” or switched on; then you can click random cells and ranges anywhere and the format is repeatedly copied until you click the Format Painter again to switch it off. If you have varied formatting across a row (for example, two white cells, a gray cell, and a blue cell, each with its own special font and number formatting), and want to copy each cell’s formatting down its column, do it like this: Select all the formatted cells in the one row, click Format Painter, and then paint across all the cells in the next row. Continue to paint to the bottom of the table, all in one continuous drag.



Just the facts ■



Use buttons on the Font and Alignment sections of the Home tab for quickest formatting; use the Format Cells dialog box for more elaborate formatting.



■



Color cell backgrounds and cell text using the Fill Color and Font Color buttons; use the Fill tab in the Format Cells dialog box to apply patterns to cell backgrounds.



■



Fit entries into cells by changing column and row size, wrapping text, and shrinking entries to fit the cell.



■



Make data easier to read by aligning and indenting entries. Use the buttons on the Formatting toolbar for the most common alignment settings.



■



Center entries across multiple cells by merging them with the Merge and Center button.



■



Hide columns and rows for more efficient data entry and to keep worksheet data out of view when necessary.



■



Copy formatting fast with the Format Painter button on the Standard toolbar.
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t’s not enough to just enter numbers in a worksheet; numbers need to be displayed in a format that’s easy to understand (for example, currency, percentages, dates, and times need recognizable formatting to be of any use). Furthermore, what you see displayed in a cell is not necessarily the value entered in that cell (or calculated by Excel). Occasionally the calculation on the worksheet may appear to be incorrect because in your mind you’re calculating the displayed values, while Excel is calculating actual values. The actual cell value, the number Excel is calculating, is always displayed in the Formula bar. Number formatting is not only important for data clarity (for example, a date serial number is meaningless to readers), but you can also use formatting to increase a worksheet’s effectiveness. For example, a conditional number format can make specific numbers leap off the page visually, and custom formats can display text (such as 8 hrs) in a cell without affecting the calculable number value in the cell.



Applying number formats to cells Many number formats can be applied as you type data (such as typing $ or % as you type the numbers). This is efficient if you’re entering data in just a single cell or two. 163



Chapter 7



GET THE SCOOP ON... Ribbon buttons for formatting ■ Formatting text entries ■ Creating custom formats ■ Using styles to streamline formatting
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Hack When you enter a number that’s too long for the cell width, the number is displayed in Scientific format (for example, 1.23456E+12). To fix the number format, widen the column and reformat the cell.



But when you need to enter large quantities of numbers — for example, a long list of expenditures in an expenses list — the extra keystroke is tedious. It’s faster to enter all the numbers, and then format the cells all at once (or format the cells, and then enter the numbers).



Ribbon buttons for formats Another fast way to apply the most common formats is to use the Number section on the Home tab on the Ribbon, shown in Figure 7.1:



Figure 7.1. Number section on the Home Ribbon ■



Accounting Number Format: This button applies Accounting style, not Currency style (real Currency style is in the Format Cells dialog box).



■



Percentage Style: This button applies a percent symbol and tells Excel to calculate the number as a percent, but it only works like you expect if you apply the Percentage Style to the cell before you enter the number; if you apply the style after you enter the number, you get a number 100 times larger.



Hack The Percentage Style button works best if you enter a real percentage, as in .12 for 12%. If you want to simply enter 12% and not figure out the calculable value (.12), forget the button and type %12 or 12%.
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■



Comma Style: This button adds a thousands separator (the comma) and two decimal places. If you don’t want the added decimal places, click the Decrease Decimal button twice to remove them.



■



Increase Decimal and Decrease Decimal: These buttons add and remove decimal places from the display (they don’t change the actual value; they just show more or less precision in the displayed value).



The Format Cells dialog box The only way to apply exactly the number formats you want (including special and custom formats) is with the Number tab in the Format Cells dialog box (shown in Figure 7.2). You access some of the more-common options by simply clicking the Number format menu on the Number section of the Home Ribbon as well (shown in Figure 7.3). To access all options, click the More button to open the Format Cells dialog box Font section of the Home tab.



Figure 7.2. All number formatting happens on the Number tab of the Format Cells dialog box.
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Inside Scoop General is the no-format format; it’s the format in empty cells in a new worksheet. When you clear formats from cells,, what’s left is General. General format is the best way to see the serial number for a date or time.



Figure 7.3. The Number format drop-down menu provides easy access to more-popular options.



Right-click a cell that has a number entered, and click Format Cells. On the Number tab, the number in your selected cell appears in the selected format in the Sample box, which makes it easy to try different formats until you see the display you want. Every format category has options specific to that format. Some of the many ways the same number can be displayed using different formats are shown in Table 7.1.



Table 7.1. Number formatting possibilities This number



In this format



Looks like this



1.2345



Number, zero decimal places



1



Number, two decimal places



1.23



Currency



$1.23



Fraction, up to one digit



1 1/4



Fraction, up to two digits



1 19/81
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This number



In this format



Looks like this



12345



Number, two decimals, thousands separator



12,345.00



Currency



$12,345.00



Scientific, one decimal place (E indicates that 04 is an exponent)



1.2E+04



Special, Social Security number



000-01-2345



General



.0012345



Number, three decimal places



.001



Percentage, two decimal places



.12%



Fraction, up to three digits



1/810



.0012345



167



Formatting dates and times Dates and times are formatted, sorted, and calculated as dates and times, even though the date or time you see is actually a serial number that corresponds to that specific date and time. A serial number that’s an integer (no decimals or fractions) indicates the time 12 a.m. (midnight) on the serial number’s date; a serial number with a fraction or decimal indicates both a date and a time of day (times are fractions of the 24-hour day). Occasionally you may enter a number such as 12345 and see it formatted as a date. Excel recognized the number as a date serial number (often because of previous cell formatting). To change the display back to a number, change the cell formatting to General or Number. The easiest way to format dates and times is to enter them in formats that Excel recognizes. ■



Type 1/7/56 and Excel recognizes the date (you can reformat the entry to any other date display in the Format Cells dialog box Number tab). Excel recognizes most common date-type entries, such as jan 7, 56, and 1-7-56.



■



Type 1:15 and Excel recognizes the time as 1:15 AM. To specify PM, type 1:15 pm or 13:15 (the 24-hour clock). The key to entering times is the colon (:), which divides a time entry into hours:minutes:seconds.
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Bright Idea When you enter dates, Excel usually enters a four-digit year display, which makes the date entry (and the column in which it’s entered) wider than it needs to be. Make the date entries narrower by reformatting the cells to a 2-digit year display.



Calculating times Excel calculates times by calculating their serial numbers, which are fractions of a 24-hour day. But if you sum times (as in a weekly timesheet), you get incorrect results when the sum is more than 24 hours. The key to getting a valid result when the sum is more than 24 hours is to use a custom format. The custom format [h]:mm creates a display that shows the full sum of hours and minutes. A similar custom format, [mm]:ss, shows elapsed time in minutes and seconds for more than 60 minutes. See the section “Creating custom formats” later in this chapter for more.



If you need a nonstandard date display, such as Jun-07, you must apply it with the Format Cells dialog box Number tab. Not only are there many ways to format dates and times on the Number tab, but you can create unique formats to better fit your purpose by creating custom formats (see the “Creating custom formats section” later in this chapter). Watch Out! If you subtract one time from another or one date from another and the result is negative, the result is ########. Rewrite your formula to fix it.



13_045947 ch07.qxd



1/4/07



10:04 PM



CHAPTER 7



■



Page 169



FORMATTING NUMBERS AND USING STYLES



169



Formatting text entries Text entries (such as labels, part numbers, and ZIP codes) might be composed entirely of number characters, but are different from number values in that they must retain any leading zeroes and not be included in calculations. Some entries, such as Social Security numbers, are properly recognized as text when you type the separating dashes; but if you want to type just the numbers and not be bothered with the dash keystrokes, you can format the cells to apply the dashes for you. There are four such formats in the Special category on the Number tab. Although the Special formats insert punctuation for you and retain leading zeroes, they do not make the formatted entries behave like text; cells with Special formats continue to be calculable numbers.



Creating custom formats A common use for custom formats is to enter a calculable number but display letter characters alongside the number in the cell. For example, in a timesheet with entries such as 6.5 hrs, the custom format 0.0 “Hrs” displays a one-decimal number with Hrs appended in the cell, but leaves the number calculable (you see just the number in the Formula bar). Custom formats apply to any cells, whether they display entered values or the results of formulas. To make text characters a part of the cell display, right-click a cell with a number already entered and click Format Cells to open the Format Cells dialog box (shown in Figure 7.4). On the Number tab, click the Custom category. Select any number format in the custom list (look at the Sample box as you select different number formats), and then type your text string, enclosed in quotes, in the appropriate position in the Type box along with the number format characters. Table 7.2 shows several examples that you can use as starting points for developing your own custom formats.
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Figure 7.4. Adding a text string to a custom format



Table 7.2. Custom formats Example (value 01234.333)



This code



Gives this result



#,##0



Rounds to a whole number; comma separates thousands; no leading zeroes



# ?/?



Displays decimal portion as a fraction



1234 1/3



0.00



Rounds to two decimal places; no thousands separator



1234.33



00000



Displays all digits, including leading zeroes to five places (like ZIP codes)



01234



000-00-0000



Placeholders for all nine digits in a Social Security number; inserts hyphens after you press Enter



123-45-6789



000-0000



Placeholders for seven digits in a telephone number; inserts hyphen after you press Enter



555-1234



1,234
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Example (value 01234.333)



This code



Gives this result



(000) 000-0000



Placeholders for an area code and telephone number; inserts parentheses and hyphen after you press Enter



000”.”000”.”0000



European-style placeholders for digits 999.555.1234 in a telephone number; inserts periods after you press Enter (quotes distinguish periods from decimal points)



(800) 555-1234



The fastest way to create the custom format you want is to start with one of the formats already in the list of Custom formats. Click different format codes in the list and watch what happens to your selected cell value in the Sample box. When you have a suitable starting-point format selected, alter the format code in the Type box by adding and removing characters until you have exactly the format you want. Every custom format you create remains available in the workbook until you delete it; you’ll find all your custom formats at the bottom of the list in the Custom category.



Applying conditional number formats If you have a sea of data and want specific values to stand out, use a conditional number format. A conditional number format is cell formatting that depends on the value in the cell. For example, in a price list you might format every number greater than $1,000 in bright red, bold font. The table in Figure 7.5 is formatted with a conditional number format that color-codes every value that is higher than 500. Even when the values change, the conditional number format always highlights the values greater than 500. The conditional format is applied to the entire named range and works in addition to any other cell formatting applied to the range. To create a conditional number format, follow these steps: 1. Select the range to which you want to apply the formatting. 2. On the Home Ribbon, choose Style  Conditional Formatting, and then choose a desired formatting rule from the lists available, such as “Greater Than” shown in figure 7.6.
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Figure 7.5. This conditional format highlights the values greater than 500 in the range.



Figure 7.6. Choose a conditional formatting rule.



3. In the dialog box, set a condition and choose a format option, shown in Figure 7.7.



Figure 7.7. Configure the desired options.



4. Click OK when you’re done.
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Because conditional formatting has so many potential uses, Excel 2007 provides a number of preconfigured rules for ease of use. However, you can also create a new rule by clicking the option on the Conditional Formatting drop-down menu, and then create the new rule in the New Formatting Rule dialog box, shown in Figure 7.8.



Figure 7.8. You can easily create new rules according to your formatting needs.



Conditional formatting can highlight any values greater or less than your condition, any values between two numbers or not between two numbers, and so on.



Converting actual values to displayed values If the results of your calculations end up with 11 or 12 decimal places and you want to permanently reduce the values to whole numbers, you can format the values to the number of decimal places you want and then change the calculable value to those simplified values.



13_045947 ch07.qxd



1/4/07



10:04 PM



174



Inside Scoop



Page 174



PART III



■



DRESSING UP YOUR DATA



Inside Scoop Excel has 15-digit precision, which means it can use and calculate up to 15 digits, regardless of which side of the decimal point they are on.



Watch Out! This change in calculation accuracy is not reversible; once it’s done, it’s done, and every cell on every worksheet in the workbook is affected.



For example, if the actual value in a cell is 12.52365987 and you want to lose all but two decimal places, start by formatting the cell to two decimal places. Then choose Office  Excel Options, and on the Advanced tab, select the Precision as displayed check box, and click OK. After you change the precision, return to the Advanced tab again and deselect the Precision as displayed check box to turn the behavior off (because you only want to use it once; if you leave it turned on, you lose accuracy every time you reformat a cell).



Hiding zeroes On some worksheets, zeroes are important values; they let you know that the value really is zip and not just missing. But on other worksheets, lots of zeroes can be messy, especially when they are the results of formulas. Hiding unnecessary zeroes makes nonzero values more noticeable. There are three ways to hide zeroes, and each is best in the appropriate circumstances: ■



Hide all zeroes on the worksheet, whether they are values or the results of formulas: Choose Office  Excel Options, click the Advanced tab, and deselect the “Show a zero” check box. Zero values throughout the workbook are hidden (but you can see them in the Formula bar).



■



Hide zeroes only when they are the result of a formula, which limits the hiding to specific cells: Nest the formula in an IF formula, =IF(formula=0,””,formula), which reads, “If the result of the formula is zero, display nothing; otherwise display the result of the formula.”
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Hack If you open a worksheet and see no zero values where there should be zeroes, check the three possible causes just discussed. The problem is most likely the Zero values check box when you choose Office  Excel Options and click the Advanced tab.



■



Create a custom number format to hide zeroes, regardless of source, in the cells where you apply the format: The custom format #,##0;(#,##0); formats positive numbers as integers with a thousands separator, negative numbers as integers with a thousands separator in parentheses, and no display of zero values. The second semicolon is critical; no format following the second semicolon means zero values have no format and don’t appear.



Using styles to streamline formatting A style is a complete package of formats that you can apply all at once. Styles can include font, font size, font and fill color, number formatting, borders, patterns — in short, any formatting you can apply to a cell can be wrapped up in a style. For example, all the formatting shown in Figure 7.9 is applied with one style.



Figure 7.9. Use styles to apply consistent packages of formatting quickly.



Formatting a worksheet with styles is a great timesaver because you can apply all the formatting you need in one step, and every cell to which you apply a specific style is consistently formatted. Here’s another timesaver: Occasionally you’ll want to change some aspect of a style, such as a



Bright Idea Use styles to format table titles and headings for a consistent, professional look and quick application.
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color or a font; if you change the style definition, all cells with that style applied are automatically updated with the redefined style formatting.



Access Styles You can access a wide range of preconfigured styles by clicking the Styles option on the Home Ribbon (see Figure 7.10). You can click any available style and see it immediately applied to your worksheet.



Figure 7.10. Styles options on the Home Ribbon



If you scroll to the bottom of the Styles options, you’ll also notice a number format. If you choose a number format, you’ll see a listing of preconfigured styles for that number format. The number formats are ■ Comma (thousands separators with two decimal places) ■



Comma [0] (thousands separators with no decimal places)



■



Currency (Accounting style with two decimal places)



■



Currency [0] (Accounting style with no decimal places)



■



Percent (value*100 with a percent symbol) Inside Scoop



Inside Scoop The difference between Currency style and Accounting style is this: In Accounting style the currency symbol ($) is aligned at the left end of the cell, there’s a space at the right of the number to leave room for closing parentheses in negative numbers, and the decimal points line up in a column.
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A style can incorporate just a few formats — Comma, Currency, and Percent, for example, only have number formatting, and don’t override the alignment, font, border, or color settings in the cell — or a style can incorporate every kind of formatting and override any existing formatting in the cell (even though the Normal style appears unformatted, it has every format accounted for).



Change a style definition While built-in styles are quick and easy for data entry, they are also uninteresting. If you want a twist to your data display, such as a Currency style that shows negative numbers in red, you can change the definition of a built-in style: Apply the built-in style to a cell and then change the formatting in that cell (formatting changes always override applied styles); then click in the Styles option on the Ribbon (the style name is highlighted when you click), and press Enter. All the cells in the workbook that have that style applied are immediately updated with the new formatting.



Create a custom style by example You can easily create a new style by clicking the New Cell Style button on the Styles drop-down menu (on the Home Ribbon). After you create a custom style, you can apply that style just like any built-in style, using the list in the Style box (see Figure 7.11).



Figure 7.11. Creating a custom style



13_045947 ch07.qxd



1/4/07



178



10:04 PM



Page 178



PART III



■



DRESSING UP YOUR DATA



Copy styles from other workbooks When you spend time creating a great style, it’s available only in the workbook in which you created it. But if it’s a style that you want to use consistently in all your workbooks, you need an easy way to copy it into other workbooks. There are two ways to copy styles to another workbook, depending on what you want to do: ■



Copy a single style. To copy a single style, open the workbook with the style (the first workbook) and the workbook that needs the style (the second workbook). In the first workbook, copy a cell that has the style. In the second workbook, paste the cell. The style is added to the Style list in the second workbook (you can delete the pasted cell).



■



Copy several styles. To copy several styles to another workbook, open both workbooks. In the workbook that doesn’t have the styles, choose Styles on the Home Ribbon. In the Style dialog box, click Merge Styles. In the Merge styles from list, click the name of the workbook that has the styles, and in the Merge Styles that have the same names message, click OK. All styles in the workbook with the styles are copied into the unstyled workbook, and any styles with the same name are overridden with the new style definition.



Delete a style When you have a long list of styles in a workbook (which you will after you experiment with creating styles), you should delete those you no longer need, if only to shorten your Style box list. When you delete a style, all cells with that style applied are returned to Normal style. To delete a style, just right-click any style on the Styles drop-down menu and click Delete, as shown in Figure 7.12. Hack Any style can be overridden by applying new formatting to a styled cell, but the Style box will still show the name of the original style. If you decide to return to the style formatting, select the cell, click in the Style box, and press Enter. When asked if you want to redefine the style, click No.
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Figure 7.12. Delete a style in the Styles drop-down menu.



Just the facts ■



Apply simple formats, such as Currency and Percentage, quickly by typing the punctuation.



■



The Number Ribbon option buttons are the next-fastest way to apply simple formats and can apply their formats to many selected cells at one time.



■



For intricate number formatting, right-click the cell(s) and click Format Cells, and then use the Number section on the Home Ribbon to create the format.



■



Format dates and times by entering data in a recognizable date or time format; refine the format, if you need to, in the Format Cells Number tab.



■



Format text entries as Text or by typing punctuation as you type the entry; formats in the Special category on the Number tab apply formatting for specific kinds of entries but do not make the entries text.



■



Add text strings to number displays by creating Custom formats that incorporate text strings enclosed in quotes.
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■



Use Conditional Formatting to make numbers that meet specific conditions highly visible.



■



Clean up a worksheet and make nonzero values stand out by hiding zeroes with formulas, custom formatting, or by turning off display of zeroes in the workbook.



■



Use styles to apply consistent formatting quickly; put the Style box on a toolbar for quick access to styles.
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fter you enter or import a sea of data into a worksheet, you need to organize the data to render it useful or meaningful. Your first line of defense against a meaningless jumble of data is sorting, and your second line of defense is filtering. Filtering hides records you don’t need to see and displays exactly the records you need to work with; it’s the best way we know to display only those records that contain blank cells in a specific field, so you can find and fix incomplete data. Querying is an advanced filtering tool; you can query data from a worksheet table, another workbook or another program, and even from Web pages, pulling out just the data you want to display.



Sorting lists Sorting any kind of table or list is a basic necessity for organizing data, and some Excel procedures (such as subtotaling a table) require that the data be sorted first. As always, there are easier ways and there are more cumbersome ways to sort data. we use only the easy ways, so that’s what we’re going to show you. When you sort a list, you arrange a specific column, or field, in the list in ascending or descending order (see Figure 8.1). The field you sort by is called a sort key. When you sort one field, all the attached data — the rest of the list or table — is sorted along with the sort key. Excel expects to 183



Chapter 8



GET THE SCOOP ON... Sorting lists ■ Filtering records ■ Calculating filtered records ■ The Query Wizard ■ Query a Web page
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Bright Idea When you sort a field that has blank cells, the blanks sort to the bottom of the column, so you can use sorts to quickly segregate missing entries in a list. Also, sort a number field in Descending order to locate any alarmingly high numbers that are the result of typographical errors.



find your data in a table, surrounded on four sides by completely blank rows and columns or by the worksheet boundaries, and sorts only the one list; all other data on the worksheet is ignored. Table or list headings are ignored by sort procedures as long as the headings are substantially different from the data in the columns; Excel recognizes that the headings are inconsistent with the data and doesn’t sort them into the list. If there are no headings in a list, Excel recognizes the consistency of the data and the entire list is sorted.



Figure 8.1. A sorted table



Sort a list by a single field To sort a list by a single field, click a single cell in that column and click either the Sort Smallest to Largest or Sort Largest to Smallest buttons on the Data tab of the Ribbon under Sort & Filter, shown in Figure 8.2. A smallest to largest sort order is 1–10 or A–Z; a largest to smallest sort order is 10-1 or Z-A. Watch Out! When you sort by a field full of numbers that are formatted as text (for example, member numbers in a membership roster), they’re sorted in “alpha” order: 1,10,100,2,20,200, and so on. If sorting by that field in numeric order is important, format the entries as numbers, not text.
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Figure 8.2. The Sort toolbar buttons



Sorting hacks If you get unexpected results when you sort data, knowing a few workarounds can save you time and frustration. For example, if you ever get the headings sorted into the list because Excel didn’t recognize the headings, undo the sort, choose the Data tab on the Ribbon, click Sort to open the Sort dialog box, and select the My Data has Headers check box. Excel recognizes the header row and you can complete the sort. Another problem you might have with sorting is that when you select an entire column within a table and try to sort it, Excel asks if you want to expand the selection (sort the whole table) or continue with the selection (sort just the column). If you sort just the column, your data integrity is lost. If that’s not what you intended, choose Expand the selection (and when you want to sort the entire table, select a single cell in the column by which you want to sort the table). One last problem you may encounter is this: Your column looks like numbers but won’t sort correctly. Chances are that somewhere in the column is a badly formatted entry. Instead of wasting time searching for the entry (it could be as simple as a hidden apostrophe at the beginning of the entry), choose the Sort option, choose My Data has Headers, and click OK. In the Sort Warning dialog box that appears, click the Sort anything that looks like a number, as a number option, and click OK. The Sort Warning dialog box tells you which number is causing the problem; you can locate that number and do whatever is required to reformat the entry as a number.
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Sort a list by more than one field There is a Sort dialog box (click the Sort button on the Sort & Filter section of the Data tab) that helps if you get confused about the order in which you want to sort fields, but usually sorting is too straightforward to require a whole dialog box. Furthermore, if you need to sort by more than three fields, the Sort dialog box becomes more confusing. It’s faster and easier to sort using the Sort buttons. When you need to sort a list by more than one field, you have major and minor sort keys. Major keys encompass minor keys. As an example, in a list of regions, states in those regions, and cities in those states, the Region field is the major sort key and the State and City fields are progressively more minor. A logical sort order might be by Region, then by State within Region, and then by City within State. The fast way to perform this sort is to use the Sort buttons on the Data tab: Sort the most minor field first, then the next most minor field, and so on until you sort the major field last. If you set up the table so that your major sort field is on the left and each sort field to the right is progressively more minor (see Figure 8.3), all you do is sort each field from right to left. Regardless of the number of fields you need to sort by, the Sort buttons on the Standard toolbar will do all the sorting you need.



Figure 8.3. Sort from right to left, minor to major.



Inside Scoop



Inside Scoop In a new dynamic list, even though the toolbar that appears with the list has a Sort command on its List button, dynamic lists sort just like normal lists — and the Standard toolbar Sort buttons are faster (one click as opposed to four).
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Inside Scoop If you need to sort a table by its headings from left to right, open the Sort dialog box, click Options, select the Sort left to right option, and click OK. The fields are rearranged in sort order from left to right.



Sort according to a custom order You can sort any field in an ascending or descending order, but what if you want to sort a list in an order that’s neither ascending nor descending? For example, you might want to sort a list of day or month names or people’s names. In this case you need to use the Sort dialog box. First, create a custom list of the entries with the sort order you want (see Chapter 3). Day and month names already exist as custom lists. Next, choose the Sort button on the Data tab. In the Order field, use the pull down menu and select Custom List. In the dialog box (see Figure 8.4), select the sort order for your field, and then click OK. Back in the Sort dialog box, select the desired order from the drop-down box, and click OK.



Figure 8.4. Sort in a custom list order rather than alphabetically.



Undo a sort Sometimes you need to sort a list temporarily but don’t want to keep that sort order. There are two ways to undo a sort:
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■



To undo a sort and return the list to its former arrangement, press Ctrl+Z (or click the Undo button on the toolbar) before you do anything else in the worksheet.



■



To be able to return to a presort arrangement after lots of worksheet manipulation, first insert a column of consecutive numbers sorted in ascending order down the right or left side of the table, as shown in Figure 8.5. (Insert a column, type the numbers 1 and 2 at the top, and double-click the fill handle to fill the column.) Then ignore the new column and work with your data. When it’s time to return to the initial sort order, sort the column of numbers you inserted.



Figure 8.5. The easy way to return a table to its original sort order: Add a re-sort column.



Filtering records When you need to focus on particular records, or rows, in a large table, you can filter the table to show only the records you need to work with and hide all the data you don’t need to see. The fastest way to filter a list is with AutoFilter. You can look for records that have a specific entry in one field or records that have specific entries in two or more fields (as shown in Figure 8.6), and you can run custom filters that find, for example, entries greater than $100 or entries that contain the text string “lamp.” You can also filter for blank cells or nonblank cells. Bright Idea If you need to sort a list randomly, add a column filled with the =RAND() function. Every time you sort on the RAND field, the list is randomly sorted again. Delete the RAND field when the list is randomly sorted to your satisfaction.
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Figure 8.6. AutoFilter quickly filters the records you need. This table is filtered in two fields — Date and Category.



Records are filtered based on criteria. A criterion is an entry or partial entry that several records have in common. You designate the criterion, and AutoFilter displays all the records that share that criterion (and hides all records that don’t). To turn on the AutoFilter, click a cell in the table you want to filter, and choose the Filter button under Sort & Filter on the Data tab. Gray filter arrows appear on each column heading. When you’re done filtering, turn AutoFilter off by clicking the Filter button again.



Filter with a single criterion To filter a list by a single criterion (a specific entry) in one field, click the filter arrow on that field’s column header. A list of all the entries in the field, in alphabetical order, opens (see Figure 8.7). Click the entry for which you want to display records. Records that contain the criterion you select are displayed and all other records are hidden. To show the hidden records again, click the filter arrow and click Select All (at the top of the list). Inside Scoop



Inside Scoop The AutoFilter you turn on is exactly the same AutoFilter that is automatically applied to a dynamic list. All of these procedures apply to AutoFilters whether they are in a dynamic list or a normal list.
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Bright Idea You can preserve the filtered results by copying the filtered range and pasting it elsewhere.



Figure 8.7. Choose the filter criterion from the AutoFilter list.



Filter with multiple criteria Quite often you’ll need to filter for multiple or complex criteria such as these: ■



You can filter on two different fields (for example, in an expenses list we want to see all records for Office Supplies from a specific Vendor).



■



You can filter on two criteria in the same field (for example, in an expenses list we want to see all records of expenses at two different stores in the Vendor field).



■



You can filter on a criteria range (for example, we want to see all the records for our office expenses in January).



■



You can filter for specific text strings (in Figure 8.8, we filter for all the records in which the Purpose field contains the word “paper”).
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Figure 8.8. AutoFilter can find specific text strings, such as the text string “paper” in the Purpose field.



AND filter or an OR filter When you filter for two or more criteria, you run either an AND filter or an OR filter. An OR filter displays records that meet either of the criteria; it reads, “Show me any entries that are X OR Y.” An AND filter displays records that meet both (or all) the criteria; it reads, “Show me each entry that’s both X AND Y.” If you create an AND filter and get no results, you probably want an OR filter instead.



Filter with two different fields A filter on two different fields (such as the filter in Figure 8.6 earlier) is an AND filter. It reads, “Show me records that have a criterion in this field AND a criterion in that field.” You can filter on as many fields as you need. To run a multiple-field filter, click the filter arrow in one field and set your criterion, and then click the filter arrow in another field and set your criterion. Both filtered fields have filter arrows to help you remember where you set the filter criteria.



Filter with two criteria in the same field A two-criteria filter in the same field might be an OR filter or an AND filter. An OR filter shows records that have one criteria OR another in the same field (such as one store OR another in a Vendor field); an AND filter shows records that meet one criteria AND another in the same field (such as records that have dates greater than or equal to January 1, 2007, AND less than or equal to January 31, 2007, in the Date field).



Filter for a text string Suppose you don’t have a specific entry for a criterion, but want to see all the records that have a specific word or text string in the filter field. You
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can filter for entries that begin with, end with, or contain specific text strings, and for entries that do not begin with, end with, or contain specific text strings. To filter on a text string, click the Advanced Filter button. In the Advanced Filter dialog box, shown in Figure 8.9, enter a list and criteria range for the advanced filter. You can also use the Copy To option if desired.



Figure 8.9. Choose the Advanced Filter button.



Calculating filtered records Viewing a filtered list is a good beginning, but without calculations it’s just a list of numbers. Usually you want to sum a subset of records in a filtered list, but you need the right formula to get an accurate sum when the list is filtered. The SUBTOTAL function gives you the right formula. SUBTOTAL calculates only the visible cells in a filtered list, whereas the SUM function calculates the entire list, including the hidden cells. (If your list is a dynamic list, the SUBTOTAL formula is already written for you as part of the list structure.) The fastest way to write a SUBTOTAL formula for a filtered list is to filter the list (filter it for anything, as long as it’s filtered), and use the AutoSum button on the Formulas tab to write the formula. (If you use the AutoSum button when the list is not filtered — even if AutoFilter is turned on — you get a SUM function instead of a SUBTOTAL function.)
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Inside Scoop The AutoSum button gives you a choice of functions when you open its list, but those choices don’t translate into different SUBTOTAL calculations. To use a different SUBTOTAL calculation (such as AVERAGE), let AutoSum write the SUBTOTAL formula and then change the calculation argument.



It matters where you write the formula on the worksheet, because if you put the formula alongside the list it will be hidden whenever a filter hides that row. Put the formula at the bottom of the list below the calculated column so it isn’t hidden when you filter the list, or put it in the header row, but be sure the range argument includes the whole field range.



The Query Wizard — A better filter If you use Access or any other relational database program, you probably already know what queries are. A query is like a better filter. When you use a filter, you can select specific records (rows), but you get every field (column) in the record. When you use a query, you can select not only specific records but also specific fields within those records. For example, in an expenses list with Date, Vendor, Category, and Amount fields, we can extract specific records and include only the Date and Amount fields. Furthermore, when you run a filter you are filtering a table in an open Excel workbook. Queries are the only way to extract data from a source that’s too large to be imported into a worksheet, or from a source that is closed (that’s right — you can extract data into a worksheet from a closed file). And you can run the same query for updated data repeatedly every day, every month — whatever schedule you need — without having to re-create the query. The Query Wizard in Excel helps you to pinpoint exactly the data you want to extract; you can use the wizard to extract data from Excel lists, Access database tables and queries, and other database program files. The procedures for querying all these file types is similar; once you know how to query an Excel list, you are able to query other database files just as easily. And you can also query Web pages, which is covered later in this chapter.



Prepare to run a query Before you run a query on an Excel table, name the range of data you’re querying so that the wizard can find the data more easily. Then save and close the workbook that has the data.
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The first time you run a query, it’s a two-part process. First, you define a data source (tell Query Wizard where to look for the data), and then you run the Query Wizard and indicate exactly what data to extract from the data source. After you define the data source, the Query Wizard remembers the data source, and you don’t need to redefine it the next time you want to extract information from that data source. All you do is run the Query Wizard each time you want to pull data from that source.



Define the data source The procedure for defining a data source is similar whether the data source is an Excel workbook, an Access database, or another type of database file. 1. Open the workbook in which you want to place the queried data. 2. Choose Data tab  From Other Sources  From Microsoft Query. 3. In the Choose Data Source dialog box (shown in Figure 8.10) on the Databases tab, double-click .



Figure 8.10. To create a new query, set up a new data source.



4. In the Create New Data Source dialog box (shown in Figure 8.11), in box 1, type a name for your data source (something you’ll recognize later; for example, March Vendors). In box 2, click the arrow and select Microsoft Excel Driver, and then click Connect. Inside Scoop



Inside Scoop After you define a database, the name you type in step 4 appears in the Databases tab list in the Choose Data Source dialog box. When you come back later to query this data source, select its name in the Databases tab in the Choose Data Source dialog box.
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Figure 8.11. Name the data source and choose the Excel driver.



5. In the ODBC Microsoft Excel Setup dialog box (shown in Figure 8.12), choose Excel 97-2000 (Query hasn’t been updated since Excel 2000) and click Select Workbook.



Figure 8.12. Choose the Excel version and click Select Workbook.



6. In the Select Workbook dialog box (shown in Figure 8.13), navigate to the workbook that contains your data source and double-click the workbook filename. The ODBC Microsoft Excel Setup dialog box from step 5 reappears and the workbook name and path appear in the Workbook line.



Figure 8.13. Choose the workbook file where the source data resides.
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7. Click OK in the ODBC Microsoft Excel Setup dialog box and in the Create New Data Source dialog box. The Choose Data Source dialog box reappears with your new data source name in the list. Your new data source is set up and ready to use any time you want to query it. At this point you can either click OK to close the Choose Data Source dialog box and come back to perform queries later, or you can continue setting up the query in the Query Wizard in the next section.



Run the Query Wizard After you define a data source, you can set up the actual query. If you’ve just finished defining the data source, the Choose Data Source dialog box is still open and you can start at step 2. If you defined the data source some time ago and want to set up a new query using that data source, begin with step 1. 1. Choose Data  From Other Source  From Microsoft Query. 2. In the Choose Data Source dialog box (shown in Figure 8.14), double-click your named data source.



Figure 8.14. Double-click your named data source to set up the query.



3. When the Query Wizard – Choose Columns dialog box appears (shown in Figure 8.15), named ranges in the data source (including the range you named before you defined the data source) are listed. Each named range has a small plus symbol (+) next to it; click the plus symbol to display the list of column headings in that range. The plus symbol changes to a minus symbol (–) after it has been clicked.
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Figure 8.15. Choose the column of data that you want to add to your query.



4. Double-click each column you want to include in the query, and then click Next. Double-clicked columns move to the Columns in your query field. 5. In the Query Wizard – Filter Data dialog box, click a column name in the Column to filter list, and then set your filter criteria in the Include only rows where: section. Setting filter criteria here is the same as setting filter criteria for AutoFilter. (If you want all of the data from just a few columns, don’t set any criteria — just click Next.) 6. In the Query Wizard – Sort Order dialog box, you can choose a sort order for the extracted data, but you don’t have to. Click Next. 7. In the Query Wizard – Finish dialog box, you’re extracting data into an Excel worksheet, so leave the default option (Return data to Microsoft Office Excel) selected and click Finish. To save the query, click Save Query and give the query a recognizable name in the Save As dialog box. Don’t change the folder in the Save in box; save the query in the default Queries folder, which is deeply nested in your computer files so that Microsoft Query can find the saved query easily when you want to reuse it.
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Bright Idea If you’re planning on making a PivotTable with the extracted data, click the Create a PivotTable report link instead of OK. The PivotTable Wizard Step 3 of 3 appears, and you’re almost finished with the PivotTable. We cover PivotTables in Chapter 10.



8. After Query spins its wheels for a few seconds, an Import Data dialog box appears, asking where to paste the data. Click the cell where you want to paste the upper left corner of the extracted data (or click New Worksheet to create a new worksheet for the extracted data) and click OK. The data you filtered from the data source is pasted in the worksheet. When extracted data is pasted into a worksheet, you get a new toolbar along with the data. The External Data toolbar buttons are active when you click in the extracted range. The Refresh button refreshes the data in the selected query; the Refresh All button refreshes all the queries in the workbook. When data in the data source changes, all you need to do to update your extracted data is click in the extract range and click the Refresh button. For example, if you query the company database for information about your department employees once a month, all you need to do is refresh the data in the existing query.



Reuse a query If you want to periodically refresh the data in your query, use the Refresh button. But what if you want to run the same query in another workbook? If you saved the query, you can run the saved query without having to redefine the source data. To reuse a saved query, click a blank cell in the worksheet, and then choose Data  From Other Sources  From Microsoft Query. In the Choose Data Source dialog box, click the Queries tab. Click the name of the saved query you want to run, and click Open. The Query Wizard starts and you have the opportunity to refine your query fields and criteria; if you don’t want to make any changes, click Next all the way through the wizard steps and then click Finish in the last step.
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Querying other programs Microsoft Query can query most types of databases. If you have Access or any other Microsoft database programs installed on your system, you’ll find entries for those programs in the Choose Data Source dialog box. If, for example, you want to query an Access database, select MS Access Database on the Databases tab in the Choose Data Source dialog box, navigate to find the Access database (on your computer or on a network), and then create and run your query just like in Excel.



If you want to use this query in another computer or back it up, you can send a copy of the saved query file to wherever is convenient. Saved queries are files with the extension .dqy (in your Queries folder if you didn’t save the query in a different folder). Search your file system for the Queries folder or files named *.dqy to find the query file.



Delete a query Queries last forever. A query is really just a definition, a paragraph of instructions to Microsoft Query to “go to this data source and extract this data.” A query doesn’t take up enough computer memory to blink at; nevertheless, you might want to delete a query one day (perhaps you queried sensitive information and don’t want anyone else to have access to it). Deleting all the data in an extracted range doesn’t delete the query; when you click an empty cell that was a part of the extract range, the External Data toolbar buttons are active and you can bring all that queried data back again (and current) by clicking the Refresh button. Deleting all the rows or columns in which the query resides deletes the query in that worksheet, but if you save the query, it can be run again in any workbook. To delete a saved query, choose Data  From Other Sources  From Microsoft query. In the Choose Data Source dialog box, click the Queries tab. Click the name of the saved query and click Delete.
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Query a Web page The Web is chock full of information that is a great deal more useful once you get it into an Excel or Word file so you can analyze it. If all you want to do is save the information on a Web page one time, you don’t need to query it; on the Web page, drag to select just the information you want to extract and press Ctrl+C to copy it, and then click in an Excel or Word file and press Ctrl+V to paste. When you want to repeatedly pull data from a specific Web page, perhaps to update a stock portfolio, a Web query is quick and reusable (mostly). To create a Web query, get the address of the Web page. Excel won’t help you find the address, so open your browser, go to the Web page, and copy the entire URL out of the browser’s Address bar (paste it somewhere handy — we use Outlook Notes, but you can paste it in a worksheet, a Word document, or anywhere convenient). Open the worksheet where you want to place the queried data and choose Data  From Web. The New Web Query dialog box opens to your browser’s home page (shown in Figure 8.16). Copy the URL you pasted somewhere handy, paste it in the Address box at the top of the New Web Query dialog box, and then click Go (or press Enter).



Figure 8.16. The New Web Query dialog box opens to your browser’s home page.
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Watch Out! Your Web query will work the first time you set it up, but if the Web page address changes, the page structure changes, or the page requires you to log in, the query will break the next time you use it. There’s nothing you can do but re-create the query.



After the New Web Query dialog box opens to your chosen Web page, select the table you want to extract from the Web page. Web pages are laid out in tables (some more efficiently than others), and each table has a yellow arrow box at the upper-left corner. Click the arrow box for any table you want to extract (you can click as many as you like), and the yellow arrow box becomes a green check mark (see Figure 8.17). (If you change your mind about a selection, click the green check mark to deselect the table.) When you’ve selected all the tables you want, click Import. Just like in a normal query, the Import Data dialog box asks you where to place the query results. Click a cell in the worksheet and click OK. Wait a few seconds and the queried data appears in the worksheet. Don’t spend too much time formatting this data because much of your formatting is lost next time you query the Web page.



Figure 8.17. Click the arrow boxes for tables you want to extract.
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Just the facts ■



Sort a list by clicking in a cell in the sort column and clicking the Sort Ascending or Sort Descending button on the Standard toolbar.



■



Sort a list by multiple sort keys with the Sort buttons on the Standard toolbar, sorting from minor to major sort keys.



■



Sort according to a custom sort order by choosing Data  Sort.



■



Filter records with AutoFilter (choose Data  Filter).



■



Calculate filtered records with the SUBTOTAL function.



■



Create reusable queries to extract data from closed workbooks, large files, or other programs.



■



Create reusable queries to extract current data from a Web page without opening the Web page.
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hen you have a long list of data, such as a checkbook register or a list of products sold, sorting, filtering, and calculating the list is an important starting point, but you need to summarize the details to make the data useful. One rapid way to summarize a long list of data is to consolidate it into categories. Another is to subtotal it, which consolidates data into categories but retains the details that can be hidden or displayed. (PivotTables are the next rung up on the big-data-picture ladder, but are complex enough to deserve their own chapters. We address them in Chapters 10 and 11.) One of a computer’s most important functions is to help us make better decisions. The capability to calculate and summarize large quantities of data is sometimes not enough, and there are a few more tools with which Excel can help you make better decisions. If you have several different possible situations or scenarios, you should compare the results of different courses of action before moving ahead with one of them. Excel’s Scenario Manager can help you to compare those different scenarios. If you’re working on a problem and you know what result or solution you want, Excel can help you figure out what you need to do to get there. The Goal Seek and
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GET THE SCOOP ON... Consolidating a table ■ Subtotaling a table ■ Creating and comparing scenarios ■ Compare answers with data tables ■ Goal-seeking for simple answers ■ Answering complex questions with Solver
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Inside Scoop There’s no need to sort a table before consolidating it. Consolidation works like a mass SUMIF function; it finds and calculates all the data related to each category label, regardless of sort order.



Solver tools work problems “backward” to find input values that give the results you want.



Consolidating a table Consolidation has been an Excel tool for a long time, and it’s as useful now as it was in Excel 5 (which is to say, very useful — we use it every year to get our tax numbers ready for our accountant). Consolidation is quick and easy, and the results are a simple list of the data categories alongside the calculated data for each category. We’ve seen some folks create their own consolidation-type tables by writing a list of SUMIF formulas (summing data that matches each category), but a consolidation table gives the same result much more quickly, reliably, and reusably. To create a consolidation table 1. Select a destination area where the consolidated list will be pasted. The destination area can be on the same worksheet, a different worksheet, or in a different workbook. 2. At the top of the destination area, enter (better yet, copy and paste) the headings of the category and number columns that you want to consolidate; then select the destination area headings (but only the headings). 3. Choose Data  Data Consolidate. The Consolidate dialog box opens. 4. Select a function in the Function box (usually Sum), and then click in the Reference box and drag to select the range you want to consolidate (shown in Figure 9.1). After selecting the range, click Add to add the range to the All references box. To consolidate similar data from several different ranges, worksheets, and workbooks, add multiple references to the All references box. You can also type or paste range names, and you can include multiple number columns, as long as the column headings are identical. 5. Select the Top row and Left column check boxes, and then click OK.
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Watch Out! The reference range must have the category labels in the leftmost column and the column labels in the top row. Other data in the range doesn’t matter, but Excel looks for category labels in the left column and numbers in the columns whose headings match the consolidation table headings.



Figure 9.1. Setting up a consolidation range and destination area



Consolidation tables do not automatically update. When data changes in the raw-data table, select the consolidation table headings (just the headings), choose Data  Consolidate, make sure the reference range is correct, and click OK to reconsolidate. If any reference ranges are in closed workbooks, leave the workbooks closed (unless you need to check reference range validity). You don’t need to open the workbooks to rerun the consolidation. Watch Out! If the reference range changes, be sure you select the previous range in the All references list and delete it, and add the new reference range. If you don’t delete the previous reference range, the table consolidates twice.
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Subtotaling a table Subtotaling goes a step beyond consolidation, providing collapsible levels of detail along with category subtotals. Subtotaling can include several levels of category-label columns as well as number columns. Subtotaling happens within the data table rather than outside the table as in consolidation and PivotTables. Figure 9.2 shows the same orders list that we consolidated in the previous section, but this time the table was subtotaled. On the left side of the worksheet are outline buttons: The 1, 2, and 3 buttons at the top expand and collapse entire detail levels of the table, and the plus/minus buttons along the side expand and collapse individual categories.



Figure 9.2. Subtotaling preserves details within the subtotaled outline.



To subtotal a table 1. Arrange the table so the columns are logically organized, and sort the columns in order from minor to major sort keys (from right to left). 2. Click a cell in the table and click Data  Subtotals. 3. In the Subtotal dialog box (see Figure 9.3), in the At each change in box, select the major category to which you want to apply subtotals; select a function in the Use function box; in the Add subtotal to box, select check boxes for the number of columns you want to subtotal (and deselect all other check boxes); then click OK.
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Bright Idea If there are columns of data in the table that don’t need to be included in the subtotal results, hide those columns. They won’t be visible, but the data won’t be lost, either.



Figure 9.3. The Subtotal dialog box for the subtotaled table shown in the previous figure



If you have only one level of categories to subtotal, stop here; you’re done.



Outlining without subtotals Subtotaling creates a collapsible/expandable outline that is useful even without the calculated data; in fact, you can outline a table that has no calculable data at all. For example, you might have a table that lists company departments and the names and personal information of employees in each department. By outlining the table, you can expand and collapse individual departments, or you can outline just part of a table rather than the entire table. To outline a table, select adjacent rows that you want to combine into a collapsible/expandable level, and then choose Data  Group  Group. Continue selecting and grouping each set of rows that you want to outline. To remove manual outlining, expand and select a single group of rows from which you want to remove outlining, and then choose Data  Ungroup  Clear Outline.
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To apply more levels of subtotals: repeat steps 1 through 3, but be sure you deselect the Replace current subtotals check box before you click OK. If you get confused and need to start over, or if you just want to remove the subtotals and have your normal table back again, click in the table, choose Data  Subtotals, and click Remove All.



Scenarios Scenarios are a tool for setting up the same formulas with different input values so you can compare the results before making decisions. For example, scenarios are a good way to compare different loan possibilities. In a scenario, you can have as many different changing input values as you like (such as different rates, terms, and amounts for the same loan); the key to having organized scenarios to compare is to name them well so you can identify them easily. When you create scenarios, you create several different sets of values and results, but only one set appears on the worksheet at a time; you use the Scenario Manager dialog box to switch between the scenarios displayed on the worksheet. Although this in itself is neither efficient nor useful, the feature that makes scenarios worthwhile is the Scenario Summary report, which is a separate worksheet that shows all your scenarios side by side.



Create scenarios To use scenarios to compare answers, follow these steps: 1. Set up your first scenario on a worksheet. We’ll use the loan calculator, which uses the PMT function, as a simple example. 2. Choose Data  What-If Analysis drop-down box  Scenario Manager. In the Scenario Manager dialog box, click Add. 3. In the Add Scenario dialog box, type an easy-to-understand name for the scenario, and then delete any cell references in the Changing cells box, leaving the cursor blinking in it as shown in Figure 9.4. 4. On the worksheet, click, drag, or Ctrl+click to select all the cells in which you want to change values in different scenarios. For example, in the loan calculator (see Figure 9.5) we want to change the rate and the number of payments in these scenarios, so we click and drag to select both input cells, and then click OK.
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Figure 9.4. Setting up the first scenario



Figure 9.5. Select all the cells whose values you want to change for comparison in different scenarios.



5. In the Scenario Values dialog box (shown in Figure 9.6), enter a value for each changing cell in this scenario. You can change just one value or all values, depending on what you want to compare. 6. Click OK, and follow steps 2 through 5 to set up more scenarios.
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Figure 9.6. Enter values for the changing cells in this scenario.



Each scenario name appears in the Scenarios list in the Scenario Manager dialog box (shown in Figure 9.7). To display a particular scenario on the worksheet, click that name and click Show. If you’re done creating/viewing scenarios, click Close. When you return to the Scenario Manager, all the scenarios on this worksheet are available.



Figure 9.7. Available scenarios



Create a scenario summary Scenarios aren’t at all useful for comparison when you can only display one at a time, but when you create a summary you can compare all the scenarios side by side. If the Scenario Manager dialog box is not open, click the What-If Analysis menu on the Data tab and choose Scenario Manager.
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To create a scenario summary, click Summary in the Scenario Manager dialog box (see Figure 9.8). In the Scenario Summary dialog box (shown in Figure 9.9), leave the Scenario summary option button selected, and delete any cell reference in the Result cells dialog box. With the insertion point in the Result cells box, click the cell that contains the formula (in the loan calculator example, it would be the Payment formula cell), and then click OK.



Figure 9.8. Put the formula cell reference in the Result cells box.



A new Scenario Summary worksheet, like the one in Figure 9.9, appears in the workbook.



Figure 9.9. A scenario summary allows you to compare all the scenarios you create.
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Compare answers with data tables A data table is another useful way to compare answers by laying out formula results for many different values in one or two formula input cells. There are two kinds of data tables: A one-input data table returns results for many formulas but can only calculate those results for one changing input value. A two-input data table returns results for only one formula but can use changing input values in two of the formula’s input values.



One-input data table A typical use for a one-input data table is a loan table that compares payments for different interest rates (see Figure 9.10). In this example, the data table calculates the same formulas as a loan calculator using the PMT function, but the loan calculator calculates just one result while the data table calculates several results for comparison. (You find the PMT function used in a loan calculator in Chapter 5.)



Figure 9.10. This data table calculates results for three different formulas based on one changing input value, the interest rate.



To build a table like the one shown in Figure 9.10, follow these steps: 1. Enter starting argument values in input cells for the formula, as shown in Figure 9.11. A data-table formula needs cell references for argument values. Inside Scoop



Inside Scoop Data tables are more limited than Scenario Manager, which can calculate and compare scenarios with many changing input values, but data tables take less time to set up and display results more concisely.
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Starting argument value



Input cell reference



Formulas Input cell reference



Figure 9.11. Building the one-input data table in Figure 9.11, steps 1 through 5



2. In the leftmost column of the one-input data table, enter the formulas that return the results. This data table uses the formulas already set up in a PMT-function loan calculator (the PMT function is covered in Chapter 5), and those formulas reference the cells with starting argument values from step 1. 3. Enter the changing input values in the row along the top of the data table. 4. Select the entire table range to include all the column formulas and all the row input values (but not the row labels). 5. Choose Data  What-If Analysis  Data Table. In the Table dialog box, click in the Row input cell box and then click the single input cell (the Rate cell on which the formulas depend). 6. Click OK. The table calculates formula results for all the changing input values. Inside Scoop



Inside Scoop You can have as many formulas in the leftmost column as you like, as long as they all depend, directly or indirectly, on the same changing input value.
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Watch Out! A Data Table writes a set of array formulas that are, in reality, all one formula shared by several cells. You cannot change or delete part of an array formula (including deleting cells), but you can delete the entire table.



Two-input data table A two-input data table calculates formula results for each set of two changing input values. A typical example of a two-input data table is a loan table (see Figure 9.12) that compares payments for different interest rates and for different loan amounts at each of those interest rates. This example table uses the PMT function, the same as a loan calculator. (You find the PMT function used in a loan calculator in Chapter 5.) Changing rate values Argument input cells



Changing amount values



Figure 9.12. This two-input data table calculates results for one payment formula with two changing input values: the interest rate and the loan amount.



To build a two-input data table: 1. Enter starting argument values in input cells for the formula.



Bright Idea A useful twist on this two-input data table would compare total interest paid for varying interest rates and terms (number of payments) for the same loan amount.
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Hack The result cells are formatted General until you reformat them. If the results are currency, select the result cells and use the Currency Style button to format them quickly.



2. In the cell that will be the upper left corner of the data table, enter the formula; reference the input cells from step 1 for arguments. 3. Enter one set of changing values in the row next to the formula (in this example, the changing rates). 4. Enter the other set of changing values in the column below the formula (in this example, the changing loan amounts). 5. Select the entire table region, including the formula cell and the changing values cells, and then choose Data  What-If Analysis  Data Table. 6. In the Table dialog box, click in the Row input cell box and then click the input cell that the formula references (in this example, the Rate cell from step 1). 7. In the Table dialog box, click in the Column input cell and then click the input cell that the formula references (in this example, the Amount cell from step 1). 8. Click OK. The data table is created.



Goal seeking for simple answers The Goal Seek tool works problems “backward” to find a specific value that gives you the answer you want. For example, the PMT function gives you a payment for a specific loan amount; you know what payment you can afford but need to know how big a loan you can get for that payment. Goal Seek is an iterative tool: it uses iterations, repeated trials of potential input values, getting closer and closer to the input value that produces the result you want. You could do the same thing manually, but Goal Seek does it at lightning speed.



Goal Seek a simple problem We’ll demonstrate Goal Seek with the PMT function. First, enter your formula (in this example, a PMT formula) and its input arguments in a worksheet, as shown in Figure 9.13.
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Figure 9.13. Goal Seek finds the input values that give the result you want.



Fill in the input values that won’t change (in this example, the annual rate and number of monthly payments), and then choose Data  What-If Analysis  Goal Seek. In the Goal Seek dialog box, set the formula result equal to a specific value by changing an input cell. For this example, delete the value in the Set cell box and then click the cell that contains the formula (in this example, the Monthly Payment cell). In the To value box, type the value you want for a formula result. Click in the By changing cell box, and then click the input cell that will change to give you the formula result you want (in this example, the Loan Amount cell). Then click OK and wait a fraction of a second. The result is displayed in the worksheet cells and in a Goal Seek Status message, shown in Figure 9.14. To keep the new values in the worksheet, click OK in the message. If you want to run Goal Seek again with different numbers, click Cancel and start over.



Figure 9.14. A Goal Seek result



Goal Seek something more difficult Goal Seek can solve very difficult problems as long as there’s only one variable to change. For example, Goal Seek can help with that bane of
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high-school algebra, the quadratic equation (not to mention science and engineering problems). As an example, the quadratic equation Y = X3 + 7X + 25 is tough when you know what Y should be but need to find the value of X that gives you that Y result. To solve this particular equation with Goal Seek, decide on an X cell (the input value cell) and a Y cell (the result cell in which you write the formula). To illustrate this example, make cell A1 the X cell and cell A2 the Y cell. In the Y cell (A2), type the equation =A1^3 + 7*A1 + 25. In the Goal Seek dialog box: Set cell A2 (the Y cell), To value your desired value, By changing cell A1 (the X cell), as shown in Figure 9.15.



Figure 9.15. Goal seeking an answer to a complex problem



When you first write the formula in the Y cell you see an erroneous result based on the blank input in the X cell; after you run Goal Seek you have logical and correct numbers in both cells, as shown in Figure 9.16.



Figure 9.16. The quadratic solution
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Answering complex questions with Solver Like most Excel authors, we know how to use Solver; unlike most Excel authors, we admit that we never use it. We never have any reason to use it; most Excel users don’t. But some of you do have complex questions that Solver can help with, so we’ll give you an overview in using Solver. Like Goal Seek, Solver is an iterative tool: it uses iterations, repeated trials of potential input values, getting closer and closer to the input values that produce the results you want. Unlike Goal Seek, Solver can work with multiple changing cells and with rules and relationships between those cells. Solver finds solutions to more-complex problems, such as how to allocate limited raw materials for maximum factory production or balance an optimal investment portfolio. Solver is an add-in, which means it’s an accessory program that you have to install.



Install the Solver add-in If you don’t see the Solver command on the Data menu, you need to install it. To install the Solver add-in, choose the Office Button and click Excel Options. Click Add-Ins and in the Manage box, select Excel AddIns. In the Add-Ins Available box, select Solver Add-in, and click OK.



Solver terminology Before you use Solver, you need to understand a few terms: ■



Target cell: The target cell contains the value for which you want to find input solutions. It doesn’t have to be a specific number; it can also be as large or small a number as possible within the rules you set up for the Solver.



■



Changing cells: Changing cells contain the input values that solver adjusts to find the target value within your rules. You can have multiple changing cells.



Inside Scoop



Inside Scoop Solver is not a Microsoft product; it’s a third-party program created by Frontline Systems, which also sells higher-level versions of the Solver tool. You can find these tools as well as sample worksheets that use Solver for more complex problems at www.solver.com.
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■



Unchanging cells: These cells contain values that affect the solution but never change; they must depend in some way on the changing cell values or the target cell. You can set constraints on them just like changing cells.



■



Constraints: Constraints are rules that govern the possible solutions Solver can find, such as a maximum and minimum value for each changing cell.



A Solver example Solver must be taught by example; it’s too complex for a simple set of general steps. The example we use here is a very simple one: optimizing workshop production to maximize total profits. In this example, a workshop produces three products: nuts, bolts, and screws in case units, and it can produce a maximum of 300 units per day of any combination of products. Figure 9.17 shows a worksheet set up to show the profit potential for each item at maximum production for that item.



These cells must contain formulas



Figure 9.17. Profit potential for each item at maximum production for that item



Because screws have the greatest return, the workshop could produce nothing but screws for maximum profit. But there are constraints on production: ■



The workshop can produce only 300 units per day of anything.



■



There is an existing order of 70 units of nuts to be filled.



■



There is an upcoming order for 30 units of bolts.



■



The screws are a specialty item and the market is limited; market demand limits production to no more than 50 units.



The problem becomes how to allocate production capacity to the three products to meet the existing market and still maximize profits.
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The quick how-to on Solver is this: Set up a worksheet with values and formulas and logical formatting; choose Formulas  Solver; set the target cell; set the changing cells; add the constraints on the changing cells; and let Solver go to work. To follow this example: 1. Set up a worksheet as shown in Figure 9.18, and choose Tools  Solver. The Solver Parameters dialog box opens. 2. With the Set Target Cell box highlighted, click the target cell — in this example, cell E6, the Total Profit cell. In the Equal To options, select Max (to maximize the Total Profit value). 3. Click in the By Changing Cells box and drag (or Ctrl+click) the changing cells (the Units cells). 4. Set constraints for the problem, which are the production limit and the market limits for each product. In this example, the constraints are Total Production (the sum of all three products) = 300, Nuts >=70, Bolts >=30, and Screws 


Figure 9.18. The Solver dialog box set up to solve this problem
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To set a constraint, click Add; in the Cell Reference box, click a changing cell, and then set the constraints for that cell value, as shown in Figure 9.19.



Figure 9.19. Adding a constraint to a changing cell



5. When you’ve added all your constraints, click OK to return to the Solver Parameters dialog box. 6. Click Solve. Solver finds a solution to the problem (shown in Figure 9.20) and asks if you want to keep the solution or return to the original values. To store the Solver solution as a scenario, click Save Scenario in the Solver Results dialog box. The solution is stored in the worksheet just like any other scenario.



Figure 9.20. Solver’s solution
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Hack If you click Add after you set your last constraint, Solver expects another constraint and tells you that you’re not done. If you’ve already clicked Add, click Cancel to close the Add Constraint dialog box.



If Solver leaves a mess in the worksheet instead of a usable solution, select the Restore Original Values option. Try setting different constraints on the problem, and check your initial table formulas for accuracy. There are many more options in Solver that can help you find a better solution, especially with more complex problems. To work with Solver’s options, click Options in the Solver Solutions dialog box. Explaining the options in the Solver Options dialog box is beyond the scope of this book; if you want to delve more deeply into Solver, check out the Frontline Systems Web site at www.solver.com. Because Solver is so complex, you cannot always trust it to arrive at the best solution in just one try. Be sure you understand Solver very well before making any major decisions based on Solver solutions.



Just the facts ■



For fast subtotaling of data by category, use data consolidation.



■



To create a collapsible outline with subtotals by category, use subtotaling.



■



To compare different inputs and results for a problem, use scenarios and create a scenario summary for side-by-side comparison.



■



To create a comparison table for formula results in which a single argument or input value changes, use a one-input data table.



■



To create a comparison table for formula results in which two arguments or input values change, use a two-input data table.



■



To work a question backward and find the input value that produces the answer you want, use Goal Seek.



■



For complex problems with many changeable input values, try Solver.
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ivotTables are an interactive and flexible presentation of data. They allow you to pivot your data to analyze it from different angles, move categories around, change calculation functions easily, and show or hide details on the fly. In a PivotTable you can change the data layout merely by clicking and dragging items with your mouse, even during a video presentation to a room full of people. In this chapter we use a long expenses list to demonstrate creating and working with a PivotTable.



Using PivotTables When you summarize data with a PivotTable, you can ■



Summarize data from several sources such as Excel lists, external databases, multiple worksheets, and other PivotTables.



■



Pivot the table to change its orientation.



■



Group items in a field (for example, group dates into months or quarters).



■



Change the calculation for a field.



■



Show the details underlying a single summarized item.



■



Format the PivotTable for a professional and readerfriendly presentation. 223



Chapter 10



GET THE SCOOP ON... Creating and working with PivotTables ■ Rearranging PivotTable data calculations ■ PivotTable formatting
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Inside Scoop PivotTables are very maneuverable but also take a little more time to create. If all we need is a static list of summaries by category (for example, summarizing my business expenses for my accountant), we take the easy route and do a consolidation instead of a PivotTable (see Chapter 9).



PivotTable terms Table 10.1. summarizes some new terms that PivotTables use.



Table 10.1. PivotTable terms Term



Definition



Page field



A field that displays one item at a time.



Page field item



The item displayed by the page field.



Row field



A field with data displayed in rows.



Column field



A field with data displayed in columns.



Item



A specific row or column heading in a field.



Data area



The part of the PivotTable where data and calculations are displayed.



Field label



The label that identifies a row or column field; also called field heading and field button.



Outer field



When more than one field is displayed in the row or column area, the outermost field is the outer field; each outer-field item encompasses one or more inner-field items.



Inner field



When more than one field is displayed in the row or column area, the innermost field is the inner field; each inner field is grouped within an outer-field item.



Source data



The data from which the PivotTable is created.



Refresh data



To update the PivotTable with changed source data.



Creating a PivotTable PivotTables are easy to create, and Excel guides you through the processes of creating and editing a PivotTable when you want to make changes. First, decide what your source data is. If you want to create a PivotTable from external data such as an Access or other database, from multiple
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Bright Idea For a list of sample data to use while you get familiar with PivotTables, type sample data in the Office Excel Help window (in the upper right corner of the program window) and search Microsoft Office Online. Download one of the Excel sample files (some come with PivotTable worksheets already set up).



worksheets, or from another PivotTable, you can make that selection when you first create the PivotTable and follow the initially different wizard steps. Here, we give you the quick how-to for creating a PivotTable from a single worksheet list. To create a PivotTable from worksheet data, follow these steps: 1. Click in the worksheet table (the source data) from which you want to create a PivotTable, choose Insert  PivotTable, and click PivotTable from the drop-down menu options. 2. In the Create PivotTable dialog box, shown in Figure 10.1, choose the Select a table or range radio button.



Figure 10.1. Create a PivotTable.



Inside Scoop



Inside Scoop If you have an existing PivotTable and need to create another PivotTable from the same data source, it’s more memory efficient to create the second PivotTable from the first PivotTable; better yet, when you refresh the data in either PivotTable, both PivotTables are refreshed.
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3. Click in the Table/Range selection box and then click on your table area to select it. Your selection appears in the Create PivotTable dialog box, shown in Figure 10.2. Click in the selection box again to expand the Create PivotTable dialog box.



Figure 10.2. PivotTable



4. Choose where you want the PivotTable to be placed; you can use a new worksheet or just create it in the existing location. When you’re done, click OK. 5. The PivotTable is created and you see a PivotTable Field List dialog box that you can use to add fields to your report, shown in Figure 10.3. If the data is unusable, such as a Date field that lists hundreds of individual dates, you can fix that later by grouping those dates. In fact, your new PivotTable might look quite messy (as shown in Figure 10.4); in the next several sections we show you how to clean it up and change the layout, the calculations, and a number of other aspects. Bright Idea Name your data source range and type the range name in Step 2 of the wizard, in which you identify the data source range.
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Figure 10.3. Use the PivotTable Field List to adjust the fields that appear in your report.



Figure 10.4. The initial finished PivotTable probably needs adjustment.



Inside Scoop



Inside Scoop Fields in the Data area must be calculable fields for summarizing, although they don’t have to be numbers. If you drop a non-numeric field in the Data area, the PivotTable automatically counts the data instead of summing it.
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Create a dynamic source range You can use Excel’s new dynamic list to create a dynamic source range, or you can create your own dynamic source range using a named OFFSET/COUNTA formula, which is covered in Chapter 5. With a dynamic source range, the PivotTable data source automatically expands and contracts as you add or delete rows of data in the data source, so that when you refresh the PivotTable you get all the data in the source range regardless of how it may have changed size. Follow the procedure in Chapter 5 to create a named OFFSET/ COUNTA formula for your range, and then type that formula name (with no equal sign) in the Range box in Step 2 of the PivotTable Wizard. In fact, if your data source range begins in cell A1 (and you have no other entries in column A or row 1), the formula =OFFSET($A$1,0,0,COUNTA($A:$A),COUNTA($1:$1)) will work for you. Defining a dynamic range with a named OFFSET/COUNTA formula works well for charts and print areas, too, as does using a new dynamic list as a data source.



When you finish laying out the PivotTable, you can close the PivotTable Field List; you can easily open the list again from the PivotTable tab that now appears on the Ribbon when you need to rearrange the PivotTable.



Change the data source range When more rows or columns of data are added to the data source, the PivotTable doesn’t automatically update to include them. To change the data source range when data is added or deleted, click PivotTable Tools on the Ribbon and click Change Data Source in the Data Group. The same basic dialog box you saw when you first created the PivotTable appears. Inside Scoop



Inside Scoop If you make your data source into a new Excel dynamic list, the source range automatically expands and contracts.
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Refresh data Refresh is the PivotTable term for updating a PivotTable with current data. When data in the source data range changes, you must refresh the PivotTable to update. To refresh a PivotTable, on the PivotTable Tools tab, click the Refresh Data button (shown in Figure 10.5). All PivotTables and PivotCharts created from that data source are refreshed at the same time.



Figure 10.5. Click the Refresh Data button to update the data in the PivotTable.



Delete a PivotTable If you want to delete a PivotTable and start over again, click and drag to select the entire PivotTable, right-click it, and click Delete from the menu that appears.



The PivotTable Tools tab Table 10.2 explains the PivotTable Tools tab options. Many of the functional and useful buttons are also commands available on the shortcut menu when you right-click any cell in the PivotTable. The following table explores the groups found on the PivotTable Tools tab.



Table 10.2. PivotTable Tools tab buttons Group



Options



Purpose



Tools



PivotChart Formulas OLAP tools



Enables you to extend the usefulness of the PivotTable with formulas and OLAP tools



Show/Hide



Field List Expand or collapse buttons Show Field Headers



Enables you to show or hide fields within the table continued
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Table 10.2. continued Group



Options



Purpose



Group



Group Selection Ungroup Group Field



Enables you to group items within the able or ungroup when necessary



Sort



Sort newest to oldest Sort oldest to newest



Enables you to sort data within the table



Data



Refresh Change Data Source



Refreshes the table or changes source data



PivotTable Options



Clear Move PivotTable Change PivotTable name Configuration options



Clears the table, moves the table, changes the table name, or accesses additional configuration options



Active Field



Change date Expand Entire Field Change Field settings Collapse Entire Field



Enables you to manage the active field



Changing PivotTable arrangement As we mentioned previously, PivotTables can be very messy when you first create them, but they’re also very fixable. We show you how to easily make the most common fixes in disorganized PivotTables in the following sections.



Pivot the table You pivot a PivotTable by dragging gray field buttons to new locations, as shown in Figure 10.6. If you drag a field button and don’t like the results, press Ctrl+Z to undo the move. If you inadvertently drag a field button out of the table and lose it, you can easily add it back as explained in the next section. Hack If dragging fields in the worksheet PivotTable gets too confusing, it’s easier to use the Layout dialog box. Right-click in the PivotTable and click Move. You can then move the desired field to the location of your choice.
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Figure 10.6. Pivot the layout by dragging field buttons.



Add fields To add a field to the PivotTable, right-click in the PivotTable and click Show Field List from the menu that appears. Drag field names from the PivotTable Field List dialog box to the PivotTable and drop them in the appropriate areas, as shown in Figure 10.7. Close the PivotTable Field List dialog box when you’re done. If you add another field to an area that already contains a field, you create an inner and outer field in that area. You can have several inner fields in a single area. If you want to swap the positions of an inner field and an outer field, all you need to do is drag one field button to the opposite side of the other field button. In Figure 10.8, the outer field, Q3, has been moved to a different position.
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Figure 10.7. Adding a field to the PivotTable



Figure 10.8. Switch positions from inner field to outer field.
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Remove fields To remove a field from a PivotTable, drag its gray field button out of the PivotTable and drop it on the worksheet. This deletes the field.



Show and hide inner-field details The big advantage of an inner field is that you can show or hide innerfield details for a specific outer-field item. For example, in Figure 10.10, you can see that we have collapsed all of the blank fields. To show inner-field details for a specific outer-field item, double-click the outer-field item. To hide the details again, double-click the outerfield item again. For example, in Figure 10.9, the blank inner field data has all been collapsed.



Figure 10.9. Show and hide inner-field items.



To hide or show all inner-field details for an outer field, click the outer-field button, and then click the Show or Hide buttons button on the PivotTable Tools tab (see Figure 10.10).
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Figure 10.10. Show or hide all inner-field details.



Show and hide specific details To hide a specific detail in a field, click the drop-down arrow on the right side of the field button to open a list of the field items (shown in Figure 10.11). Deselect the check boxes for any items you want to hide, or select the check boxes for any hidden items you want to show, and then click OK. Hidden details are not included in the PivotTable totals.



Group items in a field When you include a date field in a PivotTable, you are likely to get a listing of every individual date in the data source, which is not at all useful. To make the date data useful, group it into months, quarters, or years. Not every field can be grouped; if the data in a field cannot be grouped, a message to that effect appears. Right-click any cell in the field that you want to group, or select the desired cell and click the Group Selection on the PivotTable Tools tab, shown in Figure 10.12. If you are grouping details in a Date field, Excel offers several likely date groupings; select one and click OK.
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Figure 10.11. Choose a specific detail to hide in a field.



Figure 10.12. Grouping dates — the shortcut menu and the results



To ungroup items in a field, right-click a grouped item and click Ungroup, or use the Ungroup button on the PivotTable Tools tab. Hack When you select a grouping, deselect any other groupings or you get additional layers of groupings for the same field (although you might find it useful to have data grouped by quarter and by month within quarter, which you can have by selecting both Month and Quarter).
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Create page fields Another way to make a PivotTable more useful is to put a field in the Page area. The Page area makes the PivotTable show data for just one item in the Page area field at a time. For example, if we have a field of Vendors in an expenses list and the Vendors field is in the Page area, we can show PivotTable data for just one Vendor at a time. To create a Page field, drag a field button into the Page area. If you drag the field button above the PivotTable, a rectangular hatched border appears around the Page area; drop the field when you see the hatched rectangle, as shown in the Qtr 1 field in Figure 10.13. Initially the Page field displays all field items; to limit the data displayed in the PivotTable to just one Page field item, click the drop-down arrow in the cell next to the Page field button and click the item you want to display, as shown in Figure 10.14.



Figure 10.13. Drag a field button into the Page area.



Figure 10.14. Select a desired item to display.
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Create separate pages When you have a Page field in a PivotTable, you can separate the PivotTable data into separate “pages,” or worksheets, for each item in the Page field. For example, if we have a Page field for Vendors in an expenses list, we can create a separate PivotTable for each vendor in the source data, and each PivotTable is on its own worksheet. To create separate pages, on the PivotTable Tools tab click Options in the PivotTable Options group and click Show Pages from the menu that appears, shown in Figure 10.15. In the Show Pages dialog box, click OK.



Figure 10.15. Show Pages option



Changing PivotTable calculations Although SUM is the most common PivotTable calculation, you can change the data calculation in the Data area to any of several other functions, including AVERAGE, MIN, MAX, and COUNT. To change the calculation function for a field, right-click a data cell for which you want to change the function, and click Field Settings from the menu (it may also read Value Field Settings depending on what field you’re in). The PivotTable Field dialog box appears. In the functions list, shown in Figure 10.16, double-click the new function with which you want to calculate. The name of the field button, which was probably Sum, changes to the calculation and the field name. The numbers aren’t formatted, however; see the section “Formatting numbers” later in this chapter to learn more about formatting the numbers.
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Figure 10.16. Change the calculation function for a field.



You can add a second calculation to the Data area by adding the same field to the Data area a second time and changing the calculation. For example, you can show a Sum of data and an Average of data, side by side or one on top of the other. To display multiple calculations, drag the data field you want to calculate into the Data area a second time, and change the calculation for the second field.



Get a better view For a better view of the PivotTable and the calculated fields in the Data area, right-click in the PivotTable and click PivotTable Options. The options dialog box is the original (and often easier, we think) way to lay out a PivotTable and change calculations in Data area fields. To pivot a PivotTable in the Layout dialog box, click and drag the field buttons from one area into another, drag them out of the PivotTable layout, or drag new fields from the right side of the dialog box into the layout. Dragging a data field into the Data area multiple times for different calculations is easier to see in the Layout view. To change calculations in a data field, double-click the field button in the Data area and make your changes in the PivotTable Field dialog box. This is the same PivotTable Field dialog box you’ve seen before. To format the numbers for the data field, click Number.
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Hack If you can’t drill down for details, someone has been messing with the PivotTable options. To re-enable drilldown, right-click in the PivotTable and click Table Options to open the PivotTable Options dialog box. In the PivotTable Data options section on the Data tab, select the Enable Expand to Detail check box and click OK.



Showing underlying details You can display the raw data underlying any PivotTable data detail by drilling down for the source data. When you “drill down,” you’re able to look at the actual data instead of the result of the data. To drill down for source data, double-click a calculated data cell. A new worksheet is created that shows the raw data underlying the cell you double-clicked.



Formatting numbers PivotTables need formatting just like any other data table. You can format the table as you would any table in Excel, but more importantly, you’ll likely need to format numbers. To format the numbers in a single field, right-click a number cell and click Format Cells. (Formatting field numbers is exactly like formatting number values in cells — see Chapter 7.) You can also select specific cells (or all the cells in a field or in the table) and format them using the buttons on the Formatting toolbar. For example, if you want to add or remove decimal places to a set of currency numbers, it’s fastest to select the number of cells and click Increase Decimal or Decrease Decimal. When you format a cell, it retains that format even when you pivot the table.



Bright Idea To preserve PivotTable results permanently, freeze the table so the layout and values can’t be altered. Copy the entire PivotTable and paste values to another worksheet.



Just the facts ■



To create a PivotTable, click in a data source table and then choose Insert  PivotTable and PivotChart Report.



■



To change the data source, use the PivotTable Tools tab.
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■



Refresh PivotTable data by clicking the Refresh button on the PivotTable Tools tab.



■



Pivot the PivotTable by dragging field buttons to new locations.



■



Add fields by dragging them from the Show Field List dialog box onto the PivotTable.



■



Remove fields by dragging field buttons away from the PivotTable.



■



To group items in a field, right-click a cell in the field, point to Group and Show Detail, click Group, and select a group type.



■



Create Page fields by dragging a field button into the Page area.
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ivotCharts are a graphical representation of the data in a PivotTable. You can either create a PivotChart from an existing PivotTable or you can create a PivotTable specifically for a PivotChart. You have a couple of options when working with PivotCharts: ■



You can create a PivotChart directly from the underlying data without first creating a PivotTable (both are created at the same time).



■



You can create a PivotChart from a PivotTable you’ve already created.



■



You can create a normal chart from PivotTable data, but not directly.



If you create a PivotChart from an existing PivotTable (which is what most folks do), the PivotChart mirrors the PivotTable; any changes you make in the PivotTable, such as sorting, adding/deleting fields, changing calculations, and so on, are automatically updated to the PivotChart, and some changes you make in a PivotChart, such as removing a field, are automatically updated to the PivotTable.
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PivotCharts versus normal charts PivotCharts and normal charts are similar in many ways, but different in little ways that can be annoying if you are not expecting them. For example, some things you can do in normal charts that you can’t do in PivotCharts are ■



Move and resize chart titles.



■



Move and resize the plot area by dragging.



■



Change values by resizing a data marker.



■



Reposition the legend by dragging.



■



Move the PivotChart to a different workbook from the workbook of the linked PivotTable (the chart becomes a static picture chart, unlinked to source data).



PivotCharts use the same terminology that you find in PivotTables: row, column, page, and data fields. They also use standard chart terminology: value and category axes, data markers, legends, and so on. PivotCharts are a combination of a PivotTable and a normal chart, and are quite useful if you don’t have your heart set on resizing or repositioning chart elements.



Creating PivotCharts PivotCharts are quick to create from a PivotTable and just a little more work to create directly from source data.



Create a PivotChart from a PivotTable Creating a PivotChart from a PivotTable couldn’t be simpler: On the PivotTablet Tools tab on the Ribbon, simply click the PivotChart button. The Create Chart dialog box appears, shown in Figure 11.1, where you can choose the desired chart type and click OK. Inside Scoop



Inside Scoop You can create a normal chart from PivotTable data, which is usually a better idea than creating it directly from detailed source data.
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Figure 11.1. Choose the desired chart type in the Create Chart dialog box.



When the chart appears, you also see the PivotChart Filter Pane. Click the Axis and Legend fields drop-down arrows to determine which items to filter off the chart (see Figure 11.2). For example, you must hide the PivotChart field buttons to make the chart look normal (as discussed in the next section). The PivotChart has the same data layout as the PivotTable from which it was created, so if you know that you will be making a PivotChart from your PivotTable, it is a good idea to make your PivotTable layout as simple as possible to create the best possible chart.



Figure 11.2. The PivotChart and PivotChart Filter Pane
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Create a PivotChart from source data Creating a PivotChart directly from source data, without first creating the PivotTable, is essentially the same process as creating a PivotTable (which is explained in Chapter 10): 1. Click in the source data table. 2. Choose Insert  PivotTable  PivotChart. 3. In the Create PivotTable with PivotChart dialog box, shown in Figure 11.3, select the table or range that you want to use (source data). 4. Choose if you want the data in a new worksheet or existing worksheet and click OK.



Figure 11.3. Choose the desired source data.



You get a new worksheet and a new chart sheet, both containing empty Pivot layouts. Whether you add fields to the PivotChart or to the PivotTable, both respond to your changes identically. Don’t set up the data in the PivotChart (it’s difficult to set up what you want). Instead, use the PivotTable and set up your data there (arrange fields, group, sort, set calculation functions, format data fields, and so on). Then look at the PivotChart. The PivotChart reflects the changes you have made to the PivotTable. Hack Don’t include more than one row or column field and one data field in the PivotTable for a PivotChart; although it’s easy to visually follow a combination of row and column fields (and inner and outer fields) in a PivotTable, too many fields make a very confusing and unreadable chart.
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Create a normal chart from PivotTable data You can always create a normal chart from a data source range, but in the usual detailed list you have hundreds of rows of data and hundreds of corresponding entries in the chart, which is completely unusable. If we create a normal chart from a long list of data, we don’t often bother with a PivotTable; we consolidate the detailed list first (see Chapter 9) and chart the consolidated list. That way, only the summarized data we want to chart is in the chart’s source data range. But if we want more maneuverability in the data source than we can get with a consolidation, we create a PivotTable first and pivot the data into the arrangement we want to chart. Then we copy the entire PivotTable and paste values (either in place or in another location), click in the new static table, and choose a chart option on the Insert tab to create a normal chart (see Chapter 12).



Rearranging PivotCharts Because a PivotChart is a graphical representation of a PivotTable, the layout looks somewhat familiar — it’s a hybrid of PivotTable and chart. Here are a few things you can do to rearrange a PivotChart: ■



Change a calculation function. Open the PivotTable Field List on the PivotTable Tools tab and change the calculation in the PivotTable Field dialog box.



■



Hide or show items on the Category axis. Click the arrow on the axis field button and select or deselect check boxes to show or hide items.



■



Remove a field. Drag the field button out of the chart.



■



Add a field. Select additional fields using the PivotTable Field List.



■



Sort the chart data (for example, sort the values from highest to lowest). Switch to the PivotTable and sort the column in the PivotTable — the data is sorted in the PivotChart to match the PivotTable. Watch Out! Don’t start dragging field buttons around at random; a PivotChart is not as maneuverable as a PivotTable, and if you break it you have to rebuild the linked PivotTable. It’s easier just to rearrange fields in the PivotTable than to pivot the PivotChart.
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Formatting PivotCharts Formatting PivotCharts is just like formatting regular charts. Most important in formatting a PivotChart is hiding the PivotChart buttons. When you hide the PivotChart buttons you hide the field buttons and the empty PivotChart areas, and the PivotChart looks like a normal chart (see Figure 11.4). The PivotChart is not pivotable when the field buttons are hidden, but it still responds to all changes you make in its source PivotTable.



Figure 11.4. Hide the field buttons to make the PivotChart look like a normal chart.



Embedding a PivotChart on a worksheet It’s very convenient to have a chart on the same worksheet as the source table, and you can put a PivotChart on a worksheet just like you can put a normal chart on a worksheet (see Figure 11.5). The only difference is you have to move the PivotChart to the worksheet after you create it, instead of creating it on the worksheet to begin with like you can with a normal chart. To embed a PivotChart (make it a floating object) on a worksheet, right-click anywhere in the PivotChart and click Move Chart on the menu, or click the Move Chart button in the Location group on the PivotChart Tools Design tab. In the Move Chart dialog box, shown in Figure 11.6, choose the desired location. As you can see, we have selected the Source Data as the target location.
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Figure 11.5. An embedded PivotChart, and a copy of the embedded PivotChart with field buttons and legend hidden



Figure 11.6. Embed a PivotChart on a worksheet by changing its location.



An embedded PivotChart works just like an other PivotChart you create, but it also works like a normal embedded chart in that you can move it by dragging it and resize it by dragging border handles. An embedded PivotChart is so much smaller than a full-sheet PivotChart (because it is resting within another PivotChart) that you’ll want to hide the field buttons and the legend. To hide the field buttons and legend, access the PivotChart Tools Layout toolbar, and then in the Labels group, choose Legend and select None.
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Just the facts ■



Create a PivotChart by creating a PivotTable and then clicking the PivotChart option on the PivotTable Tools tab.



■



Create a PivotChart by choosing the desired options from the PivotTable dialog box.



■



Change calculation function and hide/show item details using the same techniques as in PivotTables.



■



Make most PivotChart changes more easily by making the changes in the linked PivotTable.



■



Hide the buttons and areas in an embedded PivotChart as needed.



■



Embed a PivotChart on a worksheet by right-clicking the PivotChart, clicking Move Chart, and selecting a desired location.
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harts present data visually, which makes the trends in data much easier to grasp. When you want your audience to quickly understand what the numbers are telling them, present the numbers with a chart; when you want to find the trends in your own data quickly and clearly, chart the data. This chapter is about normal charts, not PivotCharts (see Chapter 10). Normal charts are more formatable and easier to work with than PivotCharts (you can create a normal chart from a PivotTable summary of data by freezing the PivotTable to create a static table before you chart it — see Chapter 11). Charts exist as either chart sheets, separate sheets in a workbook that contain nothing but the chart, or embedded charts, charts that float on top of a worksheet and can be moved, resized, and displayed alongside the data. A chart can be initially created as either a chart sheet or an embedded chart, and can be relocated to switch between chart sheet and embedded chart after creation.



Creating a chart Charts are easy to create. You can create them instantly (and then make changes to them after they’re finished), or you can use the Chart Wizard to make the changes you need as you create the chart. 251



Chapter 12



GET THE SCOOP ON... Creating a chart ■ The Chart toolbar ■ Types of charts ■ Changing the chart type ■ Changing chart data ■ Changing chart orientation ■ Moving and resizing an embedded chart ■ Changing the chart location
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Create an instant chart An instant chart is a default chart that Excel creates based on a logical interpretation of the data in your table. It’s great for charting data on the fly, when you need a fast, temporary picture of trends, or you’re rushing out to a meeting and don’t have time to create a more-polished chart. You have two options for creating an instant chart: ■



Click in the data table (or click and drag to select the chartable data), and press F11. Excel creates an instant chart sheet with a column chart type.



■



Click in the data table (or click and drag to select the chartable data), and choose a Chart type from the drop-down options that appear in the Charts category of the Insert tab. Excel creates an instant embedded chart of the type you selected in the Chart Type palette.



You can create and save a custom chart type, with all your own formatting, and set that chart as the default chart type. When you create an instant chart, the new chart will be your default custom chart type. See Chapter 13 for more on custom chart types.



Use the chart wizard The Insert tab provides you with a quick and easy way to peruse the different types of charts and apply a chart format to your data. To create a chart, follow these steps: 1. Click and drag to select the data to chart. ■



Select a rectangular range of data, including any row and column headers that you want to appear in the chart.



■



Ctrl+drag to select nonadjacent rows or columns for inclusion in the chart.



■



Don’t include grand totals in the data — they throw the scale out of balance and make the chart very difficult to read.



Inside Scoop



Inside Scoop Dragging to select the data for a chart is the only way to be sure that only chartable data is included in the chart, but you can also separate your data table (headers and data) from a chart title by inserting a very narrow row between the table and the chart title.
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Instead of selecting the data to chart, you can use a range name or a named OFFSET/COUNTA formula (see Chapter 5); type the range or formula name in the Data Range box in Step 2 of the Chart Wizard.



2. On the Insert tab of the Ribbon, click the drop-down menus to view the different kinds of charts. You can also click the Create chart button to view a dialog box of options (shown in Figure 12.1), click a chart type in the Templates list, and click a subtype in the Chart subtype boxes.



Figure 12.1. Choose a chart type and subtype.



3. Click OK to apply your selection. Your chart appears within Excel, a sample of which is shown in Figure 12.2.



Figure 12.2. A typical Excel chart
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The chart is created. Now comes the fun part: changing and formatting to make the chart really informational and professional or conform to a company standard. Changing the features is covered in the rest of this chapter; formatting the elements is covered in Chapter 13.



The Charts group Usually the Charts group appears automatically whenever a chart object is active (that is, when you click a chart object or select a chart sheet), and you’ll see it on the Insert tab of the Ribbon. The buttons on the Chart toolbar help you to make common changes quickly. You can choose a style, and then simply reapply a new style by making a different selection, as you can see in Figure 12.3. When you apply a chart, the Ribbon automatically jumps to the Design tab, where the chart styles are displayed. For example, if we apply a 3-D bar chart, the Design tab appears with different kinds of chart styles available. You also see a Chart Tools button above the Design tab that allows you to move to the Design tab, shown in Figure 12.4.



Figure 12.3. Use the Ribbon to quickly apply charts.
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Figure 12.4. The Design tab allows to you apply a style to your chart.



Note that you can click the expansion button on the Ribbon and see a listing of all of the available design options for the chart you have selected (Figure 12.5). Simply click an option to have it instantly applied to your chart.



Figure 12.5. Quickly view and select all of the design options for a particular chart.



Hack The Design tab does not appear on the Ribbon all of the time. It comes to life only when you have inserted something within Excel that can be formatted using different designs.
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Bright Idea For some data, a combination chart — combining different kinds of markers (such as line and column) — is helpful. To create a combination chart, rightclick a marker in the series you want to change, click Chart Type, click the type, and then click OK. If you don’t like the change, press Ctrl+Z to undo it.



Types of charts There are several types of charts, each of which is better suited for displaying a particular kind of data. For example, a column or bar chart is good for displaying several series in relation to each other; a pie chart is good for displaying proportions in a single series; and a line chart is good for displaying changes over time. Most important in selecting a chart type is that you and your audience can easily read and understand what that chart type displays. The key ideas to keep in mind when choosing a chart type are ■



What kind of data are you charting? Consider whether you are showing, for example, discrete comparisons between categories of data, changes over time, percentages of a whole, correlations between two numeric values, or three sets of values, which are most easily displayed in a three-dimensional format.



■



What kind of chart is your audience accustomed to seeing and interpreting? If you choose a chart type that your audience isn’t familiar with, the audience is less likely to understand the data you’re presenting.



Line and area charts (shown in Figures 12.6 and 12.7, respectively) are good for showing changes over time. Area charts are best used for a single series because in a two-series area chart, one series partially hides the other. Column, bar, cylinder, cone, and pyramid charts are all good for comparing discrete categories of data at a specific point in time (such as total sales in each department for the month of January). You can see an example of a 3-D bar chart in Figure 12.8.
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Figure 12.6. Line charts can show you changes over time.



Figure 12.7. Area charts can show you changes over time, especially in a single series.



Figure 12.8. Bar charts are good for comparing discrete categories of data.
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When you want to show how data breaks down into percentages of a total amount, the pie and doughnut charts and the 100% stacked-column chart do the job effectively (see Figure 12.9 for an example of a pie chart). The caveats are that the pie chart can show only a single series, and all of these charts have more impact if you limit each series to a halfdozen data points.



Figure 12.9. Pie chart



For keeping track of investment performance, there are several versions of the stock charts (shown in Figure 12.10) you see in financial reports. The important thing to remember about stock charts is that the data must be laid out in the table in the same order as the name of the chart. For example, the data for a Smith-Adams-Hooker-WestfieldKendrick chart must be presented in the data source table in this order: date, volume, open, high, low, close. Charts such as the radar, bubble, and surface (bubble chart shown in Figure 12.11) are used in scientific applications but are not much seen (or understood) by other audiences.
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Figure 12.10. Simple stock chart



Figure 12.11. Bubble chart



XY scatter charts (shown in Figure 12.12) are common in scientific applications in which two values are correlated, such as the heights and weights of individuals in a test population, and they are the appropriate chart type for trendlines, which are discussed in Chapter 13.
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Figure 12.12. XY scatter chart



Changing chart data Charts are linked to their data source ranges and update automatically when the source data changes. But when you add or delete rows or columns of data to the source range, the chart doesn’t update automatically (unless you use a new dynamic list or a named OFFSET/COUNTA formula as the data source range).



Add data to an embedded chart When you click an embedded chart, colored borders and handles appear around the chart data (as shown in Figure 12.13). Click and drag the handles to change the size of the source data range.



Figure 12.13. Chart data handles
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Add data to a chart sheet Right-click inside the chart and click Edit Data Source. Excel switches to the worksheet where the data range is located, puts a moving marquee around the data, and displays the Edit Data Source dialog box. On the worksheet, click and drag to select the entire new data range, and then click OK in the dialog box.



Change the source range To change the data range completely (in a chart sheet or an embedded chart), right-click the chart and click Edit Data Source Data. Click and drag the new range, and then click OK in the Edit Data Source dialog box (shown in Figure 12.14).



Figure 12.14. Change the source data completely by dragging a new source range.



Quickly changing chart layout If you didn’t choose the most usable chart layout, you can easily change it by simply selecting a different chart format, or you can adjust your current chart using the Design tab on the Ribbon. Notice on the Design tab Ribbon, shown in Figure 12.15, that you can easily change your chart type, the chart layout, or once again, make desired changes to the chart styles. This new ribbon format enables you to quickly make changes without wading through a bunch of menu or toolbar options.
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Figure 12.15. Change the chart orientation quickly.



Moving and resizing an embedded chart A newly created embedded chart is unlikely to be the right size or in the right position on the worksheet, but resizing and moving it is a snap.



Move an embedded chart To move a chart, click the chart near its perimeter so the chart area is selected (handles appear around the chart border, as shown in Figure 12.16), and drag the chart to a new location.



Figure 12.16. Click and drag near the perimeter to move a chart; drag a handle to resize a chart.



Bright Idea Make more room for the plot area by moving the legend to a horizontal display across the bottom of the chart: Right-click the chart and choose Format Legend from the context menu.
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Resize an embedded chart To resize a chart, click the chart near its perimeter so the chart area is selected (handles appear around the chart border), and then click and drag a handle to resize the chart. ■



Press and hold Shift while you drag a corner handle to retain the chart’s proportions while you resize it.



■



Press and hold Ctrl while you drag to resize a chart symmetrically (both sides or top and bottom move in or out equal distances).



■



Press and hold Alt while you drag any handle to “snap” the corner or border to worksheet gridlines.



Changing the chart location When you want to print a chart along with its source data, you want the chart — at least temporarily — on the worksheet with the data. When you want a large chart in which you can display lots of details, you want the chart on its own full-page chart sheet. To move a chart from being embedded on a worksheet to a chart sheet, or from a chart sheet to embedded on a worksheet, right-click the chart and click Move Chart from the menu that appears. Select the New sheet option or the Object in option, shown in Figure 12.17, and click OK.



Figure 12.17. Relocating an embedded chart to a chart sheet



If you’re relocating a chart onto a chart sheet, the default chart sheet name, Chartnumber, is in the Location dialog box. While the chart sheet name is highlighted, type a more intuitive name for the new chart sheet.
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Just the facts ■



Create an instant chart by pressing F11 or clicking the Chart Type button on the Chart toolbar.



■



Set chart features as part of the chart-creation process by using the Insert tab on the Ribbon.



■



Choose a chart type that’s appropriate for both the data you want to display and the audience to which you present it.



■



Change a chart type quickly with the Design button on the Ribbon.



■



Change a chart’s source data range by right-clicking the chart, choosing Edit Data Source, and dragging to select the new source data range.



■



Relocate a chart to a chart sheet or to a worksheet by right-clicking the chart, clicking Move Chart, and then selecting the new location.
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ike worksheets, charts can present data in a utilitarian manner, or you can format them to make them look professional, graphically striking, or silly, depending on your audience. The good news is Excel enables you to quickly and easily format your charts for reports, presentations, or in any other situations where you need to display your data in a graphical, yet aesthetic, way. In this chapter, you take a look at Excel’s formatting capabilities.



Chart formatting possibilities When you create a chart you get Excel’s default colors, fonts, and so on, and your chart looks like every other chart ever created in Excel, but after you create a chart, your options for changing the look of your chart are endless (see Figure 13.1). There are also many ways to make your data more meaningful, including changing the axis scale to focus on the range of values, adding a secondary axis to present series with very different ranges of values, adding data labels to place the actual values of each marker directly on the markers, and adding trendlines to display the validity of data correlation.
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Shadowed border on title



Free-floating text



Drawn arrow



Chart area gradient



Data labels



Picture markers



Figure 13.1. These are just a few of your formatting opportunities in Excel charts.



Formatting chart elements To keep your audience’s attention during a presentation, make your charts visually attractive with color, line, and font formatting. For a presentation involving several charts, give them a uniform and professional look by using the same formatting for all of them.



Select a chart element to format To select any chart element, such as a data series, an axis, the plot area, gridlines, the legend or an individual legend entry (called a key), click the element. Bright Idea After spending a lot of time formatting a chart, you can save and reuse the entire formatting package on any new (or old) chart by saving the formatting as a custom format — see the section at the end of this chapter.
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When the mouse is positioned over any element, the name of the element appears near the mouse pointer in a ScreenTip, as shown in Figure 13.2.



Figure 13.2. The Chart Objects ScreenTip shows the name of the selected element.



Here’s a quick way to grab small chart elements: Click any chart element and then use the arrow keys to move from element to element until the element you want is selected.



Format an element For quick fill color, font color, or font/font size changes for a selected element, right-click the selected element and use the formatting dialog box that appears (shown in Figure 13.3). Keep in mind that you can make global changes to the chart style at any time by choosing a different style option on the Chart Tools tab on the Ribbon, or you can switch to the Formatting tab on the Ribbon and make specific formatting changes, such as font, color, and so on.



Figure 13.3. Use a chart element’s Format dialog box for maximum formatting choices.
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Interpolate missing data points In a Line chart, missing data points are shown as breaks in the line (as shown in Figure 13.4). To show a continuous line through missing data points (interpolating the missing values), click the chart to select it, and then go to the Design tab and select Edit Data Source. Click on Hidden and Empty Cells in the lower left-hand corner. (This only works in a Line chart, not in a Line series in a combination chart.)



Figure 13.4. Missing data points in a Line chart can be filled in by interpolating the data.



Add titles You can add chart and label titles to your chart quickly and easily. Click any element in the chart and then click the Layout tab on the Ribbon. Use the Layout tab (shown in Figure 13.5) to select the desired label in the Labels group. In the text box that appears on your chart, simply click in the box to type your title. The text box that appears after you make your selection is fully formatable, movable, and resizable. See Chapter 14 for more about text boxes and other graphical objects. Hack If you want to interpolate a Line series in a combination chart, such as a combination Line/Column chart, first change the entire chart to a Line chart, interpolate the chart, and then switch the Column series back to Column type.
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Figure 13.5. Choose the desired label from the Labels group on the Layout tab.



Delete a chart element To delete a chart element, select the element and press Delete. If you change your mind after deleting the element, press Ctrl+Z to undo the deletion.



Changing axis scale Changing the axis scale, the range of data displayed on an axis, can persuade an audience to your point of view. Changing axis scale doesn’t alter the values at all, but it can magnify the differences between values. In Figure 13.6, the number of trees was counted in four different quadrants of land. Both charts use the same source data, but we changed the value axis scale in the chart on the right so it would persuade the audience that there is a large difference between Quad2 and the other quadrants.



21_045947 ch13.qxd



270



1/4/07



10:07 PM



PART V



Page 270



■



PRESENTING YOUR DATA



Different axis scales, same data



Figure 13.6. The chart with the narrower range on its value axis makes the value differences much more prominent.



To change the scale of the value axis, right-click the value axis and click Format Axis. In the Format Axis dialog box (shown in Figure 13.7), click the Fixed radio buttons for Minimum and Maximum and enter a different scale if desired, and then simply click Close. While you’re here, also take note of the many other formatting options available to you for the axis. This provides you with great formatting flexibility.



Figure 13.7. Changing the scale of the value axis
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Inside Scoop You can dramatically display values that fail to meet a minimum by setting the Category (X) axis Crosses at value to that minimum value. All values that fall below the value you set appear to be negative values. Their actual values are difficult to determine, but you can display their actual values with data labels.



Reordering the series When you create a chart, the data series are plotted in the order in which Excel finds them in the source data, but you’re not limited to that series order. You might want to rearrange the series order, especially if you create a 3-D chart in which a tall series in front can hide shorter markers behind it (as shown in Figure 13.8).



The Jamie series is partially hidden



Figure 13.8. Some of the data series in this 3-D chart hide other series.



To reorder the series in a chart, select the chart and click Edit Data Source in the lower left-hand corner. You can then move the items up or down in the Legend Entries (Series) box.
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Enlarging and exploding a pie chart Pie charts are great for showing how much of the total “pie” belongs to each data point, and if you make the pie larger and “explode” it by separating the slices (or by pulling out a single slice), you can call attention to individual items in your data.



Make the pie bigger To make the pie bigger, resize the legend to make more room for the pie, and then drag the plot area to make it larger. Click in the legend to select it, and then select a much smaller font on the Home tab on the Ribbon. The legend resizes smaller to accommodate the smaller font. Next, select the Plot area and drag a corner handle to make it larger. Move the resized plot to give it more room by dragging just inside the plot border. Figure 13.9 illustrates all these changes.



Figure 13.9. Making a pie bigger



Bright Idea Make even more room for the pie by removing the legend completely, and identify the slices by adding data labels to them. Remember, you can change the dimensions of the chart area, too, to make more room for a larger pie. See the section “Working with data labels” later in this chapter.
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Explode the pie To call attention to a specific data point in a pie chart, click and drag that slice out of the pie. You can also explode the entire pie by dragging all the slices away from the center. To drag a single slice away, click in the pie so the entire pie (the whole set of slices) is selected, click the slice you want to drag away so that only the one slice has handles, and then click and drag the slice away from the pie (see Figure 13.10). To return the slice to the pie, click and drag the slice back into the center of the pie.



Figure 13.10. Clicking and dragging a single slice away from the pie calls attention to that data point.



To explode the entire pie, click in the pie so the entire pie (the whole set of slices) is selected, and then drag any of the slices away from the center of the pie (shown in Figure 13.11). All the slices separate. To rejoin the slices, click any of the slices to select the whole set, and drag any of the selected slices back into the center of the pie (unless you click a second time to select a single slice, all the slices move at the same time).



21_045947 ch13.qxd



1/4/07



274



10:07 PM



PART V



Page 274



■



PRESENTING YOUR DATA



Figure 13.11. Click a slice one time to select the whole set, and then drag one slice to move them all away or back together.



Changing 3-D perspective A 3-D chart can be an effective way to get your point across (although usually 3-D charts are used just because they look fancy), but it can be difficult to see all the markers because they hide behind one another. To bring hidden markers into view, you can rotate a 3-D chart on all three axes. You can rotate it quickly (sometimes with uncontrollable and dreadful results) by clicking and dragging a corner of the plot area, or more carefully by opening a dialog box that gives you precise control of the rotation.



Rotate by dragging To rotate a 3-D chart by clicking and dragging, click a wall or the floor (handles appear on the corner points), shown in Figure 13.12. Drag a handle carefully and watch the skeleton view of the chart as you drag. If the rotation gets out of hand, press Ctrl+Z to undo the rotation and start over. Hack If you rotate a 3-D chart by clicking and dragging a corner of the plot area (a wall or floor corner point) and create a mess, the quickest way out is to rightclick a wall or the floor, click 3-D View, click Default, and click OK.
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Figure 13.12. Rotating a 3-D chart by dragging a handle



Rotate with precision To prevent your chart from quickly ending up upside down and inside out, use the 3-D View dialog box to rotate the chart more slowly and precisely. To rotate with the dialog box, right-click a wall or the floor of the chart and click 3-D View. In the Format Chart Area dialog box (see Figure 13.13), click the various axis buttons and watch what happens to the sample skeleton chart.



Figure 13.13. The 3-D View dialog box lets you rotate the chart slowly but with precision.
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Adding a trendline Trendlines are of real value and are commonly used in the scientific and statistical arenas to demonstrate the validity of data. They are essential in appropriate circumstances, but also widely misunderstood and misused outside of the scientific arena. The purpose of a trendline is to prove mathematically whether there is a true correlation — a trend — among a set of data points. For example, if you have data that compares miles per gallon used by a vehicle and miles per hour driven in that vehicle, a trendline can show whether there is truly a correlation between speed and gasoline consumption. Moreover, a valid trendline is predictive — if a trendline in this example is valid, you can predict gasoline consumption at any given speed by using the trendline calculation. The two charts in Figure 13.14 show similar data and trendlines. The upper chart has a valid trendline, which means the data points fit the line closely and the trendline can be used to predict gas consumption from speed. The lower chart has an invalid trendline, meaning the data points are too widely scattered to be correlated, and this data cannot be used to reliably predict gas consumption from speed. The R2 (R-squared) value tells you whether the data is correlated enough to be meaningful and useful — the closer the R-squared value is to 1, the more valid the data is. The best, and really the only appropriate type of chart for a trendline, is an XY Scatter chart like those in Figure 13.14. The data normally charted in a Scatter chart — two sets of numeric values — are the sort that a trendline is designed to analyze. A trendline is a visual representation of a regression analysis of the data points; a regression analysis is a mathematical measurement of how closely data points fit a perfect line or curve, and therefore how useful the data is in predicting unmeasured data. The R-squared value is the numerical result of the regression analysis equation (for this example, a linear regression).
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The truth about trendlines Too many books about Excel are written by authors who, although expert in Excel and in areas such as finance, really don’t understand what trendlines are for (and they write that you can use them to extrapolate sales or profits into the future, which is a foolish and dangerous way to make business decisions). We come from a hard-sciences background, and we’ve used trendlines quite a lot (not just in Excel, but in the laboratory environment), and we can tell you exactly what trendlines are designed for. They are the visual representation of specific mathematical equations that, with or without the graphical trendline, prove or disprove the correlation of data points. In appropriate circumstances — such as rate of radioactive decay or level of mineral concentrations in drinking water — they are appropriately used to extrapolate data into the future or outside the range of standardized calibration tests. For example, when water is tested for the concentration of a chemical, the testing equipment is first calibrated by testing standardized samples of chemical concentrations, and then charting the test results against the known standardized concentrations. The two sets of data — the test results and the known concentrations — are charted as an XY scatter chart, and a linear trendline and its R-squared value are calculated. The R-squared value tells us whether the data points are adequately correlated (whether the equipment is functioning properly and the standardization tests were run with precision) and whether the trendline is valid enough to determine the concentrations of the tested chemical in unknown water samples. Then the unknown samples are tested, and the trendline is used as a measuring stick to determine the chemical concentrations. In essence, you mark the test results on one axis of the XY chart, draw a line across the chart to the trendline, and then take a right turn at the trendline and draw a line to the other chart axis to find the concentration that corresponds to the test result. (In reality, the concentrations are determined mathematically in a computer program such as Excel, not with a printed chart and a pencil, but you get the idea.)
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Figure 13.14. Two charts with trendlines. The top chart is valid and the bottom chart is invalid.



Add a trendline to a chart To add a trendline to a series, right-click one of the data points and click Add Trendline. In the Format Trendline dialog box, as shown in Figure 13.15. Click the type of trendline that’s appropriate for your data (Exponential, Linear, Logarithmic, Polynomial, Power, or Moving Average), and select the Display equation on chart check box and the Display R-squared value on chart check box. Click Close, and the trendline appears on the chart, as shown in Figure 13.16.



Inside Scoop



Inside Scoop For explanations of the actual mathematical equations used by each type of trendline, search Excel’s online help files. Type trendline types in the Help box, press Enter, and then select the help topic About trendline types.
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Figure 13.15. Creating a trendline



Figure 13.16. The trendline appears.



If you present this data to others, it’s imperative that you include the equation and the R-squared value on the chart, because without them the trendline is meaningless. The equation measures the slope of the trendline (and shows your audience that you used the correct trendline
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type), and the R-squared value measures the closeness with which the set of data points adheres to the line. To include the equation, click the Display equation on chart option on the Format Trendline dialog box. An R-squared value of 1.0000 is a perfect correlation of the data. In most cases, an R-squared value must be at least 0.98 to be valid; each laboratory and procedure has its own strict limits for validity.



Format the trendline and text box The trendline is formatable: Right-click the trendline and click Format Trendline, and then change the line weight, style, or color in Line or Line Style. The text box with the equation and R-squared value is also formatable, as well as movable. Click in the text and drag the text box border to move it. The fastest way to format the text box is with the buttons on the Formatting toolbar.



Delete a trendline or text box To delete the trendline or text box, click the line or text box and press Delete.



Use a moving average in business data The one type of trendline that’s useful in business (nonscientific) data is the moving average, which smooths out fluctuations over time to give you a better overall picture of performance. Moving averages are particularly useful for tracking short-term trends in data such as stocks and futures prices, factory output, workplace-accident rates, and seasonal sales of specific items. A moving average can highlight regular, periodic increases or decreases in value so you can plan for the next increase or decrease.



Inside Scoop



Inside Scoop The moving average line doesn’t begin at the first data point; because it’s an average of a number of periods, it begins at the first point where there are that many periods (data points) to average. So if the periods’ value is 5, the moving average line begins at the fifth data point.
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Like a trendline, a moving average can only be applied to a single data series. In a High-Low-Close chart of stock prices, for example, you must select the data series (the high, low, or close price series) for the moving average. To add a moving average to a series, right-click a data point in the series and click Add Trendline; on the Format Trendline dialog box, click Moving Average. In the Period box, type the number of data points to average together for the data point on the moving average line (the higher the number of periods, the smoother the line). Then click OK. Figure 13.17 shows you an example.



Figure 13.17. This moving average for the High series has a two-day period.



Adding a secondary axis A secondary axis is ideal for comparing data that’s related but that is on two different scales. For example, suppose you’re in charge of a department store sales staff and your burning questions are: How are total sales related to the number of salespeople on the staff? Does adding salespeople result in more sales revenue? At what point does a larger sales staff result in only marginally larger sales revenues? You might find your answers by charting total revenue versus the number of salespeople for several months. But if total revenue is in excess of $10,000 and salespeople number between 10 and 20, how can
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you put both sets of numbers on the same chart? The sales force values are so much smaller than the revenue values that they’re off the scale and not visible in the chart. You need a secondary axis to show both sets of values. To add a secondary axis to a chart, you need to select the data series with values so small they’re hidden. Click the Format tab on the Ribbon. In the Current Selection group, click the drop-down menu to choose the chart element you want to apply the secondary axis to; then, click the Format Selection button in the Current Selection group. This opens the Format Data Series dialog box, where you can choose Series Options. Under Plot Series On, choose the Secondary Axis option and click Close. The two sets of values are shown on separate value axes (see Figure 13.18). Secondary series changed to Line type



Primary axis for Column series



Secondary axis for Line series



Figure 13.18. A secondary axis makes both sets of values visible and easy to compare.
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For a secondary axis, it’s best to use a combination chart, such as a Line and Column chart, so it’s obvious which set of markers belongs to which axis. To change the series chart type, right-click the secondary series and then select the new chart type from the Chart Type button on the Chart toolbar.



Working with data labels Data labels add value to a chart by positioning data labels or values right next to their markers in a chart, which can sometimes make a legend unnecessary. In Figure 13.19, the labels are formatted as pale yellow so they can be seen easily.



Figure 13.19. Without a legend, this pie chart has more room for display; these data labels are individually formatted for better visibility against the pie slice colors.



Data labels show text or values from the source data range, so if you make changes in the source data, the changes automatically appear in the data labels. You can add data labels to any chart type; they’re particularly useful in pie charts. Data labels can be moved, formatted, and deleted both individually and as a group. They are so formatable and maneuverable that I find them much more useful than a data table, which takes up too much room at the bottom of the chart.
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Add data labels To add data labels, select the desired series on the chart and click the Layout tab. You can add any kind of data label from the Labels group, including Data Labels, by clicking the appropriate button. Figure 13.20 shows an example of data labels that have been added.



Figure 13.20. Adding a data label to a single marker



Format data labels To format the entire set of data labels, right-click a data label and select the Format Data Labels dialog box. For simple, quick formatting, right-click the data labels you want to format and use the buttons on the Formatting dialog box that appears. If you want borders, however, you need to use the Format tab on the Ribbon. To format individual data labels, click a data label to select the set, and then click the single data label you want to format. Right-click the selected label and simply use the Formatting dialog box that appears. Hack If you format label text as white to show up on a dark data marker, you may get a black background in the label that you can’t remove. Instead, format the text a light color such as pale yellow or pale blue. The light text is easily readable against the dark series marker, but without the black label background.
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Delete data labels To delete the entire set of data labels, click a single data label to select the set and press Delete. To delete a single data label, click a single data label to select the set, click the label you want to delete, and press Delete.



Creating picture markers Picture markers can wake up a drowsy audience by adding a touch of whimsy to a chart. A good way to use picture markers is to call attention to a particular data point by turning that single data point into a picture marker. You can use any picture you want as a data marker: clip art, objects you’ve drawn in graphics programs such as Windows Paint, or even a company logo graphic (as shown in Figure 13.21). Remember that simple is better because the picture will be pulled out of proportion by the varying values.



Figure 13.21. You can create a simple picture in the worksheet and use that picture as a data marker.
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Bright Idea Even if you delete the graphical object from the worksheet, you can copy a graphical object picture marker from one data marker to another. Select the picture marker, press Ctrl+C, select the marker to which you want to copy the picture, and press Ctrl+V.



The fastest way to create and use a simple picture marker is to draw the marker picture in the worksheet, and then copy the drawn object, select the series (or a single marker in the series), and press Ctrl+V to paste the picture in place of the marker. (See Chapter 14 for more about drawing objects in Excel.) The fastest way to use graphics files such as clip art as picture markers is to use the Clip Art task pane to find a suitable figure and insert the symbol in your worksheet. Then copy the clip art picture, select the series (or a single marker in the series), and press Ctrl+V to paste the picture in place of the marker. You don’t need to keep the original picture in your worksheet after you create your picture marker(s). When you delete the original graphic image for your worksheet, the chart is unaffected. To use a graphics file such as a picture you draw in Windows Paint, you can insert it in your worksheet and follow the procedures already outlined for copying and pasting it onto a marker, or you can open the Format Data Series or Format Data Point dialog box, click the Fill selection, click Picture or texture fill (as shown in Figure 13.22), and then simply choose to insert your picture from file, Clipboard, or clip art. You can then choose any formatting options you want.



Saving and reusing your custom chart format When you put a lot of time into formatting all the elements of a chart (or if someone sends you a workbook containing a beautifully formatted chart that you want to use), you can save all that formatting work as a custom chart format; then you can apply that same painstaking formatting to new charts with just a couple of clicks.
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Figure 13.22. Inserting a file from your computer into a data marker



Save a custom chart format To save chart formatting as a custom chart template, select the chart and click the Design tab. In the Type group, click Save As Template. Choose a descriptive name for the template and click Save, shown in Figure 13.23.



Figure 13.23. Adding a custom chart type
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Apply a custom chart format To apply a custom chart format to a new chart as you build it, choose Other Chart types from the Charts group on the Insert tab. Click All Chart Types on the menu and then click Templates, choose your chart template, and click OK. To apply a custom chart type to an existing chart, right-click the chart area and click Change Chart Type. In the Change Chart Type dialog box (as shown in Figure 13.24), choose Templates, select your template, and click OK.



Figure 13.24. Applying a custom chart type to an existing chart



If the custom chart type is one you want to use all the time, click the Set as default chart button on the Change Chart Type dialog box.
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Just the facts ■



Format chart elements quickly by selecting an element, right-clicking it, and using the quick formatting dialog box options.



■



Create more elaborate formats by selecting an item and using formatting tools on the Ribbon.



■



Add free-floating titles, labels, and text by clicking in the chart, typing the text, and then repositioning the new text box.



■



Explode a pie chart by clicking in the pie to select all the slices, and then dragging a slice away from the center.



■



Drag a single slice away from a pie chart by selecting the series, and then click the single slice and drag that slice away from the pie.



■



Add a trendline or a moving average by right-clicking the series to which you want to add the trendline and clicking Add Trendline.



■



Add a secondary axis by double-clicking the second-axis series and clicking Secondary axis on the Axis tab.



■



Add data labels to a series by selecting the series and using the Layout tab to apply the data labels.



■



Save chart formatting to reuse by saving it as a custom chart template.
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xcel isn’t about art, but all worksheets look the same until you customize yours with graphics and formatting. Like other Office 2007 programs, Excel has extensive tools for drawing graphic objects. What’s more, graphic objects can be functional: You can assign a macro to a graphic object and run the macro by clicking the object. You can draw and insert objects in worksheets and in embedded charts and chart sheets.



Using the Shapes group The Shapes group, found on the Insert tab of the Ribbon, has all the buttons you need for creating graphic objects in a worksheet or chart, shown in Figure 14.1. If you hover over a button, you’ll see a text name telling you what kind of shape the button will make. Also, you can click the More button on the right side of the interface to see a blown-out collection of the all of the shapes available to you in Excel (Figure 14.2).



291
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GET THE SCOOP ON... Using the Shapes group ■ Drawing basic shapes ■ Formatting for all graphic objects ■ Creating AutoShapes ■ Drawing text boxes ■ Creating WordArt ■ Inserting pictures and clip art ■ Creating SmartArt ■ Pasting pictures of cells
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Figure 14.2. Expanded Shape options
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Drawing basic shapes Basic shapes are lines, arrows, ovals, and rectangles. They are often more effective than fancy AutoShapes (which I discuss later in the chapter) because they’re not as distracting and you can layer them on top of each other for unique graphic objects. To draw a basic shape, click the object button and either click on the worksheet (for default objects that you can move, resize, and rotate) or drag to draw the object in the worksheet (which you can also move, resize, and rotate). Figure 14.3 shows a variety of shapes you can draw.



Figure 14.3. Basic shapes



Here are some tips for drawing and formatting basic shapes: ■



To draw a perfectly vertical or horizontal line (or arrow), press and hold Shift while you draw the line (Shift forces the line into 15-degree angles).



■



To draw any object from the center out, press and hold Ctrl while you draw.



■



To draw a perfect square or circle, press and hold Shift while you draw a rectangle or oval.



■



Arrows are just lines with arrowheads; to convert an arrow to a line or a line to an arrow, select the line or arrow and choose a different style from the Arrow Style menu under Shape Outline in the Shape Styles group.



■



To change line or border weight (thickness), select the object and click a line weight from Shape Styles group.



■



To move an object, click it and drag it with the four-arrow Move pointer.



■



To resize or reshape an object, click it and drag a handle.



■



To draw several lines, arrows, ovals, or rectangles, double-click the shape button and draw lots of objects. Then, right-click the shape and select Lock Drawing Mode. Click the shape button again to turn it off.
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Inside Scoop If you want to select some objects but not other nearby objects, press and hold Shift while you click the specific objects you want to select.



To rotate an object, drag the top handle (Figure 14.4). If you don’t see a green handle, the object cannot be rotated. (To rotate a line or arrow, drag an end handle.)



Figure 14.4. Use the green handle to rotate a shape. ■



To copy a shape, press Ctrl while you drag and drop the object.



■



To assign a macro to an object, right-click the object, click Assign Macro, click the Macro name, and click OK.



Formatting for all graphic objects For the best display of any graphics in a worksheet, turn off the worksheet gridlines. To turn off gridlines, choose the Page Layout tab on the Ribbon and clear the View check box in the Sheet Options group.



Formatting objects All objects can be formatted quickly and simply with the Format tab on the Ribbon. The Format tab only appears when you have selected a shape object.
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On the Format tab, you can first make changes to the style with the Shape Styles group. Simply click a shape style option to apply it. You can click the More button to see more options, shown in Figure 14.5. Also on the Shape Styles group, you can click the Shape fill button to apply a color from a colors palette, choose a no fill option, or add a picture fill, gradient, or texture (Figure 14.6). Simply choose the option you want and click to apply it. If you click the Shape Outline, you see a similar drop-down option where you can choose a theme color, outline weight, or use dashes or arrows for the outline of the shape. On the Shape Effects button, you see a drop-down menu where you can access different kinds of shape effects, such as shadows, reflections, glow effects, and so on (Figure 14.7). Just click a shape effect to apply it.



Figure 14.5. Shape Styles options
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Figure 14.6. Fill options



In addition to the Shape Styles group on the Format tab, you can access other standard formatting options, such as WordArt, arrangement options, and size configuration. All of these features are self-explanatory. Watch Out! Be sure you click an embedded chart to select it before you draw or paste graphics in it. If you don’t, your graphics are drawn in a layer on top of the worksheet rather than in the chart, and won’t move, copy, or resize with the chart.
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Figure 14.7. Use Shape Effects to apply different kinds of shadows, reflections, and edges.



Align and distribute objects When you’ve got multiple identical objects that need perfect alignment or spacing, allow Excel to do the perfect alignment or spacing for you. Ctrl+click the objects to select them all, and then use the Arrangement group on the Format tab of the Ribbon.



Inside Scoop



Inside Scoop When you create worksheet and form controls (see Chapter 20), it’s especially important to align and distribute controls well for proper function and ease of use. All the graphic object procedures in this chapter also apply to worksheet and form controls.
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Bright Idea Move one object into the exact position for the alignment, and then drag all the other objects away from the alignment position (for example, to align left, drag all the objects a bit to the right of the object in the alignment position). Then Ctrl+click all the objects and align them — they’ll align to the leftmost object.



The Alignment commands align all the selected objects with the one selected object that is already furthest in that direction (for example, Align Left aligns all the objects with the leftmost of the selected objects, as shown in Figure 14.8).



Figure 14.8. Left-aligned and vertically distributed objects



The Distribute commands space the objects perfectly equidistant from one another.



Group objects When you carefully draw, layer, align, distribute, and stack several objects, it is very unpleasant to have your perfect arrangement inadvertently disturbed. To maintain the arrangement of several objects, Ctrl+click the objects to select them, and then click the Group button in
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the Arrangement group and click Group. This groups your objects together so that they function as one object. When a set of objects is grouped, the group moves, copies, and formats as a single object (see Figure 14.9).



Figure 14.9. The left group is grouped and selected; the right group is ungrouped and all the separate objects were selected.



If you need to make a change to any of the grouped objects, click the group and click Group  Ungroup. Click away from the group to deselect all the objects so you can work on individual objects.



Creating AutoShapes AutoShapes are prebuilt complex shapes such as banners and block arrows that you can select from a menu. After creating an AutoShape, you can move, resize, reshape, and format it just like any other object. To create an AutoShape, just select the desired shape from the Insert tab and draw as you would a normal shape. Figure 14.10 shows you an example of a 3-D arrow. Notice that you can adjust it with the green handle and add text if desired.



Figure 14.10. Most AutoShapes have a yellow diamond handle for reshaping and can carry text like a text box.
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To put text in a basic shape such as a rectangle or oval, create a text box on top of the basic shape. Rotate the text box using a green handle that appears. Remove the text box border and fill color, color the text to be visible against the color of the basic shape object, and group the text box and basic shape so they are a single unit.



Drawing text boxes Text boxes are free-floating text labels that you can use to add information to a worksheet or chart. They are fully formattable (colors, borders, fonts) and movable/resizable just like other graphic objects. To draw a text box, select the Drawing Object and then click the Text Box button on the Format tab of the Ribbon, and then either click in the worksheet and start typing (the text box expands to accommodate what you type) or drag to draw a box in the worksheet and then type your text. To format a text box, double-click the text box; a small formatting box appears with basic text-formatting options.



Creating WordArt WordArt is a powerful, memory-intensive graphic mini-program that creates shapes from your text. It creates arresting graphics like the one shown in Figure 14.11.



Figure 14.11. WordArt creates eye-catching graphic images.
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To create a WordArt graphic, follow these steps: 1. Select an object that you want to format, and then click the Insert WordArt button found in the WordArt group on the Format tab. 2. In the WordArt Gallery dialog box, click a graphic and click OK. 3. Type your text. Select a font and a size (and bold or italic, if you want them), and then click OK. The finished WordArt graphic appears in your worksheet. Move, resize, and rotate the object as you would any other graphic object.



Inserting pictures and clip art Logos and graphic images can make a worksheet more visually interesting. For example, you can place a logo in a workbook template to tie the company’s image together — every workbook created from the template has the logo in place — or place pictures of products in invoice worksheets. To paste a picture on a worksheet, click the cell where you want to paste the upper left corner of the picture (make sure you make room for the picture by adding more rows and/or columns, because it will lie on top of worksheet cells). Then choose Insert  Picture, or choose Clip Art (for clip art). If you select Clip Art, the Clip Art task pane opens (Figure 14.12). Search for the clip art you want, and double-click it. To organize clip art images that you use often so you can find them quickly, select an image and click the arrow that appears in the image; click Copy to Collection, and click OK in the Copy to Collection dialog box. The image is copied into the default My Collections dialog box. To find images, select My Collections in the Search In list in the Clip Art task pane. If you choose to insert a photo from your own files, the Insert Picture dialog box appears. Search for the file you want and double-click it. Bright Idea When you open the Clip Art task pane to search for clip art, make your search faster and more convenient by widening the task pane (point to the left border of the task pane and drag the two-headed pointer arrow).
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Figure 14.12. Clip Art task pane



When you click an inserted picture to select it, the Format/Picture Tools tab appears, shown in Figure 14.13.
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Figure 14.13. Format/Picture Tools tab



The Format/Picture Tools tab enables you to ■



Use Picture Tools: In the Picture Tools group, you can adjust the contrast or brightness, recolor a photo, compress pictures, change the picture, or reset it.



■



Adjust the Picture Styles: You can adjust the style, picture shape, and picture border, or use picture effects.



■



Arrange pictures, using standard arrangement options.



■



Edit pictures, including cropping and resizing.



Creating SmartArt Even though workbooks are primarily for number-crunching, they are also quite useful for sharing information of other kinds, such as the relationships or hierarchies of people, things, or procedures. For example, along with the production numbers for a factory, you can show a diagram of the processes involved in production or a hierarchy of the personnel in the department. Diagrams and organization charts are ideal for this kind of information, and these are the same diagrams and charts that you find in the other Office programs, such as Word and PowerPoint. They are the same as, but a lot easier than, drawing ovals, text boxes, and connecting lines and arrows. In Office 2007, organization charts and diagrams are called SmartArt, and you’ll find them much easier and faster to implement and use. To create a diagram or organization chart, click the SmartArt button on the Insert tab. In the Choose a SmartArt Graphic dialog box (Figure 14.14), click the type of diagram you want (if you’re not sure, click each type and read the description that appears) and click OK. Your selected diagram or chart appears on the worksheet (Figure 14.15).
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Figure 14.14. SmartArt Graphic options



Figure 14.15. The diagram or chart appears in your worksheet.



When the diagram is in place, type text in the text boxes provided. Like a chart, every element in a diagram or organization chart is separately formattable; double-click an element to open its Format dialog box.



Pasting pictures of cells Pasting pictures of cells is a useful feature we’ve used for years. For example, in a long list of data with a total at the bottom, we paste a picture of the total cell at the top of the list so we can see the total without scrolling down to find it. To take a picture of a cell (or a range or a chart) that you can paste elsewhere on a worksheet or in another worksheet, you need to use the



22_045947 ch14.qxd



1/4/07



10:08 PM



CHAPTER 14



■



Page 305



ADDING PICTURES AND GRAPHIC OBJECTS



305



Camera button. The Camera button does not appear on the Ribbon by default, but you can add it (along with many other commands discussed in Chapter 19) by accessing Excel Options. This adds the Camera button to the Quick Access toolbar, which is the very top toolbar where the Save, Undo, Redo, and Print icons appear.



Put the Camera button on a toolbar To put the Camera button on a toolbar, follow these steps: 1. Click Office  Excel Options. 2. In the Customization section, click Commands Not in the Ribbon from the Choose Commands From drop-down menu. 3. In the Commands list, scroll down to Camera (see Figure 14.16). 4. Select the Camera icon and click Add. 5. Click OK.



Figure 14.16. Drag the Camera icon from the dialog box to a toolbar.
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Take a picture To take a picture of a cell (or cells), select the cell(s), and then click the Camera button. Next, click where you want to paste the picture. A linked picture of the cell(s) is pasted, and any changes in the source cell(s) are automatically updated in the picture. The picture is a graphic object; it’s movable, resizable, and can be rotated. Unlike an object, however, when you double-click a picture the source range is selected. To take an updatable (linked) picture of a chart, you must take a picture of the cells behind the chart. Anything in or on the selected cells will be in the picture, and any changes you make in or on those pictured cells will be automatically reflected in the picture. To paste a picture of an unlinked chart, right-click the chart and click copy; right-click where you want to paste the unlinked picture and click Paste. The pasted chart is truly just a picture object, unlinked to data, and formattable with a double-click.



Just the facts ■



The Insert tab is the source of all graphic objects in Excel.



■



Use the buttons on the Format tab for simple formatting of fill color, font color, and line color.



■



Double-click an object for more formatting options for that particular type of object.



■



Use Insert tab buttons to create AutoShapes, text boxes, and WordArt.



■



Enhance objects with 3-D or shadow effects.



■



Insert pictures and clip art using the buttons on the Insert toolbar.



■



Use the SmartArt button on the Insert menu to insert diagrams and organizational charts.



■



Put the Camera button on a toolbar and use it to take linked pictures of cells that you can paste elsewhere in the worksheet or workbook.
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ven though lots of companies would like to run paperless offices, for now at least that’s a pipe dream. People still need printed data to mail out, pass around at company meetings, and file as backup to oftenfragile electronic data storage. Also, paper is more quickly accessible and easier to read (errors you don’t notice onscreen often seem to jump right out on paper). Therefore, the question is not whether you need to print your Excel data, but how to print exactly what you need, quickly and easily, without wasting a lot of paper trying to get it right. This chapter talks about how to print specifically what you want; the next chapter covers the details and finer points of formatting printed pages.



Previewing printed pages Always, always, always preview pages before you print them. It takes just a moment and can save you not just paper but time reprinting a report. To preview printed pages, click Office  Print  Print Preview. The pages on-screen appear just as they look when you send them to the printer (see Figure 15.1).
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Figure 15.1. Print Preview is the only way to be sure you print what you intend.



In Print Preview mode, the mouse becomes a magnifying glass on the page. Click anywhere on the page to zoom in for a closer view of that area; click again to zoom back out. If the printout consists of multiple pages, click the Next Page and Previous Page buttons in the toolbar to flip through the pages. If your mouse has a scroll wheel, you can probably flip through the pages in Print Preview by using the scroll wheel instead of clicking the Next and Previous buttons. In the Print window, be sure to select Entire Workbook if you want to switch between different tabbed pages. If the preview looks good, click the Print button on the toolbar to print the worksheet. Bright Idea To quickly see how many pages will be printed, look at the lower left corner of the screen. If the number seems high, it’s especially important to flip through the pages and see if you have extra pages that are printing; for example, a page might contain just one column that should be fit onto the main pages.
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Inside Scoop When you point the mouse at the Print button, a ScreenTip tells you which printer the job will be sent to. If that’s not the printer you want to use, choose Office  Print and use the Print dialog box to choose a different printer.



If the worksheet needs more work, click the Close Print Preview button on the toolbar to return to normal view and edit the worksheet.



Printing a quick copy of a worksheet To quickly print a single copy of everything on a worksheet, click the Quick Print button on the Easy Access toolbar. You don’t get to Print Preview first when you use the Print button, but if you already know how the printed page is going to appear, you probably don’t need to preview the page(s). When you use the Quick Print button, Excel prints the worksheet on as many pages as the worksheet data requires, using whatever print settings you’ve been using during the current Excel session (or using Excel’s default print settings if you haven’t made any changes to the print settings).



Printing part of a worksheet You don’t always want to print your entire worksheet. Your options for selective printing are to set a print area or print a selected range.



Set a print area If you know you’ll always be printing the same range in a particular worksheet, set that area as a print area and you can quickly print the worksheet in the future. To set a print area, select the range of cells you want to print, and then go to Page Layout and click Print Area in the Page Setup group and select Set Print Area. Bright Idea If you send the worksheet to others and you want to be sure they print the worksheet correctly, set the print area in the worksheet before you send it. That way all they have to do is open the worksheet and click Print for a complete, correct printout.
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Change the print area To change the print area, just set a new print area (it replaces the old print area).



Set multiple print areas To set multiple print areas, select the first area, and then press and hold Ctrl while you select other areas. When you choose Office  Print all the Ctrl+selected areas are set as print areas, and they print on separate pages. Here are a couple of ways to print several nonadjacent areas on the same page: ■



Hide the rows and columns between the nonadjacent areas on the same worksheet, and set a single print area to contain all the areas you want to print.



■



Use the Camera button to take pictures of different areas and paste them side by side on another worksheet, and then set a single print area (select all the cells behind the pasted pictures to set the print area). This method also works for printing ranges from different worksheets on the same page. See Chapter 14 to find out more about adding the Camera button to Excel.



Print a selected range When you need to print a selected range on the fly, don’t bother with setting a semipermanent print area; all you need to do is select the range you want to print, and then choose Office  Print. In the Print dialog box (see Figure 15.2), in the Print what area, select the Selection option and click OK. If you want to preview the printed page before you print it (which we urge you to always do), click Preview; from the Print Preview window, click the Print button on the toolbar to print the page(s), or click the Close button on the toolbar to return to the worksheet. Hack To set the order in which multiple selected areas print, Ctrl+select the print areas in the order in which you want the pages printed (the first area you select is page 1, the second area you Ctrl+select is page 2, and so on).
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Figure 15.2. Choose the Selection option to print just your selected range.



Print specific pages Sometimes we catch an error such as a misspelling after we print a worksheet that’s several pages long. We have to change and reprint the pages with the corrections, but it’s a waste of time and paper to print the entire worksheet again. Instead, print just the changed pages. Open the report in Print Preview and make a note of which pages need reprinting; close Print Preview and choose Office  Print. In the Print dialog box, shown in Figure 15.3, in the Print range area, type the page numbers to reprint in the From and To boxes, and click OK to print. Hack Unlike Word, you cannot tell Excel to print nonadjacent pages in a single operation. If, for example, you need to print pages 2 and 5, you must print Pages From:2 To:2 in one operation, and Pages From:5 To:5 in a second operation.
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Figure 15.3. This Print dialog box is set to print just pages 1 and 2 of a long document.



Print a custom view When you print a worksheet that contains data that you don’t want to print (for example, sensitive company or employee data, or masses of detailed data), you can hide the rows and columns containing that data, and set the print area so that only the data that should be presented gets printed. If you routinely need to print a worksheet like this, save yourself the trouble of hiding the data and resetting the print area every time by creating a custom named view that sets all those items for you. To create a custom named view, set up the worksheet the way you want it printed (hidden data, print area(s), specific print settings for the worksheet or chart, and so on); then choose View tab  Custom Views, click Add, and type a name for the view. Select both check boxes and click OK. To print the worksheet with all your settings, choose View  Custom Views, select the view name, click Show, and then print the worksheet. Note that you cannot create a custom view when any worksheet in the workbook contains a new Excel dynamic list. (We don’t know why you can’t, but you can’t.)
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Hack Excel knows whether your printer is black-and-white or color, and shows you the appropriate print preview. If you have two printers connected, black-and-white and color, and the chart print preview is in shades of gray, open the Print dialog box and switch to the color printer. The print preview switches to color.



Printing a chart A chart can exist as an embedded chart object in a worksheet, or it can stand alone as a separate chart sheet. Right now we’re going to tell you how to print each type of chart, and in the next chapter we walk you through the finer points of formatting charts before you print them.



Print a chart sheet If the chart is a chart sheet, it is always printed alone. Printing a chart sheet is just like printing a worksheet: Display the chart sheet in Print Preview, and then print it from Print Preview, or just click Office  Print.



Print an embedded chart If the chart is an object on a worksheet, you have three print choices: ■



Print the chart alone. Click in the chart (anywhere — it doesn’t matter which element is selected), check the Print Preview, and click Print or click Office  Print.



■



Print the worksheet without the chart. To print the underlying worksheet without printing the chart, simply make sure the chart is not selected. When you click Office  Print you’ll see a standard Print dialog box.



■



Print the worksheet and the chart. Click in the worksheet and click Office  Print. The worksheet and all objects (including charts) are printed.



Watch Out! If you’ve set a print area in the worksheet, the chart must be wholly inside the print area to be printed with the worksheet. If the chart is only partially within the print area, it will only be partially printed.
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Printing several worksheets Most folks print worksheets one at a time because they get used to plodding through the same steps — but you can save yourself time by printing as many worksheets as you want, all at once. As an added incentive, if you print several copies of separate worksheets that need to be collated for handing out or mailing, the printer prints the worksheets in collated order (as long as the Collate check box is selected in the Print dialog box). You can select the sheets you want to print, or you can print the whole workbook. First, be sure every worksheet is printed appropriately by setting the print area and orientation for each one, and be sure you check the whole set in Print Preview before you print. (Page orientation is covered in the next chapter.) To print multiple worksheets (but not the whole workbook), select the worksheets you want to print by Ctrl+clicking their tabs. Use any method you like to print them — by default, Excel prints all active sheets (worksheets and chart sheets). To print the entire workbook, choose Office  Print, and in the Print dialog box (see Figure 15.4), in the Print what section, select the option for Entire workbook. If you want the sheets printed in a specific order, arrange the sheet tabs in that order, from left to right.



Figure 15.4. Print all the sheets in the workbook.
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Bright Idea If you’re printing several copies of multiple worksheets, arrange the worksheets in the workbook in the order in which you want them collated (sheet tabs left to right) so they’ll be printed in that order. Then all you have to do is staple them.



Just the facts ■



Choose Office  Print  Print Preview, or click Preview in the Print dialog box to preview your pages before printing.



■



Print a quick copy of a worksheet with the Quick Print button on the Quick Access toolbar.



■



Control which part of a worksheet is printed by setting a print area, or just print a selected range by selecting the range in the worksheet and then selecting the Selection option in the Print dialog box.



■



Print specific pages of a multipage printout by typing the page numbers in the From: and To: boxes in the Print dialog box.



■



Print an embedded chart alone by clicking the chart to select it before printing.



■



Print several sheets at once by Ctrl+clicking the sheets you want to print before printing.



■



Print an entire workbook by selecting the Entire workbook option in the Print dialog box.
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hapter 15 probably left you with some questions about fine-tuning what you print. Our goal in this chapter is to answer those questions. Now that you know how to print, there are many more details you can adjust to change the look and presentation of your printed pages. And it’s those details that make the difference between a professional presentation and a quick print. For example, what if the pages break badly and leave just one column on a second page? And how do you set up page headers for a report title on every page, or page footers for page numbers? And what if you want to print worksheet gridlines or the row numbers and column letters? In this chapter we tell you how to do these things and much more.



Setting page breaks Excel automatically sets page breaks at the page margins, but the automatic page breaks often break information at inappropriate places in a table. You can change the page breaks so that tables are broken where you choose. There are two ways to set your own page breaks: in the worksheet, and in Page Break Preview. The best and fastest way is in Page Break Preview.
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Inside Scoop Page Break Preview is just an altered view of the worksheet; the worksheet functions normally in Page Break Preview, and anything you can do in Normal view, you can do in Page Break Preview (including zooming in for a better view of cell contents).



To set page breaks in the worksheet (the old way, before Page Break Preview was invented), select a column, row, or single cell where you want to place the break and click the View tab. Click Page Break Preview in the Workbook Views group and then drag the page breaks as desired to change them. Page Break Preview (see Figure 16.1) is the best way to handle page breaks. Page Break Preview displays the worksheet print area (the white area within solid blue lines) and page break lines (the broken and solid blue lines that transect the white print area), with each page number displayed in printing order.



Figure 16.1. Page Break Preview is an aerial view of the worksheet that shows page breaks and page numbers for printing.
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Watch Out! If you set page breaks larger than the printable page, Excel often accommodates the change by printing everything smaller to fit it all on one page. To avoid reducing the size of the printed text, choose the Page Layout tab and make sure the Scale is set to 100% in the Scale to Fit group.



Here are some guidelines for setting and moving page breaks while in Page Break Preview: ■



To change page breaks, drag a break line to a new break position.



■



To change the print area, drag the blue borders around the white print area to new positions.



■



To insert a new page break, select the column to the right of or the row below the new break, right click it, and click Insert Page Break.



■



To remove a page break, drag it to the next page break or to a print area border. You can also select the row above or column to the right of a page break, right-click it, and select Remove Page Break.



If you drag a line to make a page larger and a new broken line appears, the broken line shows you where the page must break given the current margins and page settings.



Changing the page layout Several aspects of the page layout usually need your attention: ■



Orientation — either landscape (wide) or portrait (tall)



■



Paging order — either over, then down or down, and then over



■



Centering the information on the page



■



Changing page margins



All of these items, and others, are set in the Page Setup tab on the Ribbon.



Inside Scoop



Inside Scoop If you’re working in Print Preview and you notice a page setup issue that needs to be changed, click the Setup button on the Print Preview toolbar.
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Change page orientation Some worksheets and charts need to be printed in landscape orientation as shown in Figure 16.2, whereas others are better presented in a portrait orientation, as you can see in Figure 16.3.



Figure 16.2. Landscape orientation works best for wide worksheets.



Figure 16.3. Portrait orientation works best for tall worksheets.
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To change page orientation, choose the Page Layout tab and click the Orientation button as shown in Figure 16.4. Select the Portrait or Landscape option. You can then access Print Preview to see your change.



Figure 16.4. Orientation option on the Ribbon



Change paging order Paging order is the order in which the pages in the worksheet are printed. If you have a worksheet that’s several pages wide and several pages long, you can choose whether to have pages printed across the width of the worksheet or down the length. Choosing a paging order saves you time you would otherwise spend sorting and collating the printed pages. In Figure 16.5 the order is Over, and then down. If you don’t see all the page numbers like in the figure, scroll right or down to see the other page numbers. To change paging order, choose the Page Layout tab. Click the expansion arrow for the Page Setup group, which opens the Page Setup dialog box, and click the Sheet tab (see Figure 16.6); in the Page order section, select an order option. The small preview to the right explains visually what each option does.
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Figure 16.5. In Page Break Preview the page numbers show in the background.



Figure 16.6. The Sheet tab of the Page Setup dialog box
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Change page centering By default, the data on printed pages is aligned against the top and left margins of the page, as shown in Figure 16.7. Often your data looks better if it’s centered horizontally (and sometimes vertically).



Figure 16.7. Data pushed into the upper left corner looks less professional.



To center data in the page, choose the Page Setup tab, click the Margins button, and click Custom Margins (see Figure 16.8). In the Center on page section, select the check boxes for the centering you want.



Change page margins Two common situations might prompt you to change the margins on your printed pages: to reduce the number of pages by fitting more rows or columns onto each page, and to change the size of a printed chart. You can change margins precisely and identically by setting numerical margins in the Page Setup dialog box, or you can change them quickly and visually by dragging the margin lines in Print Preview. Inside Scoop



Inside Scoop Printers have margin limits, and if you set very narrow margins you may be warned that the margins are too narrow for the selected printer. If you print anyway, you may or may not get the whole page; the only way to know if your margins are really too narrow is to try it.
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Figure 16.8. Centering data on the page



Set margins precisely To set margins with precision and perfect balance, choose the Page Layout tab and click Margins  Custom Margins; type margin measurements in the Top, Bottom, Left, and Right boxes. When you click in a box to change the setting, a line appears on the small preview (see Figure 16.9) that shows you exactly which margin you’re setting. Watch Out! Header and footer spaces should always be less than top and bottom margins, or you’ll get bleed-over of the header/footer text into the worksheet data. On the other hand, if you have no text in a header or footer, you can ignore them. Header/footer text should fit between the two margin lines.
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Figure 16.9. Set margins with precision in the Page Setup dialog box.



Set margins visually Quite often you don’t need precise margin measurements, but instead you want to change margins quickly (and see the results while you change them). To change margins visually, switch to Print Preview (Office button  Print  Print Preview). On the Print Preview toolbar, click the Show Margins button (see Figure 16.10). Point to a margin line; when the mouse pointer is a two-headed arrow, drag to reposition the margin. Bright Idea While you have margins displayed, if you notice that a column is too narrow or too wide, drag its column border marker to resize it.
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Figure 16.10. Setting margins visually gives you a better feel for the results.



Printing a specific number of pages Suppose you have a table of data that’s just a few rows too long for three pages, but you don’t want to print a fourth page just for those few extra rows. Instead of spending time messing with the margins and page layout to make the data fit on three pages, you can have Excel shrink the data to fit precisely on three pages. To shrink data to fit a number of pages, choose the Page Layout tab. In the Scale to Fit group, click the expansion button to access the Page Setup dialog box. On the Page tab in the Scaling section, select the Fit to option (see Figure 16.11), and then type numbers in the page(s) wide by and tall fields. Bright Idea If you know the table will grow in length but the number of columns won’t change, set the Pages wide by box to 1, and set the tall box to 50. Excel prints as many pages as needed for the length of the list, and the large number (50) gives the list plenty of room to grow without changing the setup.
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Figure 16.11. Shrink the text to fit the report onto a specific number of pages.



Printing row/column labels on every page This concept is easier to see than to explain. When you print a table that’s several pages long and wide, the identifying column and row labels appear only on the first page, in the top row and left column, which leaves the data in the middle pages (see Figure 16.12) unidentified and meaningless. In Figure 16.13, the same page has columns and rows identified, even though this data set is in the middle of a very large data table. Adding the appropriate row and column labels to every page makes the data clear and understandable.
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Figure 16.12. What data is this? The columns and rows need labels on every page.



We know people who actually insert the column and row labels into each page at the page breaks, which is not the best way to solve the problem (it’s too much work and it limits the printed page maneuverability). The best solution is to let Excel add the column and row labels on each page for you by setting print titles, row and column labels that are printed on every page to identify the data. Print titles are not the same as page headers. Page headers print identical information at the top of every page and are completely separate from the worksheet data; print titles print the appropriate column and row labels for the data on every page.
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Figure 16.13. That’s better. Now you know exactly what the data is on every page.



To set print titles, follow these steps: 1. Display the worksheet in Normal view or Page Break Preview, and choose the Page Layout tab. Click the Print Titles button, which opens the Sheet tab on the Page Setup dialog box. 2. On the Sheet tab (see Figure 16.14), under Print titles, click in the Rows to repeat at top box. 3. In the worksheet, click or drag the row selectors for the rows that contain the column labels. The row references are entered in the Rows to repeat at top box; these rows of column labels are repeated across the top of the data table on each printed page.
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Figure 16.14. Set the Print titles section so that the data on every page are labeled with row and column headers.



4. Click in the Columns to repeat at left box, and then click or drag the column letters in the worksheet that contain the row labels. The column references are entered in the Columns to repeat at left box, and these columns of row labels are repeated down the left side of the data table on each printed page. 5. Click OK to close the dialog box, or Print Preview to see the changed pages.



Creating a header or footer Headers and footers are an important part of the printed page; they are displayed on every page and show information that’s not a part of the worksheet but that identifies the report and pulls the multiple pages
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together as a unit. Useful information in headers and footers usually includes a report title, page numbers, and the date and time the report was printed (some of which Excel calculates for you). Figure 16.15 shows a page with a custom header and footer. It has a company logo on the left, a centered title with formatted font, and a footer with custom text. Headers and footers are created the same way; the only difference is that a header appears at the top of each page and a footer appears at the bottom of each page. To create any header or footer, choose the Page Layout tab, click the expansion arrow in the Page Setup group, and click the Header/Footer tab (see Figure 16.16).



Figure 16.15. Custom headers and footers make a printed page look professional.
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Figure 16.16. The preview windows give you a general idea what your header and footer look like on the page.



Use a prebuilt header or footer To use a prebuilt header or footer, click in the Header or Footer list box and select a ready-made header or footer. (Excel creates these from combinations of the filename, sheet name, user name, page numbers, and so on.)



Create a custom header or footer To create a custom header or footer, click Custom Header or Custom Footer. In the Header (see Figure 16.17) or Footer dialog box, click in the section of the box where you want your header/footer to appear. The sections align your entries on the page (left, center, or right). Type any text you want for the header or footer, and click buttons to insert automatic field entries (filename, sheet name, date, and so on). To insert a line break in a multiline header or footer, press Enter.
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Figure 16.17. Custom headers and footers can have any text you want; they can be highly formatted and even contain graphics.



The Header and Footer buttons have never been labeled, but in earlier versions of Excel, you could at least get quick help to identify them. Now, you can simply hover over the button with your mouse and a text field appears, telling you what the button is. You can also see a quick listing of them in Table 16.1.



Table 16.1. Custom Header/Footer Buttons Button



Title Font Page number Number of pages Current date Current time Path and file name continued
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Table 16.1. continued Button



Title File name Sheet name Insert picture Format picture



Insert a picture To insert a picture (for example, a logo) in a header or footer, click in the section box, and then click the Insert Picture button and navigate to the picture you want. Double-click the picture filename to insert it. After you insert a picture, the Format Picture button is available. When you insert a picture in a header or footer, you’ll probably have to make the picture smaller. Click in the section that contains the picture, then click the Format Picture button; on the Size tab, under Scale, type a smaller percentage, and then press Tab (both Height and Width are scaled to match). Click OK twice to return to Print Preview and look at the header/footer you created.



Edit and customize your headers/footers You can edit headers and footers just like any text. Even if you used a prebuilt header or footer, you can edit it by clicking Custom Header or Custom Footer.



Inside Scoop



Inside Scoop Just as with charts, if Excel is currently set up with a black-and-white printer, you see header/footer graphics in shades of gray in Print Preview; if your current printer is color, you see header/footer graphics in color. If you use multiple printers, open the Print dialog box to switch printers.
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Of course, you’ll want to edit headers and footers if you find a misspelling, but you can also make your headers and footers more professional by adding and rearranging text. Here are a couple of tips for editing header and footer text: ■



To create a useful footer that reads “Page 1 of 4”: Type Page, and then a space; click the Page number button, type another space, type of, another space, and click the Number of pages button.



■



The ampersand (&) is part of field coding in headers and footers. So how do you include & as part of a header or footer? By typing it twice — && — to force the ampersand to be a text character.



To format text in a header or footer, open the header or footer in the custom Header or Footer dialog box, select the text you want to format, click the Font button, and set any font formatting you want (font, size, bold, and so on).



Printing worksheet gridlines Gridlines are not printed unless you specifically set them to print. But sometimes that’s exactly what you want (for example, to print a worksheet form that people can fill out in pencil). To print gridlines, choose the Page Layout tab. In the Sheet Options group, click the Print check box under Gridlines. You can also choose this on the Sheet tab of the Page Setup dialog box.



Printing in black and white We like to use colors in our worksheets to highlight important cells, but we don’t want the cell colors (or shades of gray) printed. Instead of removing cell colors from the worksheet, printing, and then replacing the cell colors, we tell Excel to print the worksheet in black and white, which hides all colors and shades of gray. To print in black and white, choose the Page Setup tab. Click the expansion button in the Sheet Options group, and on the Sheet tab, select the Black and white check box. Click OK to finish or click Print Preview to see the changed pages.
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Formatting printed charts You might want to make two changes to your charts before printing: ■



Change the size or proportions of the printed chart.



■



Switch the colors of the data markers to black-and-white patterns for clear differentiation on a black-and-white printer.



When you’re about to print a chart without a worksheet (whether it’s a chart sheet or a chart object), take a look at the chart in Print Preview before you click the Print button — what you see might need some tweaking. A printed chart is automatically stretched to fit within the margins of the printed page, which can stretch a tall or wide chart completely out of proportion. You can change the size or proportions of a printed chart by adjusting the margins in Print Preview, and you can also adjust the printing quality using the Page Setup dialog box.



Use the page margins To resize and reposition a chart using page margins, display the chart in Print Preview, click the Show Margins button on the toolbar, and drag margin lines. The chart remains within the margins in accordance with the size/scale options set in the Page Setup dialog box. If you drag a margin line and nothing happens to the chart, you probably dragged a header or footer margin line. To see which margin line you’re dragging, click on the line and look at the left end of the Excel Status bar — you see both the name and size of the margin.



Use the Page Setup dialog box To set the size/scale options you want, whether or not you’ve dragged the margin lines, display the chart, and then access the Page Setup dialog box from the Page Layout tab and click the Chart tab (see Figure 16.18).



Inside Scoop



Inside Scoop A solitary chart always looks better when it’s centered, so unless you have a reason for pinning the chart into a corner of the printed page, click Setup in Print Preview and use the Margins tab to center the chart both horizontally and vertically.
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Drag margin line



Figure 16.18. Set printed chart size and scale options on the Chart tab.



Click one of the options under printing quality — either draft quality or black and white. If you print to a black-and-white printer, you’ll be disappointed at what happens to your beautifully colored chart; sometimes the markers are difficult to differentiate and identify because they’re all in shades of gray. The solution to this problem is to have Excel print your data markers and corresponding legend keys in black-and-white patterns, as shown in Figure 16.19. You won’t notice the patterns unless you have more than two data series (the first two will be solid black and solid white). The plot area will still be a shade of gray, so for black-and-white printing it’s a good idea to color the plot area a light color.
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Figure 16.19. This chart is formatted to print on a black-and-white printer.



Just the facts ■



Set page breaks and change the print area easily by switching to Page Break Preview (choose View  Page Break Preview).



■



Change page orientation on the Page tab in the Page Setup dialog box.



■



Change paging order on the Sheet tab in the Page Setup dialog box.



■



Center data on the page with the Margins tab of the Page Setup dialog box, and change page margins with the Margins tab or by dragging margin lines in Print Preview (click the Margins button on the Print Preview toolbar to display margin lines).



■



Shrink data to fit a specific number of pages on the Page tab in the Page Setup dialog box under Scaling.



■



Set print titles (appropriate row and column labels on every page) on the Sheet tab in the Page Setup dialog box.
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■



Create headers and footers on the Header/Footer tab in the Page Setup dialog box.



■



To format printed charts, select the chart and use the Chart tab on the Page Setup dialog box.
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ou may never need to share a workbook with another user, but you might very well want to send a workbook to someone, or route a workbook to others and have it find its way back to you when they are finished with it. If you send a workbook to someone else to review, it’s not a bad idea to protect it so that the other user(s) can’t make unacceptable (or inadvertent) changes in it. The opposite end of the spectrum is not sharing at all — locking up your workbook file so that no one can open it without a password. You learn how to do all these things in this chapter. Usually if someone else has a workbook open when you try to open it, you see a message that allows you to choose between opening the workbook as read-only (so you can read it but not make changes) or being notified by an onscreen message when the workbook is closed and available. If, however, you share a workbook with other users on a network, two or more people can use the workbook simultaneously. When a workbook is shared, no one has to wait for a turn to open and make changes in a workbook. (Shared workbooks were Microsoft’s first foray into the “team” concept of corporate work.)



343
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GET THE SCOOP ON... Sharing a workbook ■ Reviewing changes in a shared workbook ■ Sending and routing workbooks ■ Protecting workbooks and worksheets
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Sharing a workbook Before you can use a workbook simultaneously with another user (or use copies of a workbook you want to merge later), you must open the workbook and set its “shared” setting. To share a workbook, click the Share Workbook button on the Changes group on the Review tab, shown in Figure 17.1. On the Share Workbook dialog box, select the Allow changes by more than one user at the same time check box, and then click OK.



Figure 17.1. Sharing a workbook



When you work in a shared workbook, you find yourself unable to perform some tasks, such as: ■



Deleting worksheets



■



Inserting or deleting ranges (although you can insert/delete entire rows and columns)



■



Merging cells



■



Creating conditional formats



■



Creating or changing data-validation settings



■



Creating or changing charts, pictures, objects, or hyperlinks



■



Draw graphical objects



■



Creating, changing, or viewing scenarios



■



Creating automatic subtotals



■



Grouping or outlining data



■



Creating or changing PivotTables Bright Idea Use a shared workbook as a communications device: If your officemates must take turns with a resource that can’t be shared (such as seats on a Go To My PC Web site), use a shared workbook on a network drive to sign in, sign out, and monitor the use of those shared resources.
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■



Taking pictures with the Camera button



■



Doing anything involving macros in the shared workbook’s modules (although macros in personal.xls are operable)



To test and practice sharing workbooks, it’s a good idea to get someone on another computer to open a shared workbook with you; or, if you have a second computer at hand, test shared workbooks with yourself on the second computer.



Who’s using a shared workbook? When you open a shared workbook, the word [Shared] in the title bar tells you it’s available to others, but you can’t tell from the title bar whether someone else is currently using the workbook (or who the other users are). To see who’s using the workbook (if anyone), choose Share Workbook on the Changes group on the Review tab, shown in Figure 17.2. On the Editing tab, shown in Figure 17.2, all current users are listed in the Who has this workbook open now list.



Figure 17.2. The Changes group enables you to quickly share a workbook.



Inside Scoop



Inside Scoop Any user can remove any other user by selecting his or her name and clicking Remove User. This might be necessary when users finish using the shared workbook but leave it open on their computers, for example.
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Saving a shared workbook If more than one user has made saved entries in a shared workbook, you see the new entries when you save the workbook. To save a shared workbook, click the Save button on the toolbar. If you make changes that others need to see, you must save the workbook for the changes to appear in the other copies. If you save your copy of a shared workbook and see a message that other users have made changes, read the message and click OK to close it. Changed cells have a colored border and a colored triangle in the upper left corner (as shown in Figure 17.3); the color identifies who made the change. The colored borders and triangles disappear after the changes are accepted or rejected (which is covered in the next few sections). When you point to a changed cell, a comment tells you who made the change and what the change was.



Figure 17.3. The bordered cells’ values were changed by other users (different-colored borders indicate different users).



Reviewing changes in a shared workbook If two or more people have made changes to the same cell, a conflict arises when the workbook is saved: Which changes should Excel keep? Excel keeps track of all changes made in a shared workbook; you can review all the changes and decide individually which changes to keep, either when you save the workbook or later when you want to see what’s been happening in the workbook while you were away.
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Bright Idea Resolve conflicts in advance by setting up the workbook so that whoever saves the workbook gets the changes saved (no conflicts). Choose  Review  Changes  Share Workbook. On the Advanced tab, under Conflicting changes between users, select “The changes being saved win.”



Resolving change conflicts When you save a workbook that contains conflicting changes to the same cells, you see the Resolve Conflicts dialog box (see Figure 17.4).



Figure 17.4. When there are two or more saved changes to the same cell, the Resolve Conflicts dialog box appears.



Your choices are pretty simple: Select one change at a time and click Accept Mine or Accept Other, or click Accept All Mine or Accept All Others to deal with all the conflicts at once. (Or click Cancel to deal with the changes later.)



Tracking changes in a shared workbook If you just opened a shared workbook and you want to see what changes were made in your absence, you can tell Excel to highlight every changed cell and then accept or reject the changes. To highlight changes, choose Review tab  Track Changes  Highlight Changes. In the Highlight Changes dialog box (see Figure 17.5), narrow the changes you want to see by selecting the check boxes and selecting alternatives from the list boxes. Make sure the Highlight changes on screen check box is selected.
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Figure 17.5. Choose the range of changes you want to see.



You can turn off both change tracking and workbook sharing from within the Highlight Changes dialog box. If you deselect the Track changes while editing check box, change tracking is turned off, every change in the workbook is replaced with the last saved entry, and the workbook is unshared.



Accepting and rejecting tracked changes After you highlight changed cells, you can accept or reject them. Choose Review tab  Track Changes  Accept or Reject Changes. You might or might not see a message that the workbook will be saved (click OK to continue). Then you might or might not see the Resolve Conflicts dialog box (depending on whether there have been any conflicting changes made); you must accept or reject the conflicting changes to satisfy the dialog box. Finally, the Select Changes to Accept or Reject dialog box appears. Use the When, Who, and Where check boxes and list boxes to limit the changes you want to see, and then click OK. If there are changes made within the When, Who, and Where parameters you set, you can accept or reject them one by one or all at once. Hack To check the entire worksheet for changes, leave the Where check box and range box empty.



26_045947 ch17.qxd



1/4/07



10:09 PM



CHAPTER 17



■



Page 349



SHARING A WORKBOOK WITH OTHER USERS



349



Bright Idea If there are lots of changes to the same cells, print the history to show others who’s been wrangling over which data.



Printing a history of changes By default, Excel keeps track of changes made to a shared workbook for 30 days. You can print a change history — a separate worksheet that lists all the changes made to cells in a specific worksheet — as long as the workbook is still shared. (Once you unshare a workbook, the history of changes is irretrievably gone.) To create a change history, choose Review tab  Track Changes  Highlight Changes. In the Highlight Changes dialog box (see Figure 17.6), deselect the When, Who, and Where check boxes, and mark the List changes on a new sheet check box. Click OK.



Figure 17.6. Deselect all the check boxes to list all the changes in the current history, and mark the List changes check box.



A new worksheet named History is created with a table of cell addresses, changes, time, date, and user name, and AutoFilter buttons so you can filter the list (see Figure 17.7). Watch Out! If you want to keep a copy of the History sheet, print it before you unshare or save the workbook; when the workbook is unshared or saved, the History sheet is deleted.
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Figure 17.7. These changes have been made since the workbook was shared.



You can change the number of days of tracked history or turn off the change history without unsharing the workbook on the Advanced tab of the Share Workbook dialog box (see Figure 17.8).



Figure 17.8. Change the History settings.



26_045947 ch17.qxd



1/4/07



10:09 PM



CHAPTER 17



■



Page 351



SHARING A WORKBOOK WITH OTHER USERS



351



Unsharing a workbook The time will come when you need to be proprietary about a workbook — for example, you want to create PivotTables or a chart, neither of which you can do in a shared workbook. In theory, unsharing a workbook is simple: Any user can choose Share Workbook and deselect the Allow changes check box. In practice, it’s sometimes a little more complicated. When one user unshares the workbook, other users are locked out of the workbook, even though it’s still open on their machines (and when the first user reshares the workbook, the locked-out workbooks are not reshared). Locked-out users must close the workbook without saving, or save a copy of the workbook with another name (and they can’t merge a copy with unsaved changes because the copy was made after the workbook was unshared). In fact, if any user other than the original user (the one who shared the workbook) makes changes to the shared and protection settings, a host of problems ensue for the other users. Our advice is: Leave the sharing and protection settings alone unless you are the owner of the workbook, and warn other users when you’re about to unshare the workbook.



Sending and routing workbooks You don’t have to share a workbook to send it to someone else; in fact, chances are good that you’ll often send workbooks such as invoices or estimates to other people and never need to share them. You can send a workbook directly to someone else in an e-mail message, or you can use e-mail to route a workbook to others and bring it back to you after it’s made its rounds.



Send a workbook There are two ways to send a workbook to someone else: Choose Office  Send in the open workbook, or open an e-mail message and attach the file. To send a file from the open workbook, choose Office  Send  Email. This action sends the current sheet as an attachment to the e-mail. Personally, we think the Send to commands are overkill. We always send our files the time-honored way: Open a message and insert the file, or drag the file name from a folder window into the message. Either way, the file is attached to the message.
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Inside Scoop You might have different commands in a computer that doesn’t use Outlook for a mail program.



Even better, you can send a specific table of data in a message by copying the table in Excel and pasting the copied table in the body of the message. When you send data this way, the message is much smaller and is sent and received more quickly.



Protecting workbooks and worksheets When you go to great effort to create a complex worksheet or workbook full of intricately constructed formulas, complex graphical objects, or important charts, you don’t want other people to inadvertently change or delete any of those formulas, objects, or charts. Excel has a few locks and keys to help you protect your work: You can protect an entire workbook or individual sheets within a workbook. The method you choose depends on what you want to protect or prevent. You should protect a workbook when you want to prevent ■



Deleting or inserting worksheets



■



Renaming worksheets



■



Copying or moving worksheets



■



Hiding or unhiding worksheets



■



Changing the size or shape of workbook windows



■



Splitting or unsplitting panes



■



Freezing or unfreezing panes You should protect a worksheet when you want to prevent changes to



■



Cell contents



■



Charts



■



Graphical objects



■



Scenario definitions



You should protect a workbook file when you want to prevent it being opened at all without a password, or allow it to be opened but prevent any changes whatsoever without a password.
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Protect and unprotect a workbook To protect an unshared workbook, choose Review tab  Changes group  Protect Workbook. In the Protect Workbook dialog box (see Figure 17.9) select either or both check boxes; type a password if you want one, and click OK.



Figure 17.9. Without a password, anyone can unprotect the workbook.



To unprotect an unshared workbook, choose Review tab  Changes group  Protect Workbook. If you protect the workbook with a password, you must type the password and click OK. When you protect a shared workbook, your only protection option is to protect the change history so that it can’t be removed.



Protect a worksheet To protect the active worksheet, chose Review tab  Changes group  Protect Sheet. In the Protect Sheet dialog box (see Figure 17.10), select check boxes to allow users to make specific changes in the sheet, and click OK. Bright Idea If you don’t do a lot of file sharing but want occasional password protection, always use the same simple password (such as “zzz”). That way you won’t forget it.
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Figure 17.10. Protect your worksheet contents with the Protect Sheet dialog box.



By default, all cells on worksheets are locked, so all cells are protected when you protect a worksheet. If you want to protect formulas but allow users to enter values for those formulas to calculate, you need to unlock the cells where values can be entered (which is explained in the next section), and then protect the worksheet.



Unlock cells before protecting a worksheet To unlock cells so they can be changed after the worksheet is protected, right-click the specific cells and choose Format Cells; on the Protection tab (shown in Figure 17.11), deselect the Locked check box. You can also use the Hidden button to hide formulas within those cells. When you protect the worksheet, be sure you mark the Select unlocked cells check box (shown in Figure 17.12) to allow users to make changes in the unlocked cells. Bright Idea The Protection tab has a Hidden check box — it hides the formula in a cell. If you create an intricate formula that you don’t want to share, hide and lock the cell and then protect the worksheet so that nobody can “borrow” your formula.
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Figure 17.11. Unlock specific cells so you can enter data in them after you protect the worksheet.



Figure 17.12. You also need to make the unlocked cells selectable in the protected worksheet so you can enter data in them.
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Protect a workbook file When you protect workbooks and worksheets, others can still open and read the workbook files regardless of the level of workbook and worksheet protection. There is another level of protection: you can passwordprotect the file from opening. To protect the workbook file, choose Office  Save As. Click the Tools option and choose General Options. Type passwords to open or modify the file. The options are ■



Password to open. The workbook is completely protected; it cannot be opened at all without the password.



■



Password to modify. The workbook can be opened but no changes saved without entering the password (although a user can still make a copy of the workbook with the Save As command).



■



Read-only recommended. When the file is opened, users see a message suggesting that they open the file as read-only so as not to make and save inadvertent changes. It’s only a reminder — it offers no protection for the workbook because all a reader must do is click No and the workbook opens normally.



Just the facts ■



Share a workbook if more than one person needs to work on it at the same time.



■



To share a workbook, use the Review tab, Changes group.



■



Review changes and print a change history in a shared workbook by choosing Track Changes  Highlight Changes.



■



Prevent changes to workbook structure by choosing Protect Workbook on the Changes group.



■



Protect a worksheet’s contents by choosing Protect Sheet on the Changes group.



■



Unlock cells before you protect a worksheet by selecting the cells and choosing Format  Cells; deselect the Locked check box on the Protection tab.



■



Keep a workbook file from being opened without a password by setting a password to open using Office  Save As and clicking Tools.
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big advantage in having Microsoft’s entire suite of Office programs on your computer is that they can cooperate and share data with one another. By sharing data between programs, you can create reports that combine data from Word documents and Excel worksheets on the same page. A table of data or a chart can be copied to a Word document as simple data or a picture, an embedded object that can be changed with Excel tools (without opening Excel), or a linked object that’s always current. Most commonly, data is shared between Excel and Word, so this chapter focuses on Excel-Word data sharing. Fewer people use Access, but we also cover Excel-Access data sharing. Lots of other (non-Microsoft) programs also share data. The only way to know whether and how they share data is to test them. You can almost always copy and paste Excel data into other programs.



Shared-data terminology This chapter uses several terms — object, paste, embed, and link — that you need to understand as we explain how to share data between programs. These terms are defined in Table 18.1. 357



Chapter 18



GET THE SCOOP ON... Shared-data terminology ■ Sending data between Excel and Word ■ Sending data between Excel and Access ■ Pasting Excel data into PowerPoint ■ Dragging a hyperlink into Excel ■ Saving a worksheet as a Web page
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Table 18.1. Shared-data definitions Term



Definition



Double-click results



Editing results



Object



A “container” of information that’s inserted in another file.



Depends on whether the object is linked or embedded.



Paste



Pasted data is inserted as text; it becomes part of the file into which it’s inserted.



No special results; pasted data is not connected to its source.



Embed



An embedded object is connected to the program in which it was created, but not to its source file.



The source program opens so you can change the object with its own editing and formatting tools.



Editing changes only the embedded object, not the source file. A file containing an embedded object is larger because it contains all the object’s data and formatting.



Link



A linked object is connected directly to its source file.



The source file and program open so you can change the source file.



Editing changes a linked object’s source file; all linked copies reflect the changes. A file containing a linked object is smaller because it contains only the link.



Sending data between Excel and Word Sending data from Excel to Word is not as easy as it should be. You can drag and drop data between an Excel program window and a Word program window and you get an embedded object, but the embedded object is the entire Excel workbook, even if you only dragged and dropped part of a table. Unless you have a reason to open the Excel environment and edit/format the data, it’s entirely too much trouble to work with (and it makes the document much larger because all the Excel data and formatting in the workbook are included).
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If you link an object, you get a picture of the Excel data that’s really an updatable live link to the workbook, but the source workbook must be in a shared folder or drive on the same network for the link to function. A linked object looks just like an embedded object (see Figure 18.1) — the difference becomes noticeable only when you double-click the object. The easiest way to get Excel data into Word, whether it’s data, a chart, or a PivotTable, is to use simple copy and paste commands to paste your selection.



Figure 18.1. Linked and embedded objects look identical; pasted objects can be turned into Word text easily.
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You can remove the table format from pasted cells by selecting the table and choosing Table Tools  Layout. In the Data Group, click Convert to Text.



Paste data For most users, usually all that’s needed is to get the data, a PivotTable, or a chart into a Word document (without any fancy features such as linking for updating or embedding so the data can be edited or formatted). The best way to do that is a simple copy and paste. To copy simple data, select the cells (or PivotTable or chart area), right-click the selection, and click Copy, or you can click the Copy button on the Clipboard group on the Home tab. To paste the copied data, right-click in the document and click Paste or use the Paste button on the Clipboard group on the Home tab. Cells and PivotTables become Word tables, as you can see in Figure 18.2, and you edit and format them using Word commands. Charts become graphic objects in Word, and are minimally formattable but fully resizable, just like other graphic objects.



Figure 18.2. A list, PivotTable, and chart, copied and pasted into a Word document.
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Bright Idea Linked data is useful if you need to make several copies of the same data, because if you need to change the data, all you have to do is change the source file; all linked copies are updated with the change automatically (as long as they’re in network contact with the source file).



Link data A linked object is a small piece of the original source file (such as a chart or table of data) that is dynamic; a link is just a short set of directions to the location of the source file, and a linked object displays the current data in the source file. When would a linked Excel object in Word be useful? If you routinely generate reports or letters that contain current data that’s maintained in Excel (such as prices or a chart of performance), a linked object in the Word document saves you the trouble of looking up the data because the linked object data is always current. To create a linked object, follow these steps: 1. In Excel, copy the data or chart you want to link. 2. In Word, choose Paste  Paste Special in the Clipboard group on the Home tab. 3. In the Paste Special dialog box (see Figure 18.3), select the Paste link option. 4. In the As list, select Microsoft Excel Worksheet Object (or Microsoft Excel Chart Object if you’re linking a chart), and click OK. Linked objects in an open Word document usually update automatically when the workbook source data changes, but sometimes they need to be updated manually. To make sure a linked object is current, right-click the object and click Update Link. When you open a document that contains a linked object, you are asked if you want to update the document with data from linked files — click Yes. (Clicking No retains the existing data in the linked object.) When you double-click a linked object, the source file opens in its own program; make your changes and save and close the source file.
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Figure 18.3. The Paste link option creates a link to the source data.



Change a link’s source The Office programs have become really good at tracking the movements of linked source data. We tried and tried to break a link by moving and renaming the source workbook, and when we opened the document with the linked object, Word found the source data every time — so you probably won’t need to change a link’s source in response to a broken link. If you want to change the source for a linked object, editing a link (by right-clicking the object and choosing Link Worksheet Object  Links) generally doesn’t work — when you switch source files you get the entire first page of the new source workbook as your linked object. If you want to change a linked object to a different source, the easiest way is to delete the current linked object and create a new linked object.



Freeze linked data When you want to keep the data as a picture but not be bothered with update questions when you open a document, you can freeze the data. To freeze linked data as a picture, right-click the linked object, choose Link Worksheet Object  Links, click the Break Link button, and click Yes when asked if you’re sure.
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Hack If you forget to Ctrl+drop the data in Word (and you lose the data in the worksheet), click the worksheet and press Ctrl+Z right away to restore the data. If you forget to press Ctrl+Z right away, close the worksheet without saving; when you reopen it, the data is restored.



Delete a linked object A linked object is like any other graphic object. To delete the linked object, click the object to select it and press Delete.



Embed data This is the fastest way to create an embedded Excel object in Word: Resize both the Word window and the Excel window so you can see them both side by side on your screen (see Figure 18.4), and then select the data in Excel and drag its border into the Word document (press Ctrl when you drop the data to drop a copy). As a reliable alternative you can right-click and drag the data and click Copy Here when you drop it.



Figure 18.4. The Excel and Word windows are vertically aligned side-by-side.
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Hack If you drag and drop data from Excel to Word, you may find some entries truncated. For example, if the column of data is center-aligned in Excel, its entries may not be completely visible in the embedded object. You must left-align the column in Excel and then drag and drop it again.



Here are a few pointers for working with an embedded Excel object in Word: ■



Double-click the object to open an Excel environment. Many of the toolbar buttons and menu commands are functional Excel commands, but some may not be and you won’t know which until you try.



■



An embedded object is not linked; when you open the table in the Excel environment, you can change data and formatting without affecting the original worksheet.



■



In the Excel environment, you can display any part of the worksheet (or other worksheets in the workbook) by dragging the hatched borders to make the display larger or smaller, and by dragging the scrollbars to display different parts of a worksheet in the object window. Whatever is displayed in the Excel environment is displayed in the object when you close the Excel environment.



To close the Excel environment, click in the document. To delete an embedded Excel object, click in the document to deselect the object, click in the object once to select it without activating Excel, and press Delete.



Bright Idea We often send data from Word to Excel (more often than the other way around) — for example, when we transcribe a handwritten list of items, we use voicerecognition software to get it easily into Word, and then copy and paste the Word list into Excel.
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Inside Scoop If the list is multicolumn and the columns are separated with Tab characters, the list is parsed into multiple columns in Excel, but if the columns are separated with space characters, all the text and spaces in a line are pasted into a single cell.



Send data from Word to Excel Sending data from Word to Excel is exactly like sending data from Excel to Word — pasting, embedding, and linking all work the same way (and when you embed a Word object, you embed the whole document). If for some reason you want to paste text that’s not a list (such as a letter) into a worksheet, paste it as a linked or embedded object so that it doesn’t get parsed into cells. Most often, however, Word data that you want to use in Excel is in lists and is suitable for parsing into cells. To copy a list from Word into Excel, copy the list in Word (select the list, right-click the selection, and click Copy), and paste it in Excel (rightclick a cell and click Paste). The pasted data is parsed neatly into cells. Figure 18.5 shows a Word list that’s been pasted into a worksheet.



Figure 18.5. This Word list was pasted into a worksheet and automatically parsed itself into the cells in a column.
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Inside Scoop Microsoft Access is not part of the Standard Microsoft Office suite. To use Access — which is well suited to relational data — you must either have the Professional version of Microsoft Office or purchase Access separately.



Sending data between Excel and Access Sending data from Excel to Access was much easier in previous versions of Excel. There was a time when you could select a table, right-click the selection, and send it to Access. But in the interest of making all their programs easier for the computer illiterati, Microsoft eliminated this option altogether and hasn’t replaced it with anything equally useful. In Excel 2007, the fastest way to send an Excel table straight to Access 2007 is 1. Open a database in Access, and open the worksheet with the data table in Excel. 2. Resize both the Access and Excel program windows so that you can see both the Excel data and the database window on your screen (see Figure 18.6). 3. Select the Excel table (including headings), and drag it into the database in the Access window. Press Ctrl when you drop the data in Access so that you drop a copy rather than moving the data out of the worksheet.



Figure 18.6. Resize the windows so you can drag data from Excel into the database.
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Hack If you forget to press Ctrl when you drop the data (and the data disappears from the worksheet), click the worksheet to select it and then press Ctrl+Z to bring the data back. It won’t affect the data in Access, but the data is replaced in Excel.



A new table, named with the worksheet name, is created in the Access database. Moving data from Access into Excel is a little simpler. Open the database table you want to copy to a worksheet and choose External Data  Export  Excel. Whether or not Excel is open, a new, saved workbook is created, named with the name of the database table and saved in the current folder (the folder you last had open in Excel).



Pasting Excel data into PowerPoint The charting feature in PowerPoint is the same as in Word and Access; you’re much better off creating a chart in Excel and pasting it into a PowerPoint slide for a presentation. To paste a chart into a PowerPoint slide, display the slide into which you want to paste the chart. Switch to Excel and copy the chart, and then switch back to PowerPoint, click in the slide where you want to paste the chart, and choose Paste from the Clipboard group on the Home tab. The chart isn’t linked in any way to Excel or the source file.



Dragging a hyperlink into Excel When you create a hyperlink, you create a colored, underlined, active link to another file; when the link is clicked, the other file opens in its own program. Using the Insert Hyperlink dialog box is covered in Chapter 1; here we give you the quick way to insert a link to an open document or workbook. To insert a hyperlink to an open Word Document, follow these steps: 1. Open the Word document and Excel workbook side by side so you can see them both. 2. Select a word or phrase in the Word document that you want displayed when the file opens (the file opens at your selected text).
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3. Right-click and drag it into the worksheet where you want to create the hyperlink. 4. Release the mouse button and click Create Hyperlink Here. You’ll want to edit the hyperlink, if only to change the name and ScreenTip. To edit a link, right-click the link and click Edit Hyperlink; change the text in the Text to display box, and click the ScreenTip button to enter a user-friendly ScreenTip. To remove a link, right-click the link and click Remove Hyperlink, and then delete the unlinked text in the cell.



Saving a worksheet as a Web page If you have a Web site and want to add a page that’s data from an Excel worksheet, open the worksheet and choose Office  Save As. In the Save As dialog box, choose the Other Options and choose Web Page from the drop-down menu. In the Save As dialog box (see Figure 18.7) ■



Select the Entire Workbook option (to publish the whole workbook, with sheet tabs) or the Selection: Sheet option (to publish just the active worksheet).



■



Click Change Title to create a title for the top of your Web page.



■



Type a filename so you can identify the file later when you want to open it in your browser or delete it from a Web site.



■



Click Publish to set up the page for publication.



Figure 18.7. Saving a worksheet as an interactive Web page
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In the Publish as Web Page dialog box (see Figure 18.8) ■



Select the portion of data you want to publish in the Choose list box (drop the list and make a selection — the options available change with each selection).



■



Click Change if you want to change the title.



■



Select the Open published web page in browser check box so you can see the finished page when you’re done.



■



Take note of the filename and path, so you can double-click the filename in the folder window to open the page in your browser.



Figure 18.8. Finishing the Web page publishing process



Just the facts ■



The easiest way to get Excel data into another program such as Word (and vice versa) is a simple copy and paste.



■



Create an embedded object by selecting, dragging, and dropping data from one program into the other; an embedded object can be edited using its native program and is not linked to the source data at all.



■



Create a linked object by copying the data in one program and choosing Paste Special in the other program; select the Paste link option to paste an object that’s linked to its source and shows current data.
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■



Send data from Excel to Access by dragging the data table (including headers) from the workbook window into a database window.



■



Send data to PowerPoint by copying the data and pasting it in a slide.



■



Create a hyperlink to another file by right-clicking and dragging data from the other file into a worksheet cell and clicking Create Hyperlink Here. Right-click the link and click Edit Hyperlink to change the displayed text and the ScreenTip.



■



Save a worksheet or workbook as a Web page by choosing Office  Save As.
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person’s computer is a unique and personal electronic environment. We always find it disconcerting to work at someone else’s machine because we all like to set up our machines in our own way. Setting up your machine to suit you makes your work more pleasant and helps you work more efficiently. One way to make your computer more efficient and comfortable is to set your view of Excel so that you can see as much of the worksheet as possible without squinting at tiny print. You can do that with a few different screen display settings. Another aspect of your workspace you’ll want to personalize is some various options within Excel. You’ll work more efficiently with Excel if it is configured to meet your personal needs and taste.



Changing your screen display Because the default screen display for workbooks is functional and useful as it is, there usually isn’t a compelling reason to change it. A few years ago monitors were small and didn’t provide much on-screen real estate, and there were tricks such as full-screen view to make the most of what little screen area you had. Now, however, most people have larger monitors with higher screen resolution capability and can see as much of the workbook as they need with 373
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no changes. But if you find yourself working on an older monitor or a laptop with a small screen, you may want to resort to full-screen view and zooming the view.



Fill the screen If you have a small monitor and want to see more of the worksheet area, you can switch to full-screen view by clicking the Full Screen button on the View tab. As you can see in Figure 19.1, you get just the active worksheet, maximized and bordered by the menu bar, row numbers, column letters, and the vertical scroll bar. The title bar, toolbars, and sheet tabs are hidden (unless you set the taskbar to AutoHide — when the taskbar is hidden, the sheet tabs and horizontal scrollbar are in view). Simply press Esc to leave full-screen mode.



Figure 19.1. Full-screen view



Zoom the view A more useful way to change your on-screen real estate (especially if you have a larger monitor) is to zoom in or out of the worksheet. Zooming
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changes the screen display by magnifying or reducing the cells in the worksheet. The fastest way to zoom in or out is to use the Zoom button on the View tab. Click the button and select a standard zoom level. You’ll probably find that none of the levels is perfect; in that case, don’t bother with the list of zoom levels — click in the Zoom button, type a custom zoom level, and press Enter. If you work at very high resolution (that is, gaming resolution) or you can’t find your glasses, select the range you want to focus on and click the arrow on the Zoom to Selection button; click Selection to zoom in to view just your selected range (see Figure 19.2).



Figure 19.2. This view is zoomed to fit the selection.



Minimizing the Ribbon The Ribbon is designed to help you quickly find commands without wading through a series of menus and dialog boxes, which had become a serious problem in previous versions of Office. As Office grew more complex over the years, so did the various menus, toolbars, and dialog boxes. The Ribbon is designed to greatly reduce that problem, and as such,
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there is no way to delete or replace the Ribbon with toolbars and menus that you saw in previous versions of Excel. However, you can minimize the Ribbon in order to free up more space on your screen. To minimize the Ribbon, click Ctrl+F1. This minimizes the Ribbon so that you see old-style-looking menus, thus freeing up screen space, as you can see in Figure 19.3.



Figure 19.3. The Ribbon has been minimized.



However, when you click a menu, the Ribbon jumps back to life so that you can use it at any time. Simply press Ctrl+F1 to toggle back and forth between the minimized and maximized Ribbon.



Customizing the Quick Access toolbar The Quick Access toolbar is the only command area that is customizable. You can easily customize the Quick Access toolbar and even move it below the Ribbon so that you can put the most commonly used commands on the toolbar. To customize the Quick Access toolbar, do the following: 1. Click Office  Excel Options  Customization. 2. In the Customization area, choose the category of the commands that you want to add to the Quick Access toolbar. Notice that you can choose to show All Commands from the drop-down menu. 3. Select a command, click the Add button to add the command to the Quick Access toolbar list, and then organize the list of commands as desired using the selection arrows, as you can see in Figure 19.4. 4. To remove buttons, select the button in the list and click Remove. 5. If you have added several buttons, click the Place Quick Access Toolbar below the Ribbon check box toward the bottom of the interface. You may find this location is easier to work with in Excel. 6. Click OK. As you can see in Figure 19.5, the Quick Access toolbar now resides below the Ribbon. You can add or remove buttons from it at any time by simply right-clicking an empty area of the toolbar and clicking Customize
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Quick Access Toolbar. You can also move it back to the top of the Ribbon by right-clicking it and clicking Place Quick Access Toolbar above the Ribbon.



Figure 19.4. Customize the Quick Access toolbar.



Figure 19.5. Quick Access toolbar below the Ribbon



Personalizing features Another way you can make Excel easier to use is to personalize some of the more-popular Excel options. Excel enables you to make these changes by accessing Office  Excel Options  Popular, as shown in Figure 19.6.
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Figure 19.6. Popular options



Here, you can select the following options: ■



Show Mini Toolbar on selection. You can have quick access to standard formatting options. We have found this helpful, and you should likely keep this option selected.



■



Enable Live Preview. You can see a preview of how a feature affects the document as you hover over different choices.



■



Show Developer tab in the Ribbon. If you are not a developer, you can simply clear this check box so that you don’t see the Developer tab, thus freeing up more Ribbon space.



■



Color scheme. You can use the drop-down menu to select a default color scheme.



■



ScreenTip style. Use the drop-down menu to choose a ScreenTip style. Show feature descriptions is selected by default.



■



Create lists for use in sorts and fill sequences. You can click the Edit Custom Lists button here to edit and create lists.



■



When creating new workbooks. You can determine a default font, size, default view, and the number of default sheets in a workbook.



■



Personalize your copy of Office. You can also change your user name and adjust Language Settings as necessary.
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Proofing options As with all Office programs, Excel tries to autocorrect mistakes that you make. However, you can adjust AutoCorrect options as well as spelling options by choosing Office  Excel Options  Proofing, as shown in Figure 19.7. As you can see in Figure 19.7, you can click the AutoCorrect Options button to change how AutoCorrect functions in Excel. If you click this button, you’ll see a basic AutoCorrect dialog box that contains check box options so that you can control how AutoCorrect behaves, shown in Figure 19.8. The options you see on these three tabs are self-explanatory.



Figure 19.7. Proofing options



Figure 19.8. AutoCorrect options
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Back on the Proofing pages, you can also adjust the way Excel corrects spelling. By default, the Office spell-checker ignores uppercase words, words that contain numbers, and Internet and file addresses, and it flags repeated words. In most cases, you’ll want to keep these default settings, but you can adjust them here as desired.



Setting Advanced options You’ll also find an Advanced feature within Excel Options, shown in Figure 19.9. You can access the Advanced options by clicking Office  Excel Options  Advanced. The Advanced option gives you check boxes and selection boxes for a number of Excel features, organized into the following categories: ■



Editing Options. Adjust how Excel handles data when you are editing, such as how selections are moved and fill handles are used, AutoComplete, and separators.



■



Cut, Copy, and Paste. Control how cut, copy, and paste functions behave.



■



Display. Control basic display options, display options for the workbook, or even specific worksheets.



■



Formulas. Choose to use multithreaded calculations or not (this setting is recommended).



■



General. Control additional general settings, including such items as sound, animation, automatic links, and so forth.



■



Lotus Compatibility. Adjust transitional keys and evaluation for Lotus.
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Figure 19.9. Advanced Options



Just the facts ■



Fill a monitor screen with the worksheet by choosing View tab  Full Screen.



■



Use the Zoom box on the Standard toolbar to change the worksheet magnification.



■



Minimize the Ribbon using the Ctrl+F1 command.



■



Access Excel Options to customize the Quick Access Toolbar.



■



Use the Personalize and Proofing options within Excel Options to adjust Excel’s behavior.



■



Use the Advanced option in Excel Options to make additional customization changes.



29_045947 ch19.qxd



1/4/07



10:10 PM



Page 382



30_045947 ch20.qxd



1/4/07



10:11 PM



Page 383



Adding Controls to a Worksheet



W



orksheet controls give you another level of worksheet automation. Controls make a worksheet easier to use for users who are not proficient with Excel, and limit input values so the resulting data retains its integrity. There are two kinds of controls in Excel: worksheet controls and ActiveX controls. Worksheet controls require no VBA programming, and ActiveX controls, designed to run VBA procedures and to be used in custom dialog boxes, are much more complex to set up. Microsoft is very proud of its ActiveX controls and wants you to use them instead of the older worksheet controls, but for basic automation of worksheet functions, worksheet controls are much faster and easier to set up. The programming required to create and use both ActiveX controls and custom dialog boxes (called userforms) is beyond the scope of this book; if you want to pursue these topics, a good place to begin is Julia Kelly’s Master VISUALLY Excel 2003 VBA Programming (Wiley, 2005). We’re going to show you how to use worksheet controls (no programming required) to automate data input procedures in a worksheet.
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What can worksheet controls do? It’s easier to show you what worksheet controls can do than to try to tell you. To begin this chapter, we’re going to show you two worksheets with functional controls in place and explain what’s going on in each worksheet; after we show you what controls can do, we’ll show you how to create the specific controls. Worksheet controls are not designed to be stand-alone features; they’re designed to work with formulas and macros, and they give a user an easy (and controlled) way to change the variables in formulas. A good example is shown in Figure 20.1. We’ve placed all of these controls in a single worksheet to show you the similarities between them; we discuss each of them in more detail in later sections. List box



Combo box



Option buttons



Shared lookup table



Figure 20.1. A worksheet using a list box, a combo box, and option buttons in a group box.



List boxes, combo boxes, and option buttons all do the same thing: They allow a user to select one of a limited group of items. They don’t enter the data itself into a cell; instead, they enter a number in a linked cell, a cell that’s linked to the control, and the number in the linked cell
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Bright Idea Hide the linked cell and the lookup table by positioning them far away on the worksheet or on a different worksheet, or by hiding the columns that contain the linked cell and the table.



is used by formulas in the worksheet. (In this example, all three controls — list box, combo box, and option group — are sharing the same linked cell; you wouldn’t normally do that, but we do it here for illustration purposes.) Each control allows you to make a single choice from a limited list of choices; each choice puts a specific number in the linked cell (you cannot control what the numbers are). Then you can use the number in the linked cell in formulas by referencing the linked cell in the formula. In this example, the cell with the product name actually contains a VLOOKUP formula; the formula looks up the linked cell entry in the lookup table, and returns the corresponding entry from the lookup table (see Chapter 5 to learn more about the VLOOKUP function). The sales of product and # Product orders cells contain SUMIF and COUNTIF formulas that use the product name returned by the VLOOKUP formula as the criterion for summing and counting cells in the coffee orders list. It’s all very interrelated and elegantly functional. In general, to create a worksheet like the one shown in Figure 20.1, follow these steps: 1. Create controls (and create a lookup table for a list box or a combo box). 2. Write a VLOOKUP formula for the product name (use cell link and lookup table in the formula). 3. Use the VLOOKUP result cell (the product name) in SUMIF and COUNTIF formulas. The next example (see Figure 20.2) illustrates ideas for using spinners, scroll bars, and check boxes. Bright Idea Which controls you use for this kind of worksheet setup depend on your sense of aesthetics, but if the list of choices is very long, a combo box takes a lot less room on the worksheet than a list box or an option group.
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Check box



Button



Figure 20.2. A worksheet using a scroll bar, spinner, check box, and button.



In this worksheet, the spinner and the scroll bar change the values in the loan calculator (no formulas are involved in this example). The check box in this example changes the value in the linked cell below it, switching between TRUE and FALSE. The Boolean values TRUE and FALSE are useful in an IF formula such as the tax calculation in the example illustrated in Figure 20.2 (useful in an invoice). The button control exists to run macros you record or write. Now that you have a few ideas about how you can use worksheet controls, we’ll tell you how to create each one.



Forms Controls To create worksheet controls, you use the Developer tab on the Ribbon. If you click the Insert button on the Controls group, you see the Form Controls that are available to you, as shown in Figure 20.3. Table 20.1 explains the buttons on the menu, from left to right.
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Figure 20.3. The Forms toolbar



Table 20.1. The Forms toolbar Icon



Button



Purpose



Button



Runs a macro when clicked



Combo Box



Displays a drop-down list of items from which the user can choose one



Check Box



Enters TRUE or FALSE into a linked cell



Spin Button



Increases or decreases a value within a range



List Box



Displays a list of items from which the user can choose one



Option Button



Enters a number into a linked cell; all option buttons in a group box share the same linked cell and only one option button in a group can be selected



Group Box



Groups option buttons into functional groups; also provides visual grouping of related controls of any kind continued
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Table 20.1. continued Icon



Button



Purpose



Label



Creates a label



Scroll Bar



Increases or decreases a value within a range



Text Field



Creates a field where text can be entered



Combo List



Creates a field where combinations of entries can be made



Combo Drop-down



Creates a combination drop-down menu



All worksheet controls All worksheet controls have some things in common. They can be ■



Moved, resized, and reshaped



■



Drawn repeatedly by double-clicking the button to make it “hot” (click the button again to turn it off)



■



Overlapped, and sent to the back or brought to the front using the commands on the Draw button (on the Drawing toolbar)



■



Grouped to move as a unit using the commands on the Draw button (on the Drawing toolbar)



■



Aligned and distributed using the commands on the Draw button (on the Drawing toolbar)



■



Snapped to worksheet gridlines with the Alt key



■



Assigned macros



■



Set up and made functional by right-clicking the control and clicking Format Control



■



Deleted by right-clicking the control and clicking Cut



All controls can be formatted to some degree, at least to apply 3-D shading, and some can be formatted with colored lines and fills. When you open a control’s Format Control or Format Object dialog box, you see what formatting, if any, is available.
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Hack When you click a control, the control becomes active and responds to your click, even if it hasn’t yet been set up. When you want to move or reshape a control, you must right-click the control, and then click the control to keep it selected while removing the shortcut menu.



Like cells, all controls are locked by default, and when you protect the worksheet, you must unlock the control to keep it functional. Like cells, the Locked check box is on the Protection tab in the Format Control or Format Object dialog box. The Current value setting for all controls is used to set a default initial value when the control is used on a custom dialog box — ignore it for worksheet controls.



List boxes and combo boxes List boxes and combo boxes on the Form Controls menu (that is, not ActiveX controls) are identical in function; they only differ in appearance. If your list of choices is short and you have the space, a list box is faster to use, but if the list is long or the available space is tight, a compact combo box with a drop-down list of choices is better.



Create a list box To create a list box, follow these steps: 1. Create an input list, the list of items you want displayed in the control. The list can be anywhere on the worksheet or on a different worksheet. 2. Click the List Box button on the Form Control menu (click the Insert button on the Ribbon’s Developer tab), and then either click or draw to create the control in the worksheet. 3. Right-click the new control, and click Format Control. 4. In the Format Object dialog box (see Figure 20.4) click in the Input range box and drag to select the input list from step 1.



Bright Idea List boxes and combo boxes can’t enter the selected text items into a list; if your intention is to automate and control entries in a list, use the list-type Data Validation instead.
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5. Click in the Cell link box, and then click a cell on the worksheet that will hold the numeric result of clicking a choice in the control. 6. Click OK, and the control is set up. You can use the value in the linked cell in formulas.



Figure 20.4. Setting up a list box



You can put the linked cell (from step 5) anywhere you want; we suggest putting it out of view, either far away on the worksheet or in a hidden column along with the input range.



Create a combo box To create a combo box, follow the previous steps, but click the Combo Box button on the Form Control menu. In the Format Control dialog box (see Figure 20.5), there’s a Drop down lines box that governs the length of the drop-down list. When you first click OK in the Format Control dialog box, no entries appear in the new combo box. Don’t worry — when you click the arrow and select an entry for the first time, the list appears. Hack What if you discover a misspelled item in your list box or combo box? Just correct the spelling in the input list.
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Figure 20.5. Setting up a combo box



You can set any number you like to control the length of the list. If you make the list shorter than the number of items in your input range, the drop-down list has a scroll bar; if you make the list longer than the number of items in your input range, the list has white space at the bottom if you’re using a list box.



Option buttons and group boxes Option buttons allow a user to select one of a group of two or more choices, just like list boxes and combo boxes. Option buttons work together in a group; all the option buttons on a worksheet are in the same logical group — they share the same linked cell — unless you create separate groups of option buttons by placing them in group boxes. Bright Idea Option buttons are one of the worksheet controls you can format with fill colors and colored borders. Formatting options are on the Colors and Lines tab in the Format Control dialog box.
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You can put any controls you want in a group box to visually segregate them — but the real function of a group box is to create distinct logical groups of options buttons. In other words, all option buttons within a group box are part of the same logical group and share the same linked cell, but are not connected to any other option buttons on the worksheet.



Create option buttons To create option buttons, follow these steps: 1. Click the Option Button button on the Forms toolbar, and then click in the worksheet to create the new control. 2. Drag to select the text in the new option button, and type a new label. 3. Repeat steps 1 and 2 to create more option buttons (see Figure 20.6).



Figure 20.6. Creating and naming option buttons



4. Drag the option buttons into roughly the arrangement you want. 5. Right-click any button and click Format Control. 6. In the Format Control dialog box, on the Control tab (see Figure 20.7), click in the Cell link box, and then click a cell in the worksheet. Click OK to finish — all the option buttons in a logical group automatically share the same linked cell. Inside Scoop



Inside Scoop The first option button you create displays the number 1 in the linked cell, the second displays the number 2, and so on. If you move the buttons around, they keep the same linked cell numbers based on the order in which they were created.
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Figure 20.7. When you link one option button, the others in the logical group are automatically linked.



Create a group box If you only have one logical group of option buttons on a worksheet, there’s no need for a group box (unless you want one because it looks good). But if you want to use option buttons for two or more sets of choices, you need to place each logical group of option buttons inside its own group box. You can create the group box after you create the option buttons; either draw the box around the buttons or drag the buttons into the box, or you can create the group box first and create the option buttons inside it. Either way, Excel knows there are option buttons within a group box. To create a group box, click the Group Box button on the Form Controls menu, and either click or draw the box in the worksheet. Drag to select the group box name and type a new name (see Figure 20.8). There’s nothing to link in a group box, but if you want to apply (or remove) 3-D shading, right-click the box and click Format Control; the 3-D shading check box is on the Control tab.
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Figure 20.8. Creating a group box



Scroll bars and spinners Scroll bars and spinners are nearly identical — both change the integer value in a cell when the user clicks the arrows in the control. Both have minimum and maximum values, and both control the increments by which the values change. The only functional difference between the two is that in a scroll bar the user can also make a page change, a large jump in value, by clicking within the scroll bar instead of clicking an arrow. The linked cells for scroll bars and spinners can be used directly in the worksheet, as illustrated in the loan calculator in Figure 20.2, as well as hidden for use in formulas (as is common with option buttons and list boxes).



Create a spin button To create a spin button, click the Spin Button option on the Form Controls menu, and then click or draw a spinner control in the worksheet. Right-click the new spinner and click Format Control. In the Format Control dialog box (see Figure 20.9), click the Control tab. In the Minimum value and Maximum value boxes, set the minimum and maximum values for the spinner to put in the linked cell (the values must be integers greater than zero). Hack If linked cells are locked and the worksheet is protected, the linked cell values can’t be changed and the controls won’t work. Instead, put the linked cells elsewhere, set the displayed cells =cellref of the real linked cells, unlock the real linked cells, and then protect the worksheet.
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In the Incremental change box, type the increment by which the spinner changes the linked cell value (for example, in the example illustrated at the beginning of this chapter, the spinner changes the value of the loan term cell by 12 because loan terms are commonly in 12-month increments). Finally, click in the Cell link box and then click the linked cell on the worksheet. Click OK, and the spinner is functional. Spinners can only be created vertically, so don’t bother trying to draw a horizontal spinner control.



Figure 20.9 Setting up a spinner



Create a scroll bar To create a scroll bar, click the Scroll Bar button on the Forms toolbar, and then click or draw a scroll bar control in the worksheet. Right-click the new scroll bar and click Format Control. In the Format Control dialog box (see Figure 20.10), set the minimum and maximum values for the scroll bar to set in the linked cell, and set the incremental change by which clicking the scroll bar arrows changes the value in the linked cell.
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Watch Out! You cannot set a maximum value higher than 30,000. If you try, Excel won’t allow you to proceed.



Figure 20.10. Setting up a scroll bar



In the Page change box, set the incremental change for the linked cell value when the user clicks in the center of the scroll bar (not on the arrow buttons). Finally, click in the Cell link box and then click the linked cell on the worksheet. Click OK, and the scroll bar is functional. Inside Scoop



Inside Scoop In a scroll bar, the width of the scroll bar makes a difference in the size of the arrow buttons. Drag a side handle to make the width smaller pixel-by-pixel, and the size of the arrows in the scroll buttons will suddenly jump to a reasonable size.
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Check boxes A check box toggles between TRUE and FALSE in the linked cell. You can use the linked cell result in any formula or activity that requires a true/false, yes/no, or on/off input. A check box can take the place of two option buttons, because both a check box and a group of two option buttons offer the user a choice between two options. To create a check box, click the Check Box button on the Form Controls menu, and click or draw a check box in the worksheet. Drag to select the text and type a new label, and then right-click the new check box and click Format Control. In the Format Object dialog box (see Figure 20.11), click in the Cell link box, and then click the linked cell on the worksheet. Pay no attention to the Values options — they set a default initial value for the check box if you use it in a custom dialog box.



Figure 20.11. Setting up a check box control
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Bright Idea You don’t have to use linked cells with check boxes; you can use unlinked check boxes as visual reminders in a worksheet, such as a project checklist, and mark the check box to indicate that a task has been accomplished.



Button controls Button controls exist only to run macros and are limited to running macros on the worksheet where they exist. We don’t mean to disparage them, however; we like button controls and use them often. To create a button control, click the Button option on the Form Controls menu, and then click or draw a button in the worksheet. As soon as you release the mouse button, the Assign Macro dialog box appears, listing all the macros available to this workbook (see Figure 20.12). Click the macro name you want, and click OK. While the button is selected, drag to select the button text and type your button label.



Figure 20.12. A new button control needs a macro.



Bright Idea Although you cannot change the color of a button control, you can format the text in a button as much as you want using the text-formatting buttons on the Formatting tab.
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If you need to change or edit the macro assigned to a button control, right-click the button and click Assign Macro. The Assign Macro dialog box opens, and you can either assign a different macro or click the Edit button to open the Visual Basic Editor to edit the exiting macro.



Labels Labels are completely passive and not at all formattable. They’re designed for labeling controls on a custom dialog box; they’re not of much use on a worksheet. We suggest using a normal text box (on the Insert tab) instead. If you want to create a label, click the Label button on the Forms toolbar, and click or draw the label in the worksheet. Drag to select the label text and type your own text.



Just the facts ■



Automate your worksheets quickly and easily using controls on the Form Control menu found on the Controls Group of the Developer tab.



■



List boxes, combo boxes, and option buttons all do the same job — they put a sequential integer value into a linked cell.



■



Use the linked cell values in formulas to automate procedures on a worksheet.



■



Group option buttons in a group box control to separate them functionally from other option buttons on the same worksheet.



■



Use scroll bar and spinner controls to change the value in a linked cell, and use the changeable linked-cell value in worksheet features and formulas.



■



Use a check box to toggle the value in a linked cell, and use the linked-cell value in worksheet formulas.



■



Use button controls to run macros you’ve written or recorded.



■



Combine features, controls, and formulas for an elegant, automated, bulletproof worksheet.



30_045947 ch20.qxd



1/4/07



10:11 PM



Page 400



31_045947 ch21.qxd



1/4/07



10:11 PM



Page 401



Using Macros to Automate Repetitive Work



M



acros are programmed procedures that are written using the Visual Basic for Applications (VBA) programming language. The words macro and procedure are used interchangeably. Macros are a useful way to automate repetitive procedures in Excel and are actually a lot of fun once you get past any initial confusion barriers. This chapter barely scratches the surface of VBA; mostly we teach you how to use it in the simplest possible way to program short procedures and get you past the “programming is hard to learn” obstacle that stops most folks from exploring it.



Introducing macros Macros are programmed procedures written in VBA language and are the same whether you record them or write them directly. When you create a macro, you must choose a storage workbook. Macros are stored in three places: in the workbook in which you create them, in a new workbook, and in the Personal Macro Workbook. ■



This Workbook. If you store a macro in This Workbook (the workbook in which the macro is created), it is available to all open workbooks as long as the workbook in which the macro is stored is open. This is a 401
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good option if you want to send a workbook and its associated macros to another user, because the macros stored in the workbook go along with the workbook file. ■



New Workbook. If you store a macro in a New Workbook, Excel creates a new, unsaved workbook and stores the macro there regardless of which workbook you record the macro in. You must save the new workbook to save the macro, and (like the This Workbook option) the macro is only available when the new workbook is open.



■



Personal Macro Workbook. If you store a macro in the Personal Macro Workbook (nearly always my choice), the macro is available all the time to any workbook you have open. The Personal Macro Workbook is a file named PERSONAL.XLSM (which is created the first time you store a macro there), which is saved in the XLSTART folder in your Microsoft folders, and is hidden. Every time you store another macro in the Personal Macro Workbook, the macro is added to the existing Personal Macro Workbook. The Personal Macro Workbook opens whenever you start Excel, but you won’t see it unless you deliberately unhide it. These macros are available to any open workbook, but only in your copy of Excel, and they don’t travel with other workbooks.



Before we discuss recording and writing macros, you need to add the Developer tab to the Ribbon. Click Office  Excel Options. In the Popular category under “Top Options for working with Excel,” click the Show Developer tab in the Ribbon check box and then click OK. To work with macros, you’ll work with the items in the Code group, as you can see in Figure 21.1.



Figure 21.1. Developer tab on the Ribbon



Watch Out! Macros in your workbooks wake up the security settings, which is Excel’s builtin protection against malicious viruses you might receive in workbooks sent to you. See the section “Setting macro virus protection” to learn how to work with and around the security settings.
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Recording a macro Recording a macro (which records all your actions) is an easy way to automate tedious and repetitive tasks without having to write code or understand programming language. Macros can be very short and quick to record, and we often create them just to save a few mouse clicks. Before you start the recorder, it’s a good idea run through all the steps you want to record — like a rehearsal — to prevent mistakes while recording.



Record a simple macro To record a macro, follow these steps: 1. Click the Record Macro button in the Code group of the Developer tab. 2. In the Record Macro dialog box (see Figure 21.2), name the macro. Macro names (like cell and range names) must begin with a letter and are limited to 255 characters. They cannot have spaces, but they can have letters, numbers, and underscore characters.



Figure 21.2. Record a new macro.



3. If you want a keyboard shortcut (it’s optional), click in the Shortcut key box and type a letter. Your keystroke will be Ctrl+yourkey. If it’s the same as an existing keystroke (such as Ctrl+C), the macro keystroke overrides whatever action the existing keystroke performs. You can get around this by typing Shift+yourkey — the macro keystroke will be Ctrl+Shift+yourkey.
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Hack If you inadvertently override a built-in keystroke that you need, you can get the original built-in keystroke back: either delete the macro, or change the macro’s keyboard shortcut (see the section “Run a macro with a keystroke”).



4. In the Store macro in box, click the down arrow and select a storage workbook (see Figure 21.3), and then click OK.



Figure 21.3. Select a storage workbook for the macro.



5. The Stop Recording button appears in the Code group (see Figure 21.4), and the recorder is recording all your actions. Notice the Record Macro button changes to Stop Recording while you record.



Figure 21.4. The Stop Recording option has two buttons: Stop Recording and Relative Reference.



6. Perform the actions you want the macro to perform. You can use both the mouse and the keyboard. Don’t be in a hurry — there’s no clock running when you record a macro, and when you take your time, you’re less likely to record errors. Also, if you misspell an entry, just fix the spelling while you’re recording. 7. Click the Stop Recording button to stop the macro recorder.
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Bright Idea Use the recorder to make longer macros easier to write by recording smaller subprocedures and then copying and pasting them together in the Visual Basic Editor.



Record a macro with relative references When you record a macro that involves selecting a cell, the macro records an absolute reference for the selected cell and always selects that same cell. Sometimes that’s good — for example, when you want a macro to write the current date in the upper left corner of a worksheet — but sometimes you want the macro to make an entry in a cell with a relative reference, a cell that’s always a specific distance away from the active cell. The Relative Reference button on Code group of the Developer tab makes the relative reference selection possible. To record a relative reference selection, start recording a macro, and when you’re ready to select the relative reference, click the Relative Reference button (see Figure 21.5). Click the relative-reference cell, and then click the Relative Reference button again to stop recording relative references.



Figure 21.5. Record relative references.



For example, suppose you want the macro to enter a formula in the cell four rows below the active cell, no matter where the active cell is when you run the macro. Start recording the macro, click the Relative Reference button, click the cell four rows below the active cell, type your formula, and press Enter. Then click the Relative Reference button again. If the recorded macro does what you want, you need never look at the code the recorder writes, but when you begin looking at code in the Visual Basic Editor, you see how relative references are written in Visual Basic code.
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Record a macro to select the last cell Suppose you want a macro to write a sum formula at the bottom of a list, but you never know how long the list is going to be. You don’t need to know any VBA programming to write a macro to select the cell at the bottom of a list — all you need to do is record a macro with a special keystroke. Select a cell in the list and start the macro recorder, and then press Ctrl+Down Arrow. The active cell jumps to the last cell in the column. It doesn’t matter if relative references are on or off because the recorder writes the same code for both — Selection. End(xlDown).Select — and the macro selects the cell at the bottom of the list no matter how long the list is or where the starting point is. When you run the macro, start with the active cell near the top of the column, and then let the macro jump to the bottom of the list and continue with your recorded macro actions.



Running a macro The whole point of a macro is to make tedious procedures quicker and less tedious, so you’ll want to run a macro in the most convenient way. Some macros are most conveniently run from a toolbar button (which you can add using Excel Options on the Office menu); other macros — those you use often — are most conveniently run from a keystroke; rarely used macros might be most conveniently run from a menu command; and macros intended to be used on a single worksheet are always conveniently run from a graphic object on the worksheet.



Run a macro with a keystroke To run a macro with a keystroke, type the keystroke you entered when you recorded the macro. Hack You cannot undo any action performed by a macro. If a macro does something in a workbook that you need to undo, you have two options: undo the damage manually, or close the workbook without saving it, which only works well if you saved the workbook right before running the macro.
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If, however, you didn’t enter a shortcut key when you recorded the macro, or if you wrote a macro without using the recorder and you want to run it with a keystroke, you can add one at any time. To regain the use of a built-in keystroke after inadvertently overriding it with a macro keystroke, use the following steps to change the keystroke; when the macro keystroke is no longer overriding the built-in keystroke, the built-in keystroke is automatically restored. To add or change a macro shortcut key, click the Macros button on the Code group of the Developer tab. Click the macro name in the Macro dialog box, and click the Options button. In the Macro Options dialog box (see Figure 21.6), type a shortcut key and click OK. Click Cancel to close the Macro dialog box, and test your shortcut key.



Figure 21.6. Add or change a macro shortcut key.



Attach a macro to the Quick Access toolbar Run a macro from the Quick Access toolbar by simply adding the macro to it. Open Office  Excel Options. Click Customization and choose Macros from the drop-down menu. Select the desired Macro and click Add to add it to the Quick Access toolbar. Click OK. The Macro now appears as a button on the Quick Access toolbar, as shown in Figure 21.7. New macro



Figure 21.7. Assign a macro to the Quick Access toolbar.
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Attach a macro to an object You can attach a macro to any object: Right-click the object and click Assign Macro. In the Assign Macro dialog box, click the macro name and click OK.



Exploring the Visual Basic Editor We’re not going to go into the Visual Basic Editor very deeply — that’s for another book to do — but we’re going to get you familiar enough with the Visual Basic Editor to edit your recorded macros comfortably. Figure 21.8 shows the Visual Basic Editor, which opens in its own program window. Simply click the Visual Basic button on the Code group of the Developer tab to open it.



Project window



Code window



Figure 21.8. The Visual Basic Editor window



The Project window The Project window (also called the Project Explorer window) is structured like the file tree in the Windows Explorer. Each entry in the Project window is called a node. The top nodes, in bold font, are open projects — a
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Inside Scoop In Curt’s Project window, the funcres project (the Funcres.xla file) is displayed because he has the Analysis Toolpak installed (because he likes having the Convert function always available). If you don’t have the Analysis Toolpak installed, you won’t see this project.



VBA project is the container for all the VBA code in a workbook, and the workbook name is in parentheses next to the project name. All projects are initially named VBA Project (workbook.xls), as seen in Figure 21.9. After you record your first macro, the Personal Macro Workbook is created, and it has a project node — VBA Project (PERSONAL.XLS) — in the Project window. Projects for every open workbook (and only for open workbooks) are listed in the window.



Modules Workbook name



Figure 21.9. The Project window



Below each project node are the folder nodes for Excel objects (the workbook and the sheets in the workbook) and modules. Each sheet object and the workbook object can hold procedures that are triggered



31_045947 ch21.qxd



1/4/07



410



Inside Scoop



10:11 PM



PART VII



Page 410



■



MAKING EXCEL YOUR OWN



Inside Scoop You can rename the project — right-click the project name, click VBA Properties, and then type a new project name — but it’s completely unnecessary when you’re a beginner in VBA.



by specific workbook or sheet events, such as sheet activation or workbook opening. To collapse or expand the list of Excel objects for a project, doubleclick the project name.



Modules Modules only appear when you create VBA procedures (macros) for them to hold. A project can contain multiple module folders; Excel creates a new module every time you open a workbook and record a macro (but all the macros you record during a single Excel session are written to the same new module). You can combine procedures (macros) from several modules into the same module by copying and pasting the routines from one module to another. To display the code for a specific module, double-click the module. Macros in the open module appear in the Code window.



The Code window The Code window (see Figure 21.10) displays all the routines and subroutines for the open module (or other Excel object). For our purposes, the important parts of a macro are the Sub line, the End Sub line, statements, and comments. Inside Scoop



Inside Scoop The Procedure View and Full Module View buttons in the lower left corner of the Code window switch between listing all of your macros and listing them one at a time. In Procedure View, select individual macros from the Procedure list box in the upper right corner of the Code window.
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Bright Idea Use the recorder to learn what the code is for specific procedures (record the procedure and then read it in the Visual Basic Editor).



Procedure list box



Comment Sub line



End Sub line



Satement



Full Macro



Full Module View Procedure View



Figure 21.10. The Code window



The Sub line Every macro begins with a Sub line. Sub is a keyword that signals the beginning of a macro and is followed by the macro name (which you typed when you recorded the macro) and a pair of open parentheses. If you must change the macro name for some reason, follow the macro naming rules and don’t delete the parentheses. When you change a macro name, every object that depends on that name (such as objects to which you attached the macro) will be inoperative until you attach the new macro name.
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The End Sub line Every macro closes with an End Sub line. End Sub is a keyword that signals the end of the macro — don’t mess with it.



Statements Statements are the individual steps a macro follows — these are the parts you can edit or write yourself. Indents in statements are only for ease of reading and editing the procedure.



Comments Comments (colored green and preceded by an apostrophe) are informational and don’t affect the macro at all. Some are entered by the macro recorder, but you can erase them, edit them, and enter your own at will. Any line preceded by an apostrophe becomes a green comment when you press Enter, and you can enter comments wherever you like (on their own lines, at the ends of statements, and so on). Many programmers enter comments at the end of almost every statement, as a quick reminder of exactly what that statement is intended to do, so that later they can find and fix bugs in the code more quickly. In Figure 21.10, we entered the keyboard shortcut comments ourselves, because if you don’t create keyboard shortcuts when you first record the macro (which we didn’t), the macro recorder doesn’t write a keyboard shortcut comment. We created the keyboard shortcuts later — using the Macro dialog box Options button — and then wrote the reminder comments ourselves because we tend to forget keyboard shortcuts that we don’t use every day.



The Visual Basic Editor Standard toolbar In the Visual Basic Editor Standard toolbar (see Figure 21.11), the only important buttons for our purposes are View Microsoft Excel, Save, Run, and Reset. Those buttons are explained in Table 21.1. View Microsoft Excel Save workbook



Run Sub/UserForm Reset



Figure 21.11. The Visual Basic Editor Standard toolbar



31_045947 ch21.qxd



1/4/07



CHAPTER 21



10:11 PM



■



Page 413



USING MACROS TO AUTOMATE REPETITIVE WORK



413



Table 21.1. Visual Basic Editor Standard toolbar buttons Icon



Name



Function



View Microsoft Excel



Switches you back to the Excel program window (the same as clicking the Microsoft Excel button in the taskbar). The Visual Basic Editor window stays open, and you can return to it quickly by clicking the Microsoft Visual Basic button in the toolbar or by clicking the Visual Basic Editor button on the Visual Basic toolbar.



Save workbookname



Saves both your current changes in the Visual Basic Editor and the workbook. Whether you’re in the Excel window or the Visual Basic Editor window, whenever you save one, you save both.



Run Sub/UserForm



Runs the macro in which the cursor resides. Click anywhere in the macro code, and then click Run Sub/UserForm to run that macro.



Reset



This button is for problems. If you run a macro and there’s a bug, the Visual Basic Editor wants you to respond before it goes any further. The Reset button stops the whole process of running the macro and removes the yellow highlighting from the statement in error. If all you do is record macros and do some light editing, you’ll probably never need the Reset button.



Editing a macro After you record a macro, a little minor editing can make it even more useful. For example, we use a macro to turn on fixed-decimal entry by recording Tools  Options  Edit tab, Fixed decimal check box, OK. That’s five clicks, and our macro performs them in a single click. But after we turn fixed-decimal entry on, we need to turn it off again — so we edit the macro into a toggle that turns the fixed-decimal setting on and off by clicking the same button.



Create a toggle macro Any macro that turns on a feature that has only two settings — on and off — can be easily turned into a toggle macro. All you do is edit the macro to read “whatever this setting is, make it the other.”
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To make a macro into a toggle macro, follow these steps: 1. Record the macro. 2. Open the macro in the Visual Basic Editor (Figure 21.12 is my recorded fixed-decimal macro). Keyword



Figure 21.12. My fixed-decimal macro — the keyword True is blue.



3. Replace the keyword True with the keyword not. (Don’t type capital letters; if you spell the keyword correctly, Excel properly cases the word when you’re done with the statement.) 4. Copy the first part of the statement and paste it to the right of the keyword not. Be sure you type a space between the keyword and the pasted text. 5. Click at the end of the statement and press Enter. The finished toggle macro is shown in Figure 21.13. Now you can test the macro: Maximize your Excel window, and then resize the Visual Basic Editor window smaller so you can see the Excel status bar below the Visual Basic Editor (see Figure 21.14). Click in the macro and then click the Run Sub/UserForm button on the Visual Basic Editor toolbar repeatedly — you see the word FIX (which indicates that fixed-decimal entry is on) appear and disappear in the right end of the Status bar every time you run the toggle macro.
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Hack If you get a Compile error and the statement turns red, click OK and ignore the red color. All will be normal when you finish the statement.



Changed keyword



Figure 21.13. The keyword Not tells Excel to change this setting to its opposite. Run the macro



Figure 21.14. Use the Visual Basic Editor to test your macro.
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Hack If you delete statements from a macro, or make any other changes, and suddenly the macro doesn’t run or is buggy, click in the macro and press Ctrl+Z to replace or undo whatever you did. Press Ctrl+Z until the macro is returned to its original working condition, and start editing again.



Fix errors in a macro If you record a macro to enter a text string in a specific cell, and discover later that the text string was misspelled or you need to change the specific cell where the entry was made, you don’t need to rerecord the macro. These are simple errors that you can edit in the macro. 1. Open the macro in the Visual Basic Editor (Figure 21.15 is a macro that enters a company name in the upper left corner of a worksheet). Error



Errors



Figure 21.15. This macro has three errors — a misspelling in the text string, and the wrong cell.



2. Type any changes you need as if you are typing in a Word document. In this example, we fixed the spelling error (“Statioery” to “Stationery”) and changed the cell reference — Range(“B2”) to Range(“A1”), and the active cell movement to the next cell down, Range(“A2”), as shown in Figure 21.16.
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3. Run the macro. If it works, save the macro and workbook (click the Save button in either the Excel window or the Visual Basic Editor). Corrected



Corrected



Figure 21.16. The edited macro



Deleting a macro After learning to use the macro recorder, you’ll have experimental and test macros you don’t need. To delete a macro that’s not in the Personal Macro Workbook, click the Run Macro button in the Visual Basic toolbar, click the macro name, and click Delete. When asked if you want to delete the macro, click Yes. If the macro is in the Personal Macro Workbook, you must unhide the Personal Macro Workbook before you can use the Macro dialog box to delete macros.



Setting macro virus protection A macro virus is a macro that can do some damage to a workbook — such as overwrite text or delete sections of data — when you perform an action that triggers the macro to run. Most macro viruses also spread to other workbooks on your computer or network, and if you don’t realize
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Watch Out! Always use a good antivirus and firewall program (don’t rely on the Windows firewall). Be forewarned — there are some antivirus programs that are so zealous they can cripple your ability to work, and others that just aren’t quite up to snuff. We like Norton AntiVirus by Symantec.



you have one, you can unknowingly send it to others in e-mail and infect their computers. Because macro viruses spread so easily, Excel has protection built in that warns you if a macro is present before you open the file. This is a good thing that’s also very annoying because Excel can’t distinguish between dangerous macros from computer crackers and your own benign macros. Fortunately you can change the macro security settings to suit your comfort level. To change your security setting, click the Security button on the Visual Basic toolbar (or choose Developer tab  Code Group  Macro Security), click a security level (see Figure 21.17), and click OK.



Figure 21.17. Set a security level you’re comfortable with. ■



Disable all macros without notification: All macros not in a trusted location are automatically disabled. You can consider this a very high security setting



■



Disable all macros with notification: This setting will disable all macros not in a trusted location, but with notification to you.



■



Disable all macros except digitally signed macros: All macros are disabled that are not digitally signed.
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Enable all macros: This is the lowest security setting; all macros will run regardless of digital signatures.



This book doesn’t cover digital signatures and trusted sources — those subjects are thoroughly covered in other books that focus on VBA.



Just the facts ■



Use the Developer tab to access macro options.



■



Click the Record Macro button to record a macro.



■



Click the Relative References button while you record when you want to record relative movements of the active cell.



■



Run a macro with a shortcut key if it’s a macro you use often and you can create a convenient, easy-to-remember shortcut key.



■



Attach a macro to a graphic object to make it available only on the worksheet where the object is located.



■



Open the Visual Basic Editor by clicking Visual Basic on the Code group of the Developer tab.



■



Edit macro code in the Visual Basic Editor to make it more functional or to correct errors.



■



Delete a macro you no longer need either by using the Delete button in the Macro dialog box, or by deleting the macro code in the Visual Basic Editor.



■



Set the macro security level you’re comfortable with in the Security dialog box.
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e find Excel most useful when we combine features and formulas to create functionality that goes well beyond what any single feature can accomplish. In this appendix we show you how to create three real-life worksheets (worksheets we created for ourselves and clients): a checkbook calculator; a time-log that gives the user a very quick way to track actual hours worked; and a presentation worksheet in which you can switch charts by clicking option buttons. You probably won’t need any of these specific worksheets, but they are full of ideas you can adapt for your own worksheets. All the features in these worksheets have been covered elsewhere in this book, and we won’t be leading you stepby-step through features covered elsewhere (although there are a couple of macros that we didn’t cover in Chapter 21 that we tell you step-by-step how to write).



Checkbook calculator We’re the kind of people who have meltdowns if our checkbooks aren’t balanced. We used to calculate running balances on an empty worksheet, but then we designed this worksheet (see Figure A.1) just for balancing our checkbooks. It’s dedicated, easy to get to, and quick to use.
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Figure A.1. My checkbook balance worksheet, in use



This single-worksheet workbook uses formulas to calculate the running balance, and macros to both turn fixed-decimal entry on when the workbook opens and turn fixed-decimal entry off when the workbook is closed. It also uses a macro to close the workbook “quietly,” without saving changes or asking you to save changes, so that every time you open it you get a clean, ready-to-use worksheet. When we open this workbook, fixed-decimal entry is on; we start by entering the current balance in the topmost cell in the Balance column. Watch Out! Never save changes when you use this worksheet; if you save changes while you work in the worksheet, the workbook won’t open clean and ready to use next time you open it.
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Bright Idea To keep your eyes focused on the correct number as you read down a long list of numbers, select the entire column of numbers, and press Enter to move the highlighted active cell down the column as you transcribe each number. The highlighting helps draw your eyes to the correct cell.



Then we enter all our check and check card amounts in the Checks column, and deposits in the Deposits column (we don’t bother with dates — this is just a temporary record for balancing our checkbooks). Because fixed-decimal entry is turned on, we never type the decimal point — just the numbers. Be sure to type the zeroes when you enter a whole-dollar amount. When we finish entering the check and deposit amounts from our checkbooks, we transcribe the numbers from the balance column back into our checkbooks. When we finish balancing our checkbooks, we close the workbook. We don’t ever save it while we work in it — the “Don’t Save Changes” note reminds us not to — and when we close it, we’re not asked to save. When the workbook closes, a macro turns off fixed-decimal entry in Excel.



Build the worksheet Okay, now that you know what this worksheet does, we’ll show you how to build it. 1. Enter the table headings and format the first few rows (see Figure A.2). Leave the row below the headings blank (the first cell below the Balance heading is where you enter the starting balance each time you use the worksheet).



Figure A.2. Enter table headings.



2. In the second row below the headings, in the Balance column, enter the formula =IF(AND(ISBLANK(D4),ISBLANK(C4)),””,E3-D4+C4), as shown in Figure A.3. The formula reads “If the Checks cell and Deposits cell to the left are both blank, display nothing; otherwise,
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calculate the Balance cell above minus the Checks cell to the left plus the Deposits cell to the left.” This running balance formula uses relative references, and this particular formula assumes that the table is positioned on the worksheet as shown in Figure A.3, with the table headers beginning in cell C2. If your table is positioned elsewhere, you need to modify the references in the formula.



Running balance formula



Figure A.3. This formula calculates a running balance when data is entered in either of the other two columns.



3. Fill the formula down the column (make the list as long as you like). 4. Format as desired (borders, colors, whatever you choose) down the length of the list. 5. Make yourself a reminder comment in the starting Balance cell, and a Don’t Save Changes reminder entry on the worksheet, as shown in Figure A.4.



Figure A.4. Add reminders to the worksheet.
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Bright Idea The list length is changeable; when you use the worksheet, if you need to make the list longer, just use AutoFill and Format Painter to make it longer. When you close the workbook without saving, the list returns to its original length.



6. Save the workbook and give it a memorable name, such as Checkbook Balance. 7. Enter a starting balance and a few checks and deposits to test the formulas, and then delete the test data (be careful not to delete the formulas in the Balance column).



Write the macros The workbook needs two short macros that cannot be recorded, only written. They turn on fixed-decimal entry when the workbook opens; when the workbook closes, they turn off fixed-decimal entry and close the workbook “quietly” without saving. 1. Open the Visual Basic Editor. 2. In the Project window (see Figure A.5), you should see the VBA Project for this workbook. Open the Microsoft Excel Objects node to display the This Workbook node, and double-click This Workbook. 3. In the Object list box above the Code window (see Figure A.6), select Workbook. A Workbook_Open macro starts for you automatically. Any statements you write in this macro run automatically every time the workbook opens. 4. Click in the line between the Sub line and the End Sub line, and type the statement Application.FixedDecimal = True (see Figure A.7). When you type the statement, the Visual Basic Editor helps by giving you AutoLists of appropriate objects for whatever you typed. For example, type application. After you type the period, an AutoList appears. Type fix, and the AutoList jumps to FixedDecimal. Doubleclick FixedDecimal — the list enters FixedDecimal and disappears. Type the equal sign (=) and another AutoList appears. Double-click True and click away from the line to finish the statement.
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Workbook name



Double-click Open



Figure A.5. Open the This Workbook object in the VBA Project for this workbook. Object list box



Figure A.6. Select the Workbook object in the Object list box.
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Watch Out! Don’t make any changes in the Private Sub Workbook_Open line. If you change anything in this line, the macro won’t work.



Figure A.7. This macro turns on fixed-decimal entry when the workbook opens.



5. Open the Procedure list box (see Figure A.8), and click BeforeClose. The Private Sub Workbook_BeforeClose(Cancel As Boolean) macro appears at the top of the Code window.



Inside Scoop



Inside Scoop You can give yourself more room to work by pressing Enter to create new blank lines in the macro; blank lines don’t affect the macro at all. And you can type the entire statement yourself and ignore the AutoLists — they are helpful but optional.



Watch Out! Don’t make any changes in the Private Sub Workbook_BeforeClose(Cancel As Boolean) line. If you make any changes in this line, the macro won’t work.
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Procedure list box



Figure A.8 Select BeforeClose in the Procedure list box to start a BeforeClose macro for the workbook.



6. In the BeforeClose macro, enter two statements: Application.FixedDecimal = False and ThisWorkbook.Saved = True (see Figure A.9). These statements turn off fixed-decimal entry and close the workbook without asking you to save just before the workbook closes. 7. Click the Save workbook button on the toolbar, and close the Visual Basic Editor. 8. Test the worksheet. Enter a starting balance and some checks and deposits, and then close the workbook (without saving or deleting data). 9. Open the workbook again. It should open clean, with fixed-decimal entry turned on. One last thing to make the worksheet easy to open quickly: Place a shortcut to the workbook on your desktop. Open the folder where you saved the workbook, and right-click-and-drag the workbook icon from the folder to your desktop. When you release the mouse button, select Create Shortcuts Here on the shortcut menu.
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Figure A.9. These two statements run just before the workbook closes.



Time-log template Julia has a client who is an independent contractor and needs to keep precise records of the time he spends on the job. He wanted a worksheet in which he could click to mark ten-minute time blocks or click to unmark them, and have the worksheet automatically total his marked time blocks for each day and for the week. Yes, he could just type an X in cells in a worksheet grid and total them with COUNT formulas, but that was too much trouble. He wanted to just click with the mouse to mark and unmark, and have everything else automatic. Shown in Figure A.10 is Julia’s solution (and he likes it). There’s no VBA programming involved in this worksheet — just formulas, check boxes, and conditional formatting. Each check box is linked (and fitted) to the cell directly beneath it, and each cell is conditionally formatted to turn red when the value is TRUE (see Figure A.11) but return to uncolored when the value is FALSE.
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Figure A.10. Click a time block to mark it or unmark it. Check box gets linked cell value



Selected cell



Figure A.11. Marking the check box turns the linked cell beneath it red.



The formulas that total each day’s hours are COUNTIF formulas that count the number of cells that have the value TRUE and multiply that count by 0.166667 (which is the date/time serial number value for ten minutes). The weekly hours total sums the daily hours totals. The cells beneath the check boxes, the cells for entering dates, and the cells with formulas are unlocked so that their values can change, and



Inside Scoop



Inside Scoop In this worksheet, Julia must use the arrow keys to select cells beneath the check boxes; Julia can’t click to select cells because they are completely covered by the check box controls (which is unavoidable but also protects the underlying cell values).
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then the worksheet is protected so that the check boxes cannot be inadvertently selected and moved. Figure A.12 shows a close-up view of the relationship between the check boxes and the cells whose values they control. Single check box



Overlapping check boxes



Figure A.12. Each check box is centered over the cell beneath it (the control borders overlap one another).



To create this worksheet, follow these steps: 1. Set up the worksheet grid in which you write formulas and position check boxes, as shown in Figure A.13. 2. To each time-segment cell, add a check box (see Figure A.14). If you use small cells like the ones shown, you need to create the check box away from the cell, delete the label, and resize it as small as possible. Link the check box to the cell and then move it into position over the cell.
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Figure A.13. Set up the grid for all the components for your worksheet, enter headers, and apply fill colors to cells.



Move each check box into alignment by “snapping” it to the worksheet grid by pressing Alt. This is a good way to get all the check boxes positioned perfectly over their linked cells and aligned with each other. 3. Repeat step 2 for every cell that needs a check box. It’s tedious, but there’s no faster way to do this because every control must be linked individually to its own cell. To speed up the process, make one check box, delete the label, resize it perfectly, and then copy it repeatedly to make matching check boxes. They still must be linked individually to their cells and moved into position, but copies make it a bit faster. 4. To total the hours for each day, enter the formula =(COUNTIF(reference range,TRUE))*time serial in a day total cell. The reference range is all the time segments in a day, and the time serial is whatever’s appropriate for your time segments, for example, 10 minutes, 30 minutes, and so on. Use relative references and copy the formula to all the day total cells (see Figure A.15).
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New check box Linked cell



Figure A.14. Each time-segment cell gets its own check box. Daily total hours formula



Figure A.15. Write the formula once, with relative references, and copy it to the other cells.



To determine the appropriate time serial for a period of time, enter a time segment in a cell (such as 00:20 for 20 minutes), and then format the cell with the Number format General.
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Bright Idea Once you make a worksheet full of linked check boxes like this, save it as a starter workbook for other workbooks you might want to create in the future, so you won’t have to do the tedious linking more than once.



5. Write a SUM formula in the weekly total cell. Because the weekly total is more than 24 hrs, the cell needs the custom format [h]:mm to display the full number of hours. 6. The next procedure is conditional formatting to make the cells below the marked check boxes highly visible and to hide the display of TRUE and FALSE behind the check boxes. Select the entire set of linked cells and conditionally format them to be a vibrant cell color and the same color font when the value is TRUE, and for the cell and font to be white when the value is FALSE (see Figure A.16).



Figure A.16. The marked cells and font are colored bright red, and the unmarked cells and font are colored white.



7. The last piece of the puzzle is protection. You don’t want the check boxes inadvertently selected or moved, and you don’t want the cells behind the check boxes to be easily selected by clicking. All the cells that change value — the cells behind the check boxes and the cells with formulas — must be unlocked, and then the worksheet protected.
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Here are a few final bright ideas for the worksheet: ■



Enter instructions for use in the cells below the grid in the worksheet.



■



Turn the gridlines off so the worksheet looks more polished.



■



Save a copy of the workbook as a template, at least in your machine, so if other users break their copies of the workbook you have another immediately available to send them.



■



Make several copies of the worksheet in a workbook, and use a new worksheet for each time period (date each worksheet on its sheet tab).



■



To reuse a worksheet, print it to save the data, and then unprotect it and drag to select all the cells underneath the check boxes (start the drag outside the grid, and continue the drag across the entire grid of controlled cells), and press Delete to delete all the TRUE/FALSE entries.



■



Make the worksheet look like a custom program. Hide all the columns and rows outside the grid (select the unused columns all the way to the edge of the worksheet, and hide them; do the same with the rows below the worksheet).



Chart Presentation Figure A.17 shows an example of using worksheet controls in a presentation worksheet. Option buttons (or a list box or a combo box) display a variety of charts with a click. In this worksheet, option buttons, formulas, charts, and the Camera button work together to make a worksheet that the most unsavvy Excel user can use, and that makes an easy-to-switch presentation. The charts are switched using linked pictures and a named IF formula. Hack This is a somewhat complex procedure that intertwines several features. We suggest you follow the steps and figures exactly the first time you try this; after you get a handle on it, you can make changes with less opportunity for confusion. Refer to earlier chapters for guidance when you need to.
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Figure A.17. A great presentation idea — change the chart display by clicking an option button.



To create the previous worksheet 1. Create all the embedded charts you want to display. Locate them off the viewable screen on the presentation worksheet or on another worksheet in the workbook. 2. Position each chart precisely over a specific range of cells (press Alt when you move or resize a chart to “snap” it into position over cells). 3. Name the range of cells beneath each chart (use simple, identifiable names because you’ll be using these names in a formula). 4. Use the Camera button to take a picture of the cells beneath just one chart. The Camera button takes a picture of selected cells; any graphical objects on top of those cells are included in the picture. Hack How do you select cells when you’ve covered them perfectly and completely with a chart object? Either use the arrow keys and Shift key to select all the cells beneath the chart, or move the chart, select the cells, take the picture (or name the range), and then reposition the chart perfectly over the cells.
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Camera button



Named range



Figure A.18. This named range includes a cell with a chart title.



5. Switch to the presentation worksheet, and click where you want the upper-left corner of the chart to appear. Position the chart picture object exactly where you want all the charts to appear (you’ll be switching charts with option buttons, and they all appear right where you position the first picture). 6. Create option buttons — one for each chart — and label them according to the chart they switch to (see Figure A.19).
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Bright Idea For illustration, the linked cell is displayed on this worksheet, but in a realworld worksheet you want to hide the linked cell (under the picture would be a good place).



Hide this cell



Figure A.19. Create option buttons to switch charts in the picture.



7. Name the linked cell (you’ll use the linked cell name in a formula). In this example, the linked cell is named LinkCell. 8. Create a named formula that uses the linked cell name and value, and the named cell ranges beneath the charts, to select each chart. In this example, the formula named Choice (see Figure A.20) is =IF(LinkCell=1,SalesChart,IF(LinkCell=2,MarketingChart, ProductionChart)). This IF formula is nested two levels deep (it has two IF( levels), and can display three results. Because an IF formula can be nested up to seven levels deep, you can use up to eight LinkCell values in the formula by adding more nested IF levels into the main IF formula.
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Formula name



Named cell



Named formula



Figure A.20. The named formula will be used in the picture object. Each different value in the LinkCell results in a different named range displayed in the picture object.



9. Click the picture object. In the Formula bar, delete the formula and type this new formula: =formulaname (use the formula name you defined in step 8) and press Enter. As shown in Figure A.21, the picture uses the named formula =Choice to select the named range to display. 10. Click a cell in the worksheet (to deselect the picture), and click option buttons to test the new presentation worksheet.
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Picture object selected by named formula Named formula



Figure A.21. The picture displays a named range selected by the named formula and linked cell value.
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hese are books about Excel that we use and find useful.



Excel Hacks — 100 Industrial-Strength Tips and Tools A great accessory book once you get a handle on Excel. Lots of stuff you already know, but there are gems in this book (and things you didn’t know you wanted to do) waiting to be discovered.



Microsoft Excel 2002 Visual Basic for Applications Step by Step A great course in beginner Excel VBA programming. Don’t let the version 2002 throw you — VBA has not changed since Excel 2002.



Excel 2007 VBA Programming For Dummies My beginner-to intermediate-level book about VBA programming in Excel. Good for a nonscary, easy-to-follow introduction to VBA in small bites, and a quick reference for simple-but-important VBA procedures such as conditions and loops.
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Excel for Scientists and Engineers A great book that focuses on data analysis, number crunching, and “what-if” scenarios. Written for scientists and engineers, but lots of nonscientists and nonengineers find it extremely useful, even if they’re not Excel masters. Out of print, but you can find it from used booksellers online (expensive now because it’s so terrific).



Excel 2007 Bible A compendium of all things Excel 2007, in great detail and very well written. The Bible covers the more in-depth topics that this book doesn’t cover.



Internet sites Here’s a selection of Web sites that are safe, free, and full of interesting stuff for Excel, Windows, and more.



Google www.google.com This is my home page because I use it so much. It’s not just for shopping — you can Google words for definitions, computer drivers to find updates, phone numbers to locate and research people, and just about anything else you can think of.



Excel 2003 Review (and Excel in general) www.j-walk.com/ss/excel John Walkenbach’s Excel site, which includes loads of tips, oddities, and minutiae you can access from the navigation pane on the left side of the Web page.



FOLDOC (Free Online Computing Dictionary) http://foldoc.doc.ic.ac.uk/foldoc This is a great Web site for quickly looking up computer terminology and acronyms.
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OnlineConversion.com www.onlineconversion.com If you think the Excel CONVERT function is too much trouble (it’s in the Analysis Toolpak add-in), give this Web site a try. It converts just about anything to anything else (more than 5,000 units and 50,000 conversions).



Microsoft http://office.microsoft.com This is the Microsoft site for all things Microsoft, including downloads of extra stuff and updates for your Microsoft programs.



Annoyances.org www.annoyances.org The Annoyances site has long been a good place to find fixes for annoying things in all versions of Windows.
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Activate (Chart) Select a chart for editing or formatting. To activate a chart sheet, click the sheet tab. To activate an embedded chart, click the chart. Active cell The selected cell. You can enter or edit data in the active cell. Active sheet The sheet that you are currently working on. When a sheet is active, the name on the sheet tab is bold. Active window The window that you are currently using or that is currently selected. Only one window can be active at a time, and keystrokes and commands affect the active window. Add-ln Add-Ins are files that can be installed to add commands and functions to Excel. Address The location of a cell on a sheet. The cell address consists of a row address and a column address, such as F12, in which F is the sixth column on the sheet and 12 is the twelfth row on the sheet. Argument Information you supply to a function for calculation. An argument can be a value, reference, name, formula, or another function. AutoComplete An automated means of quick data entry that maintains data integrity; when you begin to type an entry that is similar to other entries in the column, Excel completes the entry for you (if that’s not the entry you want, continue typing).
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Glossary



Absolute reference A cell reference that specifies the exact address of a cell. An absolute reference takes the form $A$1, $B$3, and so on.
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AutoCorrect An automated means of quick data entry that corrects spelling mistakes; any misspelling that’s listed in the AutoCorrect dialog box is automatically corrected as you type. You can also use AutoCorrect to enter long phrases for you when you type an abbreviation. AutoFill AutoFill creates a series of incremental or fixed values on a worksheet when you drag the fill handle with the mouse. Axes Borders on the plot area that provide a frame of reference for measurement or comparison. On most charts, data values are plotted along the y-axis and categories are plotted along the x-axis. On a typical column chart, the x-axis is the horizontal axis and the y-axis is the vertical axis. Pie and doughnut charts have no axes, radar charts have a single central axis, and scatter charts have two value axes. Some 3-D charts have three axes (X, Y, and Z) for values, categories, and series. Boolean Only two possible values: True or False. Any object or function that returns the values On/Off, Yes/No, I/O, and so on is returning Boolean values. Check boxes are worksheet controls that return only Boolean values (True/False). Button control Cell



A button that initiates an action when it is clicked.



The intersection of a column and a row.



Cell format The visual aspect of a cell in a worksheet — number format, color, borders, and so on. Cell reference The set of row and column coordinates that identifies a cell location on a worksheet. Also referred to as the cell address. Chart A graphical representation of worksheet data. A chart can be embedded (an object on a worksheet) or it can be a chart sheet (a separate sheet in the workbook). Charts are linked to the data they are created from and are automatically updated when the data changes. Chart area The entire region surrounding the chart, just outside the plot area. When the chart area is selected, uniform font characteristics can be applied to all text in the chart. Chart object An embedded chart that is not selected and active. A chart object behaves like other graphical worksheet objects. Chart sheet



A sheet in a workbook that contains only a chart.



Chart text Text in a chart is either linked to worksheet data or unlinked. Unlinked text (for example, axis and chart titles, text boxes, and trendline
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labels) can be added after creating a chart, then edited, formatted, and moved. Linked text (for example, legend entries, tick-mark labels, and data labels) is created from text or values in the source data. Chart toolbar The toolbar that contains buttons for the most common chart procedures. Chart type A chart type is a specific kind of chart. All Excel chart types are based on these basic chart types: area, bar, column, line, pie, doughnut, radar, XY (scatter), 3-D area, 3-D bar, 3-D column, 3-D line, 3-D pie, 3-D doughnut, or 3-D surface. Each chart type has at least one subtype that is a variation of the original chart type. Check Box control A control that turns an option on or off; click to select the check box to turn the option on, and click to deselect the check box to turn the option off. Clipboard (Office or Windows) A temporary holding area for data that is cut or copied. The data remains on the Clipboard until you clear the Clipboard or quit Excel. You can paste data in the Clipboard to another location, worksheet, workbook, or application. Circular reference A formula that refers to its own cell, either directly or indirectly. Formulas containing circular references can be solved if iteration is turned on. Code window The Visual Basic Editor window in which macro code is displayed, written, and edited. Column A vertical range of cells. Each column is identified by a unique letter or letter combination (for example, A, Z, CF). Combo Box control A text box with a drop-down list box. It is similar to a list box control (you can select a choice from the list), but it takes less room on the worksheet. (This book discusses only combo boxes that are not ActiveX controls.) Command bar Any toolbar or menu bar that holds buttons or menus/commands for performing actions or starting features. Comment A note that adds supplementary information to the data in a specific cell, without being seen as a part of the worksheet. Comparison operator A mathematical symbol used to compare two values (such as, =, >, , =).
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Cell formatting that depends on the value in



Constant A cell value that does not start with an equal sign. For example, the date, the value 345, and text are all constants. Constraints Limitations placed on a Solver problem. Constraints can be applied to changing cells, the target cell, or other cells directly or indirectly related to your problem. Criteria A set of search conditions used to find data in filters and queries. A criterion can be a series of characters you want matched, such as “March,” or an expression, such as “>300.” Cursor The flashing vertical line that shows where text is entered (for example, in a cell during in-cell editing). Also referred to as the insertion point. Custom sort order A nonalpha, non-numeric sort order, such as Low, Medium, High, or Monday, Tuesday, Wednesday. You can use one of the built-in custom sort orders or create your own. Data label A label that provides additional information about a data marker in a chart. Data labels can be applied to a single marker, an entire data series, or all data markers in a chart. Depending on the chart type, data labels can show values, names of data series (or categories), percentages, or a combination of these. They may be formatted and moved, but not sized. Data marker A bar, area, dot, slice, or other symbol in a chart that represents a single data point or value originating from a worksheet cell. Related data markers in a chart comprise a data series. Data point An individual value plotted in a chart that originates from a single cell in a worksheet. Data points are represented by bars, columns, lines, pie or doughnut slices, dots, and various other shapes. These shapes are called data markers. Data series A group of related data points in a chart that originates from a single worksheet row or column. Each data series in a chart is distinguished by a unique color or pattern. You can plot one or more data series in a chart, except for a pie chart, which is limited to one series. Data source



The source of raw data for a chart, PivotTable, or query.
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Default startup workbook The new, unsaved workbook that is displayed when you start Excel. The default startup workbook is displayed only if you have not saved any workbooks in the XLSTART directory. Delimiter A hidden character, such as a space, tab, or paragraph mark character that separates rows (records) of data into columns (fields). When you import data from a text file such as a Word document, delimiters in the imported text determine how the imported text is parsed, or separated, into columns. Dependents active cell.



Cells with formulas that refer to (draw values from) the



Dependent worksheet A worksheet that contains a formula, PivotTable, or chart that draws values from another source. When two worksheets are linked, the dependent worksheet relies on a source worksheet for values. When you link a worksheet to a document in another application, the dependent worksheet relies on that source document for values. Destination area In a Consolidation, the range of cells you select to hold the summarized data. The destination area can be on the same worksheet as the source data, or it can be on a different worksheet. Dialog box A dialog box appears when you choose a command that requires additional information. It may include areas in which you type text or numbers, and view or change settings for options related to the command. Discontiguous selection A selection of two or more cells or ranges that do not touch each other (also known as noncontiguous or nonadjacent). Dynamic List The Excel list feature that adds AutoFilter buttons to the list headers and a Total row with a SUBTOTAL formula at the bottom. Dynamic Range A range definition that changes as you add or delete rows and/or columns of data. The formula =OFFSET($A$1,0,0,COUNTA ($A:$A),COUNTA($1:$1)) defines a dynamic range that begins in cell A1. Embed The process of creating or copying an object into another document. Objects can be embedded between documents within the same application, or between documents in different applications if both applications support the embedding process. An embedded object maintains a connection to its original application, so that you can open the



35_045947 gl.qxd



1/4/07



452



10:13 PM



Page 452



PART VIII



■



APPENDIXES



original application and edit the embedded object by double-clicking the object. Embedded chart A chart object that has been placed on a worksheet. When a chart object is selected, you can move and resize it; when it’s activated, you can select items and add data. You can also move, format, and resize items in the chart, depending on the item. Embedded charts are linked to source data and are updated when the source data changes. Empty text Text without characters, or null text; for example, a pair of quotes with nothing between them (“”). Enter You manually enter data in a cell when you type and then press Enter, Tab, or an arrow key, or click in a different cell. Using any of the nontyping data-entry techniques, such as AutoFill, AutoCorrect, AutoComplete, and Pick From List, also enters data in a cell. External reference In a formula, a reference to a cell, range, or named area in a different worksheet or workbook. Field A column in a database. Each field (column) in a database contains a unique category of data, and each cell in a database shares a common characteristic with other cells in the same field (column). Fill color



The background color of a cell or a graphic object.



Fill handle The small, black square in the lower right corner of the selected cell or range. When you position the mouse pointer over the fill handle, the pointer changes to a black cross. Drag the fill handle to copy contents to adjacent cells or to create a series. Right-dragging the fill handle displays a shortcut menu. Filtering



Hiding all data that doesn’t meet specific criteria.



Floating toolbar A toolbar that is not docked at the edges of the application window. A floating toolbar stays on top of all Excel windows within the program window. Font A collection of letters, numbers, and special characters that share a consistent and identifiable typeface, such as Arial or Times New Roman. Font color



The color of characters displayed in a cell.



Forms toolbar The toolbar that holds the buttons for creating worksheet controls (not ActiveX controls).
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Formula A sequence of values, cell references, names, functions, or operators that is contained in a cell and produces a new value from existing values. A formula always begins with an equal sign (=). Formula bar A bar above the worksheet in which you type or edit values and formulas in cells or charts; displays the formula or constant value from the active cell or object. Function A built-in formula that uses a series of values (arguments) to perform an operation and returns the result of that operation. You can use the Function Wizard to select a function, fill in the arguments, get help with the function, and enter the function into a cell. General number format General is the default number format for all cells on a new worksheet. In the General format, Excel displays numbers using integer format (for example, 125), decimal fraction format (for example, 125.42), or scientific notation (for example, 125E+07) if the number is longer than the width of the cell. The General format displays up to 11 digits, numbers are right aligned, text is left aligned, and logical and error values are centered. When you enter data into a cell formatted as General, Excel usually assigns another built-in format (such as Date) based on what you enter. Global A setting or procedure that applies throughout a worksheet, workbook, or document. For example, if you click Replace All in the Find and Replace dialog box (to replace all instances of a specific word in a worksheet or document), you run a global find-and-replace procedure. Goal seek A tool for finding the input value a formula needs in order to return a specific result. You can enter your goal value, select the variable that you want to change, and then let Excel find the input value that returns your goal result. Graphic object A line or shape (button, text box, ellipse, rectangle, arc, picture) you draw using the tools on the toolbar, or a picture you paste into Excel. Gridlines (Chart) Lines on a chart that extend from the tick marks on an axis across the plot area. Gridlines come in various forms: horizontal, vertical, major, minor, and combinations. They make it easier to view and evaluate data in a chart.
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Group Box control A control composed of a bordered area containing a group of option buttons, only one of which can be selected at a time. A group box serves to segregate groups of option buttons from other option buttons in a worksheet or form, as well as visually segregating controls for easier reading. Group In an outline or PivotTable, one or more detail rows or columns that are adjacent and subordinate to a summary row or column. Handles Small black squares located around the perimeter of selected graphic objects, chart items, or chart text. By dragging the handles, you can move, copy, or resize the selected object, chart item, or chart text. Hardcode Specific, nondynamic data or settings that will not change, such as specific numbers in a formula or VBA procedure. See Static. Hyperlink Word, phrase, or icon that links to another file or Web page; when you click a hyperlink, the linked file or Web page opens. Hyperlinks are usually colored and underlined. Insertion point A flashing vertical line that shows the text entry point. Also known as the cursor. Iteration Repeated calculation of the worksheet until a specific numeric condition is met. When iteration is used, Excel can solve formulas containing circular references. Also, Goal Seek and the Solver add-in use iteration to solve problems. Keyword A VBA programming word that has a specific meaning in the Visual Basic Editor, such as Not, True, False, Sub, and End Sub. Keywords, when spelled correctly, appear in blue in completed statements in a macro. Label control A worksheet control consisting of text you provide for the user, including control names, instructions, and cautions. Legend A box containing legend entries and keys that help to identify the data series or categories in a chart. The legend keys, to the left of each entry, show the patterns and colors assigned to the data series or categories in the chart. Link A data connection between a dependent worksheet (the worksheet that uses the data) and a source worksheet (the worksheet in which



35_045947 gl.qxd



1/4/07



10:13 PM



Page 455



GLOSSARY



455



the original data resides). Because of the link, the dependent worksheet is updated whenever the data changes in the source worksheet. You can link graphics, text, and other types of information between a source file and a dependent file. Linked picture A picture object that’s linked to a specific range of cells or to a specific part of a file in another program. A linked picture is dynamic; it always reflects (or can be updated to reflect) the current contents of the source range or file. List A range of cells containing data that is related to a particular subject or purpose. The terms table and list are used interchangeably. (Similar but not to be confused with the new Excel 2003 “list,” which I refer to as a dynamic list.) List Box control A worksheet control that displays a list of items from which a user can choose a value. Logical group (option button control) A group of values that’s exclusive to a group of option buttons. When option buttons are not enclosed in a group box control, all the option buttons on the worksheet are part of the same logical group; when option buttons are enclosed in a group box control, those grouped option buttons are part of a logical group that’s separate from the rest of the worksheet. Macro A sequence of VBA commands in a module. You can write or record a macro, and then run the macro to automate your work. A macro can be assigned to a shortcut key, button, or object for easy use. Mixed reference In a formula, a combination of a relative reference and an absolute reference. A mixed reference takes the form $A1 or A$1, where A is the column cell address and 1 is the row cell address. The dollar sign ($) denotes the absolute portion of the reference. Module The part of a VBA project in which VBA procedures are stored. When you open a module, the VBA procedures (macros) in that module are displayed in the Code window of the VBA Editor. Moving average A sequence of averages computed from adjacent points in a data series. In a chart, a moving average smoothes the fluctuations in data, thus showing the pattern or trend more clearly.
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Name A unique identifier you create to refer to one or more cells, a formula, or an object. When you use names in a formula, the formula is easier to read and maintain than a formula containing cell references. Named formula A formula that’s given a name in the Define Name dialog box; a formula name can be used in place of a lengthy formula in a cell, and is the only means of redirecting a linked picture to alternate pictures. Nested functions Serve as arguments within other functions/formulas; the inner (contained) functions are called nested. Functions can be nested 64 levels deep in a formula. Nested subtotals Multiple levels of subtotals within a table that provide additional levels of detail. Node (Visual Basic Editor) The icon in the Project window with which you navigate to code in a specific part of a VBA Project. Normal Style The style used by all cells on worksheets until another style is applied. Option Button control A button for selecting one of a group of mutually exclusive options. Place two or more option buttons in a Group Box to group them and segregate them from other option buttons in a worksheet. Outline A summary report of worksheet data that contains up to eight nested levels of detail data and summary data for each level of detail. The user can change the view of the outline to show or hide as much detail as needed. Page change (scroll bar control) The incremental jump in value produced by clicking in the middle of a scroll bar instead of on one of the scroll buttons. Pane Panes allow you to view different areas of a large worksheet simultaneously. You can horizontally or vertically split a window into two panes or split a window both vertically and horizontally to display four panes, and you can freeze panes to keep some data frozen in view while you scroll through the rest of the worksheet. Parse To separate imported data into discrete columns in a worksheet. Parsing is accomplished by setting delimiter characters during the text import process. Password A secret word or expression that prevents access to a protected item by unauthorized users.
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Personal macro workbook A hidden workbook that contains macros that are available in every open workbook every time you start Excel. When you record a macro, you can choose to save it into your personal macro workbook. Pick from list An automated means of quick data entry that maintains data integrity; when you right-click a cell and click Pick From List, you see a list of all the entries in that column, and can click an entry to enter it in the cell. PivotTable An interactive worksheet table that summarizes data from existing databases, lists, and tables. Use the PivotTable Wizard to specify the database, list, or table you want to use, and to arrange the data in the PivotTable. Once you create a PivotTable, you can reorganize the data by dragging fields and items. PivotTable column field A field that is assigned a column orientation in a PivotTable. Items associated with a column field are displayed as column labels. PivotTable data area The part of a PivotTable that contains summary data. Values in each cell of the data area represent a summary of data from the source records or rows. PivotTable data area label In a PivotTable, the cell in the upper left corner that identifies the source field for the data area and the function used to calculate the values of cells. For example, a data label for a data area calculated using the default summary function in the Sales field reads “Sum of Sales.” PivotTable data field A field in a source list or table that contains data you want summarized in a PivotTable. A data field usually contains numeric data, such as statistics or sales amounts, but it can also contain text values. Data from a data field is summarized in the data area of a PivotTable. PivotTable detail item field in a PivotTable.



An item associated with an inner row or column



PivotTable field A category of data that is derived from a field in a source list or table. For example, the Year field in a source list or database becomes the Year field in a PivotTable. Items from the source list or table, such as 2004, 2005, and so on, become subcategories in the PivotTable.
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PivotTable grand totals Total values for all cells in a row or all cells in a column of a PivotTable. Values in a grand total row or column are calculated using the same summary function used in the data area of the PivotTable. PivotTable item A subcategory of a PivotTable field. Items in a PivotTable are derived from unique items in a database field or from unique cells in a list column. In a PivotTable, items appear as row, column, or page labels. PivotTable page field A field that is assigned to a page orientation in a PivotTable, in the upper left corner above the PivotTable. Only one item in a page field is displayed in a PivotTable. PivotTable row field A field that is assigned a row orientation in a PivotTable. Items associated with a row field are displayed as row labels. PivotTable subtotal A row or column that displays the total of detail items in a PivotTable field, using a summary function you choose. Plot area The area of a chart in which data is plotted. In 2-D charts, it is bounded by the axes and encompasses the data markers and gridlines. In 3-D charts, the plot area includes the chart’s walls, axes, and tickmark labels. Precedents



Cells that are referred to by the formula in the active cell.



Precision The number of digits Excel uses when calculating values. By default, Excel calculates with a maximum of 15 digits of a value (full precision).Excel rounds values to the number of digits displayed on the worksheet before calculating. Numbers in General format are always calculated with full precision, regardless of the Precision As Displayed setting. Print area



The area of a worksheet that is specified to be printed.



Print titles Worksheet rows and/or columns that are printed at the top or left of every page. For example, if you select row 1 for a print title, row 1 values are printed in the top on every page. If you select column A for a print title, column A values are printed in the left column of every page. Print titles are part of the worksheet, not in the margin like headers and footers. Procedure (VBA) Project (VBA)



See Macro.



See VBA project.
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Project window The Visual Basic Editor window in which the object, module, and userform nodes for each open workbook are listed. You navigate to the code in different parts of a VBA Project by double-clicking nodes in the Project window. Query In Microsoft Query, a means of finding the records that answer a particular question you ask about the data stored in a data source. Query definition Information that Microsoft Query uses to connect to and determine which data to retrieve from a data source. A query definition can include table names, field names, and criteria. A query definition is sent to a data source for execution in the form of a Structured Query Language (SQL) statement. Range Two or more cells on a sheet. Ranges can be contiguous or noncontiguous. Record A single row in a list or table. The first row of a table usually contains field names, and each additional row in the database is a record. Each record in the table contains the same categories (fields) of data as every other record in the table. Reference The location of a cell or range of cells on a worksheet, indicated by column letter and row number. For example, B2 and C3:D4 are references. Reference style The method used to identify cells in a worksheet. In the Al reference style, columns are lettered and rows are numbered. In the R1C1 reference style, R indicates row and C indicates column, and both rows and columns are numbered. Reference type The type of reference: absolute, relative, or mixed. A relative reference (for example, Al) in a formula indicates the location of the referenced cell relative to the cell containing the formula. An absolute reference (for example, $A$1) always refers to the exact location of the referenced cell. A mixed reference (for example, $A1; A$1) is half relative and half absolute. Refresh



Update a pivot table or a query.



Regression analysis A form of statistical analysis used for forecasting. Regression analysis estimates the relationship between variables so that a new variable can be predicted from existing variables.
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Relative reference Specifies the location of a referenced cell in relation to the cell containing the reference. A relative reference takes the form A4, C12, and so on (no dollar signs). Result cell A cell on the worksheet that is recalculated when a new scenario is applied. Result set



The set of records that results from running a query.



Route Send a workbook through e-mail to one or more other users, and have the workbook send itself to the next person on the list (or back to you) when the current user sends it to the next recipient. Row



A horizontal set of cells. Each row is identified by a unique number.



R-squared value In regression analysis, a calculated value that indicates how valid the correlation between two sets of data is for interpolating or extrapolating new data points. Scale In a chart, the scale determines what value tick-mark labels are displayed on an axis, at what intervals the values occur, and where one axis crosses another. Scenario A named set of input values that you can substitute in a worksheet model to perform a what-if analysis. Scenario Manager rize scenarios.



A feature that allows you to create, view, and summa-



Scroll bars The shaded bars along the right side and bottom of the Excel window. With the scroll bars, you can scroll from top to bottom in a long sheet, or from side to side in a wide sheet. Scroll Bar control A worksheet control that looks like a scroll bar, used for changing a displayed value in specified increments. Scroll Lock With Scroll Lock on, the arrow keys move the active sheet, column by column and row by row, rather than moving the active cell within the worksheet. Secondary axis In a chart with more than one series, a secondary axis allows you to plot a series or a chart type group along a different value axis, so that you can create two different value scales in the same chart. Sheet tab shortcut menu A shortcut menu containing commands relative to Excel sheets. To display the sheet tab shortcut menu, right-click a sheet tab.
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Shortcut menu A menu that shows a list of commands relative to the selected item. To display the shortcut menu for an item, right-click the item. Solver An add-in program that calculates solutions to complex problems based on adjustable cells, constraint cells, and, optionally, cells that must be maximized or minimized. You must install the Solver add-in before you can use Solver. Sort key



The field name or criteria by which you want to sort data.



Sort order An arrangement of data based on value or data type. An ascending sort order sorts text from A to Z, numbers from the smallest negative number to the largest positive number, and dates and times from the earliest to the latest. A descending sort order is the opposite of an ascending sort order, except for blanks, which are always sorted last. If you choose a custom sort order, an ascending sort order is the order in which the items appear in the Sort Options dialog box. Source data for PivotTables The list, database, or table used to create a PivotTable. Source data can be an Excel list or database, an external data source such as a dBase or Microsoft Access file, Excel worksheet ranges with labeled rows and columns, or another PivotTable. Source worksheet The worksheet referred to by an external reference formula. The source worksheet contains the value used by the external reference formula. Spinner control A worksheet control composed of a pair of arrow buttons for increasing or decreasing a displayed value in specified increments. Split bar The horizontal or vertical line dividing a split worksheet. You can change the position of the split bar by dragging it, or remove the split bar by double-clicking it. Standard font The default text font for worksheets. The standard font is the default font for the Normal cell style. You can change the standard font on the Home tab. Startup directory A directory named XLSTART in which you save workbooks or other files that you want to open automatically when you start Excel. Templates placed in this directory are not opened automatically, but are listed in the New dialog box (displayed by choosing File  New).
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Static An entry that is not dynamic (that is, does not change when data in the worksheet changes). For example, a formula that calculates a specific tax rate (rather than referencing a cell that contains the tax rate) calculates a static tax rate argument. See Hardcode. Status bar The bar at the bottom of the screen that displays information about the selected command or tool, or an operation in progress. Structured Query Language (SQL) updating, and managing data.



A language used for retrieving,



Style A named combination of formats that can be applied to a cell or range. If you redefine the style to be a different combination of formats, all cells to which the style was applied automatically change to reflect the new formats. A style can include (or exclude) formats for number, font, alignment, borders, patterns, and protection. Summary function A type of calculation that you direct Excel to use when combining source data in a PivotTable or a consolidation table, or when inserting automatic subtotals in a list or database. Examples of summary functions include Sum, Count, and Average. Table A range of cells containing data and bounded by empty columns and rows. Target cell The cell that you want Solver to set to a minimum, maximum, or specific value by adjusting the changing cells defined in the problem. The target cell should contain a formula that depends, directly or indirectly, on the changing cells. Template A workbook that you create and then use as the starting point for new workbooks. Template file names end in .xltx. Text box



A rectangular graphical object in which you can type text.



Tick marks In a chart, small lines that intersect an axis like divisions on a ruler. Tick marks are part of and can be formatted with an axis. Tick-mark labels Labels that identify the categories, values, and series in a chart. They come from and are automatically linked to cells in the worksheet selection. They can be formatted like other chart text. Title bar The bar across the top of the main application window that contains the program name, Microsoft Excel, and the active workbook name.
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Trendline A graphical representation of a mathematical trend in data. Trendlines are used to study problems of prediction, also called regression analysis. Trendline label Optional text for a trendline, including either the regression equation or the R-squared value, or both. A trendline label may be formatted and moved; it cannot be sized. Unattached text (floating text) Text that is not linked to a chart object and can be moved anywhere on the chart. A text box is an example of unattached text. VBA (Visual Basic for Applications) for Microsoft Office programs. VBA project



VBA is the programming language



The container for all the VBA code in a specific workbook.



Web query A query to extract data from a Web page into an Excel worksheet. As long as the Web page doesn’t change, the data can be refreshed as often as you like without rebuilding the query. Wildcard character A character (? or *) that stands in for one or more other characters in search criteria when finding or filtering data. An asterisk (*) represents any number of characters. A question mark (?) represents any single character in the same position as the question mark. To search for a literal question mark or asterisk, precede it with a tilde (~). For example, to search for asterisk, search for ~*. Workbook



An Excel file. It contains at least one worksheet or chart sheet.



Working directory The directory that Excel first makes available to you when you choose File  Save As or File  Open. Worksheet The primary document you use in Excel to store and manipulate data. A worksheet consists of cells organized into columns and rows, and is always part of a workbook. X-axis The category axis in a chart. On most charts, categories are plotted along the x-axis. On a typical column chart, the x-axis is the horizontal axis. XY (scatter) chart A 2-D chart that has numeric values plotted along both axes, rather than values along one axis and categories along the
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other axis. This type of chart is typically used to analyze scientific data to see whether one set of values is related to another set of values. Y-axis The data axis in a chart. On most charts, data values are plotted along the y-axis. On a typical column chart, the Y-axis is the vertical axis. When a secondary axis is added, it is a secondary y-axis.
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#### error, 108 ####### date or time result, 138 negative date or number, 168 % (percent symbol), 50 & (ampersand), as shorthand for CONCATENATE, 128 * (asterisk) wildcard character, 463 = directly opening functions, 114 typing formula without, 132 ~ (tilde), 463 , (comma), separating groups of numbers, 50 - (minus sign) before numbers, 50 ( ) parentheses enclosing function arguments in, 112 enclosing numbers in, 50 ? (question mark) wildcard character, 463 3-D bar chart, 256 3-D charts defined, 448 rotating, 274–275 3-D shading, applying to group box, 393 15-digit precision, 174 24-hour format, entering times in, 51 100% stacked-column chart, 258



A absolute references cell names created with, 98 defined, 459 described, 91, 447



Access moving data between Excel and, 366–367 querying, 199 accounting style, 176 underlines, 146 Accounting Number Format button, 164 actions, undoing, 65 active cell, 9, 425, 447 Active Field group, 230 active window, 447 active worksheet, 30, 447 ActiveX controls, 383 actual values, 163, 173–175 Add Scenario dialog box, 208, 209 add-ins, 218, 447 Add-Ins Quick Access Toolbar, 8 addresses, 89, 447 Advanced Filter dialog box, 192 Advanced options, setting, 380–381 alignment commands, 298 Ribbon groups, 143–144 snapping check boxes into, 434 Alignment tab for Format Cell dialog box, 152–153, 156 for Merge and Center button, 159 Alt+Enter, 56, 157 Alt+F4, quitting Excel using, 25 ampersand (&), field coding in headers and footers, 337 anchor cell, 130 AND filter, 191 answers, finding and comparing, 203–222



465



Index



Symbols and Numerics
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466 antivirus programs, 418 apostrophe (‘), at beginning of numbers, 50 application-level setting, 55 Apply Names dialog box, 104 area chart, 256, 257 arguments defined, 447, 453 with functions, 112 in SUBTOTAL function, 118–119 arithmetic operators, 92–93 Arrangement group, 297 array formulas, 214 arrow, converting to lines, 293 arrow keys, 37 ascending sort order, 183, 461 Assign Macro dialog box, 398–399, 408 asterisk (*) wildcard character, 463 auditing formulas, 106–107 AutoCalculate, 85–87, 120 AutoComplete, 61, 447 AutoCorrect defined, 448 described, 62–63 dialog box, 63, 379 options, 63, 379 AutoFill copying formulas using, 95–96 creating custom lists using, 63–64 date-filling behavior, 60 defined, 448 filling number series using, 59–60 options button, 59 with UPPER, LOWER, and PROPER, 127–128 AutoFilter, 188–189 AutoLists, 427 automation formatting, punctuation for, 50 page breaks, 319 saving backup files, 20 AutoRecover, 20–21 AutoShapes, creating, 299–300 AutoSum changing function in, 88 COUNT calculation, 120 described, 85, 87–88 on Formulas tab, 192, 193 AVERAGE calculation by SUBTOTAL function, 119



INDEX



AVERAGE function, 115, 116 axes category, 245, 463 data, 464 defined, 448 format, 270 number-formatted, 266 scale, changing, 269–271 secondary, 281–283, 460 x-, 448, 463 y-, 448, 464



B backup files, automatically saving, 20 bar chart, 256, 257 BeforeClose macro, 429–431 blank cells, 115, 184 blank lines, creating in macros, 429 bold, applying, 145 Boolean values, defined, 448 border(s), 146–148, 260 Border tab, Format Cells dialog box, 148 bubble chart, 258, 259 business data, moving averages in, 280–281 button control creating, 398–399 defined, 448 described, 387 button, worksheet, 386



C calculation function in AutoSum, 88 changing, 86, 174 in PivotTable, 237–239, 245 calculations basics of, 85–110 simple, 85–89 calculator, 88–89 Camera button adding, 305 taking pictures of selected cells, 438–439 taking pictures of different areas, 312 capital letters in names, 99 category axis, 245, 463 cell(s), 28 active, 9, 425, 447 adding to formulas, 106
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address, 117, 447, 448 becoming Word tables, 360 blank, 115, 184 changed in shared workbooks, 346 changing in Solver, 218, 220 clearing selected, 65 color in, 148–152 copying, 74 cutting, 74 data entry, into, 49–50, 52, 57–58 defined, 448 deleting, 79 dependent, 106, 107 entries, editing, 69–70 formatting, 72, 143–161, 448 formulas, entering, 93 identified by references, 90 inserting, 79 joining displayed values in multiple, 128–129 linked, 384–385, 440 merging, 158–159 naming, 95, 98–105 number formats, 163–164 opening, 9 parsing, 80–81 pasting, 74, 304–306 rearranging, 79–80 recording macro to select list, 406 result, defined, 460 selecting, 18, 39, 69, 114, 438 starting new line in, 56–57 text, fitting in, 152–160 unlocking, 354 wrapping text in, 156–157 cell references about, 89–90 defined, 89 replacing in formulas, 105 versus static entries, 93 types, 90–92 CellAbove, 134–135 Center button, Format Cells dialog box, 159 centering check box over cells, 433 data on page, 325, 326 Change Chart Type dialog box, 288 change conflicts, resolving, 347 changes history of, 349–350 in shared workbooks, 346–351



467 showing over time, 256 tracked, accepting and rejecting, 348–349 chart(s). See also embedded chart; PivotChart 3-D, 274–275, 448 3-D bar, 256 100% stacked-column, 258 activating, 447 adding titles to, 268–269 adding trendlines to, 276–281 area, 256–257 bar, 256–257 bubble, 258–259 changing data on, 260–261 column, 256 combination, 256, 268, 283 compared to PivotCharts, 242 cone, 256 creating, 245, 251–254 custom formats for, 286–288 cylinder, 256 defined, 448 doughnut, 258 formatting, 265–288, 338–340 as graphic objects in Word, 360 instant, 252 instant, creating, 252 layout of, changing, 261–262 line, 256–257, 268 location of, changing, 263 object, 448 organization, 303–304 organization, creating, 303–304 pasting into PowerPoint slides, 367 pie, 256, 258, 272–274 printing, 315, 338–340 pyramid, 256 radar, 258, 259, 448 scatter, 448 sorting data in, with PivotChart, 245 stock, 258, 259 surface, 258, 259 text, 448–449 types of, 253, 256–260, 449 XY Scatter, 259–260, 276, 463–464 chart area, 448 chart elements deleting, 269 formatting, 266–269 resizing or repositioning, 242



36_045947 bindex.qxd



1/4/07



10:13 PM



Page 468



468 chart elements (cont.) selecting, 266–267 small, grabbing, 267 chart presentation, sample worksheet, 437–442 chart sheet adding data to, 261 defined, 251, 448 printing, 315 Chart tab, Page Setup dialog box, 338–340 chart toolbar, 449 Chart Tools tab on the Ribbon, 267 Chart Wizard, 252–254 Charts group, 254–255 check box centered over cells, 433 creating, 397–398 Group similar taskbar buttons, 16, 17 Hidden, in Protection tab, 354 Locked, for controls, 389 snapping into alignment, 434 unlinked, 398 in worksheet, 386 check box control, 387, 449 check mark button, 9 checkbook calculator sample worksheet, 423–431 Choose Data Source dialog box, 194, 196 Choose SmartArt Graphic dialog box, 303–304 circle circumference of, 92 drawing, 293 Circle Invalid Data button, 110 circular reference defined, 449 message error, 108 option, 110 clip art, 286, 301–303 Clip Art task pane, 286, 301, 302 Clipboard pane, 74–75, 449. See also Office Clipboard closing Excel, 25 windows, 24, 43 workbook files, 24 Code window defined, 449 in Visual Basic Editor, 408, 410–412



INDEX



Collapse/Expand icon, 114 colon (:) in range reference, 90 in time entries, 51, 52, 167 colors adding in cells, 148–152 applying from palette, 295, 296 custom, creating, 151–152 selecting scheme for, 378 Colors dialog box, 148, 149, 151–152 column(s) address, 447 defined, 449 deleting, 77 freezing, 40 hiding, 157–158, 207, 312, 437 inserting, 78 labels, printing on every page, 329–332 multiple, creating, 80–81 in PivotTable, 224 rearranging, 79–80 referencing entire, 90 repeating entries in, 61–62 selecting, 39 sorting, 185 switching to rows, 159–160 width of, 154–156 worksheet, 28 column chart, 256 combination chart, 256, 268, 283 combo box, 384, 389, 390–391 combo box control, 387, 449 combo drop-down control, 388 combo list control, 388 comma, separating groups of numbers, 50 comma style, 165, 176, 177 command bar, 449 comments adding to worksheets, 81–82 in changed cells, 346 defined, 449 in macros, 411, 412 communications device, shared workbook as, 344 Compare Side by Side command, 43–45 comparison operators, 449 CONCATENATE function, 128–129, 136–137
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conditional formatting applying, 171–173 defined, 450 MAX and MIN with, 119–120 in time-log template, 436 cone chart, 256 conflicts. See change conflicts Consolidate dialog box, 204–205 consolidation compared to PivotTable creation, 224 of data, 203 of tables, 204–205 consolidation tables, creating, 204–205 constant, 450 constant value, 100 constraints defined, 450 Solver, 219, 220–221 Control tab of Format Control dialog box, 392–396, 435 of Format Object dialog box, 397 controls. See also worksheet controls ActiveX, 383 adding to worksheets, 383–399 button, 387, 398–399, 448 check box, 387, 449 clicking, 389 combo box, 387, 449 combo drop-down, 388 combo list, 388 form, 386–388 formatting, 388 Group Box, 387, 454 label, 388, 454 List Box, 387, 455 Option Button, 387, 456 Scroll Bar, 388, 460 spin button, 387 spinner, 461 text field, 388 CONVERT function, 131–132 Convert Text to Columns Wizard, 80 Convert to Range option, 66–67 Copy dialog box, 34 Copy to Collection dialog box, 301 copying cells, 74 data, 73–76 dialog boxes, 34, 301 formatting, 160–161



469 formulas, 94–96 history sheets, 349 lists, from Word into Excel, 365 shapes, 294 workbook styles, 178 worksheets, 33, 33–35 COUNT calculation by SUBTOTAL function, 119 COUNT functions, 120–122 COUNT NUMS calculation, 120 COUNTA calculation, 119, 120, 133 COUNTIF function, 121–122, 432, 434–435 Create Chart dialog box, 242–243 Create Names dialog box, 100 Create New Data Source dialog box, 194–195, 196 Create PivotTable dialog box, 225–226 Create PivotTable with PivotChart dialog box, 244 criteria for data validation, specifying, 68 defined, 450 filtering with, 189–192 Ctrl copying worksheets using, 33 dropping data into Access using, 367 Ctrl+’, 53, 58, 94 Ctrl+; (semicolon), 53, 127 Ctrl+A, 39 Ctrl+B, 145 Ctrl+Backspace, 38 Ctrl+C, 53, 74 Ctrl+click, 16, 58, 316 Ctrl+D, 53, 58 Ctrl+Down Arrow, 406 Ctrl+End, 37, 38 Ctrl+Enter, 53, 58 Ctrl+F, 70, 72 Ctrl+F1, 376 Ctrl+H, 72 Ctrl+Home, 37, 40 Ctrl+I, 145 Ctrl+O, 14 Ctrl+Pg Dn, 37 Ctrl+Pg Up, 37 Ctrl+R, 58 Ctrl+Shift+;, 53 Ctrl+U, 145 Ctrl+V, 53, 57, 74 Ctrl+X, 53, 57, 74
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470 Ctrl+Y, 65 Ctrl+Z described, 53, 63, 65, 74, 230, 367 fixing macro using, 416 undoing Replace All using, 73 undoing rotation using, 274 undoing sort using, 188 using undo for best fit, 155 Currency style, 176, 177, 215 currency symbol, 50 cursor, 450. See also insertion point custom named view, printing, 314 CUSTOM.DIC, 83 Customize Quick Access Toolbar option, 7 customizing chart formats, 286–288 colors, 151–152 Excel, 377–378 formats, 168, 169–171 headers and footers, 333, 334–336 lists, 63–64, 187 number format, 175 sort order, 187, 450 styles, 177 zoom setting, 46 cylinder chart, 256



D dashes in numbers, 51 data centering on page, 325, 326 copying, 73–76 deleting, 64–65 entering, 49–50, 52, 53–54 finding and replacing, 70–73 linked, freezing, 362 moving, 73–76, 364 organizing, 183–201 pasting, 360, 367 presenting with charts, 251–263 sending to Access, 366–367 sending to Word, 358–365 summarizing with PivotTables, 223 validating, 67–69 data area in PivotTable, 224 data axis, 464 data entry, techniques, 52–65 Data group, PivotTable Tools tab, 230
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data labels adding to charts, 266, 284 defined, 450 deleting, 285 described, 283–285 formatting, 284 data markers defined, 450 printing, 339 data points correlation of, 277 defined, 450 missing, interpolating, 268 Data Quick Access Toolbar, 8 data range, changing, 261 data series defined, 450 for moving average, 281 reordering, 271 data sharing, 358–365. See also shared workbooks data source defined, 450 for Query Wizard, 194–196 range, changing, 228 data tables comparing answers with, 212–215 creating instant charts using, 252 data validation, 67–69 Data Validation dialog box, 67–69 Databases tab list, 194 date calculating, 138 current, entering, 53 formatting, 51–52, 167–168 unchanging, entering, 127 Date and Time functions, 138 DAY function, 138 decimal equivalent, for fractions, 56 decimal fraction format, 453 decimal places, displaying, 165 decimal point, entering, 50 decision making, better, 203–204 Decrease Decimal button, 165 default folder, changing for documents, 18–19 default startup workbook, 451 default templates, changing, 23–24 Define Name dialog box, 134 Delete dialog box, 79
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deleting cells, 79 chart elements, 269 columns, 77 data, 64–65 data labels, 285 embedded Excel object, 364 linked objects, 363 macros, 417 names, 103 PivotTables, 229 queries, 199 rows, 77 shortcut icon label, 15 styles, 178–179 trendlines or text boxes, 280 worksheets, 36 delimiters, defined, 80, 451 dependent cells, 106, 107 dependent workbook, 98 dependent worksheet, 451 dependents, 451 descending sort order, 183, 184, 461 Design tab applying chart style using, 254, 255 on the Ribbon, 261, 262 desktop, starting Excel from, 4 destination area, 204, 205, 451 Developer tab on the Ribbon, 378, 386, 402 Diagnose button under Office Diagnostics, 12 diagrams, creating, 303–304 dialog boxes. See also Format Cells dialog box; Page Setup dialog box Add Scenario, 208, 209 Advanced Filter, 192 Apply Names, 104 Assign Macro, 398–399, 408 AutoCorrect, 63, 379 Change Chart Type, 288 Choose Data Source, 194, 196 Choose SmartArt Graphic, 303, 304 Colors, 148, 149, 151–152 Consolidate, 204–205 Copy to Collection, 301 Create Chart, 242–243 Create Names, 100 Create New Data Source, 194–195, 196 Create PivotTable, 225–226



471 Create PivotTable with PivotChart, 244 Data Validation, 67–69 Define Name, 134 defined, 451 Delete, 79 Edit Data Source, 261 Edit Hyperlink, 17 Error Checking, 109–110 Find and Replace, 71, 72 Format Axis, 270 Format Chart Area, 275 Format Control, 392–396, 435 Format Data Labels, 284 Format Data Point, 286 Format Data Series, 282, 286, 287 Format Object, 389–390, 391, 397 Format Trendline, 278, 279, 281 Function Arguments, 113–114, 122, 125, 132 Go To, 131, 133 Greater Than, 172 group launcher, 5 Header, 334, 335 Highlight Changes, 347–348, 349 Import Data, 198 Insert, 35, 79 Insert Function, 112–113 Insert Hyperlink, 17–18 Insert Picture, 301 Macro Options, 407 Move Chart, 246–247, 263 Move or Copy, 34 Name Manager, 100–103 New Formatting Rule, 173 New Web Query, 200–201 ODBC Microsoft Excel Setup, 195, 196 Paste Special, 361, 362 PivotTable Field, 238 PivotTable Field List, 226, 227, 231 PivotTable Options, 239 Print, 312, 313, 314, 316 Protect Sheet, 353–354, 355 Protect Workbook, 353 Publish as Web Page, 368–369 Replace, 71, 72 Resolve Conflicts, 347 Save As, 368 Scenario Manager, 208, 210, 211 Select Changes to Accept or Reject, 348
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472 dialog boxes (cont.) Select Workbook, 195, 345, 350 Sort, 186, 187 Sort Warning, 185 Spelling, 83–84 Subtotal, 206–208 dictionary, editing, 83 discontiguous selection, 451 displayed values, 9, 173–175 Distribute commands, 298 #DIV/0! error, 108 dollar signs ($), determining reference type, 91 double-clicking to best fit columns or rows, 155–156 doughnut chart, 258 .dqy extension, 199 draft quality, 339 dragging to change column width or row height, 154–155 Excel icon to desktop, 4 field buttons, to pivot layout, 230–231 field names, 231 fill handle, 58–59 hyperlinks into Excel, 367–368 ranges, 73, 73–74 to rotate 3-D charts, 274–275 to select chart data, 252 sheet tabs, 33–34 drawing basic shapes, 293–294 text boxes, 300 drilldown in PivotTable re-enabling, 239 for source data, 239 drop-down list, picking from, 61–62 duplicate entries, in long lists, 124 dynamic lists. See also list(s) AutoFilter applied to, 189 creating, 65–67 defined, 55, 451 source range for, 228 dynamic range defined, 451 defining, 133–135 testing, 133–134 using, 134–135 dynamic source range, 130, 228
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E Edit Data Source dialog box, 261 Edit Hyperlink dialog box, 17 editing cell entries, 69–70 dictionary, 83 footers, 336–337 in Formula bar, 106 formulas, 105–106 lists, 378 macros, 408, 413–417 names, 102–103 pictures, 303 range names, 102–103 Editing tab, Share Workbook dialog box, 345 e-mail messages sending tables of data as, 352 sending workbooks as attachments to, 351 embedded chart. See also chart(s) adding data to, 260 defined, 251, 452 moving, 262 printing, 315 resizing, 263 embedded objects, 358. See also objects compared to linked, 359 Excel, working with, 363–364 embedding, 451–452 empty text, 452 End Sub line of a macro, 411, 412 Enter defined, 452 moving active cells using, 53, 54 Entire workbook option, Print dialog box, 316 environment of Excel, 4–12 Formula bar, 8–10 Help button, 10 menus, 6–7 Microsoft Knowledge Base, 13 Office Diagnostics program, 12–13 Ribbon, 5 status bar, 10 task panes, 5–6 equations on charts, 279, 280
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mathematical, visual representation of, 277 quadratic, solving with Goal Seek, 217 error(s) #### error, 108 circular reference, 108 #DIV/0! error, 108 in formulas, locating, 109 in macros, fixing, 416–417 #N/A error, 108 #NAME? error, 108 #NULL! error, 108 #NUM! error, 108 #REF! error, 108 #VALUE! error, 108 in worksheets, locating, 108–110 Error Alert tab, stop style on, 110 Error Checking dialog box, 109–110 Esc, 53, 69 Excel Access and, sharing data, 366–367 controls in, types of, 383 default window, 4 embedded object from, working with, 363–364 icon, dragging to desktop, 4 personalizing features of, 377–378 quitting, 25 starting, 3–4 Word and, sharing data, 358–365 Excel table. See table extensions, file, 22 External Data toolbar buttons, 198 external reference, 452



F field(s) defined, 452 filtering with, 191 in lists, 183 PivotCharts, removing, 233, 245 PivotTables, adding, 231–232, 245 sorting lists by, 184–185 field buttons, 230–231 field label in PivotTable, 224 file(s), creating hyperlinks to, 17–18 file extensions, 22 file icons. See icon(s) file properties, settings, 19–20



473 fill color, 148, 452 Fill Color button, 148–149 fill handle, 58–59, 452 Fill tab, Format Cells dialog box, 149–151 filtering defined, 452 described, 183 ignoring cells hidden by, 118 records, 188–192 records, calculating, 192–193 setting criteria in Query Wizard, 197 Find and Replace dialog box, 71, 72 Find what box, 70, 72 finding. See also searching answers, 203–222 clip art, 286 data, 70–73 duplicate entries in long lists, 124 invalid data in worksheets, 109–110 specific entries in lists, 124 text strings, 70–71 fixed decimals entering numbers with, 54–55 macros turning on and off, 427–429 floating toolbar, 452 folder nodes, 409 font color, 148, 452 defined, 452 formatting, 144–146 Font and Alignment Ribbon groups, 143–144 Font button, Formatting toolbar, 145 Font section, Home tab, 148 Font tab settings, 145–146 footer(s) creating, 332–336 editing and customizing, 336–337 inserting pictures in, 336 prebuilt, 334 forced breaks, 157 form controls, 386–388 Format Axis dialog box, 270 Format Cells dialog box adding colors, 149–151 Alignment tab, 152–153, 156 applying formatting options from, 144 Border tab, 146–148
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474 Format Cells dialog box (cont.) Center button, 159 Number tab, 165–167, 168, 169–171 Protection tab, 354 Format Chart Area dialog box, 275 Format Control dialog box, 392–396, 435 Format Data Labels dialog box, 284 Format Data Point dialog box, 286 Format Data Series dialog box, 282, 286, 287 Format Object dialog box, 389–390, 391, 397 Format Painter, 160–161 Format Picture button, 336 Format tab on the Ribbon, 294–297 Format Trendline dialog box, 278, 279, 281 Format/Picture Tools tab, 302–303 formatting automatic, punctuation, 50 cell, 71, 72, 143–161 charts, 265–288 controls, 388 copying with Format Painter, 160–161 customizing, 169–171 data labels, 284 dates, 167–168 defined, 143 font, 144–146 graphic objects, 294–299 negative numbers as integers in, 175 numbers, 163, 239 objects, 294–297 PivotCharts, 246 positive numbers as integers in, 175 printed charts, 338–340 printed pages, 319–340 Ribbon buttons for, 164–165 streamlining, with styles, 175–179 text entries, 169 times, 167–168 trendlines and text boxes, 280 Formatting tab on the Ribbon, 267 Forms toolbar, 387, 452 formula(s). See also named formula auditing, 106–107 for checkbook calculator, 425–426 copying with AutoFill, 95–96 defined, 453 displaying, 94 editing, 105–106 errors in, locating, 109



INDEX



linked, updating, 98 linking worksheets or workbooks, 96–98 moving and copying, 94–96 names for, 100–101 tracing, 106–107 writing, 92–94 zeroes resulting from, hiding, 174 Formula Auditing toolbar, 109 Formula bar, 8–10, 106, 163, 453 formula cell, copying, 94–95 Formulas Quick Access Toolbar, 8 found-cells pane, Find and Replace dialog box, 71 fractions, entering, 56 free-floating text on charts, 266 freezing columns, 40 linked data, 362 panes, 39–40 rows, 40 Full Module View, Code window, 410 full-screen view, switching to, 374 function(s). See also calculation function AVERAGE, 115, 116 combining for more power, 132–138 common and useful, 114–132 CONCATENATE, 128–129, 136–137 CONVERT, 131–132 COUNTIF, 121–122, 432, 434–435 DAY, 138 defined, 111, 453 described, 85 HLOOKUP, 122 IF, 123–124, 135–136, 456 LEFT, 128, 137 LOWER, 127–128 MAX, 119–120 MIN, 119–120 MONTH, 138 names of, 112 NOW, 126–127 opening directly to, 114 PMT, 125–126, 213, 214, 215–216 PROPER, 127–128, 137 RIGHT, 128, 137 SUBTOTAL, 66, 115, 117, 192–193 SUM, 115–119, 436 SUMIF, 115, 116–117, 122, 204 TODAY, 126–127 UPPER, 127–128, 137
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using, 111–114 VLOOKUP, 122–123, 136, 157, 385 WEEK, 138 Function Arguments dialog box, 113–114 CONVERT section of, 132 PMT function, 125 for VLOOKUP, 122 Function Library, Formulas tab, 131 function name in the Select function list, 113 Function Wizard (fx button), 8, 112, 453



G General number format, 166, 453 global setting or procedure, 453 Go To dialog box, 131, 133 Goal Seek, 215–217, 453 graphic objects, 294–299, 453. See also shape(s) graphical object picture marker, 286 graphics file, using as picture marker, 286 Greater Than dialog box, 172 gridlines chart, 453 worksheet, 294, 337 group(s) Active Field, 230 Arrangement, 297 Charts, 254–255 Data group, PivotTable Tools tab, 230 defined, 454 Font and Alignment Ribbon, 143–144 Group, PivotTable Tools tab, 230 Picture Tools, 303 PivotTable Options, 230 on the Ribbon, 5 Shape Styles group, Format tab, 295 Shapes, 291–292 Show/Hide group, PivotTable Tools tab, 229 Sort group, PivotTable Tools tab, 230 Tools group, PivotTable Tools tab, 229 Group Box, 392, 393–394 Group Box control, 387, 454 Group, PivotTable Tools tab, 230 Group similar taskbar buttons check box, 16, 17 [Group] in program title bar, 30 grouping objects, 298–299 Growth Trend command, 60



H hand mouse pointer, 18 handles around chart data, 260 defined, 454 resizing charts using, 263 hardcode, 454. See also static entry hatched-line insert bar, 79, 80 header(s) creating, 332–336 editing and customizing, 336–337 inserting pictures in, 336 page, compared to print titles, 330 prebuilt, 334 Header and Footer buttons, listing of, 335–336 Header dialog box, 334, 335 Header/Footer tab, Page Setup dialog box, 333, 334 headings, 184, 185 Help button, 7, 10–12 help, getting, 10–12 Hidden check box, Protection tab, 354 hiding columns, 157–158, 207, 312, 437 details of inner fields, 233–234 details in PivotTable, 234, 239 items on category axis, 245 linked cells, 440 PivotChart buttons, 246 rows, 66, 157–158, 312, 437 sheet tabs, 37 worksheets, 37 zeroes, 174–175 Highlight Changes dialog box, 347–348, 349 history of changes, printing, 349–350 History sheet, 349 HLOOKUP functions, 122 Home, 37 Home Quick Access Toolbar, 8, 9 Home tab Font section on, 148 Paste menu from, 75 hyperlinks creating, 17–18, 368 defined, 454 dragging into Excel, 367–368 inserting in Word document, 367–368 removing, 18 selecting cells behind, 18
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I icon(s) adjacent, “lasso”ing, 16 Collapse/Expand, 114 More Functions, 131 Office Button, 7 placing on desktop, 14 Save Disk, 7 icon based menus, 6–7 IF formula, 440 IF functions, 123–124, 135–136, 456 Import Data dialog box, 198 Increase Decimal button, 165 indenting, entries, 153, 154 inner fields, 224, 233–234 Insert dialog box, 35, 79 Insert Function dialog box, 112–113 Insert Hyperlink dialog box, 17–18 Insert Picture dialog box, 301 Insert Quick Access Toolbar, 8 Insert tab, viewing chart types using, 253 inserting cells, 79 clip art, 301–303 columns, 78 hyperlinks, 367–368 logos, 301 pictures, 301–303, 336 rows, 78 insertion point, 454. See also cursor instant chart, creating, 252 integer format, 453 interest rate calculating, 212–213 entering in PMT, 125 interface, standard, 4 interpolating, missing data points, 268 invalid data, finding in worksheets, 109–110 invalid trendline, 276, 278 invoice numbers, creating unique, 136–137 italics, applying, 145 iteration, 454 iterative tool Goal Seek as, 215 Solver as, 218



K key. See legend entry keyboard shortcuts, 53, 403, 407
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keystrokes built-in, overriding, 404 moving or copying data, 74 running macro with, 406–407 keywords, 454 Keywords property, 19, 20



L label(s) creating, 399 rotated, 153, 154 label control, 388, 454 landscape orientation, 321, 322, 323 layout, changing for pages, 8, 29, 321 Layout dialog box, pivoting PivotTable in, 238 Layout tab on the Ribbon, 268, 269 LEFT function, 128, 137 legend, 454 legend entry, 266 legend keys, printing, 339 letter case, changing, 137 letter characters, displaying alongside numbers, 169 limiting values for data validation, 68 line(s) converting to arrows, 293 creating blank in macros, 429 drawing, 293 line breaks, 56–57 line chart, 256, 257, 268 link(s), 362, 454–455 linked cells, 384–385, 440 linked data, freezing, 362 linked formulas, updating, 98 linked objects, 358, 359, 361–363 linked picture, 455 linked text, 449 list(s). See also dynamic lists; table(s) copying from Word into Excel, 365 defined, 455 editing and creating, 378 finding specific entries in, 124 sorting, 183–188 list box, 384, 389–390 List Box control, 387, 455 Live preview, enabling, 378 loan, calculating using PMT, 125 loan-payment table, 126, 212–213, 214
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Lock Drawing Mode, 293 Locked check box for controls, 389 logical group, 391, 455 logos, inserting, 301 lookup table in VLOOKUP, 122 Lotus, compatibility with, 380 LOWER function, 127–128 lowercase letters, function names in, 112



M macro(s) attaching to objects, 408 blank lines in, creating, 429 for checkbook calculator, 427–431 combining from several modules, 410 defined, 401, 455 deleting, 417 editing, 408, 413–417 errors in, fixing, 416–417 introducing, 401–402 naming, 403 parts of, 410–412 on Quick Access toolbar, 407 recording, 403–406 running, 398, 406–408 storing, 401–402 testing, 414, 415 undoing actions performed by, 406 Macro Options dialog box, 407 macro shortcut keys, 403, 407 macro virus protection, 417–419 magnifying glass mouse, 310 major sort keys, 186 margins. See page margins mathematical equations, visual representation of, 277 MAX function, 119–120 menus, 6–7 Merge and Center button, Alignment tab, 159 Merge Styles, Style dialog box, 178 merging cells, 158–159 Microsoft Knowledge Base, 13 MIN function, 119–120 Mini Toolbar, 5, 378 Minimize command, 7 minimizing the Ribbon, 375–376 minor sort keys, 186 minus sign (-) before numbers, 50 mixed cell reference, 91, 455, 459



mock data, testing functions with, 114 modules defined, 455 in Visual Basic Editor, 410 MONTH function, 138 month name, typing in a date cell, 52 More Functions icon, Function Library, 131 mouse pointer, positioning over toolbar button, 5 Move Chart dialog box, 246–247, 263 Move or Copy dialog box, 34 moving active cells, using Enter, 53, 54 between cells, using Tab key, 53–55 data, 73–76, 364, 366–367 down columns in active cells, 425 embedded charts, 262 to end of worksheet used area, 38 formulas, 94–96 ranges, 73 worksheets, 33, 34–35 within worksheets, 37–38 moving averages, 280–281, 455 multiple windows, opening, 42–45 multithreaded calculations, 380



N #N/A error, 108 name(s) defined, 456 deleting, 103 editing, 102–103 Name box, 8, 89, 99 #NAME? error, 108 Name Manager dialog box, 100–103 named constant value, creating, 100 named formula. See also formula(s) in a cell, 102 creating, 103–104 defined, 456 described, 104–105 in picture object, 441 named ranges. See range names naming cells, 95, 98–105 macros, 403 OFFSET functions, 130 ranges, 99 worksheets, 31–32
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478 negative numbers formatting integers as, 175 time or date result as, 138 nested IF functions, 135–136, 456 nested subtotals, 456 nesting, 135 New Cell Style button, 177 New Formatting Rule dialog box, 173 New Web Query dialog box, 200–201 New Workbook, storing macro in, 402 nodes, 408, 456 nonadjacent areas, printing, 312 nonadjacent pages, printing, 313 normal style, 456 Not keyword, 415 NOW function, 126–127 #NULL! error, 108 null text, 452 #NUM! error, 108 number(s) with fixed decimals, 54–55 formatting in cells, 163 conditional, 171–173 in PivotTable, 239 possibilities for, 166–167 punctuation for, 50 styles preconfigured for, 176 series of, filling in, 59–60 sorted in alpha order, 184 Number format menu, Number section of Home Ribbon, 165, 166 Number Lock, turning on, 10 Number section, Home Ribbon, 164–165 Number tab, Format Cells dialog box, 165–171 number-formatted axis, 266



O objects. See also embedded objects; graphic objects; linked objects aligning and distributing, 297–298 attaching macros to, 408 chart, defined, 448 defined for data sharing, 358 formatting, 294–297 grouping, 298–299 rotating, 294 ODBC Microsoft Excel Setup dialog box, 195, 196



INDEX



Office Assistant, 12 Office Button icon, 7 Office Clipboard, 74 Office Diagnostics program, 12–13 Office menu, 7, 15 OFFSET, 130–131, 133 OFFSET range, 131 OFFSET/COUNTA formula, 228 one-input data table, 212–213 opening cells, 9, 70 directly to functions, 114 macros in Visual Basic Editor, 414, 416 Paste Names dialog box, 104 windows, 16, 42–45 workbooks, 14–17, 42, 343 option button(s), 384, 391–393, 439–440 Option Button control, 387, 456 OR filter, 191 organization charts, 303–304 orientation, 321, 322–323 Orientation button, Page Layout tab, 323 outer field in PivotTable, 224 outline, 207, 456



P page(s) layout of, 321 orientation of, 322–323 in PivotTable, 237 printing specific, 313–315 printing specific number of, 328–329 Page area, PivotTable, 236 page break, 319–321 Page Break Preview, 320–321 page centering, 325, 326 page change, 456 page fields, PivotTable, 224, 236 page headers, 330. See also header(s) Page Layout Quick Access Toolbar, 8 Page Layout View, 29 page margins changing, 325–328 chart, resizing and repositioning, 338 setting precisely, 326–327 setting visually, 327–328 Page Setup dialog box Header/Footer tab, 333, 334 Page tab, 328
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setting margins with precision, 326, 327 setting size/scale options, 338–340 Sheet tab, 323, 324, 331, 332 Page Setup tab on the Ribbon, 321 paging order, 323–324 panes, 39–40, 41, 456 parentheses enclosing function arguments in, 112 enclosing numbers in, 50 parsing, 80–81, 456 password, 456 Password to modify option, 356 Password to open option, 356 Paste Link option, 76 Paste menu, Home tab, 75 Paste Name dialog box, 103–104 Paste Options button, turning off, 59, 76 Paste Special dialog box, 361, 362 Paste Values option, 76 pasted data, 358 pasting cells, 74, 304–306 charts into PowerPoint slides, 367 data, 360 data into PowerPoint, 367 data into Word, 359 items, 74–76 names into formulas, 103–104 pictures, 301–302, 304–306 text, 365 values, 76 patterns applying from Format Cells dialog box, 148–149 applying to cell backgrounds, 149–151 payments in PMT, 125 Percent style, 176, 177 percent symbol (%), 50 Percentage Style button, 164 Personal Macro Workbook creation of, 409 defined, 457 storing macro in, 402 unhiding before deleting macros, 417 PERSONAL.XLSM file, 402 Pick From List option, 457 picture(s) of cells, 306 editing, 303 inserting, 301–303, 336 linked, 455



479 picture markers, 266, 285–286 picture styles, 303 Picture Tools group, 303 pie chart, 256, 258, 272–274 Pin to Start Menu option, 3 PivotChart. See also chart(s) compared to normal charts, 242 creating, 242–245 displaying PivotTables, 241–247 embedding on worksheets, 246–247 Filter Pane, 243 formatting, 246 hiding buttons, 246 rearranging, 245 pivoting, data, 223 PivotTable arrangement of, changing, 230–237 becoming Word tables, 360 calculations in, changing, 237–239 column field, defined, 457 creating, 198, 224–228 creating PivotCharts from, 242–243 data area, 457 data area label, 457 data field, 457 defined, 457 deleting, 229 described, 223 detail items, 234, 239, 457 displaying with PivotCharts, 241–247 grand totals, 458 item, 458 page field, 458 pivoting, 230–231 row field, 458 source data, 461 subtotal, 458 terms used, 224 using, 223–224 PivotTable field defined, 457 items in, 224, 234–235 PivotTable Field dialog box, 238 PivotTable Field List dialog box, 226, 227, 231 PivotTable Options dialog box, 239 PivotTable Options group, 230 PivotTable Tools tab, 229–230, 233, 234 PivotTable Wizard, 457 plot area, 262, 458
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480 PMT function described, 125–126 example of, 213, 214 Goal Seek with, 215–216 points, 145 portrait orientation, 321, 322, 323 positive numbers, formatting integers as, 175 PowerPoint, pasting Excel data into, 367 prebuilt header or footer, 334 prebuilt templates, 22–23 precedent, 458 precedent cells, 106, 107 precision, 174, 458 present value of a loan, 126 preset zoom settings, selecting, 45 previewing printed pages, 309–311 print area changing, 312 defined, 458 setting, 311–312, 315 Print button, toolbar, 310 Print dialog box, 312, 313, 314, 316 Print Preview, 310, 315, 327–328 print titles compared to page headers, 330 defined, 458 setting, 331 printed charts, formatting, 338–340 printed pages changing margins on, 325–328 formatting, 319–340 previewing, 309–311, 312 printers, margin limits of, 325 printing in black and white, 337, 339, 340 charts, 315, 338–340 custom named view, 314 history of changes, 349–350 nonadjacent areas, 312 nonadjacent pages, 313 quality, options for, 339 row/column labels, 329–332 selected ranges, 312–313 selective, options for, 311–312 specific number of pages, 328–329 specific pages, 313–315 worksheets, 310, 311–317, 337 Procedure View, in Code window, 410 PRODUCT calculation by SUBTOTAL function, 119



INDEX



production capacity, allocating, 219 project defined, 408–409 renaming VBA, 410 Project window, 408–410, 459 proofing options, 379–380 PROPER function, 127–128, 137 Protect Sheet dialog box, 353–354, 355 Protect Workbook dialog box, 353 Protection tab, Format Cells dialog box, 354, 355 Publish as Web Page dialog box, 368–369 punctuation for date or time formatting, 51–52 for numeric formatting, 50 pyramid chart, 256



Q quadratic equation, solving with Goal Seek, 217 query defined, 459 deleting, 199 described, 183, 193 other programs, 199 preparing to run, 193–194 reusing, 198–199 saving, 197 Query Wizard, 193–199 question mark (?) wildcard character, 463 Quick Access toolbar access to, 6–7 adding Camera button to, 305 attaching macro to, 407 customizing, 376–377 Quick Launch menu, adding Excel to, 4 Quick Print button, 311 quitting, Excel, 25



R R2 (R-squared) value, 276 radar chart, 258, 259, 448 RAND field, sorting on, 188 range(s) conditional formats for, 171 defined, 459 dragging between worksheets and workbooks, 73–74 moving to new location, 73 printing selected, 312–313
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pulling highest and lowest figures out of, 137 selecting, 39 range names appearing in arguments, 116 in data source, 196 described, 99 editing, 102–103 viewing, 46 range reference, 90 range tip, 73 raw data, 49 Read-only option for workbooks, 356 rearranging cells, 79–80 columns, 79–80 PivotChart, 245 rows, 79–80 worksheets, 33 record(s) defined, 459 filtering, 188–192 recording macros, 403–406 Redo button, Standard toolbar, 65 #REF! error, 108 reference, 459 reference range, Consolidate dialog box, 205 reference style, 459 reference types, 116, 459 Refresh All button, 198 Refresh button, 198 Refresh Data button, 224, 229 refreshing, 229, 459 regression analysis, 276, 459 relative references copying formula cell with, 95 defined, 459, 460 described, 91 recording macros with, 405–406 renaming project VBA, 410 worksheets, 32 Repeat option, 7 Replace All, undoing, 73 Replace dialog box, 71, 72 Replace with box, 72 replacing cell references in formulas, 105 data, 70–73 text strings, 72–73



481 Reset button, Visual Basic Editor Standard toolbar, 412–413 Reset Window Position button, 44 reshaping AutoShapes, 299 resizing chart elements, 242 embedded charts, 263 page margins in charts, 338 Resolve Conflicts dialog box, 347 re-sort column, adding, 188 Restore command, 7 Restore Window button, 35 result cell, 460 result set, 460 Review Quick Access Toolbar, 8 Review tab Changes group on, 344 managing comments using, 82 Ribbon, 5 adding Developer tab to, 402 alignment groups, 143–144 applying charts from, 254 Chart Tools tab, 267 Design tab, 261, 262 Developer tab, 378, 386, 402 environment, 5 format buttons on, 164–165 Format tab, 294–297 Formatting tab, 267 groups on, 5 Layout tab, 268, 269 minimizing, 375–376 Page Setup tab, 321 placing Quick Access toolbar below, 376, 377 RIGHT function, 128, 137 right-aligned labels, 153 right-click method, 74 rotated labels, 153, 154 rotating objects, 294 routing, 351–352, 460 row(s) coloring, 161 defined, 460 deleting, 77 freezing, 40 height of, 154–156 hiding, 157–158, 312, 437 inserting, 78 rearranging, 79–80 referencing entire, 90
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482 row(s) (cont.) selecting, 39 switching to columns, 159–160 unhiding, 157–158 in worksheets, 28 row address, 447 row field in PivotTable, 224 row labels, printing on every page, 329–332 R-squared value, 277 on charts, 279, 280 defined, 460 rules, for conditional formatting, 173 Run Sub/UserForm button, 412, 413 running balance, calculating, 426



S Save As dialog box, 368 Save button, 18 Save disk icon, 7 Save Workbook button, 412, 413 saved query, reusing, 198–199 saving backup files, automatically, 20 chart formats, 286–288 queries, 197 templates, 21 workbooks, 18–19, 346 worksheets as web pages, 368–369 scales, 460 Scaling section, Page Setup dialog box, 328 scatter charts, 448. See also XY Scatter chart scenario, 208–210, 460 Scenario Manager, 203, 212, 460 Scenario Manager dialog box, 208, 210, 211 Scientific format, numbers displayed in, 164 scientific notation, 453 screen display, changing, 373–375 screen, filling, 374 ScreenTip on charts, 267 for hyperlink, 18, 368 for Print button, 311 scheme, changing, 5 style, choosing, 378 scroll bar creating, 395–396 defined, 460 described, 394



INDEX



width of, 396 in worksheet, 386 Scroll Bar control, 388, 460 Scroll Lock, 460 searching. See also finding Help files, 10–11 Microsoft Knowledge Base, 13 secondary axis, 281–283, 460 security level, setting for macros, 402, 418 Select Changes to Accept or Reject dialog box, 348 Select Workbook dialog box, 195 selected worksheet. See active worksheet Send to commands, as overkill, 351 sending data to Access, 366–367 data to Word, 358–365 workbooks, 351–352 serial numbers, date or time, 138, 166, 167 series. See data series Series command, 60 Set Print Area, selecting, 311 shadowed border on chart titles, 266 shape(s), 293–294 Shape Effects button, 295, 297 Shape Styles group, Format tab, 295 Shapes group, 291–292 Share Workbook button, Review tab, 344 Share Workbook dialog box, 345, 350 shared workbooks changes in, 346–351 described, 343 between programs, 343–356 protecting, 353 saving, 346 tasks not available, 344–345 users locked-out, 351 users, removing, 345 shared-data terminology, 357–358 SharePoint site, 67 sharing data, 358–365 workbooks, 343–356 sheet(s). See worksheet(s) Sheet tab coloring, 32–33 dragging and dropping, 33 dragging between workbooks, 34 hiding, 37 on Page Setup dialog box, 323, 324, 331, 332
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selecting worksheets, 30 shortcut menu, 460 shortcut icons to folders, 14 labels, 14–15 shortcut menu, defined, 461 Show/Hide group, PivotTable Tools tab, 229 Shrink to fit setting, 158 shrinking entries, 158 side-by-side scrolling in two windows, 43–44 simple borders, 146 simple formulas, writing, 93–94 simple macro, recording, 403–405 Smart Tags, turning off, 64 SmartArt, 303–304 Social Security number, format for, 170 Solver, 218–222, 461 Sort buttons, 186, 187 Sort dialog box, 186, 187 Sort group, PivotTable Tools tab, 230 sort key, 183, 461 sort order, 461 Sort toolbar buttons, 184, 185 Sort Warning dialog box, 185 sorting customizing, 187 lists, 183–188 undoing, 187–188 unexpected results from, 185 source data creating PivotChart from, 244 drilling down for, 239 for PivotTable, 224–225, 461 source range, changing for charts, 261 source workbooks, 98 source worksheet, 461 space character, in Find what and Replace with boxes, 72 Special category, Number tab, 169 spelling checking, 82–84 correction of, adjusting, 380 Spelling dialog box, 83–84 spin button, 394–395 spin button control, 387 spinner(s), 386, 394, 395 spinner control, 461 split bar, 461



483 Split button, 41 split windows, compared to multiple windows, 41 splitting panes, 41 square, drawing, 293 square root, calculating, 88 standard font, 461 Start menu Documents list, 14 starting Excel from, 3–4 startup directory, 461 statements in macros, 411, 412 static entry, 93, 462. See also hardcode static range, 130 status bar, 10, 462 STDEV calculation, 119 STDEVP calculation, 119 stock charts, versions of, 258, 259 Stop Recording button, 404 Stop style, Error Alert tab, 110 storage workbooks for macros, 401 strikethrough, 146 strings. See text strings Structured Query Language (SQL), 462 style(s) accessing, 176–177 accounting, 176 comma, 165, 176, 177 Currency, 176, 177, 215 customizing, 177 definition of, 175, 177, 462 deleting, 178–179 formatting with, 175–179 normal, defined, 456 for numbers, 176 percent, 176, 177 picture, adjusting, 303 reference, defined, 459 ScreenTip, choosing, 378 underline, selecting, 145–146 workbook, copying, 178 worksheet, 175 Style box, 177, 178 Styles option on the Home Ribbon, 176 Sub line in macros, 411 subscript, 146 Subtotal dialog box, 206–208 SUBTOTAL function, 66, 115, 117, 192–193 subtotal(s), nested, defined, 456
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484 subtotaling tables, 206–208 SUM function, 115–119, 436 SUMIF function, 115, 116–117, 122, 204 Summary function, 462 superscript, 146 surface chart, 258, 259 Synchronous Scrolling button, 44



T Tab key, moving between cells, 53, 54, 55 table(s) consolidating, 204–205 defined, 462 described, 55 entering data in, 53–54 running query on, preparation for, 193–194 sending in e-mail message, 352 sorting by headings, 187 subtotaling, 206–208 transposing, 159–160 table format, removing from pasted cells, 360 tabs, default, 8, 9 target cell defined, 462 in Solver, 218 in Solver Parameters, 220 task panes, 5–6 taskbar buttons, making separate, 16 telephone number, custom format for, 170, 171 template(s) creating, 21–22 default, changing, 23–24 defined, 21, 462 prebuilt, 22–23 saving, 21 testing dynamic range, 133–134 functions with mock data, 114 macros, 414, 415 text aligning in cells, 152–153 converting Excel objects into, 360 fitting in cells, 152–160 linked, 449 pasting into worksheets, 365 placing in basic shape, 300 shrinking to fit, 329



INDEX



unattached, 463 unlinked, 448–449 wrapping in cells, 156–157 text box defined, 462 deleting, 280 drawing, 300 formatting, 280 text case functions, 127–128 text characters, making part of cell display, 169 text entries AutoFilling, 58–59 formatting, 169 text field control, 388 text functions, 127–128, 136–137 text strings enclosing in quote marks, 129, 169, 170 extracting a specific number of characters, 128 filter for, 191–192 finding, 70–71 indicating in Excel, 117 replacing, 72–73 tick mark, 462 tick-mark label, 462 tilde (~), 463 time calculating, 138, 168 current, entering, 53 formatting, 167–168 punctuation for formatting, 51–52 serial numbers, 138, 166, 167 showing changes over, 256 time blocks, clicking to mark or unmark, 432 Time functions, 138 time-log template, 431–437 title(s) adding to charts, 268–269 entering across tables, 158–159 title bar, 15, 462 TODAY function, 126–127 toggle macro, 413–416 toolbar Add-Ins Quick Access, 8 chart, 449 Data Quick Access, 8 floating, 452 Forms, 387, 452
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Formula Auditing, 109 Formulas Quick Access, 8 Home Quick Access, 8, 9 Insert Quick Access, 8 Mini, 5, 378 Page Layout Quick Access, 8 placing Camera button on, 305 Quick Access access to, 6–7 adding Camera button to, 305 attaching macro to, 407 customizing, 376–377 Review Quick Access, 8 View Quick Access, 8 toolbar buttons, 145 Tools group, PivotTable Tools tab, 229 total interest paid, adding with PMT, 126 Trace Dependents button, 107 Trace Error button, 109 Trace Precedents button, 107 tracing formulas, 106–107 tracked changes, accepting and rejecting, 348–349 transposing tables, 159–160 trendline(s) adding to charts, 276–281 defined, 463 deleting, 280 formatting, 280 purpose of, 276 truth about, 277 trendline label, 463 triangle (red) in a commented cell, 81 two-criteria filter, 191 two-input data table, 214–215



U unattached text, 463 unchanging cells in Solver, 219 underline styles, selecting, 145–146 Undo button, Quick Access toolbar, 65 Undo option, 7 undoing actions, 65 macros, 406 Replace All, 73 rotation, 274 sorting, 187–188 unfreezing panes, 40 Ungroup button, PivotTable Tools tab, 235



Ungroup Sheets option, 31 unhiding rows, 157–158 worksheets, 37 unlinked text, 448–449 unlocking cells that change value, 436 Update Link option, 361 UPPER function, 127–128, 137 user forms, 383 user name in comments, 82



V valid trendline, 276, 278 validating data during entry, 67–69 value(s) converting actual to displayed, 173–175 pasting, 76 value axis, scale of, 269–270 #VALUE! error, 108 VAR calculation by SUBTOTAL function, 119 VARP calculation by SUBTOTAL function, 119 VBA (Visual Basic for Applications), 463 view of PivotTables, 238 zooming, 45–46 View Microsoft Excel button, 412, 413 View Quick Access Toolbar, 8 Visual Basic Editor building macros for checkbook calculator, 427–431 exploring, 408–413 opening macro in, 414, 416 Standard toolbar, 412–413 Visual Basic for Applications (VBA) programming language. See macro(s) VLOOKUP function, 122–123, 136, 157, 385 voice-recognition program, 64



W Web pages creating hyperlinks to, 17 querying, 200–201 saving worksheets as, 368–369 Web query, 463 WEEK function, 138



36_045947 bindex.qxd



1/4/07



10:13 PM



486 wildcard characters, 463 windows active, 447 closing, 43 multiple, 16, 42–45 opening, 16, 43 reshaping, 43 split, compared to multiple, 41 Windows calculator, 88–89 Windows Start menu. See Start menu Word linked object in documents, 361 placing side by side with Excel, 363 sending data to Excel, 364 WordArt, 300–301 workbook(s) closing quietly, macro for, 429–431 color-coding contents of, 32–33 creating, 30, 35 defined, 28, 463 dependent, 98 dragging ranges to new, 73 formulas linking, 97–98 moving or copying worksheets to, 34–35 opening, 16, 343 opening multiple windows in, 42 opening windows in different, 43 printing entire, 316 properties, setting, 19–20 protecting, 352–356 rearranging worksheets in, 33 reusing existing, 22 sending and routing, 351–352 sharing, 343–356 sharing between programs, 357–369 storage for macros, 401 styles from, copying, 178 templates for, 21–24, 462 unshared, protecting, 353 unsharing, 351 workbook files closing, 24 multiple, opening, 16 opening, 14–17 protecting, 356 saving, 18–19 Workbook_Open macro, 427
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working directory, 463 worksheet(s) active, 30, 447 adding, 35–36 adding comments to, 81–82 adding controls to, 383–399 basics, 28–29 buttons in, 386 copying, 33, 34–35 creating PivotTable from, 225 default in each, 27 defined, 28, 463 deleting, 36 dependent, 451 dragging ranges to, 73 elements of, 28 embedding PivotCharts on, 246–247 errors in, locating, 108–110 formatting with styles, 175 formulas linking, 96–97 gridlines, 294, 337 group of, deselecting, 31 hiding, 37 invalid data in, finding, 109–110 moving, 33, 34–35 moving around in, 37–38 multiple identical, 31 naming, 31–32 number of, changing, 36 panes, creating multiple within, 41 pasting pictures on, 301–302 printing, 310, 311–317 protecting, 352–356, 353–355 real-life examples of, 423–442 rearranging, 33 renaming, 32 saving as Web pages, 368–369 selecting, 29–31 templates for, 36 used area of, moving to end of, 38 zeroes in, hiding, 174 zooming in and out of, 374–375 worksheet controls. See also controls capabilities of, 384–386 common aspects, 388–389 creating, 386 described, 383 workspace, customizing, 373–381 wrapped text in cells, 156–157
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X



Y



X button, 9 x-axis, 448, 463 XLSTART folder, 24, 402 .xlt extension, 21 XY Scatter chart, 259–260, 276, 463–464



y-axis, 448, 464



Z zeroes, hiding, 174–175 ZIP codes, custom format for, 170 zooming, view, 45–46, 374–375
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